How to Contact MathWorks

www.mathworks.com Web
comp.soft-sys.matlab Newsgroup
www.mathworks.com/contact_TS.html Technical Support

@ suggest@mathworks.com Product enhancement suggestions
bugs@mathworks.com Bug reports
doc@mathworks.com Documentation error reports
service@mathworks.com Order status, license renewals, passcodes
info@mathworks.com Sales, pricing, and general information

508-647-7000 (Phone)
508-647-7001 (Fax)

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

For contact information about worldwide offices, see the MathWorks Web site.

Curve Fitting Toolbox™ User’s Guide

© COPYRIGHT 2001–2013 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used or copied only under the terms of the license agreement. No part of this manual may be photocopied or reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by, for, or through the federal government of the United States. By accepting delivery of the Program or Documentation, the government hereby agrees that this software or documentation qualifies as commercial computer software or commercial computer software documentation as such terms are used or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern the use, modification, reproduction, release, performance, display, and disclosure of the Program and Documentation by the federal government (or other entity acquiring for or through the federal government) and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the government’s needs or is inconsistent in any respect with federal procurement law, the government agrees to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may be trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see www.mathworks.com/patents for more information.
<table>
<thead>
<tr>
<th>Date</th>
<th>Printing</th>
<th>Revision Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 2001</td>
<td>First printing</td>
<td>New for Version 1 (Release 12.1)</td>
</tr>
<tr>
<td>July 2002</td>
<td>Second printing</td>
<td>Revised for Version 1.1 (Release 13)</td>
</tr>
<tr>
<td>June 2004</td>
<td>Online only</td>
<td>Revised for Version 1.1.1 (Release 14)</td>
</tr>
<tr>
<td>October 2004</td>
<td>Online only</td>
<td>Revised for Version 1.1.2 (Release 14SP1)</td>
</tr>
<tr>
<td>March 2005</td>
<td>Online only</td>
<td>Revised for Version 1.1.3 (Release 14SP2)</td>
</tr>
<tr>
<td>June 2005</td>
<td>Third printing</td>
<td>Minor revision</td>
</tr>
<tr>
<td>September 2005</td>
<td>Online only</td>
<td>Revised for Version 1.1.4 (Release 14SP3)</td>
</tr>
<tr>
<td>March 2006</td>
<td>Online only</td>
<td>Revised for Version 1.1.5 (Release 2006a)</td>
</tr>
<tr>
<td>September 2006</td>
<td>Online only</td>
<td>Revised for Version 1.1.6 (Release 2006b)</td>
</tr>
<tr>
<td>November 2006</td>
<td>Fourth printing</td>
<td>Mini revision</td>
</tr>
<tr>
<td>March 2007</td>
<td>Online only</td>
<td>Revised for Version 1.1.7 (Release 2007a)</td>
</tr>
<tr>
<td>September 2007</td>
<td>Online only</td>
<td>Revised for Version 1.2 (Release 2007b)</td>
</tr>
<tr>
<td>March 2008</td>
<td>Online only</td>
<td>Revised for Version 1.2.1 (Release 2008a)</td>
</tr>
<tr>
<td>October 2008</td>
<td>Online only</td>
<td>Revised for Version 1.2.2 (Release 2008b)</td>
</tr>
<tr>
<td>March 2009</td>
<td>Online only</td>
<td>Revised for Version 2.0 (Release 2009a)</td>
</tr>
<tr>
<td>September 2009</td>
<td>Online only</td>
<td>Revised for Version 2.1 (Release 2009b)</td>
</tr>
<tr>
<td>March 2010</td>
<td>Online only</td>
<td>Revised for Version 2.2 (Release 2010a)</td>
</tr>
<tr>
<td>September 2010</td>
<td>Online only</td>
<td>Revised for Version 3.0 (Release 2010b)</td>
</tr>
<tr>
<td>April 2011</td>
<td>Online only</td>
<td>Revised for Version 3.1 (Release 2011a)</td>
</tr>
<tr>
<td>September 2011</td>
<td>Online only</td>
<td>Revised for Version 3.2 (Release 2011b)</td>
</tr>
<tr>
<td>March 2012</td>
<td>Online only</td>
<td>Revised for Version 3.2.1 (Release 2012a)</td>
</tr>
<tr>
<td>September 2012</td>
<td>Online only</td>
<td>Revised for Version 3.3 (Release 2012b)</td>
</tr>
<tr>
<td>March 2013</td>
<td>Online only</td>
<td>Revised for Version 3.3.1 (Release 2013a)</td>
</tr>
</tbody>
</table>
Selecting Compatible Size Surface Data .............. 2-10
Troubleshooting Data Problems ...................... 2-11

Interactive Fit Comparison ............................ 2-13
Refining Your Fit ..................................... 2-13
Creating Multiple Fits ............................... 2-13
Duplicating a Fit ...................................... 2-14
Deleting a Fit ......................................... 2-14
Displaying Multiple Fits Simultaneously .......... 2-14
Using the Statistics in the Table of Fits .......... 2-18

Sessions ..................................................... 2-20
Overview .............................................. 2-20
Saving Sessions ....................................... 2-20
Reloading Sessions .................................... 2-20
Removing Sessions .................................... 2-20

Generating MATLAB Code and Exporting Fits ...... 2-21
Interactive Code Generation and Programmatic Fitting ... 2-21

Curve Fitting to Census Data ........................ 2-22
Interactive Curve Fitting Workflow ................. 2-22
Loading Data and Creating Fits ..................... 2-22
Determining the Best Fit ............................. 2-26
Analyzing Your Best Fit in the Workspace .......... 2-32
Saving Your Work ................................... 2-34

Surface Fitting to Franke Data ...................... 2-36

Programmatic Curve and Surface Fitting

Curve and Surface Fitting ........................... 3-2
Fitting a Curve ....................................... 3-2
Fitting a Surface ..................................... 3-2
Model Types and Fit Analysis ....................... 3-3
Workflow for Command Line Fitting ................ 3-3
Linear and Nonlinear Regression

Parametric Fitting .................................. 4-2
Parametric Fitting with Library Models ............ 4-2
Selecting a Model Type Interactively ............... 4-3
Selecting Model Type Programmatically .......... 4-5
Using Normalize or Center and Scale .............. 4-6
Specifying Fit Options and Optimized Starting Points ... 4-7

List of Library Models for Curve and Surface Fitting .. 4-13
Use Library Models to Fit Data ...................... 4-13
Library Model Types ................................ 4-13
Model Names and Equations ......................... 4-14

Polynomial Models .................................. 4-19
About Polynomial Models ............................ 4-19
Selecting a Polynomial Fit Interactively .......... 4-20
Selecting a Polynomial Fit at the Command Line .... 4-22
Defining Polynomial Terms for Polynomial Surface Fits .. 4-23

Exponential Models .................................. 4-25
About Exponential Models ............................ 4-25
Selecting an Exponential Fit Interactively ........... 4-25
Selecting an Exponential Fit at the Command Line .... 4-27

Fourier Series ...................................... 4-29
About Fourier Series Models ......................... 4-29
Selecting a Fourier Fit Interactively ............... 4-29
Selecting a Fourier Fit at the Command Line ....... 4-30

Gaussian Models .................................... 4-31
About Gaussian Models .............................. 4-31
Selecting a Gaussian Fit Interactively ......................... 4-31
Selecting a Gaussian Fit at the Command Line ............... 4-32

Power Series .................................................. 4-33
About Power Series Models ..................................... 4-33
Selecting a Power Fit Interactively ............................ 4-33
Selecting a Power Fit at the Command Line ................... 4-34

Rational Polynomials ........................................... 4-35
About Rational Models ........................................... 4-35
Selecting a Rational Fit Interactively .......................... 4-36
Selecting a Rational Fit at the Command Line ............... 4-36
Example: Rational Fit ........................................... 4-37

Sum of Sines Models ........................................... 4-42
About Sum of Sines Models .................................... 4-42
Selecting a Sum of Sine Fit Interactively ....................... 4-42
Selecting a Sum of Sine Fit at the Command Line .......... 4-43

Weibull Distributions ........................................... 4-44
About Weibull Distribution Models ............................. 4-44
Selecting a Weibull Fit Interactively .......................... 4-44
Selecting a Weibull Fit at the Command Line ............... 4-45

Least-Squares Fitting .......................................... 4-47
Introduction .................................................... 4-47
Error Distributions .............................................. 4-48
Linear Least Squares ........................................... 4-49
Weighted Least Squares ........................................ 4-52
Robust Least Squares .......................................... 4-54
Nonlinear Least Squares ....................................... 4-56
Example: Robust Fitting ....................................... 4-58

Custom Linear and Nonlinear Regression

Custom Models ................................................... 5-2
Custom Models vs. Library Models .............................. 5-2
About Smoothing Splines .............................................. 6-8
Selecting a Smoothing Spline Fit Interactively .................. 6-9
Selecting a Smoothing Spline Fit at the Command Line ........ 6-11
Example: Nonparametric Fitting with Cubic and Smoothing Splines ......................................................... 6-11

Lowess Smoothing ..................................................... 6-16
About Lowess Smoothing .............................................. 6-16
Selecting a Lowess Fit Interactively ............................... 6-16
Selecting a Lowess Fit at the Command Line ................... 6-18
Fitting Automotive Fuel Efficiency Surfaces at the Command Line ................................................................. 6-18

Filtering and Smoothing Data ........................................ 6-30
About Data Smoothing and Filtering ............................... 6-30
Moving Average Filtering ............................................. 6-30
Savitzky-Golay Filtering .............................................. 6-32
Local Regression Smoothing ......................................... 6-34
Example: Smoothing Data ............................................. 6-40
Example: Smoothing Data Using Loess and Robust Loess .............................................................. 6-42

Fit Postprocessing

Exploring and Customizing Plots .................................... 7-2
Displaying Fit and Residual Plots ................................... 7-2
Viewing Surface Plots and Contour Plots ......................... 7-4
Using Zoom, Pan, Data Cursor, and Outlier Exclusion ....... 7-6
Customizing the Fit Display .......................................... 7-6
Print to MATLAB Figures ............................................ 7-9

Removing Outliers .................................................... 7-10

Selecting Validation Data ............................................ 7-11

Generating Code and Exporting Fits to the Workspace ....... 7-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating Code from the Curve Fitting Tool</td>
<td>7-12</td>
</tr>
<tr>
<td>Exporting a Fit to the Workspace</td>
<td>7-13</td>
</tr>
<tr>
<td><strong>Evaluating Goodness of Fit</strong></td>
<td>7-16</td>
</tr>
<tr>
<td>How to Evaluate Goodness of Fit</td>
<td>7-16</td>
</tr>
<tr>
<td>Goodness-of-Fit Statistics</td>
<td>7-17</td>
</tr>
<tr>
<td><strong>Residual Analysis</strong></td>
<td>7-21</td>
</tr>
<tr>
<td>Plotting and Analysing Residuals</td>
<td>7-21</td>
</tr>
<tr>
<td>Example: Residual Analysis</td>
<td>7-23</td>
</tr>
<tr>
<td><strong>Confidence and Prediction Bounds</strong></td>
<td>7-28</td>
</tr>
<tr>
<td>About Confidence and Prediction Bounds</td>
<td>7-28</td>
</tr>
<tr>
<td>Confidence Bounds on Coefficients</td>
<td>7-29</td>
</tr>
<tr>
<td>Prediction Bounds on Fits</td>
<td>7-29</td>
</tr>
<tr>
<td>Example: Prediction Intervals</td>
<td>7-33</td>
</tr>
<tr>
<td><strong>Differentiating and Integrating a Fit</strong></td>
<td>7-36</td>
</tr>
</tbody>
</table>

**Spline Fitting**

**About Splines**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introducing Spline Fitting</td>
<td>8-2</td>
</tr>
<tr>
<td>About Splines in Curve Fitting Toolbox</td>
<td>8-2</td>
</tr>
<tr>
<td>Spline Overview</td>
<td>8-3</td>
</tr>
<tr>
<td>Interactive Spline Fitting</td>
<td>8-3</td>
</tr>
<tr>
<td>Programmatic Spline Fitting</td>
<td>8-4</td>
</tr>
<tr>
<td><strong>Curve Fitting Toolbox Splines and MATLAB Splines</strong></td>
<td>8-5</td>
</tr>
<tr>
<td>Curve Fitting Toolbox Splines</td>
<td>8-5</td>
</tr>
<tr>
<td>MATLAB Splines</td>
<td>8-7</td>
</tr>
<tr>
<td>Expected Background</td>
<td>8-7</td>
</tr>
<tr>
<td>Vector Data Type Support</td>
<td>8-8</td>
</tr>
<tr>
<td>Spline Function Naming Conventions</td>
<td>8-8</td>
</tr>
<tr>
<td>Arguments for Curve Fitting Toolbox Spline Functions</td>
<td>8-9</td>
</tr>
<tr>
<td>Acknowledgments</td>
<td>8-9</td>
</tr>
</tbody>
</table>
### Simple Spline Examples

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cubic Spline Interpolation</td>
<td>9-2</td>
</tr>
<tr>
<td>Cubic Spline Interpolant of Smooth Data</td>
<td>9-2</td>
</tr>
<tr>
<td>Periodic Data</td>
<td>9-3</td>
</tr>
<tr>
<td>Other End Conditions</td>
<td>9-4</td>
</tr>
<tr>
<td>General Spline Interpolation</td>
<td>9-4</td>
</tr>
<tr>
<td>Knot Choices</td>
<td>9-6</td>
</tr>
<tr>
<td>Smoothing</td>
<td>9-7</td>
</tr>
<tr>
<td>Least Squares</td>
<td>9-9</td>
</tr>
</tbody>
</table>

### Vector-Valued Functions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fitting Values at N-D Grid with Tensor-Product Splines</td>
<td>9-10</td>
</tr>
</tbody>
</table>

### Types of Splines

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Types of Splines: ppform and B-form</td>
<td>10-2</td>
</tr>
<tr>
<td>Polynomials vs. Splines</td>
<td>10-2</td>
</tr>
<tr>
<td>ppform</td>
<td>10-3</td>
</tr>
<tr>
<td>B-form</td>
<td>10-3</td>
</tr>
<tr>
<td>Knot Multiplicity</td>
<td>10-3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-Splines and Smoothing Splines</td>
<td>10-5</td>
</tr>
<tr>
<td>B-Spline Properties</td>
<td>10-5</td>
</tr>
<tr>
<td>Variational Approach and Smoothing Splines</td>
<td>10-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multivariate and Rational Splines</td>
<td>10-8</td>
</tr>
<tr>
<td>Multivariate Splines</td>
<td>10-8</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Rational Splines</td>
<td>10-9</td>
</tr>
<tr>
<td><strong>The ppform</strong></td>
<td>10-10</td>
</tr>
<tr>
<td>Introduction to ppform</td>
<td>10-10</td>
</tr>
<tr>
<td>Definition of ppform</td>
<td>10-10</td>
</tr>
<tr>
<td>Constructing and Working with ppform Splines</td>
<td>10-12</td>
</tr>
<tr>
<td>Constructing a ppform</td>
<td>10-12</td>
</tr>
<tr>
<td>Working With ppform Splines</td>
<td>10-13</td>
</tr>
<tr>
<td>Example ppform</td>
<td>10-14</td>
</tr>
<tr>
<td><strong>The B-form</strong></td>
<td>10-16</td>
</tr>
<tr>
<td>Introduction to B-form</td>
<td>10-16</td>
</tr>
<tr>
<td>Definition of B-form</td>
<td>10-16</td>
</tr>
<tr>
<td>B-form and B-Splines</td>
<td>10-16</td>
</tr>
<tr>
<td>B-Spline Knot Multiplicity</td>
<td>10-17</td>
</tr>
<tr>
<td>Choice of Knots for B-form</td>
<td>10-19</td>
</tr>
<tr>
<td>Constructing and Working with B-form Splines</td>
<td>10-22</td>
</tr>
<tr>
<td>Construction of B-form</td>
<td>10-22</td>
</tr>
<tr>
<td>Working With B-form Splines</td>
<td>10-23</td>
</tr>
<tr>
<td>Example: B-form Spline Approximation to a Circle</td>
<td>10-24</td>
</tr>
<tr>
<td>Multivariate Tensor Product Splines</td>
<td>10-27</td>
</tr>
<tr>
<td>Introduction to Multivariate Tensor Product Splines</td>
<td>10-27</td>
</tr>
<tr>
<td>B-form of Tensor Product Splines</td>
<td>10-27</td>
</tr>
<tr>
<td>Construction With Gridded Data</td>
<td>10-28</td>
</tr>
<tr>
<td>ppform of Tensor Product Splines</td>
<td>10-28</td>
</tr>
<tr>
<td>Example: The Mobius Band</td>
<td>10-28</td>
</tr>
<tr>
<td>NURBS and Other Rational Splines</td>
<td>10-30</td>
</tr>
<tr>
<td>Introduction to Rational Splines</td>
<td>10-30</td>
</tr>
<tr>
<td>rsform: rpform, rBform</td>
<td>10-30</td>
</tr>
<tr>
<td>Constructing and Working with Rational Splines</td>
<td>10-32</td>
</tr>
<tr>
<td>Rational Spline Example: Circle</td>
<td>10-32</td>
</tr>
<tr>
<td>Rational Spline Example: Sphere</td>
<td>10-33</td>
</tr>
<tr>
<td>Functions for Working With Rational Splines</td>
<td>10-34</td>
</tr>
<tr>
<td>Constructing and Working with stform Splines</td>
<td>10-36</td>
</tr>
</tbody>
</table>
## Advanced Spline Examples

### Least-Squares Approximation by Natural Cubic Splines
- **Splines** ........................................ 11-2
- **Problem** ........................................ 11-2
- **General Resolution** .............................. 11-2
- **Need for a Basis Map** .......................... 11-3
- **A Basis Map for “Natural” Cubic Splines** ....... 11-3
- **The One-line Solution** ......................... 11-4
- **The Need for Proper Extrapolation** ............ 11-4
- **The Correct One-Line Solution** .................. 11-6
- **Least-Squares Approximation by Cubic Splines** ..... 11-7

### Solving A Nonlinear ODE
- **Problem** ........................................ 11-8
- **Approximation Space** ............................ 11-8
- **Discretization** ................................... 11-9
- **Numerical Problem** .............................. 11-9
- **Linearization** ...................................... 11-10
- **Linear System to Be Solved** .................... 11-10
- **Iteration** ......................................... 11-11

### Construction of the Chebyshev Spline
- **What Is a Chebyshev Spline?** ..................... 11-14
- **Choice of Spline Space** .......................... 11-14
- **Initial Guess** ..................................... 11-15
- **Remez Iteration** ................................ 11-16

### Approximation by Tensor Product Splines
- **Choice of Sites and Knots** ....................... 11-20
- **Least Squares Approximation as Function of y** .... 11-21
- **Approximation to Coefficients as Functions of x** .. 11-22
- **The Bivariate Approximation** .................... 11-23
- **Switch in Order** ................................ 11-25
Getting Started

- “Product Description” on page 1-2
- “Curve Fitting Tools” on page 1-3
- “Curve Fitting” on page 1-4
- “Surface Fitting” on page 1-6
- “Spline Fitting” on page 1-8
Product Description

Fit curves and surfaces to data using regression, interpolation, and smoothing

Curve Fitting Toolbox™ provides graphical tools and command-line functions for fitting curves and surfaces to data. The toolbox lets you perform exploratory data analysis, preprocess and post-process data, compare candidate models, and remove outliers. You can conduct regression analysis using the library of linear and nonlinear models provided or specify your own custom equations. The library provides optimized solver parameters and starting conditions to improve the quality of your fits. The toolbox also supports nonparametric modeling techniques, such as splines, interpolation, and smoothing.

After creating a fit, you can apply a variety of post-processing methods for plotting, interpolation, and extrapolation; estimating confidence intervals; and calculating integrals and derivatives.

Key Features

- Graphical tools for curve and surface fitting
- Linear and nonlinear regression with custom equations
- Library of regression models with optimized starting points and solver parameters
- Interpolation methods, including B-splines, thin plate splines, and tensor-product splines
- Smoothing techniques, including smoothing splines, localized regression, Savitzky-Golay filters, and moving averages
- Preprocessing routines, including outlier removal and sectioning, scaling, and weighting data
- Post-processing routines, including interpolation, extrapolation, confidence intervals, integrals and derivatives
Curve Fitting Tools

Curve Fitting Toolbox software allows you to work in two different environments:

- An interactive environment, with Curve Fitting Tool and Spline Tool graphical user interfaces
- A programmatic environment that allows you to write object-oriented MATLAB® code using curve and surface fitting methods

To open Curve Fitting Tool or Spline Tool, enter one of the following:

- cftool
- splinetool

To list the Curve Fitting Toolbox functions for use in MATLAB programming, type

help curvefit

The code for any function can be opened in the MATLAB Editor by typing

edit function_name

Brief, command line help for any function is available by typing

help function_name

Complete documentation for any function is available by typing

doc function_name

You can change the way any toolbox function works by copying and renaming its file, examining your copy in the editor, and then modifying it.

You can also extend the toolbox by adding your own files, or by using your code in combination with functions from other toolboxes, such as Statistics Toolbox™ or Optimization Toolbox™ software.
Curve Fitting

Interactive Curve Fitting
To interactively fit a curve, follow the steps in this simple example:

1. Load some data at the MATLAB command line.
   ```matlab
   load hahn1
   ```

2. Open Curve Fitting Tool. Enter:
   ```matlab
   cftool
   ```

3. In Curve Fitting Tool, select X Data and Y Data.
   Curve Fitting Tool creates a default interpolation fit to the data.

4. Choose a different model type using the fit category drop-down list, e.g., select Polynomial.

5. Try different fit options for your chosen model type.

   Curve Fitting Tool creates a file in the Editor containing MATLAB code to recreate all fits and plots in your interactive session.

For more information about fitting curves in Curve Fitting Tool, see “Interactive Curve and Surface Fitting” on page 2-2.

For details and examples of specific model types and fit analysis, see the following sections:

1. “Linear and Nonlinear Regression”
2. “Interpolation”
3. “Smoothing”
4. “Fit Postprocessing”
Programmatic Curve Fitting

To programmatically fit a curve, follow the steps in this simple example:

1 Load some data.
   
   ```matlab
   load hahn1
   ```

   Create a fit using the `fit` function, specifying the variables and a model type (in this case `rat23` is the model type).
   
   ```matlab
   f = fit( temp, thermex, 'rat23' )
   ```

   Plot your fit and the data.
   
   ```matlab
   plot( f, temp, thermex )
   f( 600 )
   ```

See these sections:

1 “Curve and Surface Fitting” on page 3-2

2 “Curve and Surface Fitting Objects and Methods” on page 3-6

For details and examples of specific model types and fit analysis, see the following sections:

1 “Linear and Nonlinear Regression”

2 “Interpolation”

3 “Smoothing”

4 “Fit Postprocessing”
Surface Fitting

**Interactive Surface Fitting**
To interactively fit a surface, follow the steps in this simple example:

1. Load some data at the MATLAB command line.
   ```matlab
   load franke
   ```

2. Open Curve Fitting Tool. Enter:
   ```matlab
   cftool
   ```

3. In Curve Fitting Tool, select **X Data**, **Y Data** and **Z Data**.
   Curve Fitting Tool creates a default interpolation fit to the data.

4. Choose a different model type using the fit category drop-down list, e.g., select **Polynomial**.

5. Try different fit options for your chosen model type.

6. Select **File > Generate Code**.
   Curve Fitting Tool creates a file in the Editor containing MATLAB code to recreate all fits and plots in your interactive session.

For more information about fitting surfaces in Curve Fitting Tool, see “Interactive Curve and Surface Fitting” on page 2-2.

For details and examples of specific model types and fit analysis, see the following sections:

1. “Linear and Nonlinear Regression”
2. “Interpolation”
3. “Smoothing”
4. “Fit Postprocessing”
Programmatic Surface Fitting

To programmatically fit a surface, follow the steps in this simple example:

1. Load some data.
   ```matlab
   load franke
   ```

2. Create a fit using the `fit` function, specifying the variables and a model type (in this case `poly23` is the model type).
   ```matlab
   f = fit( [x, y], z, 'poly23' )
   ```

3. Plot your fit and the data.
   ```matlab
   plot(f, [x,y], z)
   ```

To programmatically fit surfaces, see the following topics:

1. “Curve and Surface Fitting” on page 3-2
2. “Curve and Surface Fitting Objects and Methods” on page 3-6

For details and examples of specific model types and fit analysis, see the following sections:

1. “Linear and Nonlinear Regression”
2. “Interpolation”
3. “Smoothing”
4. “Fit Postprocessing”
Spline Fitting

In this section...

| “About Splines in Curve Fitting Toolbox” on page 1-8 |
| “Interactive Spline Fitting” on page 1-9 |
| “Programmatic Spline Fitting” on page 1-9 |

About Splines in Curve Fitting Toolbox

You can work with splines in Curve Fitting Toolbox in several ways.

Using Curve Fitting Tool or the fit function you can:

- Fit cubic spline interpolants to curves or surfaces
- Fit smoothing splines and shape-preserving cubic spline interpolants to curves (but not surfaces)

The toolbox also contains specific splines functions to allow greater control over what you can create. For example, you can use the csapi function for cubic spline interpolation. Why would you use csapi instead of the fit function 'cubicinterp' option? You might require greater flexibility to work with splines for the following reasons:

- You want to combine the results with other splines, e.g., by addition.
- You want vector-valued splines. You can use csapi with scalars, vectors, matrices, and ND-arrays. The fit function only allows scalar-valued splines.
- You want other types of splines such as ppform, B-form, tensor-product, rational, and stform thin-plate splines.
- You want to create splines without data.
- You want to specify breaks, optimize knot placement, and use specialized functions for spline manipulation such as differentiation and integration.
If you require specialized spline functions, see the following sections for interactive and programmatic spline fitting.

**Interactive Spline Fitting**
You can access all spline functions from the `splinetool` GUI.

See “Introducing Spline Fitting” on page 8-2.

**Programmatic Spline Fitting**
To programmatically fit splines, see “Construction” for descriptions of types of splines and numerous examples.
Interactive Fitting

- “Interactive Curve and Surface Fitting” on page 2-2
- “Data Selection” on page 2-8
- “Interactive Fit Comparison” on page 2-13
- “Sessions” on page 2-20
- “Generating MATLAB Code and Exporting Fits” on page 2-21
- “Curve Fitting to Census Data” on page 2-22
- “Surface Fitting to Franke Data” on page 2-36
Interactive Curve and Surface Fitting

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Introducing the Curve Fitting Tool” on page 2-2</td>
</tr>
<tr>
<td>“Fitting a Curve” on page 2-2</td>
</tr>
<tr>
<td>“Fitting a Surface” on page 2-4</td>
</tr>
<tr>
<td>“Model Types for Curves and Surfaces” on page 2-6</td>
</tr>
</tbody>
</table>

Introducing the Curve Fitting Tool
You can fit curves and surfaces to data and view plots with the Curve Fitting Tool GUI. This tool lets you:

- Create, plot, and compare multiple fits.
- Use linear or nonlinear regression, interpolation, smoothing, and custom equations.
- View goodness-of-fit statistics, display confidence intervals and residuals, remove outliers and assess fits with validation data.
- Automatically generate code to fit and plot curves and surfaces, or export fits to the workspace for further analysis.

Fitting a Curve
1 Load some example data at the MATLAB command line:
   
   load census

2 Open the Curve Fitting Tool by entering:
   
   cftool

   Alternatively, select Curve Fitting on the Apps tab.

3 Select X data and Y data. For details, see “Data Selection” on page 2-8.
The Curve Fitting Tool creates a default polynomial fit to the data.

4 Try different fit options. For example, change the polynomial Degree to 3 to fit a cubic polynomial.

5 Select a different model type from the fit category list, e.g., Smoothing Spline. For information about models you can fit, see “Model Types for Curves and Surfaces” on page 2-6.
Select **File > Generate Code**.

The Curve Fitting Tool creates a file in the Editor containing MATLAB code to recreate all fits and plots in your interactive session.

**Tip** For a detailed workflow example, see “Curve Fitting to Census Data” on page 2-22.

To create multiple fits and compare them, see “Interactive Fit Comparison” on page 2-13.

**Fitting a Surface**

1. Load some example data at the MATLAB command line:
   
   ```matlab
   load franke
   ```

2. Open the Curve Fitting Tool:
   
   ```matlab
cftool
   ```

3. Select **X data**, **Y data** and **Z data**. For more information, see “Data Selection” on page 2-8.
The Curve Fitting Tool creates a default interpolation fit to the data.

4 Select a different model type from the fit category list, e.g., Polynomial.

For information about models you can fit, see “Model Types for Curves and Surfaces” on page 2-6.

5 Try different fit options for your chosen model type.

6 Select **File > Generate Code**.

The Curve Fitting Tool creates a file in the Editor containing MATLAB code to recreate all fits and plots in your interactive session.

**Tip** For a detailed example, see “Surface Fitting to Franke Data” on page 2-36.

To create multiple fits and compare them, see “Interactive Fit Comparison” on page 2-13.
# Model Types for Curves and Surfaces

Based on your selected data, the fit category list shows either curve or surface fit categories. The following table describes the options for curves and surfaces.

<table>
<thead>
<tr>
<th>Fit Category</th>
<th>Curves</th>
<th>Surfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regression Models</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polynomial</td>
<td>Yes (up to degree 9)</td>
<td>Yes (up to degree 5)</td>
</tr>
<tr>
<td>Exponential</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Fourier</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Gaussian</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Rational</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Sum of Sine</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Weibull</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Interpolation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interpolant</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Methods:</td>
<td>Nearest neighbor</td>
<td>Nearest neighbor</td>
</tr>
<tr>
<td></td>
<td>Linear</td>
<td>Linear</td>
</tr>
<tr>
<td></td>
<td>Cubic</td>
<td>Cubic</td>
</tr>
<tr>
<td></td>
<td>Shape-preserving (PCHIP)</td>
<td>Biharmonic (v4)</td>
</tr>
<tr>
<td><strong>Smoothing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smoothing Spline</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Lowess</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Equation</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For information about these fit types, see:

- “Linear and Nonlinear Regression”
• “Custom Models” on page 5-2
• “Interpolation”
• “Smoothing”
**Data Selection**

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Opening the Curve Fitting Tool” on page 2-8</td>
</tr>
<tr>
<td>“Selecting Data to Fit” on page 2-8</td>
</tr>
<tr>
<td>“Selecting Compatible Size Surface Data” on page 2-10</td>
</tr>
<tr>
<td>“Troubleshooting Data Problems” on page 2-11</td>
</tr>
</tbody>
</table>

**Opening the Curve Fitting Tool**

Open the Curve Fitting Tool using one of these methods:

- Enter `cftool` at the MATLAB command line.
- Select from the MATLAB Start menu:

```
Start > Toolboxes > Curve Fitting > Curve Fitting Tool (cftool)
```

Next, you are ready to select the data you want to fit.

**Selecting Data to Fit**

To select data to fit, use the drop-down lists in the Curve Fitting Tool to select variables in your MATLAB workspace.

- To fit curves:
  - Select **X data** and **Y data**.
  - Select only **Y data** to plot Y against index (x=1:length( y )).
- To fit surfaces, select **X data**, **Y data** and **Z data**.

You can use the Curve Fitting Tool drop-down lists to select any numeric variables (with more than one element) in your MATLAB workspace.

Similarly, you can select any numeric data in your workspace to use as **Weights**.
For curves, X, Y, and Weights must be matrices with the same number of elements.

For surfaces, X, Y, and Z must be either:

- Matrices with the same number of elements
- Data in the form of a table

For surfaces, weights must have the same number of elements as Z.

For more information see “Selecting Compatible Size Surface Data” on page 2-10.

When you select variables, the Curve Fitting Tool immediately creates a curve or surface fit with the default settings. If you want to avoid time-consuming refitting for large data sets, you can turn off Auto fit by clearing the check box.

Note The Curve Fitting Tool uses a snapshot of the data you select. Subsequent workspace changes to the data have no effect on your fits. To update your fit data from the workspace, first change the variable selection, and then reselect the variable with the drop-down controls.
Selecting Compatible Size Surface Data

For surface data, you can select either “Matrices of the Same Size” on page 2-10 or “Table Data” on page 2-10.

Matrices of the Same Size

Curve Fitting Tool expects inputs to be the same size. If the sizes are different but the number of elements are the same, then the tool reshapes the inputs to create a fit and displays a warning in the Results pane. The warning indicates a possible problem with your selected data.

Table Data

Table data means that \( X \) and \( Y \) represent the row and column headers of a table (sometimes called breakpoints) and the values in the table are the values of the \( Z \) output.

Sizes are compatible if:

- \( X \) is a vector of length \( n \).
- \( Y \) is a vector of length \( m \).
- \( Z \) is a 2D matrix of size \([m,n]\).

The following table shows an example of data in the form of a table with \( n = 4 \) and \( m = 3 \).

<table>
<thead>
<tr>
<th>( y(1) )</th>
<th>( x(1) )</th>
<th>( x(2) )</th>
<th>( x(3) )</th>
<th>( x(4) )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( y(1) )</td>
<td>( z(1,1) )</td>
<td>( z(1,2) )</td>
<td>( z(1,3) )</td>
<td>( z(1,4) )</td>
</tr>
<tr>
<td>( y(2) )</td>
<td>( z(2,1) )</td>
<td>( z(2,2) )</td>
<td>( z(2,3) )</td>
<td>( z(2,4) )</td>
</tr>
<tr>
<td>( y(3) )</td>
<td>( z(3,1) )</td>
<td>( z(3,2) )</td>
<td>( z(3,3) )</td>
<td>( z(3,4) )</td>
</tr>
</tbody>
</table>

Like the surf function, the tool expects inputs where \( \text{length}(X) = n \), \( \text{length}(Y) = m \) and \( \text{size}(Z) = [m,n] \). If the size of \( Z \) is \([n,m]\), the tool creates a fit but first transposes \( Z \) and warns about transforming your data. You see a warning in the Results pane like the following example:

Using X Input for rows and Y Input for columns to match Z Output matrix.
For suitable example table data, run the following code:

```matlab
x = linspace( 0, 1, 7 );
y = linspace( 0, 1, 9 ).';
z = bsxfun( @franke, x, y );
```

**Weights**

If you specify surface Weights, assign an input the same size as Z. If the sizes are different but the number of elements is the same, Curve Fitting Tool reshapes the weights and displays a warning.

**Troubleshooting Data Problems**

If there are problems with the data you select, you see messages in the **Results** pane. For example, the Curve Fitting Tool ignores Infs, NaNs, and imaginary components of complex numbers in the data, and you see messages in the **Results** pane in these cases.

If you see warnings about reshaping your data or incompatible sizes, read “Selecting Compatible Size Surface Data” on page 2-10 for information.

If you see the following warning: **Duplicate x-y data points detected: using average of the z values.**, this means that there are two or more data points where the input values (x, y) are the same or very close together. The default interpolant fit type needs to calculate a unique value at that point. You do not need do anything to fix the problem, this warning is just for your information. The Curve Fitting Tool automatically takes the average z value of any group of points with the same x-y values.

Other problems with your selected data can produce the following error:

**Error computing Delaunay triangulation. Please try again with different data.**

Some arrangements of data make it impossible for Curve Fitting Tool to compute a Delaunay triangulation. Three out of the four surface interpolation methods (linear, cubic, and nearest) require a Delaunay triangulation of the data. An example of data that can cause this error is a case where all the data
lies on a straight line in x-y. In this case, Curve Fitting Tool cannot fit a surface to the data. You need to provide more data in order to fit a surface.

**Note** Data selection is disabled if you are in debug mode. Exit debug mode to change data selections.
Interactive Fit Comparison

In this section...

“Refining Your Fit” on page 2-13
“Creating Multiple Fits” on page 2-13
“Duplicating a Fit” on page 2-14
“Deleting a Fit” on page 2-14
“Displaying Multiple Fits Simultaneously” on page 2-14
“Using the Statistics in the Table of Fits” on page 2-18

Refining Your Fit
After you create a single fit, you can refine your fit, using any of the following optional steps:

- Change fit type and settings. Select GUI settings to use the Curve Fitting Tool built-in fit types or create custom equations. For fit settings for each model type, see “Linear and Nonlinear Regression”, “Interpolation”, and “Smoothing”.

- Exclude data by removing outliers in the Curve Fitting Tool. See “Removing Outliers” on page 7-10.

- Select weights. See “Data Selection” on page 2-8.

- Select validation data. See “Selecting Validation Data” on page 7-11

- Create multiple fits and you can compare different fit types and settings side by side in the Curve Fitting Tool. See “Creating Multiple Fits” on page 2-13.

Creating Multiple Fits
After you create a single fit, it can be useful to create multiple fits to compare.
When you create multiple fits you can compare different fit types and settings side-by-side in the Curve Fitting Tool.

After creating a fit, you can add an additional fit using any of these methods:
• Click the New Fit button next to your fit figure tabs in the Document Bar.
• Right-click the Document Bar and select New Fit.
• Select Fit > New Fit.

Each additional fit appears as a new tab in the Curve Fitting Tool and a new row in the Table of Fits. See “Interactive Fit Comparison” on page 2-13 for information about displaying and analyzing multiple fits.

Optionally, after you create an additional fit, you can copy your data selections from a previous fit by selecting Fit > Use Data From > Other Fit Name. This copies your selections for x, y, and z from the previous fit, and any selected validation data. No fit options are changed.

Use sessions to save and reload your fits. See “Sessions” on page 2-20.

**Duplicating a Fit**
To create a copy of the current fit tab, select Fit > Duplicate "Current Fit Name". You also can right-click a fit in the Table of Fits and select Duplicate.

Each additional fit appears as a new tab in the Curve Fitting Tool.

**Deleting a Fit**
Delete a fit from your session using one of these methods:

• Select the fit tab display and select Fit > Delete Current Fit Name.
• Select the fit in the Table of Fits and press Delete.
• Right-click the fit in the table and select Delete Current Fit Name.

**Displaying Multiple Fits Simultaneously**
When you have created multiple fits you can compare different fit types and settings side by side in the Curve Fitting Tool. You can view plots simultaneously and you can examine the goodness-of-fit statistics to compare your fits. This section describes how to compare multiple fits.
To compare plots and see multiple fits simultaneously, use the layout controls at the top right of the Curve Fitting Tool. Alternatively, you can click **Window** on the menu bar to select the number and position of tiles you want to display. A **fit figure** displays the fit settings, results pane and plots for a single fit. The following example shows two fit figures displayed side by side. You can see multiple fits in the session listed in the **Table of Fits**.

You can close fit figures displays (with the Close button, **Fit** menu, or context menu), but they remain in your session. The **Table of Fits** displays all your...
fits (open and closed). Double-click a fit in the **Table of Fits** to open (or focus if already open) the fit figure. To remove a fit, see “Deleting a Fit” on page 2-14

---

**Tip** If you want more space to view and compare plots, as shown next, use the **View** menu to hide or show the **Fit Settings**, **Fit Results**, or **Table of Fits** panes.
You can dock and undock individual fits and navigate between them using the standard MATLAB Desktop and Window menus in the Curve Fitting Tool. For more information, see “Optimize Desktop Layout for Limited Screen Space” in the MATLAB Desktop Tools and Development Environment documentation.
Using the Statistics in the Table of Fits

The Table of Fits list pane shows all fits in the current session.

<table>
<thead>
<tr>
<th>Fit name</th>
<th>Data</th>
<th>Fit type</th>
<th>SSE</th>
<th>R-square</th>
<th>DFE</th>
<th>Adj R-sq</th>
<th>RMSE</th>
<th># Coeff</th>
</tr>
</thead>
<tbody>
<tr>
<td>poly6</td>
<td>pop vs. cd...</td>
<td>poly6</td>
<td>106.9276</td>
<td>0.9991</td>
<td>14</td>
<td>0.9988</td>
<td>2.7636</td>
<td>7</td>
</tr>
<tr>
<td>poly5</td>
<td>pop vs. cd...</td>
<td>poly5</td>
<td>144.1661</td>
<td>0.9988</td>
<td>15</td>
<td>0.9984</td>
<td>3.1002</td>
<td>6</td>
</tr>
<tr>
<td>poly4</td>
<td>pop vs. cd...</td>
<td>poly4</td>
<td>145.9689</td>
<td>0.9988</td>
<td>16</td>
<td>0.9985</td>
<td>3.0204</td>
<td>5</td>
</tr>
<tr>
<td>poly3</td>
<td>pop vs. cd...</td>
<td>poly3</td>
<td>149.7687</td>
<td>0.9988</td>
<td>17</td>
<td>0.9986</td>
<td>2.9682</td>
<td>4</td>
</tr>
<tr>
<td>poly2</td>
<td>pop vs. cd...</td>
<td>poly2</td>
<td>159.0293</td>
<td>0.9987</td>
<td>18</td>
<td>0.9986</td>
<td>2.9724</td>
<td>3</td>
</tr>
<tr>
<td>exp</td>
<td>pop vs. cd...</td>
<td>exp1</td>
<td>1.8942e+03</td>
<td>0.9847</td>
<td>19</td>
<td>0.9839</td>
<td>9.9847</td>
<td>2</td>
</tr>
</tbody>
</table>

After using graphical methods to evaluate the goodness of fit, you can examine the goodness-of-fit statistics shown in the table to compare your fits. The goodness-of-fit statistics help you determine how well the model fits the data. Click the table column headers to sort by statistics, name, fit type, and so on.

The following guidelines help you use the statistics to determine the best fit:

- **SSE** is the sum of squares due to error of the fit. A value closer to zero indicates a fit that is more useful for prediction.

- **R-square** is the square of the correlation between the response values and the predicted response values. A value closer to 1 indicates that a greater proportion of variance is accounted for by the model.

- **DFE** is the degree of freedom in the error.

- **Adj R-sq** is the degrees of freedom adjusted R-square. A value closer to 1 indicates a better fit.

- **RMSE** is the root mean squared error or standard error. A value closer to 0 indicates a fit that is more useful for prediction.

- **# Coeff** is the number of coefficients in the model. When you have several fits with similar goodness-of-fit statistics, look for the smallest number of coefficients to help decide which fit is best. You must trade off the number of coefficients against the goodness of fit indicated by the statistics to avoid overfitting.
For a more detailed explanation of the Curve Fitting Toolbox statistics, see “Goodness-of-Fit Statistics” on page 7-17.

To compare the statistics for different fits and decide which fit is the best tradeoff between over- and under-fitting, use a similar process to that described in “Curve Fitting to Census Data” on page 2-22.
 Sessions

In this section...

| “Overview” on page 2-20 |
| “Saving Sessions” on page 2-20 |
| “Reloading Sessions” on page 2-20 |
| “Removing Sessions” on page 2-20 |

Overview

You can save and reload sessions for easy access to multiple fits. The session file contains all the fits and variables in your session and remembers your layout.

Saving Sessions

To save your session, first select File > Save Session to open your file browser. Next, select a name and location for your session file (with file extension .sfit).

After you save your session once, you can use File > Save MySessionName to overwrite that session for subsequent saves.

To save the current session under a different name, select File > Save Session As .

Reloading Sessions

Use File > Load Session to open a file browser where you can select a saved curve fitting session file to load.

Removing Sessions

Use File > Clear Session to remove all fits from the current Curve Fitting Tool session.
Generating MATLAB Code and Exporting Fits

Interactive Code Generation and Programmatic Fitting

Curve Fitting Tool makes it easy to plot and analyze fits at the command line. You can export individual fits to the workspace for further analysis, or you can generate MATLAB code to recreate all fits and plots in your session. By generating code you can use your interactive curve fitting session to quickly assemble code for curve and surface fits and plots into useful programs.

1 Select **File > Generate Code**.

The Curve Fitting Tool generates code from your session and displays the file in the MATLAB Editor. The file includes all fits and plots in your current session. The file captures the following information:

- Names of fits and their variables
- Fit settings and options
- Plots
- Curve or surface fitting objects and methods used to create the fits:
  - A cell-array of `cfit` or `sfit` objects representing the fits
  - A structure array with goodness-of fit information.

2 Save the file.

For more information on working with your generated code, exporting fits to the workspace, and recreating your fits and plots at the command line, see:

- “Generating Code from the Curve Fitting Tool” on page 7-12
- “Exporting a Fit to the Workspace” on page 7-13
Curve Fitting to Census Data

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Interactive Curve Fitting Workflow” on page 2-22</td>
</tr>
<tr>
<td>“Loading Data and Creating Fits” on page 2-22</td>
</tr>
<tr>
<td>“Determining the Best Fit” on page 2-26</td>
</tr>
<tr>
<td>“Analyzing Your Best Fit in the Workspace” on page 2-32</td>
</tr>
<tr>
<td>“Saving Your Work” on page 2-34</td>
</tr>
</tbody>
</table>

Interactive Curve Fitting Workflow
The next topics fit some census data using polynomial equations up to the sixth degree, and a single-term exponential equation. The steps demonstrate how to:

- Load data and explore various fits using different library models.
- Search for the best fit by:
  - Comparing graphical fit results
  - Comparing numerical fit results including the fitted coefficients and goodness-of-fit statistics
- Export your best fit results to the MATLAB workspace to analyze the model at the command line.
- Save the session and generate MATLAB code for all fits and plots.

Loading Data and Creating Fits
You must load the data variables into the MATLAB workspace before you can fit data using the Curve Fitting Tool. For this example, the data is stored in the MATLAB file `census.mat`.

1 Load the data:

```matlab
load census
```

The workspace contains two new variables:
• **cdate** is a column vector containing the years 1790 to 1990 in 10-year increments.

• **pop** is a column vector with the U.S. population figures that correspond to the years in **cdate**.

2 Open the Curve Fitting Tool:

```matlab
cftool```

3 Select the variable names **cdate** and **pop** from the **X data** and **Y data** lists.

The Curve Fitting Tool creates and plots a default fit to **X input** (or predictor data) and **Y output** (or response data). The default fit is a linear polynomial fit type. Observe the fit settings display **Polynomial**, of **Degree** 1.

4 Change the fit to a second degree polynomial by selecting **2** from the **Degree** list.

The Curve Fitting Tool plots the new fit. The Curve Fitting Tool calculates a new fit when you change fit settings because **Auto fit** is selected by default. If refitting is time consuming, e.g., for large data sets, you can turn off **Auto fit** by clearing the check box.

The Curve Fitting Tool displays results of fitting the census data with a quadratic polynomial in the **Results** pane, where you can view the library model, fitted coefficients, and goodness-of-fit statistics.

5 Change the **Fit name** to **poly2**.

6 Display the residuals by selecting **View > Residuals Plot**.

The residuals indicate that a better fit might be possible. Therefore, continue exploring various fits to the census data set.
7 Add new fits to try the other library equations.
   
   a Right-click the fit in the Table of Fits and select Duplicate “poly2” (or use the Fit menu).
Tip  For fits of a given type (for example, polynomials), use Duplicate "fitname" instead of a new fit because copying a fit requires fewer steps. The duplicated fit contains the same data selections and fit settings.

b  Change the polynomial Degree to 3 and rename the fit poly3.

c  When you fit higher degree polynomials, the Results pane displays this warning:

Equation is badly conditioned. Remove repeated data points or try centering and scaling.

Normalize the data by selecting the Center and scale check box.

d  Repeat steps a and b to add polynomial fits up to the sixth degree, and then add an exponential fit.

e  For each new fit, look at the Results pane information, and the residuals plot in the Curve Fitting Tool.

The residuals from a good fit should look random with no apparent pattern. A pattern, such as a tendency for consecutive residuals to have the same sign, can be an indication that a better model exists.

About Scaling

The warning about scaling arises because the fitting procedure uses the cdate values as the basis for a matrix with very large values. The spread of the cdate values results in a scaling problem. To address this problem, you can normalize the cdate data. Normalization scales the predictor data to improve the accuracy of the subsequent numeric computations. A way to normalize cdate is to center it at zero mean and scale it to unit standard deviation. The equivalent code is:

(cdate - mean(cdate))./std(cdate)
Note Because the predictor data changes after normalizing, the values of the fitted coefficients also change when compared to the original data. However, the functional form of the data and the resulting goodness-of-fit statistics do not change. Additionally, the data is displayed in the Curve Fitting Tool plots using the original scale.

Determining the Best Fit
To determine the best fit, you should examine both the graphical and numerical fit results.

Examine the Graphical Fit Results

1 Determine the best fit by examining the graphs of the fits and residuals. To view plots for each fit in turn, double-click the fit in the Table of Fits. The graphical fit results indicate that:
   • The fits and residuals for the polynomial equations are all similar, making it difficult to choose the best one.
   • The fit and residuals for the single-term exponential equation indicate it is a poor fit overall. Therefore, it is a poor choice and you can remove the exponential fit from the candidates for best fit.

2 Examine the behavior of the fits up to the year 2050. The goal of fitting the census data is to extrapolate the best fit to predict future population values.
   a Double-click the sixth-degree polynomial fit in the Table of Fits to view the plots for this fit.
   b Change the axes limits of the plots by selecting Tools > Axes Limits.
   c Alter the X (cdate) Maximum to 2050, and increase the Main Y (pop) Maximum to 400, and press Enter.
   d Examine the fit plot. The behavior of the sixth-degree polynomial fit beyond the data range makes it a poor choice for extrapolation and you can reject this fit.
Curve Fitting to Census Data

Evaluate the Numerical Fit Results

When you can no longer eliminate fits by examining them graphically, you should examine the numerical fit results. The Curve Fitting Tool displays two types of numerical fit results:

- Goodness-of-fit statistics
- Confidence bounds on the fitted coefficients

The goodness-of-fit statistics help you determine how well the curve fits the data. The confidence bounds on the coefficients determine their accuracy.

Examine the numerical fit results:

1. For each fit, view the goodness-of-fit statistics in the Results pane.
2 Compare all fits simultaneously in the **Table of Fits**. Click the column headings to sort by statistics results.

<table>
<thead>
<tr>
<th>Fit name</th>
<th>Data</th>
<th>Fit type</th>
<th>SSE</th>
<th>R-square</th>
<th>DFE</th>
<th>Adj R-sq</th>
<th>RMSE</th>
<th># Coeff</th>
</tr>
</thead>
<tbody>
<tr>
<td>poly6</td>
<td>pop vs. cd...</td>
<td>poly6</td>
<td>106.9276</td>
<td>0.9991</td>
<td>14</td>
<td>0.9988</td>
<td>2.7636</td>
<td>7</td>
</tr>
<tr>
<td>poly5</td>
<td>pop vs. cd...</td>
<td>poly5</td>
<td>144.1661</td>
<td>0.9988</td>
<td>15</td>
<td>0.9984</td>
<td>3.1002</td>
<td>6</td>
</tr>
<tr>
<td>poly4</td>
<td>pop vs. cd...</td>
<td>poly4</td>
<td>145.9689</td>
<td>0.9988</td>
<td>16</td>
<td>0.9985</td>
<td>3.0204</td>
<td>5</td>
</tr>
<tr>
<td>poly3</td>
<td>pop vs. cd...</td>
<td>poly3</td>
<td>149.7687</td>
<td>0.9988</td>
<td>17</td>
<td>0.9986</td>
<td>2.9682</td>
<td>4</td>
</tr>
<tr>
<td>poly2</td>
<td>pop vs. cd...</td>
<td>poly2</td>
<td>159.0293</td>
<td>0.9987</td>
<td>18</td>
<td>0.9986</td>
<td>2.9724</td>
<td>3</td>
</tr>
<tr>
<td>exp</td>
<td>pop vs. cd...</td>
<td>exp1</td>
<td>1.8942e+03</td>
<td>0.9847</td>
<td>19</td>
<td>0.9839</td>
<td>9.9847</td>
<td>2</td>
</tr>
</tbody>
</table>

3 Examine the sum of squares due to error (SSE) and the adjusted $R$-square statistics to help determine the best fit. The SSE statistic is the least-squares error of the fit, with a value closer to zero indicating a better fit. The adjusted $R$-square statistic is generally the best indicator of the fit quality when you add additional coefficients to your model.

The largest SSE for **exp1** indicates it is a poor fit, which you already determined by examining the fit and residuals. The lowest SSE value is associated with **poly6**. However, the behavior of this fit beyond the data...
range makes it a poor choice for extrapolation, so you already rejected this fit by examining the plots with new axis limits.

The next best SSE value is associated with the fifth-degree polynomial fit, poly5, suggesting it might be the best fit. However, the SSE and adjusted $R^2$-square values for the remaining polynomial fits are all very close to each other. Which one should you choose?

4 Resolve the best fit issue by examining the confidence bounds for the remaining fits in the Results pane. Double-click a fit in the Table of Fits to open (or focus if already open) the fit figure and view the Results pane. A fit figure displays the fit settings, results pane and plots for a single fit.

Display the fifth-degree polynomial and the poly2 fit figures side by side. Examining results side by side can help you assess fits.

a To show two fit figures simultaneously, use the layout controls at the top right of the Curve Fitting Tool or select Window > Left/Right Tile or Top/Bottom Tile.

b To change the displayed fits, click to select a fit figure and then double-click the fit to display in the Table of Fits.

c Compare the coefficients and bounds ($p_1$, $p_2$, and so on) in the Results pane for both fits, poly5 and poly2. The toolbox calculates 95% confidence bounds on coefficients. The confidence bounds on the coefficients determine their accuracy. Check the equations in the Results pane ($f(x)=p_1x+p_2x^2+...$) to see the model terms for each coefficient. Note that $p_2$ refers to the $p_2x$ term in Poly2 and the $p_2x^4$ term in Poly5. Do not compare normalized coefficients directly with non-normalized coefficients.

Tip Use the View menu to hide the Fit Settings or Table of Fits if you want more space to view and compare plots and results, as shown next. You can also hide the Results pane to show only plots.
The bounds cross zero on the $p_1$, $p_2$, and $p_3$ coefficients for the fifth-degree polynomial. This means you cannot be sure that these coefficients differ from zero. If the higher order model terms may have coefficients of zero, they are not helping with the fit, which suggests that this model overfits the census data.
However, the small confidence bounds do not cross zero on \( p_1, p_2, \) and \( p_3 \) for the quadratic fit, \texttt{poly2} indicate that the fitted coefficients are known fairly accurately.

Therefore, after examining both the graphical and numerical fit results, you should select \texttt{poly2} as the best fit to extrapolate the census data.
Note The fitted coefficients associated with the constant, linear, and quadratic terms are nearly identical for each normalized polynomial equation. However, as the polynomial degree increases, the coefficient bounds associated with the higher degree terms cross zero, which suggests overfitting.

Analyzing Your Best Fit in the Workspace

You can use Save to Workspace to export the selected fit and the associated fit results to the MATLAB workspace. The fit is saved as a MATLAB object and the associated fit results are saved as structures.

1 Right-click the poly2 fit in the Table of Fits and select Save “poly2” to Workspace (or use the Fit menu).

2 Click OK to save with the default names.

The fittedmodel is saved as a Curve Fitting Toolbox cfit object.

```
>> whos fittedmodel
    Name      Size          Bytes  Class                Attributes
    fittedmodel 1x1           822    cfit
```

Examine the fittedmodel cfit object to display the model, the fitted coefficients, and the confidence bounds for the fitted coefficients:

```
fittedmodel
```
fittedmodel =
   Linear model Poly2:
   fittedmodel(x) = p1*x^2 + p2*x + p3
   Coefficients (with 95% confidence bounds):
   p1 =  0.006541  (0.006124, 0.006958)
   p2 =  -23.51    (-25.09, -21.93)
   p3 =  2.113e+004 (1.964e+004, 2.262e+004)

Examine the goodness structure to display goodness-of-fit results:

goodness

   goodness =
               sse: 159.0293
               rsquare: 0.9987
               dfe: 18
               adjrsquare: 0.9986
               rmse: 2.9724

Examine the output structure to display additional information associated with the fit, such as the residuals:

output

   output =
             numobs: 21
             numparam: 3
             residuals: [21x1 double]
             Jacobian: [21x3 double]
             exitflag: 1
             algorithm: 'QR factorization and solve'
             iterations: 1

You can evaluate (interpolate or extrapolate), differentiate, or integrate a fit over a specified data range with various postprocessing functions.

For example, to evaluate the fittedmodel at a vector of values to extrapolate to the year 2050, enter:

   y = fittedmodel(2000:10:2050)
$y = \begin{align*}
274.6221 \\
301.8240 \\
330.3341 \\
360.1524 \\
391.2790 \\
423.7137
\end{align*}$

Plot the fit to the census data and the extrapolated fit values:

```matlab
plot(fittedmodel, cdate, pop)
hold on
plot(fittedmodel, 2000:10:2050, y)
hold off
```

For more examples and instructions for interactive and command-line fit analysis, and a list of all postprocessing functions, see “Fit Postprocessing”.

For an example reproducing this interactive census data analysis using the command line, see “Custom Nonlinear Census Analysis” on page 5-6.

### Saving Your Work

The toolbox provides several options for saving your work. You can save one or more fits and the associated fit results as variables to the MATLAB workspace. You can then use this saved information for documentation purposes, or to extend your data exploration and analysis. In addition to saving your work to MATLAB workspace variables, you can:

- Save the current curve fitting session by selecting **File > Save Session**. The session file contains all the fits and variables in your session and remembers your layout. See “Sessions” on page 2-20.

- Generate MATLAB code to recreate all fits and plots in your session by selecting **File > Generate Code**. The Curve Fitting Tool generates code from your session and displays the file in the MATLAB Editor.

You can recreate your fits and plots by calling the file at the command line with your original data as input arguments. You can also call the file with new data, and automate the process of fitting multiple data sets.
For more information, see “Generating Code from the Curve Fitting Tool” on page 7-12.
Surface Fitting to Franke Data

The Curve Fitting Tool provides some example data generated from Franke’s bivariate test function. This data is suitable for trying various fit settings in Curve Fitting Tool.

To load the example data and create, compare, and export surface fits, follow these steps:

1 To load example data to use in the Curve Fitting Tool, enter `load franke` at the MATLAB command line. The variables `x`, `y`, and `z` appear in your workspace.

The example data is generated from Franke’s bivariate test function, with added noise and scaling, to create suitable data for trying various fit settings in Curve Fitting Tool. For details on the Franke function, see the following paper:


2 To divide the data into fitting and validation data, enter the following syntax:

```matlab
xv = x(200:293);
yv = y(200:293);
zv = z(200:293);
x = x(1:199);
y = y(1:199);
z = z(1:199);
```

3 To fit a surface using this example data:

   a Open Curve Fitting Tool. Enter `cftool`, or select **Curve Fitting** on the **Apps** tab.

   b Select the variables `x`, `y`, and `z` interactively in the Curve Fitting Tool.
Alternatively, you can specify the variables when you enter `cftool(x,y,z)` to open Curve Fitting Tool (if necessary) and create a default fit.

The Curve Fitting Tool plots the data points as you select variables. When you select `x`, `y`, and `z`, the tool automatically creates a default surface fit. The default fit is an interpolating surface that passes through the data points.
4 Try a Lowess fit type. Select the Lowess fit type from the drop-down list in the Curve Fitting Tool.

The Curve Fitting Tool creates a local smoothing regression fit.

5 Try altering the fit settings. Enter 10 in the Span edit box.
By reducing the span from the default to 10% of the total number of data points you produce a surface that follows the data more closely. The span defines the neighboring data points the toolbox uses to determine each smoothed value.

6 Edit the **Fit name** to **Smoothing regression**.

7 If you divided your data into fitting and validation data in step 2, select this validation data. Use the validation data to help you check that your surface is a good model, by comparing it against some other data not used for fitting.

   a Select **Fit > Specify Validation Data**. The Specify Validation Data dialog box opens.

   b Select the validation variables in the drop-down lists for **X input**, **Y input**, and **Z output**: xv, yv, and zv.

Review your selected validation data in the plots and the validation statistics (SSE and RMSE) in the **Results** pane and the **Table of Fits**.
8 Create another fit to compare by making a copy of the current surface fit. Either select Fit > Duplicate "Smoothing regression", or right-click the fit in the Table of Fits, and select Duplicate.

The tool creates a new fit figure with the same fit settings, data, and validation data. It also adds a new row to the table of fits at the bottom.

9 Change the fit type to Polynomial and edit the fit name to Polynomial.

10 Change the Degrees of x and y to 3, to fit a cubic polynomial in both dimensions.

11 Look at the scales on the x and y axes, and read the warning message in the Results pane:

   Equation is badly conditioned. Remove repeated data points
or try centering and scaling.

Select the **Center and scale** check box to normalize and correct for the large difference in scales in x and y.

Normalizing the surface fit removes the warning message from the **Results** pane.

12 Look at the **Results** pane. You can view (and copy if desired):

- The model equation
- The values of the estimated coefficients
- The goodness-of-fit statistics
- The goodness of validation statistics

**Linear model Poly33:**

\[
f(x,y) = p_{00} + p_{10}x + p_{01}y + p_{20}x^2 + p_{11}xy + p_{02}y^2 + p_{30}x^3 + p_{21}x^2y + p_{12}xy^2 + p_{03}y^3
\]

where x is normalized by mean 1977 and std 866.5

and where y is normalized by mean 0.4932 and std 0.29

**Coefficients (with 95% confidence bounds):**

- \( p_{00} = 0.4359 \) (0.3974, 0.4743)
- \( p_{10} = -0.1375 \) (-0.194, -0.08104)
- \( p_{01} = -0.4274 \) (-0.4843, -0.3706)
- \( p_{20} = 0.0161 \) (-0.007035, 0.03923)
- \( p_{11} = 0.07158 \) (0.05091, 0.09225)
- \( p_{02} = -0.03668 \) (-0.06005, -0.01332)
- \( p_{30} = 0.02081 \) (-0.005475, 0.04709)
Interactive Fitting

\[ p21 = 0.02432 \quad (0.0012, 0.04745) \]
\[ p12 = -0.03949 \quad (-0.06287, -0.01611) \]
\[ p03 = 0.1185 \quad (0.09164, 0.1453) \]

Goodness of fit:

SSE: 4.125
R-square: 0.776
Adjusted R-square: 0.7653
RMSE: 0.1477

Goodness of validation:

SSE : 2.26745
RMSE : 0.155312

13 To export this fit information to the workspace, select **Fit > Save to Workspace**. Executing this command also exports other information such as the numbers of observations and parameters, residuals, and the fitted model.

You can treat the fitted model as a function to make predictions or evaluate the surface at values of X and Y. For details see “Exporting a Fit to the Workspace” on page 7-13.

14 Display the residuals plot to check the distribution of points relative to the surface. Click the toolbar button or select **View > Residuals Plot**.
15 Right-click the residuals plot to select the **Go to X-Z view**. The X-Z view is not required, but the view makes it easier to see to remove outliers.

16 To remove outliers, click the toolbar button [Exclusion](#) or select **Tools > Exclude Outliers**.

When you move the mouse cursor to the plot, it changes to a cross-hair to show you are in outlier selection mode.

- **a** Click a point that you want to exclude in the surface plot or residuals plot. Alternatively, click and drag to define a rectangle and remove all enclosed points.

A removed plot point displays as a red star in the plots.

- **b** If you have **Auto-fit** selected, the Curve Fitting Tool refits the surface without the point. Otherwise, you can click **Fit** to refit the surface.

- **c** To return to rotation mode, click the toolbar button again to switch off **Exclude Outliers** mode.

17 To compare your fits side-by-side, use the tile tools. Select **Window > Left/Right Tile**, or use the toolbar buttons.
Review the information in the **Table of Fits**. Compare goodness-of-fit statistics for all fits in your session to determine which is best.
19 To save your interactive surface fitting session, select File > Save Session. You can save and reload sessions to access multiple fits. The session file contains all the fits and variables in your session and remembers your layout.

20 After interactively creating and comparing fits, you can generate code for all fits and plots in your Curve Fitting Tool session. Select File > Generate Code.

The Curve Fitting Tool generates code from your session and displays the file in the MATLAB Editor. The file includes all fits and plots in your current session.

21 Save the file with the default name, createFits.m.

22 You can recreate your fits and plots by calling the file from the command line (with your original data or new data as input arguments). In this case, your original variables still appear in the workspace.

- Highlight and evaluate the first line of the file (excluding the word function). Either right-click and select Evaluate, press F9, or copy and paste the following to the command line:

  \[ \text{[fitresult, gof] = createFits(x, y, z, xv, yv, zv)} \]

- The function creates a figure window for each fit you had in your session. Observe that the polynomial fit figure shows both the surface and residuals plots that you created interactively in the Curve Fitting Tool.

- If you want you can use the generated code as a starting point to change the surface fits and plots to fit your needs. For a list of methods you can use, see $fit$.

For more information on all fit settings and tools for comparing fits, see:

- “Interactive Fit Comparison” on page 2-13
- “Linear and Nonlinear Regression”
- “Interpolation”
- “Smoothing”
- “Fit Postprocessing”
Programmatic Curve and Surface Fitting

- “Curve and Surface Fitting” on page 3-2
- “Curve and Surface Fitting Objects and Methods” on page 3-6
Curve and Surface Fitting

In this section...

“Fitting a Curve” on page 3-2
“Fitting a Surface” on page 3-2
“Model Types and Fit Analysis” on page 3-3
“Workflow for Command Line Fitting” on page 3-3

Fitting a Curve
To programmatically fit a curve, follow the steps in this simple example:

1 Load some data.

    load hahn1

Create a fit using the fit function, specifying the variables and a model type (in this case rat23 is the model type).

    f = fit( temp, thermex, 'rat23' )

Plot your fit and the data.

    plot( f, temp, thermex )
    f( 600 )

Fitting a Surface
To programmatically fit a surface, follow the steps in this simple example:

1 Load some data.

    load franke

2 Create a fit using the fit function, specifying the variables and a model type (in this case poly23 is the model type).

    f = fit( [x, y], z, 'poly23' )
3 Plot your fit and the data.

plot(f, [x,y], z)

**Model Types and Fit Analysis**
For details and examples of specific model types and fit analysis, see the following sections:

1 “Linear and Nonlinear Regression”
2 “Interpolation”
3 “Smoothing”
4 “Fit Postprocessing”

**Workflow for Command Line Fitting**
Curve Fitting Toolbox software provides a variety of methods for data analysis and modeling. These methods are applied in a systematic manner, which can be represented in a workflow diagram such as the one below.
A typical analysis using curve fitting methods proceeds as follows:

1. Import your data into the MATLAB workspace using the `load` command (if your data has previously been stored in MATLAB variables) or any of the more specialized MATLAB functions for reading data from particular file types.

2. (Optional) If your data is noisy, you might want to smooth it using the `smooth` function. Smoothing is used to identify major trends in the data that can assist you in choosing an appropriate family of parametric models. If a parametric model is not evident or appropriate, smoothing can be an end in itself, providing a nonparametric fit of the data.
**Note** Smoothing estimates the center of the distribution of the response at each predictor. It invalidates the assumption that errors in the data are independent, and so also invalidates the methods used to compute confidence and prediction intervals. Accordingly, once a parametric model is identified through smoothing, the *original* data should be passed to the `fit` function.

3 Specify a parametric model for the data—either a Curve Fitting Toolbox library model or a custom model that you define. You can specify the model by passing a string or expression to the `fit` function or (optional) with a `fittype` object you create with the `fittype` function.

To view available library models, see “List of Library Models for Curve and Surface Fitting” on page 4-13.

4 (Optional) You can create a fit options structure for the fit using the `fitoptions` function. Fit options specify things like weights for the data, fitting methods, and low-level options for the fitting algorithm.

5 (Optional) You can create an exclusion rule for the fit using the `excludedata` function. Exclusion rules indicate which data values will be treated as outliers and excluded from the fit.

6 You pass the data, a model (string, expression or `fittype` object), and (optionally) a fit options structure and an exclusion rule, to the `fit` function to perform the fit.

The `fit` function returns a `cfit` (for curves) or `sfit` (for surfaces) object that encapsulates the computed coefficients and the fit statistics.

7 You can then postprocess the `cfit` and `sfit` objects returned by the `fit` function, by passing them to a variety of functions, such as `feval`, `differentiate`, `integrate`, `plot`, `coeffvalues`, `probvalues`, `confint`, and `predint`.

For more details on functions, see “Curve and Surface Fitting Objects and Methods” on page 3-6.
This section describes how to use Curve Fitting Toolbox functions from the command-line or to write programs for curve and surface fitting applications.

The Curve Fitting Tool is a graphical user interface that allows convenient, interactive use of Curve Fitting Toolbox functions, without programming. You can, however, access Curve Fitting Toolbox functions directly, and write programs that combine curve fitting functions with MATLAB functions and functions from other toolboxes. This allows you to create a curve fitting environment that is precisely suited to your needs.

Models and fits in Curve Fitting Tool are managed internally as curve fitting objects. Objects are manipulated through a variety of functions called methods. You can create curve fitting objects, and apply curve fitting methods, outside of Curve Fitting Tool.

Curve Fitting Objects

In MATLAB programming, all workspace variables are objects of a particular class. Familiar examples of MATLAB classes are double, char, and function_handle. You can also create custom MATLAB classes, using object-oriented programming.

Methods are functions that operate exclusively on objects of a particular class. Data types package together objects and methods so that the methods operate exclusively on objects of their own type, and not on objects of other types. A clearly defined encapsulation of objects and methods is the goal of object-oriented programming.

Curve Fitting Toolbox software provides you with new MATLAB data types for performing curve fitting:
• fittype — Objects allow you to encapsulate information describing a parametric model for your data. Methods allow you to access and modify that information.

• cfit and sfit — Two subtypes of fittype, for curves and surfaces. Objects capture information from a particular fit by assigning values to coefficients, confidence intervals, fit statistics, etc. Methods allow you to post-process the fit through plotting, extrapolation, integration, etc.

Because cfit is a subtype of fittype, cfit inherits all fittype methods. In other words, you can apply fittype methods to both fittype and cfit objects, but cfit methods are used exclusively with cfit objects. Similarly for sfit objects.

As an example, the fittype method islinear, which determines if a model is linear or nonlinear, would apply equally well before or after a fit; that is, to both fittype and cfit objects. On the other hand, the cfit methods coeffvalues and confint, which, respectively, return fit coefficients and their confidence intervals, would make no sense if applied to a general fittype object which describes a parametric model with undetermined coefficients.

Curve fitting objects have properties that depend on their type, and also on the particulars of the model or the fit that they encapsulate. For example, the following code uses the constructor methods for the two curve fitting types to create a fittype object f and a cfit object c:
f = fittype('a*x^2+b*exp(n*x)')
f =
   General model:
   f(a,b,n,x) = a*x^2+b*exp(n*x)
c = cfit(f,1,10.3,-1e2)
c =
   General model:
   c(x) = a*x^2+b*exp(n*x)
   Coefficients:
   a = 1
   b = 10.3
   n = -100

Note that the display method for fittype objects returns only basic information, piecing together outputs from formula and indepnames.

cfit and fittype objects are evaluated at predictor values x using feval. You can call feval indirectly using the following functional syntax:

y = cfun(x) % cfit objects;
y = ffun(coef1,coef2,...,x) % fittype objects;

**Curve Fitting Methods**

Curve fitting methods allow you to create, access, and modify curve fitting objects. They also allow you, through methods like plot and integrate, to perform operations that uniformly process the entirety of information encapsulated in a curve fitting object.

The methods listed in the following table are available for all fittype objects, including cfit objects.

<table>
<thead>
<tr>
<th>Fit Type Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>argnames</td>
<td>Get input argument names</td>
</tr>
<tr>
<td>category</td>
<td>Get fit category</td>
</tr>
<tr>
<td>coeffnames</td>
<td>Get coefficient names</td>
</tr>
<tr>
<td>dependnames</td>
<td>Get dependent variable name</td>
</tr>
<tr>
<td>feval</td>
<td>Evaluate model at specified predictors</td>
</tr>
<tr>
<td><strong>Fit Type Method</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>fittype</td>
<td>Construct fittype object</td>
</tr>
<tr>
<td>formula</td>
<td>Get formula string</td>
</tr>
<tr>
<td>indepnames</td>
<td>Get independent variable name</td>
</tr>
<tr>
<td>islinear</td>
<td>Determine if model is linear</td>
</tr>
<tr>
<td>numargs</td>
<td>Get number of input arguments</td>
</tr>
<tr>
<td>numcoeffs</td>
<td>Get number of coefficients</td>
</tr>
<tr>
<td>probnames</td>
<td>Get problem-dependent parameter names</td>
</tr>
<tr>
<td>setoptions</td>
<td>Set model fit options</td>
</tr>
<tr>
<td>type</td>
<td>Get name of model</td>
</tr>
</tbody>
</table>

The methods listed in the following table are available exclusively for `cfit` objects.

<table>
<thead>
<tr>
<th><strong>Curve Fit Method</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>cfit</td>
<td>Construct cfit object</td>
</tr>
<tr>
<td>coeffvalues</td>
<td>Get coefficient values</td>
</tr>
<tr>
<td>confint</td>
<td>Get confidence intervals for fit coefficients</td>
</tr>
<tr>
<td>differentiate</td>
<td>Differentiate fit</td>
</tr>
<tr>
<td>integrate</td>
<td>Integrate fit</td>
</tr>
<tr>
<td>plot</td>
<td>Plot fit</td>
</tr>
<tr>
<td>predint</td>
<td>Get prediction intervals</td>
</tr>
<tr>
<td>probvalues</td>
<td>Get problem-dependent parameter values</td>
</tr>
</tbody>
</table>

A complete list of methods for a curve fitting object can be obtained with the MATLAB `methods` command. For example,

```matlab
f = fittype('a*x^2+b*exp(n*x)');
methods(f)
```

Methods for class fittype:
argnames  dependnames  fittype  islinear  probnames
category  feval  formula  numargs  setoptions
coeffnames  fitoptions  indepnames  numcoeffs  type

Note that some of the methods listed by methods do not appear in the
tables above, and do not have reference pages in the Curve Fitting Toolbox
documentation. These additional methods are generally low-level operations
used by Curve Fitting Tool, and not of general interest when writing curve
fitting applications.

There are no global accessor methods, comparable to getfield and setfield,
available for fittype objects. Access is limited to the methods listed above.
This is because many of the properties of fittype objects are derived from
other properties, for which you do have access. For example,

\[
f = \text{fittype}('a*cos( b*x-c )')
\]

\[
f = \text{General model:} \quad f(a,b,c,x) = a*cos( b*x-c )
\]

\[
\text{formula}(f) \quad \text{ans} = \quad a*cos( b*x-c )
\]

\[
\text{argnames}(f) \quad \text{ans} = \quad 'a'
\quad 'b'
\quad 'c'
\quad 'x'
\]

You construct the fittype object f by giving the formula, so you do have
write access to that basic property of the object. You have read access to
that property through the formula method. You also have read access to the
argument names of the object, through the argnames method. You don’t,
however, have direct write access to the argument names, which are derived
from the formula. If you want to set the argument names, set the formula.
Surface Fitting Objects and Methods

Surface Fitting Objects and Methods
The surface fit object (sfit) stores the results from a surface fitting operation, making it easy to plot and analyze fits at the command line.

Like cfit objects, sfit objects are a subclass of fittype objects, so they inherit all the same methods of fittype listed in “Curve Fitting Methods” on page 3-8.

sfit objects also provide methods exclusively for sfit objects. See sfit.

One way to quickly assemble code for surface fits and plots into useful programs is to generate a file from a session in Curve Fitting Tool. In this way, you can transform your interactive analysis of a single data set into a reusable function for command-line analysis or for batch processing of multiple data sets. You can use the generated file without modification, or edit and customize the code as needed. See “Generating Code and Exporting Fits to the Workspace” on page 7-12.
Linear and Nonlinear Regression

- “Parametric Fitting” on page 4-2
- “List of Library Models for Curve and Surface Fitting” on page 4-13
- “Polynomial Models” on page 4-19
- “Exponential Models” on page 4-25
- “Fourier Series” on page 4-29
- “Gaussian Models” on page 4-31
- “Power Series” on page 4-33
- “Rational Polynomials” on page 4-35
- “Sum of Sines Models” on page 4-42
- “Weibull Distributions” on page 4-44
- “Least-Squares Fitting” on page 4-47
Parametric Fitting

In this section...

“Parametric Fitting with Library Models” on page 4-2
“Selecting a Model Type Interactively” on page 4-3
“Selecting Model Type Programmatically” on page 4-5
“Using Normalize or Center and Scale” on page 4-6
“Specifying Fit Options and Optimized Starting Points” on page 4-7

Parametric Fitting with Library Models

Parametric fitting involves finding coefficients (parameters) for one or more models that you fit to data. The data is assumed to be statistical in nature and is divided into two components:

\[ \text{data} = \text{deterministic component} + \text{random component} \]

The deterministic component is given by a parametric model and the random component is often described as error associated with the data:

\[ \text{data} = \text{parametric model} + \text{error} \]

The model is a function of the independent (predictor) variable and one or more coefficients. The error represents random variations in the data that follow a specific probability distribution (usually Gaussian). The variations can come from many different sources, but are always present at some level when you are dealing with measured data. Systematic variations can also exist, but they can lead to a fitted model that does not represent the data well.

The model coefficients often have physical significance. For example, suppose you collected data that corresponds to a single decay mode of a radioactive nuclide, and you want to estimate the half-life \( T_{1/2} \) of the decay. The law of radioactive decay states that the activity of a radioactive substance decays exponentially in time. Therefore, the model to use in the fit is given by

\[ y = y_0 e^{-\lambda t} \]
where \( y_0 \) is the number of nuclei at time \( t = 0 \), and \( \lambda \) is the decay constant. The data can be described by

\[
data = y_0 e^{-\lambda t} + \text{error}
\]

Both \( y_0 \) and \( \lambda \) are coefficients that are estimated by the fit. Because \( T_{1/2} = \ln(2)/\lambda \), the fitted value of the decay constant yields the fitted half-life. However, because the data contains some error, the deterministic component of the equation cannot be determined exactly from the data. Therefore, the coefficients and half-life calculation will have some uncertainty associated with them. If the uncertainty is acceptable, then you are done fitting the data. If the uncertainty is not acceptable, then you might have to take steps to reduce it either by collecting more data or by reducing measurement error and collecting new data and repeating the model fit.

With other problems where there is no theory to dictate a model, you might also modify the model by adding or removing terms, or substitute an entirely different model.

The Curve Fitting Toolbox parametric library models are described in the following sections.

**Selecting a Model Type Interactively**
Select a model type to fit from the drop-down list in the Curve Fitting Tool.
What fit types can you use for curves or surfaces? Based on your selected data, the fit category list shows either curve or surface categories. The following table describes the options for curves and surfaces.

<table>
<thead>
<tr>
<th>Fit Category</th>
<th>Curves</th>
<th>Surfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regression Models</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polynomial</td>
<td>Yes (up to degree 9)</td>
<td>Yes (up to degree 5)</td>
</tr>
<tr>
<td>Exponential</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Fourier</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Gaussian</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Rational</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Sum of Sine</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Weibull</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Interpolation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interpolant</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Methods:</td>
<td>Nearest neighbor</td>
<td>Nearest neighbor</td>
</tr>
<tr>
<td>Linear</td>
<td></td>
<td>Linear</td>
</tr>
<tr>
<td>Cubic</td>
<td></td>
<td>Cubic</td>
</tr>
<tr>
<td>Shape-preserving</td>
<td></td>
<td>Biharmonic</td>
</tr>
<tr>
<td>(PCHIP)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Smoothing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smoothing Spline</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Lowess</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Equation</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For all fit categories, look in the **Results** pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.
Tip If your fit has problems, messages in the **Results** pane help you identify better settings.

## Selecting Fit Settings

The Curve Fitting Tool provides a selection of fit types and settings that you can change to try to improve your fit. Try the defaults first, then experiment with other settings.

For an overview of how to use the available fit options, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

You can try a variety of settings within a single fit figure, and you can also create multiple fits to compare. When you create multiple fits you can compare different fit types and settings side by side in the Curve Fitting Tool. See “Interactive Fit Comparison” on page 2-13.

## Selecting Model Type Programmatically

You can specify a library model name as a string when you call the `fit` function. For example, to specify a quadratic `poly2`:

```matlab
f = fit( x, y, 'poly2' )
```

See “List of Library Models for Curve and Surface Fitting” on page 4-13 to view all available library model names.

You can also use the `fittype` function to construct a `fittype` object for a library model, and use the `fittype` as an input to the `fit` function.

Use the `fitoptions` function to find out what parameters you can set, for example:

```matlab
fitoptions(poly2)
```

For examples, see the sections for each model type, listed in the table in “Selecting a Model Type Interactively” on page 4-3. For details on all the functions for creating and analysing models, see “Curve and Surface Fitting” on page 3-2.
Using Normalize or Center and Scale

Most model types in the Curve Fitting Tool share the Center and scale option. When you select this option, the tool refits with the data centered and scaled, by applying the Normalize setting to the variables. At the command line, you can use Normalize as an input argument to the fitoptions function. See the fitoptions reference page.

Generally, it is a good idea to normalize inputs (also known as predictor data), which can alleviate numerical problems with variables of different scales. For example, suppose your surface fit inputs are engine speed with a range of 500–4500 r/min and engine load percentage with a range of 0–1. Then, Center and scale generally improves the fit because of the great difference in scale between the two inputs. However, if your inputs are in the same units or similar scale (e.g., eastings and northings for geographic data), then Center and scale is less useful. When you normalize inputs with this option, the values of the fitted coefficients change when compared to the original data.

If you are fitting a curve or surface to estimate coefficients, or the coefficients have physical significance, clear the Center and scale check box. The Curve Fitting Tool plots use the original scale with or without the Center and scale option.

At the command line, to set the option to center and scale the data before fitting, create the default fit options structure, set Normalize to on, then fit with the options:

```matlab
options = fitoptions;
options.Normalize = 'on';
options =
    Normalize: 'on'
    Exclude: [1x0 double]
    Weights: [1x0 double]
    Method: 'None'

load census
f1 = fit(cdate,pop,'poly3',options)
```
Specifying Fit Options and Optimized Starting Points

- “About Fit Options” on page 4-7
- “Fitting Method and Algorithm” on page 4-8
- “Finite Differencing Parameters” on page 4-9
- “Fit Convergence Criteria” on page 4-9
- “Coefficient Parameters” on page 4-10
- “Optimized Starting Points and Default Constraints” on page 4-10
- “Specifying Fit Options at the Command Line” on page 4-11

About Fit Options
Interactive fit options are described in the following sections. To specify the same fit options programmatically, see “Specifying Fit Options at the Command Line” on page 4-11.

To specify fit options interactively in the Curve Fitting Tool, click the **Fit Options** button to open the Fit Options dialog box. All fit categories except interpolants and smoothing splines have configurable fit options.

The available options depend on whether you are fitting your data using a linear model, a nonlinear model, or a nonparametric fit type:

- All the options described next are available for nonlinear models.
- **Lower** and **Upper** coefficient constraints are the only fit options available in the dialog box for polynomial linear models. For polynomials you can set **Robust** in the Curve Fitting Tool, without opening the Fit Options dialog box.
- Nonparametric fit types have no additional fit options dialog box (interpolant, smoothing spline, and lowess).

The fit options for the single-term exponential are shown next. The coefficient starting values and constraints are for the census data.
Fitting Method and Algorithm

- **Method** — The fitting method.
  
The method is automatically selected based on the library or custom model you use. For linear models, the method is *LinearLeastSquares*. For nonlinear models, the method is *NonlinearLeastSquares*.

- **Robust** — Specify whether to use the robust least-squares fitting method.
  - **Off** — Do not use robust fitting (default).
  - **On** — Fit with the default robust method (bisquare weights).
  - **LAR** — Fit by minimizing the least absolute residuals (LAR).
- **Bisquare** — Fit by minimizing the summed square of the residuals, and reduce the weight of outliers using bisquare weights. In most cases, this is the best choice for robust fitting.

- **Algorithm** — Algorithm used for the fitting procedure:
  - **Trust-Region** — This is the default algorithm and must be used if you specify Lower or Upper coefficient constraints.
  - **Levenberg-Marquardt** — If the trust-region algorithm does not produce a reasonable fit, and you do not have coefficient constraints, try the Levenberg-Marquardt algorithm.

### Finite Differencing Parameters

- **DiffMinChange** — Minimum change in coefficients for finite difference Jacobians. The default value is $10^{-8}$.

- **DiffMaxChange** — Maximum change in coefficients for finite difference Jacobians. The default value is 0.1.

Note that **DiffMinChange** and **DiffMaxChange** apply to:

- Any nonlinear custom equation, that is, a nonlinear equation that you write
- Some of the nonlinear equations provided with Curve Fitting Toolbox software

However, **DiffMinChange** and **DiffMaxChange** do not apply to any linear equations.

### Fit Convergence Criteria

- **MaxFunEvals** — Maximum number of function (model) evaluations allowed. The default value is 600.

- **MaxIter** — Maximum number of fit iterations allowed. The default value is 400.

- **TolFun** — Termination tolerance used on stopping conditions involving the function (model) value. The default value is $10^{-6}$. 
• **TolX** — Termination tolerance used on stopping conditions involving the coefficients. The default value is $10^{-6}$.

**Coefficient Parameters**

• **Unknwons** — Symbols for the unknown coefficients to be fitted.

• **StartPoint** — The coefficient starting values. The default values depend on the model. For rational, Weibull, and custom models, default values are randomly selected within the range $[0,1]$. For all other nonlinear library models, the starting values depend on the data set and are calculated heuristically. See optimized starting points below.

• **Lower** — Lower bounds on the fitted coefficients. The tool only uses the bounds with the trust region fitting algorithm. The default lower bounds for most library models are $-\infty$, which indicates that the coefficients are unconstrained. However, a few models have finite default lower bounds. For example, Gaussians have the width parameter constrained so that it cannot be less than 0. See default contraints below.

• **Upper** — Upper bounds on the fitted coefficients. The tool only uses the bounds with the trust region fitting algorithm. The default upper bounds for all library models are $\infty$, which indicates that the coefficients are unconstrained.

For more information about these fit options, see the `lsqcurvefit` function in the Optimization Toolbox documentation.

**Optimized Starting Points and Default Constraints**

The default coefficient starting points and constraints for library and custom models are shown in the next table. If the starting points are optimized, then they are calculated heuristically based on the current data set. Random starting points are defined on the interval $[0,1]$ and linear models do not require starting points.

If a model does not have constraints, the coefficients have neither a lower bound nor an upper bound. You can override the default starting points and constraints by providing your own values using the Fit Options dialog box.
Default Starting Points and Constraints

<table>
<thead>
<tr>
<th>Model</th>
<th>Starting Points</th>
<th>Constraints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom linear</td>
<td>N/A</td>
<td>None</td>
</tr>
<tr>
<td>Custom nonlinear</td>
<td>Random</td>
<td>None</td>
</tr>
<tr>
<td>Exponential</td>
<td>Optimized</td>
<td>None</td>
</tr>
<tr>
<td>Fourier</td>
<td>Optimized</td>
<td>None</td>
</tr>
<tr>
<td>Gaussian</td>
<td>Optimized</td>
<td>$c_i &gt; 0$</td>
</tr>
<tr>
<td>Polynomial</td>
<td>N/A</td>
<td>None</td>
</tr>
<tr>
<td>Power</td>
<td>Optimized</td>
<td>None</td>
</tr>
<tr>
<td>Rational</td>
<td>Random</td>
<td>None</td>
</tr>
<tr>
<td>Sum of Sine</td>
<td>Optimized</td>
<td>$b_i &gt; 0$</td>
</tr>
<tr>
<td>Weibull</td>
<td>Random</td>
<td>$a, b &gt; 0$</td>
</tr>
</tbody>
</table>

Note that the sum of sines and Fourier series models are particularly sensitive to starting points, and the optimized values might be accurate for only a few terms in the associated equations.

**Specifying Fit Options at the Command Line**

Create the default fit options structure and set the option to center and scale the data before fitting:

```matlab
options = fitoptions;
options.Normal = 'on';
options =
Normalize: 'on'
Exclude: [1x0 double]
Weights: [1x0 double]
Method: 'None'
```

Modifying the default fit options structure is useful when you want to set the Normalize, Exclude, or Weights fields, and then fit your data using the same options with different fitting methods. For example:
load census
f1 = fit(cdate,pop,'poly3',options);
f2 = fit(cdate,pop,'exp1',options);
f3 = fit(cdate,pop,'cubicsp',options);

Data-dependent fit options are returned in the third output argument of the fit function. For example, the smoothing parameter for smoothing spline is data-dependent:

[f,gof,out] = fit(cdate,pop,'smooth');
smoothparam = out.p
smoothparam =
   0.0089

Use fit options to modify the default smoothing parameter for a new fit:

options = fitoptions('Method','Smooth','SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop,'smooth',options);

For more details on using fit options, see the fitoptions reference page.
List of Library Models for Curve and Surface Fitting

Use Library Models to Fit Data
You can use the Curve Fitting Toolbox library of models for data fitting with the `fit` function. You use library model names as input arguments in the `fit`, `fitoptions`, and `fittype` functions.

Library Model Types
The following tables describe the library model types for curves and surfaces.

- Use the links in the table for examples and detailed information on each library type.
- If you want a quick reference of model names for input arguments to the `fit` function, see “Model Names and Equations” on page 4-14.

<table>
<thead>
<tr>
<th>Library Model Types for Curves</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>distribution</td>
<td>Distribution models such as Weibull. See “Weibull Distributions” on page 4-44.</td>
</tr>
<tr>
<td>exponential</td>
<td>Exponential function and sum of two exponential functions. See “Exponential Models” on page 4-25.</td>
</tr>
<tr>
<td>fourier</td>
<td>Up to eight terms of Fourier series. See “Fourier Series” on page 4-29.</td>
</tr>
<tr>
<td>gaussian</td>
<td>Sum of up to eight Gaussian models. See “Gaussian Models” on page 4-31.</td>
</tr>
<tr>
<td>interpolant</td>
<td>Interpolating models, including linear, nearest neighbor, cubic spline, and shape-preserving cubic spline. See “Nonparametric Fitting” on page 6-2.</td>
</tr>
<tr>
<td><strong>Library Model Types for Curves</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>polynomial</td>
<td>Polynomial models, up to degree nine. See “Polynomial Models” on page 4-19.</td>
</tr>
<tr>
<td>power</td>
<td>Power function and sum of two power functions. See “Power Series” on page 4-33.</td>
</tr>
<tr>
<td>rational</td>
<td>Rational equation models, up to 5th degree/5th degree (i.e., up to degree 5 in both the numerator and the denominator). See “Rational Polynomials” on page 4-35.</td>
</tr>
<tr>
<td>sin</td>
<td>Sum of up to eight sin functions. See “Sum of Sines Models” on page 4-42.</td>
</tr>
<tr>
<td>spline</td>
<td>Cubic spline and smoothing spline models. See “Nonparametric Fitting” on page 6-2.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Library Model Types for Surfaces</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>interpolant</td>
<td>Interpolating models, including linear, nearest neighbor, cubic spline, and biharmonic interpolation. See “Interpolants” on page 6-3.</td>
</tr>
<tr>
<td>lowess</td>
<td>Lowess smoothing models. See “Lowess Smoothing” on page 6-16.</td>
</tr>
<tr>
<td>polynomial</td>
<td>Polynomial models, up to degree five. See “Polynomial Models” on page 4-19.</td>
</tr>
</tbody>
</table>

**Model Names and Equations**

To specify the model you want to fit, consult the following tables for a model name to use as an input argument to the `fit` function. For example, to specify a quadratic curve with model name “poly2”:

```matlab
f = fit(x, y, 'poly2')
```
**Polynomial Model Names and Equations**

<table>
<thead>
<tr>
<th>Examples of Polynomial Model Names for Curves</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>poly1</td>
<td>$Y = p1*x+p2$</td>
</tr>
<tr>
<td>poly2</td>
<td>$Y = p1<em>x^2+p2</em>x+p3$</td>
</tr>
<tr>
<td>poly3</td>
<td>$Y = p1<em>x^3+p2</em>x^2+...+p4$</td>
</tr>
<tr>
<td>...etc., up to poly9</td>
<td>$Y = p1<em>x^9+p2</em>x^8+...+p10$</td>
</tr>
</tbody>
</table>

For polynomial surfaces, model names are 'polyij', where $i$ is the degree in $x$ and $j$ is the degree in $y$. The maximum for both $i$ and $j$ is five. The degree of the polynomial is the maximum of $i$ and $j$. The degree of $x$ in each term will be less than or equal to $i$, and the degree of $y$ in each term will be less than or equal to $j$. See the following table for some example model names and equations, of many potential examples.

<table>
<thead>
<tr>
<th>Examples of Polynomial Model Names for Surfaces</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>poly21</td>
<td>$Z = p00 + p10<em>x + p01</em>y + p20<em>x^2 + p11</em>x*y$</td>
</tr>
<tr>
<td>poly13</td>
<td>$Z = p00 + p10<em>x + p01</em>y + p11<em>x</em>y + p02<em>y^2 + p12</em>x<em>y^2 + p03</em>y^3$</td>
</tr>
<tr>
<td>poly55</td>
<td>$Z = p00 + p10<em>x + p01</em>y +...+p14<em>x</em>y^4 + p05*y^5$</td>
</tr>
</tbody>
</table>

**Distribution Model Name and Equation**

<table>
<thead>
<tr>
<th>Distribution Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>weibull</td>
<td>$Y = a<em>b</em>x^{(b-1)}<em>\exp(-a</em>x^b)$</td>
</tr>
</tbody>
</table>
## Exponential Model Names and Equations

<table>
<thead>
<tr>
<th>Exponential Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>exp1</td>
<td>( Y = a \times \exp(b \times x) )</td>
</tr>
<tr>
<td>exp2</td>
<td>( Y = a \times \exp(b \times x) + c \times \exp(d \times x) )</td>
</tr>
</tbody>
</table>

## Fourier Series Model Names and Equations

<table>
<thead>
<tr>
<th>Fourier Series Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>fourier1</td>
<td>( Y = a_0 + a_1 \cos(x \times p) + b_1 \sin(x \times p) )</td>
</tr>
<tr>
<td>fourier2</td>
<td>( Y = a_0 + a_1 \cos(x \times p) + b_1 \sin(x \times p) + a_2 \cos(2 \times x \times p) + b_2 \sin(2 \times x \times p) )</td>
</tr>
<tr>
<td>fourier3</td>
<td>( Y = a_0 + a_1 \cos(x \times p) + b_1 \sin(x \times p) + a_3 \cos(3 \times x \times p) + b_3 \sin(3 \times x \times p) )</td>
</tr>
<tr>
<td>... etc., up to fourier8</td>
<td>( Y = a_0 + a_1 \cos(x \times p) + b_1 \sin(x \times p) + a_8 \cos(8 \times x \times p) + b_8 \sin(8 \times x \times p) )</td>
</tr>
</tbody>
</table>

Where \( p = \frac{2 \times \pi}{\max(xdata) - \min(xdata)} \).

## Gaussian Model Names and Equations

<table>
<thead>
<tr>
<th>Gaussian Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>gauss1</td>
<td>( Y = a_1 \times \exp(-((x-b_1)/c_1)^2) )</td>
</tr>
<tr>
<td>gauss2</td>
<td>( Y = a_1 \times \exp(-((x-b_1)/c_1)^2) + a_2 \times \exp(-((x-b_2)/c_2)^2) )</td>
</tr>
<tr>
<td>gauss3</td>
<td>( Y = a_1 \times \exp(-((x-b_1)/c_1)^2) + a_3 \times \exp(-((x-b_3)/c_3)^2) )</td>
</tr>
<tr>
<td>... etc., up to gauss8</td>
<td>( Y = a_1 \times \exp(-((x-b_1)/c_1)^2) + ... + a_8 \times \exp(-((x-b_8)/c_8)^2) )</td>
</tr>
</tbody>
</table>
Power Model Names and Equations

<table>
<thead>
<tr>
<th>Power Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>power1</td>
<td>( Y = a \cdot x^b )</td>
</tr>
<tr>
<td>power2</td>
<td>( Y = a \cdot x^b + c )</td>
</tr>
</tbody>
</table>

Rational Model Names and Equations
Rational models are polynomials over polynomials with the leading coefficient of the denominator set to 1. Model names are \( \text{rat}ij \), where \( i \) is the degree of the numerator and \( j \) is the degree of the denominator. The degrees go up to five for both the numerator and the denominator.

<table>
<thead>
<tr>
<th>Examples of Rational Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>rat02</td>
<td>( Y = \frac{p1}{x^2+q1 \cdot x+q2} )</td>
</tr>
<tr>
<td>rat21</td>
<td>( Y = \frac{p1 \cdot x^2+p2 \cdot x+p3}{x+q1} )</td>
</tr>
<tr>
<td>rat55</td>
<td>( Y = \frac{p1 \cdot x^5+...+p6}{x^5+...+q5} )</td>
</tr>
</tbody>
</table>

Sum of Sine Model Names and Equations

<table>
<thead>
<tr>
<th>Sum of Sine Model Names</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin1</td>
<td>( Y = a_1 \cdot \sin(b_1 \cdot x+c_1) )</td>
</tr>
<tr>
<td>sin2</td>
<td>( Y = a_1 \cdot \sin(b_1 \cdot x+c_1)+a_2 \cdot \sin...+a_8 \cdot \sin(b_8 \cdot x+c_8) )</td>
</tr>
<tr>
<td>sin3</td>
<td>( Y = a_1 \cdot \sin(b_1 \cdot x+c_1)+...+a_3 \cdot \sin(b_3 \cdot x+c_3) )</td>
</tr>
<tr>
<td>...etc., up to sin8</td>
<td>( Y = a_1 \cdot \sin(b_1 \cdot x+c_1)+...+a_8 \cdot \sin(b_8 \cdot x+c_8) )</td>
</tr>
</tbody>
</table>

Spline Model Names
Spline models are supported for curve fitting, not for surface fitting.
### Spline Model Names

<table>
<thead>
<tr>
<th>Spline Model Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cubicspline</td>
<td>Cubic interpolating spline</td>
</tr>
<tr>
<td>smoothingspline</td>
<td>Smoothing spline</td>
</tr>
</tbody>
</table>

### Interpolant Model Names

<table>
<thead>
<tr>
<th>Type</th>
<th>Interpolant Model Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curves and Surfaces</td>
<td>linearinterp</td>
<td>Linear interpolation</td>
</tr>
<tr>
<td></td>
<td>nearestinterp</td>
<td>Nearest neighbor interpolation</td>
</tr>
<tr>
<td></td>
<td>cubicinterp</td>
<td>Cubic spline interpolation</td>
</tr>
<tr>
<td>Curves only</td>
<td>pchipinterp</td>
<td>Shape-preserving (pchip) interpolation</td>
</tr>
<tr>
<td>Surfaces only</td>
<td>biharmonicinterp</td>
<td>Biharmonic (MATLAB 4 griddata) interpolation</td>
</tr>
</tbody>
</table>

### Lowess Model Names

Lowess models are supported for surface fitting, not for curve fitting.

<table>
<thead>
<tr>
<th>Lowess Model Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lowess</td>
<td>Local linear regression</td>
</tr>
<tr>
<td>loess</td>
<td>Local quadratic regression</td>
</tr>
</tbody>
</table>
Polynomial Models

In this section...

“About Polynomial Models” on page 4-19
“Selecting a Polynomial Fit Interactively” on page 4-20
“Selecting a Polynomial Fit at the Command Line” on page 4-22
“Defining Polynomial Terms for Polynomial Surface Fits” on page 4-23

About Polynomial Models

Polynomial models for curves are given by

\[ y = \sum_{i=1}^{n+1} p_i x^{n+1-i} \]

where \( n + 1 \) is the order of the polynomial, \( n \) is the degree of the polynomial, and \( 1 \leq n \leq 9 \). The order gives the number of coefficients to be fit, and the degree gives the highest power of the predictor variable.

In this guide, polynomials are described in terms of their degree. For example, a third-degree (cubic) polynomial is given by

\[ \gamma = p_1 x^3 + p_2 x^2 + p_3 x + p_4 \]

Polynomials are often used when a simple empirical model is required. You can use the polynomial model for interpolation or extrapolation, or to characterize data using a global fit. For example, the temperature-to-voltage conversion for a Type J thermocouple in the 0 to 760\(^\circ\) temperature range is described by a seventh-degree polynomial.

**Note** If you do not require a global parametric fit and want to maximize the flexibility of the fit, piecewise polynomials might provide the best approach. Refer to “Nonparametric Fitting” on page 6-2 for more information.
The main advantages of polynomial fits include reasonable flexibility for data that is not too complicated, and they are linear, which means the fitting process is simple. The main disadvantage is that high-degree fits can become unstable. Additionally, polynomials of any degree can provide a good fit within the data range, but can diverge wildly outside that range. Therefore, exercise caution when extrapolating with polynomials.

When you fit with high-degree polynomials, the fitting procedure uses the predictor values as the basis for a matrix with very large values, which can result in scaling problems. To handle this, you should normalize the data by centering it at zero mean and scaling it to unit standard deviation. Normalize data by selecting the Center and scale check box in the Curve Fitting Tool.

**Selecting a Polynomial Fit Interactively**

In the Curve Fitting Tool, select Polynomial from the model type list.

The Polynomial fit uses the Curve Fitting Toolbox polynomial library model.

For curves, the Polynomial model fits a polynomial in \( x \).

For surfaces, the Polynomial model fits a polynomial in \( x \) and \( y \).
You can specify the following options:

- The degree for the $x$ and $y$ inputs:
  - For curves, degree of $x$ can be up to 9.
  - For surfaces, degree of $x$ and $y$ can be up to 5.
  
  The degree of the polynomial is the maximum of $x$ and $y$ degrees. See “Defining Polynomial Terms for Polynomial Surface Fits” on page 4-23.

- The robust linear least-squares fitting method to use (Off, LAR, or Bisquare). For details, see Robust on the fitoptions reference page.

- Set bounds or exclude terms by clicking Fit Options. You can exclude any term by setting its bounds to 0.

  Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

**Tip** If your input variables have very different scales, select and clear the Center and scale check box to see the difference in the fit. Messages in the Results pane prompt you when scaling might improve your fit.

For an example comparing various polynomial fits, see “Curve Fitting to Census Data” on page 2-22.
Selecting a Polynomial Fit at the Command Line

The polynomial library model is an input argument to the fit and fittype functions. Specify the model type poly followed by the degree in x (up to 9), or x and y (up to 5).

For example, to specify a quadratic curve poly2:

```matlab
f = fit(x, y, 'poly2')
```

To specify a cubic surface poly3:

```matlab
f = fit([x, y] z, 'poly3')
```

To view available polynomial models and equations, see “Polynomial Model Names and Equations” on page 4-15.

To find out what parameters you can set:

```matlab
fitoptions poly2
```

For example, to load some data and fit a cubic polynomial with center and scale and robust fitting options:

```matlab
load census;
f=fit(cdate, pop, 'poly3', 'Normalize', 'on', 'Robust', 'on')
plot(f,cdate,pop)
```

Robust 'on' is equivalent to 'Bisquare', the default method.

All fitting methods have the default properties Normalize, Exclude, Weights, and Method. For an example, see “Specifying Fit Options at the Command Line” on page 4-11.

Polynomial models have the Method property value LinearLeastSquares, and the additional fit options properties shown in the next table. For details on all fit options, see the fitoptions reference page.
Polynomial Models

Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robust</td>
<td>Specifies the robust linear least-squares fitting method to use. Values are 'on', 'off', 'LAR', or 'Bisquare'. The default is 'off'. 'LAR' specifies the least absolute residual method and 'Bisquare' specifies the bisquare weights method. 'on' is equivalent to 'Bisquare', the default method.</td>
</tr>
<tr>
<td>Lower</td>
<td>A vector of lower bounds on the coefficients to be fitted. The default value is an empty vector, indicating that the fit is unconstrained by lower bounds. If bounds are specified, the vector length must equal the number of coefficients. Individual unconstrained lower bounds can be specified by -Inf.</td>
</tr>
<tr>
<td>Upper</td>
<td>A vector of upper bounds on the coefficients to be fitted. The default value is an empty vector, indicating that the fit is unconstrained by upper bounds. If bounds are specified, the vector length must equal the number of coefficients. Individual unconstrained upper bounds can be specified by Inf.</td>
</tr>
</tbody>
</table>

Defining Polynomial Terms for Polynomial Surface Fits

You can control the terms to include in the polynomial surface model by specifying the degrees for the x and y inputs. If $i$ is the degree in x and $j$ is the degree in y, the total degree of the polynomial is the maximum of $i$ and $j$. The degree of x in each term is less than or equal to $i$, and the degree of y in each term is less than or equal to $j$. The maximum for both $i$ and $j$ is five.

For example:

```
poly21  Z = p00 + p10*x + p01*y + p20*x^2 + p11*x*y
```

```
poly13  Z = p00 + p10*x + p01*y + p11*x*y + p02*y^2 + p12*x*y^2 + p03*y^3
```
poly55  \[ Z = p_{00} + p_{10}x + p_{01}y + \ldots + p_{14}x^i y^j + p_{05}y^5 \]

For example, if you specify an \( x \) degree of 3 and a \( y \) degree of 2, the model name is \texttt{poly32}. The model terms follow the form in this table.

<table>
<thead>
<tr>
<th>Degree of Term</th>
<th>0</th>
<th>1</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>( y )</td>
<td>( y^2 )</td>
</tr>
<tr>
<td>1</td>
<td>( x )</td>
<td>( xy )</td>
<td>( xy^2 )</td>
</tr>
<tr>
<td>2</td>
<td>( x^2 )</td>
<td>( x^2y )</td>
<td>N/A</td>
</tr>
<tr>
<td>3</td>
<td>( x^3 )</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

The total degree of the polynomial cannot exceed the maximum of \( i \) and \( j \). In this example, terms such as \( x^3y \) and \( x^2y^2 \) are excluded because their degrees sum to more than 3. In both cases, the total degree is 4.
Exponential Models

In this section...

“About Exponential Models” on page 4-25
“Selecting an Exponential Fit Interactively” on page 4-25
“Selecting an Exponential Fit at the Command Line” on page 4-27

About Exponential Models

The toolbox provides a one-term and a two-term exponential model as given by

\[ y = ae^{bx} \]
\[ y = ae^{bx} + ce^{dx} \]

Exponentials are often used when the rate of change of a quantity is proportional to the initial amount of the quantity. If the coefficient associated with \( b \) and/or \( d \) is negative, \( y \) represents exponential decay. If the coefficient is positive, \( y \) represents exponential growth.

For example, a single radioactive decay mode of a nuclide is described by a one-term exponential. \( a \) is interpreted as the initial number of nuclei, \( b \) is the decay constant, \( x \) is time, and \( y \) is the number of remaining nuclei after a specific amount of time passes. If two decay modes exist, then you must use the two-term exponential model. For the second decay mode, you add another exponential term to the model.

Examples of exponential growth include contagious diseases for which a cure is unavailable, and biological populations whose growth is uninhibited by predation, environmental factors, and so on.

Selecting an Exponential Fit Interactively

In the Curve Fitting Tool, select Exponential from the model type list.

The exponential fit uses the \( \text{exp1} \) and \( \text{exp2} \) library models. These library models are input arguments to the \texttt{fit} and \texttt{fittype} functions.
You can specify the following options:

- Choose one or two terms to fit exp1 or exp2.
  Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

- (Optional) Click Fit Options to specify coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings.

The toolbox calculates optimized start points for exponential fits, based on the current data set. You can override the start points and specify your own values in the Fit Options dialog box.

The fit options for the single-term exponential are shown next. The coefficient starting values and constraints are for the census data.
Selecting an Exponential Fit at the Command Line

Specify the model type 'exp1' or 'exp2'.

For example, to generate data with an exponential trend and then fit the data using a single-term exponential:

```matlab
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));
```
f = fit(x,y,'exp1')
plot(f,x,y)

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with NonlinearLeastSquares on the fitoptions reference page.
Fourier Series

About Fourier Series Models
The Fourier series is a sum of sine and cosine functions that describes a periodic signal. It is represented in either the trigonometric form or the exponential form. The toolbox provides this trigonometric Fourier series form

\[ y = a_0 + \sum_{i=1}^{n} a_i \cos(nx) + b_i \sin(nx) \]

where \(a_0\) models a constant (intercept) term in the data and is associated with the \(i = 0 \) cosine term, \(w\) is the fundamental frequency of the signal, \(n\) is the number of terms (harmonics) in the series, and \(1 \leq n \leq 8\).

For more information about the Fourier series, refer to “Fourier Analysis and Filtering”.

Selecting a Fourier Fit Interactively
In the Curve Fitting Tool, select Fourier from the model type list.
You can specify the following options:

- Choose the number of terms: 1 to 8.

  Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

- (Optional) Click Fit Options to specify coefficient starting values and constraint bounds, or change algorithm settings.

  The toolbox calculates optimized start points for Fourier series models, based on the current data set. You can override the start points and specify your own values in the Fit Options dialog box.

  For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

For an example comparing the library Fourier fit with custom equations, see “Fourier Analysis of ENSO Data” on page 5-9.

**Selecting a Fourier Fit at the Command Line**

Specify the model type fourier followed by the number of terms, e.g., 'fourier1' to 'fourier8'.

For example, to load some data and fit an eight-term Fourier model:

```matlab
load enso;
f = fit(month,pressure,'fourier8')
plot(f,month,pressure)
```

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with NonlinearLeastSquares on the fitoptions reference page.
Gaussian Models

**In this section...**

“About Gaussian Models” on page 4-31
“Selecting a Gaussian Fit Interactively” on page 4-31
“Selecting a Gaussian Fit at the Command Line” on page 4-32

**About Gaussian Models**
The Gaussian model fits peaks, and is given by

\[ y = \sum_{i=1}^{n} a_i e^{-\left(\frac{x-b_i}{c_i}\right)^2} \]

where \(a\) is the amplitude, \(b\) is the centroid (location), \(c\) is related to the peak width, \(n\) is the number of peaks to fit, and \(1 \leq n \leq 8\).

Gaussian peaks are encountered in many areas of science and engineering. For example, Gaussian peaks can describe line emission spectra and chemical concentration assays.

**Selecting a Gaussian Fit Interactively**
In the Curve Fitting Tool, select Gaussian from the model type list.

You can specify the following options:
• Choose the number of terms: 1 to 8.

Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

• (Optional) Click Fit Options to specify coefficient starting values and constraint bounds, or change algorithm settings.

The toolbox calculates optimized start points for Gaussian models, based on the current data set. You can override the start points and specify your own values in the Fit Options dialog box.

Gaussians have the width parameter $c_1$ constrained with a lower bound of 0. The default lower bounds for most library models are $-\infty$, which indicates that the coefficients are unconstrained.

For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

**Selecting a Gaussian Fit at the Command Line**

Specify the model type `gauss` followed by the number of terms, e.g., `'gauss1'` to `'gauss8'`.

For example, to load some data and fit an eight-term Gaussian model:

```matlab
load enso;
f = fit(month,pressure,'gauss8')
plot(f,month,pressure)
```

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with `NonlinearLeastSquares` on the `fitoptions` reference page.
Power Series

In this section...

“About Power Series Models” on page 4-33
“Selecting a Power Fit Interactively” on page 4-33
“Selecting a Power Fit at the Command Line” on page 4-34

About Power Series Models
The toolbox provides a one-term and a two-term power series model as given by

\[ y = ax^b \]
\[ y = a + bx^c \]

Power series models describe a variety of data. For example, the rate at which reactants are consumed in a chemical reaction is generally proportional to the concentration of the reactant raised to some power.

Selecting a Power Fit Interactively
In the Curve Fitting Tool, select Power from the model type list.

You can specify the following options:

- Choose the number of terms: 1 to 2.
  Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.
• (Optional) Click **Fit Options** to specify coefficient starting values and constraint bounds, or change algorithm settings.

The toolbox calculates optimized start points for power series models, based on the current data set. You can override the start points and specify your own values in the Fit Options dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

**Selecting a Power Fit at the Command Line**

Specify the model type `power` followed by the number of terms, e.g., `'power1'` or `'power2'`.

For example, to load some data and fit a two-term power series model:

```matlab
load hahn1;
f = fit(temp,thermex,'power2')
plot(f,temp,thermex)
```

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with `NonlinearLeastSquares` on the `fitoptions` reference page.
Rational Polynomials

In this section...

“About Rational Models” on page 4-35
“Selecting a Rational Fit Interactively” on page 4-36
“Selecting a Rational Fit at the Command Line” on page 4-36
“Example: Rational Fit” on page 4-37

About Rational Models

Rational models are defined as ratios of polynomials and are given by

\[ y = \frac{\sum_{i=1}^{n+1} p_i x^{n+1-i}}{x^m + \sum_{i=1}^{m} q_i x^{m-1}} \]

where \( n \) is the degree of the numerator polynomial and \( 0 \leq n \leq 5 \), while \( m \) is the degree of the denominator polynomial and \( 1 \leq m \leq 5 \). Note that the coefficient associated with \( x^m \) is always 1. This makes the numerator and denominator unique when the polynomial degrees are the same.

In this guide, rationals are described in terms of the degree of the numerator/the degree of the denominator. For example, a quadratic/cubic rational equation is given by

\[ y = \frac{p_1 x^2 + p_2 x + p_3}{x^3 + q_1 x^2 + q_2 x + q_3} \]

Like polynomials, rationals are often used when a simple empirical model is required. The main advantage of rationals is their flexibility with data that has a complicated structure. The main disadvantage is that they become unstable when the denominator is around 0. For an example that uses rational polynomials of various degrees, see “Example: Rational Fit” on page 4-37.
Selecting a Rational Fit Interactively

In the Curve Fitting Tool, select Rational from the model type list.

You can specify the following options:

- Choose the degree of the numerator and denominator polynomials. The numerator can have degree 0 to 5, and the denominator from 1 to 5.

  Look in the Results pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

- (Optional) Click Fit Options to specify coefficient starting values and constraint bounds, or change algorithm settings.

  The toolbox calculates random start points for rational models, defined on the interval [0,1]. You can override the start points and specify your own values in the Fit Options dialog box.

  For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

Selecting a Rational Fit at the Command Line

Specify the model type ratij, where i is the degree of the numerator polynomial and j is the degree of the denominator polynomial. For example, 'rat02', 'rat21' or 'rat55'.

For example, to load some data and fit a rational model:

```
load hahn1;
f = fit( temp, thermex, 'rat32')
plot(f,temp,thermex)
```
See “Example: Rational Fit” on page 4-37 to fit this example interactively with various rational models.

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with NonlinearLeastSquares on the fitoptions reference page.

**Example: Rational Fit**

This example fits measured data using a rational model. The data describes the coefficient of thermal expansion for copper as a function of temperature in degrees kelvin.

For this data set, you will find the rational equation that produces the best fit. Rational models are defined as a ratio of polynomials as given by:

\[
y = \frac{p_1 x^n + p_2 x^{n-1} + \ldots + p_{n+1}}{x^m + q_1 x^{m-1} + \ldots + q_m}
\]

where \( n \) is the degree of the numerator polynomial and \( m \) is the degree of the denominator polynomial. Note that the rational equations are not associated with physical parameters of the data. Instead, they provide a simple and flexible empirical model that you can use for interpolation and extrapolation.

1 Load the thermal expansion data from the file **hahn1.mat**, which is provided with the toolbox.

   ```
   load hahn1
   ```

   The workspace contains two new variables:
   - **temp** is a vector of temperatures in degrees kelvin.
   - **thermex** is a vector of thermal expansion coefficients for copper.

2 Open the Curve Fitting Tool by entering:

   ```
   cftool
   ```

3 Select **temp** and **thermex** from the **X data** and **Y data** lists.
The Curve Fitting Tool fits and plots the data.

4 Select **Rational** in the fit category list.

5 Try an initial choice for the rational model of quadratic/quadratic. Select 2 for both **Numerator degree** and **Denominator degree**.

The Curve Fitting Tool fits a quadratic/quadratic rational.

6 Examine the residuals. Select **View > Residuals Plot** or click the toolbar button.

Examine the data, fit, and residuals. Observe that the fit misses the data for the smallest and largest predictor values. Additionally, the residuals show a strong pattern throughout the entire data set, indicating that a better fit is possible.
For the next fit, try a cubic/cubic equation. Select 3 for both Numerator degree and Denominator degree.

Examine the data, fit, and residuals. The fit exhibits several discontinuities around the zeros of the denominator.

Note Your results depend on random start points and may vary from those shown.
8 Look in the Results pane. The message and numerical results indicate that the fit did not converge.

Fit computation did not converge:
Fitting stopped because the number of iterations or function evaluations exceeded the specified maximum.

Although the message in the Results pane indicates that you might improve the fit if you increase the maximum number of iterations, a better choice at this stage of the fitting process is to use a different rational equation because the current fit contains several discontinuities. These discontinuities are due to the function blowing up at predictor values that correspond to the zeros of the denominator.

9 Try fitting the data using a cubic/quadratic equation. Select 2 for the Denominator degree and leave the Numerator degree set to 3.
The input variables have very different scales, so select the **Center and scale** option.

The data, fit, and residuals are shown below.

The fit is well behaved over the entire data range, and the residuals are randomly scattered about zero. Therefore, you can confidently use this fit for further analysis.
Sum of Sines Models

In this section...

“About Sum of Sines Models” on page 4-42
“Selecting a Sum of Sine Fit Interactively” on page 4-42
“Selecting a Sum of Sine Fit at the Command Line” on page 4-43

About Sum of Sines Models

The sum of sines model fits periodic functions, and is given by

\[ y = \sum_{i=1}^{n} a_i \sin(b_i x + c_i) \]

where \(a\) is the amplitude, \(b\) is the frequency, and \(c\) is the phase constant for each sine wave term. \(n\) is the number of terms in the series and \(1 \leq n \leq 8\). This equation is closely related to the Fourier series described in “Fourier Series” on page 4-29. The main difference is that the sum of sines equation includes the phase constant, and does not include a constant (intercept) term.

Selecting a Sum of Sine Fit Interactively

In the Curve Fitting Tool, select Sum of Sine from the model type list.

You can specify the following options:

- Choose the number of terms: 1 to 8.
Look in the **Results** pane to see the model terms, the values of the coefficients, and the goodness-of-fit statistics.

- (Optional) Click **Fit Options** to specify coefficient starting values and constraint bounds, or change algorithm settings.

The toolbox calculates optimized start points for sum of sine models, based on the current data set. You can override the start points and specify your own values in the Fit Options dialog box.

The sum of sine model has a lower bound constraint on \( c_i \) of 0. The default lower bounds for most library models are \(-\text{Inf}\).

For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

### Selecting a Sum of Sine Fit at the Command Line

Specify the model type `sin` followed by the number of terms, e.g., `'sin1'` to `'sin8'`.

For example, to load some periodic data and fit a six-term sum of sine model:

```matlab
load enso;
f = fit( month, pressure, 'sin6')
plot(f,month,pressure)
```

If you want to modify fit options such as coefficient starting values and constraint bounds appropriate for your data, or change algorithm settings, see the table of additional properties with **NonlinearLeastSquares** on the `fitoptions` reference page.
Weibull Distributions

In this section...

“About Weibull Distribution Models” on page 4-44
“Selecting a Weibull Fit Interactively” on page 4-44
“Selecting a Weibull Fit at the Command Line” on page 4-45

About Weibull Distribution Models

The Weibull distribution is widely used in reliability and life (failure rate) data analysis. The toolbox provides the two-parameter Weibull distribution

\[ y = abx^{b-1}e^{-ax^b} \]

where \( a \) is the scale parameter and \( b \) is the shape parameter.

Note that there are other Weibull distributions but you must create a custom equation to use these distributions:

- A three-parameter Weibull distribution with \( x \) replaced by \( x - c \) where \( c \) is the location parameter
- A one-parameter Weibull distribution where the shape parameter is fixed and only the scale parameter is fitted.

Curve Fitting Toolbox does not fit Weibull probability distributions to a sample of data. Instead, it fits curves to response and predictor data such that the curve has the same shape as a Weibull distribution.

Selecting a Weibull Fit Interactively

In the Curve Fitting Tool, select Weibull from the model type list.
There are no fit settings to configure.

(Optional) Click **Fit Options** to specify coefficient starting values and constraint bounds, or change algorithm settings.

The toolbox calculates random start points for Weibull models, defined on the interval [0,1]. You can override the start points and specify your own values in the Fit Options dialog box.

For more information on the settings, see “Specifying Fit Options and Optimized Starting Points” on page 4-7.

**Selecting a Weibull Fit at the Command Line**

Specify the model type `weibull`.

For example, to load some example data measuring blood concentration of a compound against time, and fit and plot a Weibull model specifying a start point:

```matlab
time = [0.1; 0.1; 0.3; 0.3; 1.3; 1.7; 2.1; 2.6; 3.9; 3.9; ... 5.1; 5.6; 6.2; 6.4; 7.7; 8.1; 8.2; ... 8.9; 9.0; 9.5; ... 9.6; 10.2; 10.3; 10.8; 11.2; 11.2; 11.2; ... 11.7; 12.1; 12.3; ... 12.3; 13.1; 13.2; 13.4; 13.7; 14.0; 14.3; ... 15.4; 16.1; 16.1; ... 16.4; 16.4; 16.7; 16.7; 17.5; 17.6; 18.1; ... 18.5; 19.3; 19.7];
conc = [0.01; 0.08; 0.13; 0.16; 0.55; 0.90; 1.11; 1.62; 1.79; 1.59; ... 4-45
```
Appropriate start point values and scaling \( \text{conc}/25 \) for the two-parameter Weibull model were calculated by fitting a 3 parameter Weibull model using this custom equation:

\[
f = \text{fit}(\text{time}, \text{conc}, 'c*a*b*x^{(b-1)}*\exp(-a*x^b)', 'StartPoint', [0.01, 2, 5])
\]

\[
f = \begin{align*}
\text{General model:} \\
f(x) &= c*a*b*x^{(b-1)}*\exp(-a*x^b) \\
\text{Coefficients (with 95\% confidence bounds):} \\
a &= 0.009854 (0.007465, 0.01224) \\
b &= 2.003 (1.895, 2.11) \\
c &= 25.65 (24.42, 26.89)
\end{align*}
\]

This Weibull model is defined with three parameters: the first scales the curve along the horizontal axis, the second defines the shape of the curve, and the third scales the curve along the vertical axis. Notice that while this curve has almost the same form as the Weibull probability density function, it is not a density because it includes the parameter \( c \), which is necessary to allow the curve’s height to adjust to data. This Weibull model is based on a Statistics Toolbox example, Curve Fitting and Distribution Fitting.
Least-Squares Fitting

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Introduction” on page 4-47</td>
</tr>
<tr>
<td>“Error Distributions” on page 4-48</td>
</tr>
<tr>
<td>“Linear Least Squares” on page 4-49</td>
</tr>
<tr>
<td>“Weighted Least Squares” on page 4-52</td>
</tr>
<tr>
<td>“Robust Least Squares” on page 4-54</td>
</tr>
<tr>
<td>“Nonlinear Least Squares” on page 4-56</td>
</tr>
<tr>
<td>“Example: Robust Fitting” on page 4-58</td>
</tr>
</tbody>
</table>

Introduction

Curve Fitting Toolbox software uses the method of least squares when fitting data. Fitting requires a parametric model that relates the response data to the predictor data with one or more coefficients. The result of the fitting process is an estimate of the model coefficients.

To obtain the coefficient estimates, the least-squares method minimizes the summed square of residuals. The residual for the $i$th data point $r_i$ is defined as the difference between the observed response value $y_i$ and the fitted response value $\hat{y}_i$, and is identified as the error associated with the data.

$$ r_i = y_i - \hat{y}_i $$

residual=data–fit

The summed square of residuals is given by

$$ S = \sum_{i=1}^{n} r_i^2 = \sum_{i=1}^{n} (y_i - \hat{y}_i)^2 $$

where $n$ is the number of data points included in the fit and $S$ is the sum of squares error estimate. The supported types of least-squares fitting include:
• Linear least squares
• Weighted linear least squares
• Robust least squares
• Nonlinear least squares

**Error Distributions**

When fitting data that contains random variations, there are two important assumptions that are usually made about the error:

• The error exists only in the response data, and not in the predictor data.
• The errors are random and follow a normal (Gaussian) distribution with zero mean and constant variance, $\sigma^2$.

The second assumption is often expressed as

$$ \text{error} \sim N(0, \sigma^2) $$

The errors are assumed to be normally distributed because the normal distribution often provides an adequate approximation to the distribution of many measured quantities. Although the least-squares fitting method does not assume normally distributed errors when calculating parameter estimates, the method works best for data that does not contain a large number of random errors with extreme values. The normal distribution is one of the probability distributions in which extreme random errors are uncommon. However, statistical results such as confidence and prediction bounds do require normally distributed errors for their validity.

If the mean of the errors is zero, then the errors are purely random. If the mean is not zero, then it might be that the model is not the right choice for your data, or the errors are not purely random and contain systematic errors.

A constant variance in the data implies that the “spread” of errors is constant. Data that has the same variance is sometimes said to be of *equal quality*.

The assumption that the random errors have constant variance is not implicit to weighted least-squares regression. Instead, it is assumed that the weights provided in the fitting procedure correctly indicate the differing levels of
quality present in the data. The weights are then used to adjust the amount of influence each data point has on the estimates of the fitted coefficients to an appropriate level.

**Linear Least Squares**

Curve Fitting Toolbox software uses the linear least-squares method to fit a linear model to data. A *linear* model is defined as an equation that is linear in the coefficients. For example, polynomials are linear but Gaussians are not. To illustrate the linear least-squares fitting process, suppose you have $n$ data points that can be modeled by a first-degree polynomial.

$$y = p_1 x + p_2$$

To solve this equation for the unknown coefficients $p_1$ and $p_2$, you write $S$ as a system of $n$ simultaneous linear equations in two unknowns. If $n$ is greater than the number of unknowns, then the system of equations is *overdetermined*.

$$S = \sum_{i=1}^{n} (y_i - (p_1 x_i + p_2))^2$$

Because the least-squares fitting process minimizes the summed square of the residuals, the coefficients are determined by differentiating $S$ with respect to each parameter, and setting the result equal to zero.

$$\frac{\partial S}{\partial p_1} = -2 \sum_{i=1}^{n} x_i (y_i - (p_1 x_i + p_2)) = 0$$

$$\frac{\partial S}{\partial p_2} = -2 \sum_{i=1}^{n} (y_i - (p_1 x_i + p_2)) = 0$$

The estimates of the true parameters are usually represented by $b$. Substituting $b_1$ and $b_2$ for $p_1$ and $p_2$, the previous equations become
where the summations run from \( i = 1 \) to \( n \). The normal equations are defined as

\[
\begin{align*}
 b_1 \sum x_i^2 + b_2 \sum x_i &= \sum x_i y_i \\
 b_1 \sum x_i + n b_2 &= \sum y_i
\end{align*}
\]

Solving for \( b_1 \)

\[
b_1 = \frac{n \sum x_i y_i - \sum x_i \sum y_i}{n \sum x_i^2 - (\sum x_i)^2}
\]

Solving for \( b_2 \) using the \( b_1 \) value

\[
b_2 = \frac{1}{n} \left( \sum y_i - b_1 \sum x_i \right)
\]

As you can see, estimating the coefficients \( p_1 \) and \( p_2 \) requires only a few simple calculations. Extending this example to a higher degree polynomial is straightforward although a bit tedious. All that is required is an additional normal equation for each linear term added to the model.

In matrix form, linear models are given by the formula

\[
y = X\beta + \epsilon
\]

where

- \( y \) is an \( n \)-by-1 vector of responses.
- \( \beta \) is a \( m \)-by-1 vector of coefficients.
- \( X \) is the \( n \)-by-\( m \) design matrix for the model.
- \( \epsilon \) is an \( n \)-by-1 vector of errors.
For the first-degree polynomial, the \( n \) equations in two unknowns are expressed in terms of \( y, X, \) and \( \beta \) as

\[
\begin{bmatrix}
y_1 \\
y_2 \\
y_3 \\
n \\
y_n
\end{bmatrix} =
\begin{bmatrix}
x_1 & 1 \\
x_2 & 1 \\
x_3 & 1 \\
. & . \\
. & . \\
. & . \\
x_n & 1
\end{bmatrix}
\times
\begin{bmatrix}
p_1 \\
p_2
\end{bmatrix}
\]

The least-squares solution to the problem is a vector \( b \), which estimates the unknown vector of coefficients \( \beta \). The normal equations are given by

\[
(X^TX)b = X^Ty
\]

where \( X^T \) is the transpose of the design matrix \( X \). Solving for \( b \),

\[
b = (X^TX)^{-1}X^Ty
\]

Use the MATLAB backslash operator (\texttt{mldivide}) to solve a system of simultaneous linear equations for unknown coefficients. Because inverting \( X^TX \) can lead to unacceptable rounding errors, the backslash operator uses \textit{QR} decomposition with pivoting, which is a very stable algorithm numerically. Refer to \textit{Arithmetic Operators} in the MATLAB documentation for more information about the backslash operator and \textit{QR} decomposition.

You can plug \( b \) back into the model formula to get the predicted response values, \( \hat{y} \).

\[
\hat{y} = Xb = Hy
\]

\[
H = X(X^TX)^{-1}X^T
\]

A hat (circumflex) over a letter denotes an estimate of a parameter or a prediction from a model. The projection matrix \( H \) is called the hat matrix, because it puts the hat on \( y \).
The residuals are given by

\[ r = y - \hat{y} = (1-H)y \]

**Weighted Least Squares**

It is usually assumed that the response data is of equal quality and, therefore, has constant variance. If this assumption is violated, your fit might be unduly influenced by data of poor quality. To improve the fit, you can use weighted least-squares regression where an additional scale factor (the weight) is included in the fitting process. Weighted least-squares regression minimizes the error estimate

\[ s = \sum_{i=1}^{n} w_i (y_i - \hat{y}_i)^2 \]

where \( w_i \) are the weights. The weights determine how much each response value influences the final parameter estimates. A high-quality data point influences the fit more than a low-quality data point. Weighting your data is recommended if the weights are known, or if there is justification that they follow a particular form.

The weights modify the expression for the parameter estimates \( b \) in the following way,

\[ b = \hat{\beta} = (X^T W X)^{-1} X^T W y \]

where \( W \) is given by the diagonal elements of the weight matrix \( w \).

You can often determine whether the variances are not constant by fitting the data and plotting the residuals. In the plot shown below, the data contains replicate data of various quality and the fit is assumed to be correct. The poor quality data is revealed in the plot of residuals, which has a “funnel” shape where small predictor values yield a bigger scatter in the response values than large predictor values.
The weights you supply should transform the response variances to a constant value. If you know the variances of the measurement errors in your data, then the weights are given by

$$w_i = \frac{1}{\sigma_i^2}$$

Or, if you only have estimates of the error variable for each data point, it usually suffices to use those estimates in place of the true variance. If you do not know the variances, it suffices to specify weights on a relative scale. Note that an overall variance term is estimated even when weights have been specified. In this instance, the weights define the relative weight to each point in the fit, but are not taken to specify the exact variance of each point.

For example, if each data point is the mean of several independent measurements, it might make sense to use those numbers of measurements as weights.
Robust Least Squares

It is usually assumed that the response errors follow a normal distribution, and that extreme values are rare. Still, extreme values called outliers do occur.

The main disadvantage of least-squares fitting is its sensitivity to outliers. Outliers have a large influence on the fit because squaring the residuals magnifies the effects of these extreme data points. To minimize the influence of outliers, you can fit your data using robust least-squares regression. The toolbox provides these two robust regression methods:

- Least absolute residuals (LAR) — The LAR method finds a curve that minimizes the absolute difference of the residuals, rather than the squared differences. Therefore, extreme values have a lesser influence on the fit.

- Bisquare weights — This method minimizes a weighted sum of squares, where the weight given to each data point depends on how far the point is from the fitted line. Points near the line get full weight. Points farther from the line get reduced weight. Points that are farther from the line than would be expected by random chance get zero weight.

For most cases, the bisquare weight method is preferred over LAR because it simultaneously seeks to find a curve that fits the bulk of the data using the usual least-squares approach, and it minimizes the effect of outliers.

Robust fitting with bisquare weights uses an iteratively reweighted least-squares algorithm, and follows this procedure:

1. Fit the model by weighted least squares.

2. Compute the adjusted residuals and standardize them. The adjusted residuals are given by

   \[ r_{adj} = \frac{r_i}{\sqrt{1 - h_i}} \]

   \( r_i \) are the usual least-squares residuals and \( h_i \) are leverages that adjust the residuals by reducing the weight of high-leverage data points, which have a large effect on the least-squares fit. The standardized adjusted residuals are given by
\[ u = \frac{r_{adj}}{Ks} \]

\( K \) is a tuning constant equal to 4.685, and \( s \) is the robust variance given by \( \text{MAD}/0.6745 \) where \( \text{MAD} \) is the median absolute deviation of the residuals.

**3** Compute the robust weights as a function of \( u \). The bisquare weights are given by

\[
w_i = \begin{cases} 
(1 - (u_i)^2)^2 & |u_i| < 1 \\
0 & |u_i| \geq 1 
\end{cases}
\]

Note that if you supply your own regression weight vector, the final weight is the product of the robust weight and the regression weight.

**4** If the fit converges, then you are done. Otherwise, perform the next iteration of the fitting procedure by returning to the first step.

The plot shown below compares a regular linear fit with a robust fit using bisquare weights. Notice that the robust fit follows the bulk of the data and is not strongly influenced by the outliers.
Instead of minimizing the effects of outliers by using robust regression, you can mark data points to be excluded from the fit. Refer to “Removing Outliers” on page 7-10 for more information.

**Nonlinear Least Squares**

Curve Fitting Toolbox software uses the nonlinear least-squares formulation to fit a nonlinear model to data. A nonlinear model is defined as an equation that is nonlinear in the coefficients, or a combination of linear and nonlinear in the coefficients. For example, Gaussians, ratios of polynomials, and power functions are all nonlinear.

In matrix form, nonlinear models are given by the formula

\[ y = f(X, \theta) + \varepsilon \]

where
• \( y \) is an \( n \)-by-1 vector of responses.
• \( f \) is a function of \( \beta \) and \( X \).
• \( \beta \) is a \( m \)-by-1 vector of coefficients.
• \( X \) is the \( n \)-by-\( m \) design matrix for the model.
• \( \varepsilon \) is an \( n \)-by-1 vector of errors.

Nonlinear models are more difficult to fit than linear models because the coefficients cannot be estimated using simple matrix techniques. Instead, an iterative approach is required that follows these steps:

1. Start with an initial estimate for each coefficient. For some nonlinear models, a heuristic approach is provided that produces reasonable starting values. For other models, random values on the interval \([0,1]\) are provided.

2. Produce the fitted curve for the current set of coefficients. The fitted response value \( \hat{y} \) is given by

\[
\hat{y} = f(X,\beta)
\]

and involves the calculation of the Jacobian of \( f(X,\beta) \), which is defined as a matrix of partial derivatives taken with respect to the coefficients.

3. Adjust the coefficients and determine whether the fit improves. The direction and magnitude of the adjustment depend on the fitting algorithm. The toolbox provides these algorithms:

• Trust-region — This is the default algorithm and must be used if you specify coefficient constraints. It can solve difficult nonlinear problems more efficiently than the other algorithms and it represents an improvement over the popular Levenberg-Marquardt algorithm.

• Levenberg-Marquardt — This algorithm has been used for many years and has proved to work most of the time for a wide range of nonlinear models and starting values. If the trust-region algorithm does not produce a reasonable fit, and you do not have coefficient constraints, you should try the Levenberg-Marquardt algorithm.

4. Iterate the process by returning to step 2 until the fit reaches the specified convergence criteria.
You can use weights and robust fitting for nonlinear models, and the fitting process is modified accordingly.

Because of the nature of the approximation process, no algorithm is foolproof for all nonlinear models, data sets, and starting points. Therefore, if you do not achieve a reasonable fit using the default starting points, algorithm, and convergence criteria, you should experiment with different options. Refer to “Specifying Fit Options and Optimized Starting Points” on page 4-7 for a description of how to modify the default options. Because nonlinear models can be particularly sensitive to the starting points, this should be the first fit option you modify.

**Example: Robust Fitting**

1. Create a baseline sinusoidal signal:

   ```
   xdata = (0:0.1:2*pi)';
y0 = sin(xdata);
   ``

2. Add noise to the signal with non-constant variance:

   ```
   % Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

   % Salt-and-pepper noise
spnoise = zeros(size(y0));
p = randperm(length(y0));
sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));
   ``
ydata = y0 + gnoise + spnoise;

3. Fit the noisy data with a baseline sinusoidal model:

   ```
   f = fittype('a*sin(b*x)');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
   ``

4. Identify “outliers” as points at a distance greater than 1.5 standard deviations from the baseline model, and refit the data with the outliers excluded:
fdata = feval(fit1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata,'indices',I);

fit2 = fit(xdata,ydata,f,'StartPoint',[1 1],'Exclude',outliers);

5 Compare the effect of excluding the outliers with the effect of giving them lower bisquare weight in a robust fit:

fit3 = fit(xdata,ydata,f,'StartPoint',[1 1],'Robust','on');

6 Plot the data, the outliers, and the results of the fits:

plot(fit1,'r-',xdata,ydata,'k.',outliers,'m*')
hold on
plot(fit2,'c--')
plot(fit3,'b:')
xlim([0 2*pi])

7 Plot the residuals for the two fits considering outliers:

figure
plot(fit2,xdata,ydata,'co','residuals')
hold on
plot(fit3,xdata,ydata,'bx','residuals')
Custom Linear and Nonlinear Regression

- “Custom Models” on page 5-2
- “Custom Nonlinear Census Analysis” on page 5-6
- “Fourier Analysis of ENSO Data” on page 5-9
- “Gaussian Fitting with an Exponential Background” on page 5-20
- “Biopharmaceutical Drug Interaction Surface Fitting” on page 5-24
- “Custom Linear Models” on page 5-37
Custom Models

In this section...

“Custom Models vs. Library Models” on page 5-2
“Selecting a Custom Equation Fit Interactively” on page 5-2
“Selecting a Custom Equation Fit at the Command Line” on page 5-4

Custom Models vs. Library Models

If the toolbox library does not contain a desired parametric equation, you can create your own custom equation. Library models, however, offer the best chance for rapid convergence. This is because:

- For most library models, the toolbox calculates optimal default coefficient starting points. For custom models, the toolbox chooses random default starting points on the interval [0,1].
- Library models use an analytic Jacobian. Custom models use finite differencing.

Selecting a Custom Equation Fit Interactively

In the Curve Fitting Tool, select Custom Equation from the model type list.

Use the custom equation fit to define your own equations. An example custom equation appears when you select Custom Equation from the list, as shown here for curve data.
If you have surface data, the example custom equation uses both \( x \) and \( y \).

![Custom Equation](image)

1 You can edit \( x \), \( y \), and \( z \) to any valid variable names.

2 In the lower box, edit the example to define your own custom equation. You can enter any valid MATLAB expression in terms of your variable names.

You can create custom general equations. General models are nonlinear combinations of (perhaps nonlinear) terms. They are defined by equations that might be nonlinear in the parameters. The custom equation fit uses the nonlinear least-squares fitting procedure.

You can define a custom linear equation, but the nonlinear fitting is less efficient and usually slower than linear least-squares fitting. If you need linear least-squares fitting for custom equations, you must use the legacy Curve Fitting Tool. See “Creating Custom Models Using the Legacy Curve Fitting Tool” on page 5-46.

You can save your custom equations as part of your saved Curve Fitting Tool sessions.

Your function can execute a number of times, both during fitting and during preprocessing before fitting. Be aware this may be time-consuming if you are using functions with side effects such as writing data to a file, or displaying diagnostic information to the Command Window.

For examples, see:

- “Fourier Analysis of ENSO Data” on page 5-9
Selecting a Custom Equation Fit at the Command Line

To fit custom models, either:

- Use an anonymous function with the `fit` function.
- Create a `fittype` object with the `fittype` function to use as an input argument for the `fit` function.

This example loads some data and uses a custom equation defining a Weibull model as an input to the `fit` function:

```matlab
time = [ 0.1; 0.1; 0.3; 0.3; 1.3; 1.7; 2.1; 2.6; 3.9; 3.9
        5.1; 5.6; 6.2; 6.4; 7.7; 8.1; 8.2; 8.9; 9.0; 9.5
        9.6; 10.2; 10.3; 10.8; 11.2; 11.2; 11.2; 11.7; 12.1; 12.3
        12.3; 13.1; 13.2; 13.4; 13.7; 14.0; 14.3; 15.4; 16.1; 16.1
        16.4; 16.4; 16.7; 16.7; 17.5; 17.6; 18.1; 18.5; 19.3; 19.7
        ];
conc = [0.01; 0.08; 0.13; 0.16; 0.55; 0.90; 1.11; 1.62; 1.79; 1.59
        1.83; 1.68; 2.09; 2.17; 2.66; 2.08; 2.26; 1.65; 1.70; 2.39
        2.08; 2.02; 1.65; 1.96; 1.91; 1.30; 1.62; 1.57; 1.32; 1.56
        1.36; 1.05; 1.29; 1.32; 1.20; 1.10; 0.88; 0.63; 0.69; 0.69
        0.49; 0.53; 0.42; 0.48; 0.41; 0.27; 0.36; 0.33; 0.17; 0.20
        ];
f = fit( time, conc, 'c*a*b*x^(b-1)*exp(-a*x^b)', 'StartPoint', [0.01, 2, 5
        ];
plot( f, time, conc
        );
```

To define a custom model using `fittype`, use the form:

```matlab
f = fittype(expr)
```

which constructs a custom model `fittype` object for the MATLAB expression contained in the string, cell array, or anonymous function `expr`.

For details on specifying dependent and independent variables, problem parameters, and coefficients using `fittype`, see on the `fittype` reference page.
If `expr` is a string or anonymous function, then the toolbox uses a nonlinear fitting algorithm. To use a linear fitting algorithm for your custom equation, use a cell array of terms. See on the `fittype` reference page.

For examples of linear and nonlinear custom models, see the `fittype` reference page. For a step-by-step example, see “Custom Nonlinear Census Analysis” on page 5-6.
Custom Nonlinear Census Analysis

The following code, using Curve Fitting Toolbox functions and methods, reproduces an interactive analysis of the census data in the Curve Fitting Tool in “Curve Fitting to Census Data” on page 2-22.

1 Load and plot the data in census.mat:

```matlab
load census
plot(cdate,pop,'o')
hold on
```

2 Create a fit options structure and a `fittype` object for the custom nonlinear model \( y = a(x-b)^n \), where \( a \) and \( b \) are coefficients and \( n \) is a problem-dependent parameter:

```matlab
s = fitoptions('Method','NonlinearLeastSquares',...
    'Lower',[0,0],...
    'Upper',[Inf,max(cdate)],...
    'Startpoint',[1 1]);
f = fittype('a*(x-b)^n','problem','n','options',s);
```

3 Fit the data using the fit options and a value of \( n = 2 \):
[c2,gof2] = fit(cdate,pop,f,'problem',2)
c2 =
    General model:
    c2(x) = a*(x-b)^n
    Coefficients (with 95% confidence bounds):
    a = 0.006092 (0.005743, 0.006441)
    b = 1789 (1784, 1793)
    Problem parameters:
    n = 2
gof2 =
    sse: 246.1543
    rsquare: 0.9980
    dfe: 19
    adjrsquare: 0.9979
    rmse: 3.5994

4 Fit the data using the fit options and a value of $n = 3$:

[c3,gof3] = fit(cdate,pop,f,'problem',3)
c3 =
    General model:
    c3(x) = a*(x-b)^n
    Coefficients (with 95% confidence bounds):
    a = 1.359e-005 (1.245e-005, 1.474e-005)
    b = 1725 (1718, 1731)
    Problem parameters:
    n = 3
gof3 =
    sse: 232.0058
    rsquare: 0.9981
    dfe: 19
    adjrsquare: 0.9980
    rmse: 3.4944

5 Plot the fit results and the data:

plot(c2,'m')
plot(c3,'c')
Custom Linear and Nonlinear Regression
Fourier Analysis of ENSO Data

This example fits the ENSO data using several custom nonlinear equations. The ENSO data consists of monthly averaged atmospheric pressure differences between Easter Island and Darwin, Australia. This difference drives the trade winds in the southern hemisphere.

The ENSO data is clearly periodic, which suggests it can be described by a Fourier series:

\[ y(x) = a_0 + \sum_{i=1}^{\infty} a_i \cos \left( \frac{2\pi x}{c_i} \right) + b_i \sin \left( \frac{2\pi x}{c_i} \right) \]

where \( a_i \) and \( b_i \) are the amplitudes, and \( c_i \) are the periods (cycles) of the data. The question to answer here is how many cycles exist?

As a first attempt, assume a single cycle and fit the data using one cosine term and one sine term.

\[ y_1(x) = a_0 + a_1 \cos \left( \frac{2\pi x}{c_1} \right) + b_1 \sin \left( \frac{2\pi x}{c_1} \right) \]

If the fit does not describe the data well, add additional cosine and sine terms with unique period coefficients until a good fit is obtained.

The equation is nonlinear because an unknown coefficient \( c_1 \) is included as part of the trigonometric function arguments.

**In this section...**

- “Load Data and Fit Library and Custom Fourier Models” on page 5-10
- “Use Fit Options to Constrain a Coefficient” on page 5-13
- “Create Second Custom Fit with Additional Terms and Constraints” on page 5-15
- “Create a Third Custom Fit with Additional Terms and Constraints” on page 5-16


**Load Data and Fit Library and Custom Fourier Models**

1. Load the data and open the Curve Fitting Tool:

   ```
   load enso
cftool
   ```

2. The toolbox includes the Fourier series as a nonlinear library equation. However, the library equation does not meet the needs of this example because its terms are defined as fixed multiples of the fundamental frequency \( w \). Refer to “Fourier Series” on page 4-29 for more information. Create the built-in library Fourier fit to compare with your custom equations:

   - **a** Select **month** for **X data** and **pressure** for **Y data**.
   - **b** Select **Fourier** for the model type.
   - **c** Enter **Fourier** for the **Fit name**.
   - **d** Change the number of terms to 8.

   Observe that this library model does not describe the data well enough.
3 Duplicate your fit. Right-click your fit in the Table of Fits and select Duplicate 'Fourier'.

4 Name the new fit Enso1Period.

5 Change the fit type from Fourier to Custom Equation.

6 Replace the example text in the equation edit box with

\[ a_0 + a_1 \cos(2\pi x/c_1) + b_1 \sin(2\pi x/c_1) \]

The toolbox applies the fit to the enso data.

The graphical and numerical results shown here indicate that the fit does not describe the data well. In particular, the fitted value for \( c_1 \) is unreasonably small. Your initial fit results might differ from these results because the starting points are randomly selected.
By default, the coefficients are unbounded and have random starting values from 0 to 1. The data include a periodic component with a period of about 12 months. However, with $c_1$ unconstrained and with a random starting point, this fit failed to find that cycle.
Use Fit Options to Constrain a Coefficient

1 To assist the fitting procedure, constrain \( c_1 \) to a value from 10 to 14. Click the Fit Options button to view and edit constraints for unknown coefficients.

2 In the Fit Options dialog box, observe that by default the coefficients are unbounded (bounds of -\( \text{Inf} \) and \( \text{Inf} \)).

3 Change the Lower and Upper bounds for \( c_1 \) to constrain the cycle from 10 to 14 months, as shown next.

4 Click Close. The Curve Fitting Tool refits.
Observe the new fit and the residuals plot. If necessary, select View > Residuals Plot or use the toolbar button.

The fit appears to be reasonable for some data points but clearly does not describe the entire data set very well. As predicted, the numerical results in the Results pane (c1=11.94) indicate a cycle of approximately 12 months. However, the residuals show a systematic periodic distribution, indicating that at least one more cycle exists. There are additional cycles that you should include in the fit equation.
Create Second Custom Fit with Additional Terms and Constraints

To refine your fit, you need to add an additional sine and cosine term to \( y_1(x) \) as follows:

\[
y_2(x) = y_1(x) + a_2 \cos \left( \frac{2\pi x}{c_2} \right) + b_2 \sin \left( \frac{2\pi x}{c_2} \right)
\]

and constrain the upper and lower bounds of \( c_2 \) to be roughly twice the bounds used for \( c_1 \).

1. Duplicate your fit by right-clicking it in the Table of Fits and selecting Duplicate ‘Enso1Period’.

2. Name the new fit Enso2Period.

3. Add these terms to the end of the previous equation:
   \[ +a_2\cos(2\pi x/c_2)+b_2\sin(2\pi x/c_2) \]

4. Click Fit Options. When you edit the custom equation, the tool refits with default fit options. So:
   a. Change the Lower and Upper for \( c_1 \) to constrain the cycle from 10 to 14 months.
   b. Change the Lower and Upper for \( c_2 \) to be roughly twice the bounds used for \( c_1 \) (20<\( c_2 \)<30).
   c. Change the StartPoint for \( a_0 \) to 5.

When you close the dialog box, the Curve Fitting Tool refits. The fit and residuals are shown next.
The fit appears reasonable for most data points. However, the residuals indicate that you should include another cycle to the fit equation.

**Create a Third Custom Fit with Additional Terms and Constraints**

As a third attempt, add an additional sine and cosine term to $y_2(x)$

$$y_3(x) = y_2(x) + a_3 \cos \left( \frac{2\pi}{c_3} x \right) + b_3 \sin \left( \frac{2\pi}{c_3} x \right)$$

and constrain the lower bound of $c_3$ to be roughly triple the value of $c_1$. 
1 Duplicate your fit by right-clicking it in the Table of Fits and selecting Duplicate ‘Enso1Period’.

2 Name the new fit Enso3Period.

3 Add these terms to the end of the previous equation:

\[ +a_3 \cos(2\pi x/c_3)+b_3 \sin(2\pi x/c_3) \]

4 Click Fit Options.

a Change the Lower and Upper for \( c_1 \) to constrain the cycle from 10 to 14 months.

b Change the Lower and Upper for \( c_2 \) to be roughly twice the bounds used for \( c_1 \) (20<\( c_2 \)<30).

c Change the Lower bound for \( c_3 \) to be 36, which is roughly triple the value of \( c_1 \).

d Change the StartPoint for \( a_0 \) to be 5.
Close the dialog box. The Curve Fitting Tool refits. The fit and residuals appear next.
The fit is an improvement over the previous two fits, and appears to account for most of the cycles in the ENSO data set. The residuals appear random for most of the data, although a pattern is still visible indicating that additional cycles might be present, or you can improve the fitted amplitudes.

In conclusion, Fourier analysis of the data reveals three significant cycles. The annual cycle is the strongest, but cycles with periods of approximately 44 and 22 months are also present. These cycles correspond to El Nino and the Southern Oscillation (ENSO).
Gaussian Fitting with an Exponential Background

This example fits two poorly resolved Gaussian peaks on a decaying exponential background using a general (nonlinear) custom model.

Fit the data using this equation

\[ y(x) = a e^{-bx} + a_1 e\left(-\frac{x-b_1}{c_1}\right)^2 + a_2 e\left(-\frac{x-b_2}{c_2}\right)^2 \]

where \( a_i \) are the peak amplitudes, \( b_i \) are the peak centroids, and \( c_i \) are related to the peak widths. Because unknown coefficients are part of the exponential function arguments, the equation is nonlinear.

1. Load the data and open the Curve Fitting Tool:
   ```matlab
   load gauss3
   cftool
   ```

   The workspace contains two new variables:
   - \( x\text{peak} \) is a vector of predictor values.
   - \( y\text{peak} \) is a vector of response values.

2. In the Curve Fitting Tool, select \( x\text{peak} \) for \textbf{X data} and \( y\text{peak} \) for \textbf{Y data}.

3. Enter Gauss2exp1 for the \textbf{Fit name}.

4. Select Custom Equation for the model type.

5. Replace the example text in the equation edit box with these terms:
   ```matlab
   a*exp(-b*x)+a1*exp(-((x-b1)/c1)^2)+a2*exp(-((x-b2)/c2)^2)
   ```

   The fit is poor (or incomplete) at this point because the starting points are randomly selected and no coefficients have bounds.

6. Specify reasonable coefficient starting points and constraints. Deducing the starting points is particularly easy for the current model because the Gaussian coefficients have a straightforward interpretation and
the exponential background is well defined. Additionally, as the peak amplitudes and widths cannot be negative, constrain \( a_1, a_2, c_1, \) and \( c_2 \) to be greater than 0.

\textbf{a} Click \textbf{Fit Options}.

\textbf{b} Change the \textbf{Lower} bound for \( a_1, a_2, c_1, \) and \( c_2 \) to 0, as the peak amplitudes and widths cannot be negative.

\textbf{c} Enter start points as shown for the unknown coefficients.

<table>
<thead>
<tr>
<th>Unknowns</th>
<th>Start Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>100</td>
</tr>
<tr>
<td>a1</td>
<td>100</td>
</tr>
<tr>
<td>a2</td>
<td>80</td>
</tr>
<tr>
<td>b</td>
<td>0.1</td>
</tr>
<tr>
<td>b1</td>
<td>110</td>
</tr>
<tr>
<td>b2</td>
<td>140</td>
</tr>
<tr>
<td>c1</td>
<td>20</td>
</tr>
<tr>
<td>c2</td>
<td>20</td>
</tr>
</tbody>
</table>
When you close the dialog box, the Curve Fitting Tool refits. Following are the fit and residuals.
Biopharmaceutical Drug Interaction Surface Fitting

In this section...

“Surface Fitting to Biopharmaceutical Data” on page 5-24
“Custom Equation Fitting to Biopharmaceutical Data” on page 5-31

Surface Fitting to Biopharmaceutical Data

Curve Fitting Toolbox software provides some example data for an anesthesia drug interaction study. You can use Curve Fitting Tool to fit response surfaces to this data to analyze drug interaction effects. Response surface models provide a good method for understanding the pharmacodynamic interaction behavior of drug combinations.

This data is based on the results in this paper:


Anesthesia is typically at least a two-drug process, consisting of an opioid and a sedative hypnotic. This example uses Propofol and Reminfentanil as drug class prototypes. Their interaction is measured by four different measures of the analgesic and sedative response to the drug combination. Algometry, Tetany, Sedation, and Laryngoscopy comprise the four measures of surrogate drug effects at various concentration combinations of Propofol and Reminfentanil.

To interactively create response surfaces for this drug combination:

1. Use the Current Folder browser to locate and view the folder `matlab\toolbox\curvefit\curvefit`.

2. Right-click the file `OpioidHypnoticSynergy.txt`, and select Import Data. The Import Wizard appears.
   - Leave the default Column delimiters set to Tab and Column vectors in the Imported Data section.
Review the six variables selected for import: Propofol, Remifentanil, Algometry, Tetany, Sedation, and Laryngoscopy.

On the Import tab, in the Import section, click **Import Selection** to import the dose-response data into the MATLAB workspace.

Alternatively, you can import the data programmatically. Enter the following code to read the dose-response data from the file into the MATLAB workspace.

```matlab
data = importdata('OpioidHypnoticSynergy.txt');
Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Tetany = data.data(:,4);
Sedation = data.data(:,5);
Laryngoscopy = data.data(:,6);
```

3 To create response surfaces you must select the two drugs for the X and Y inputs, and one of the four effects for the Z output. After you load the variables into your workspace, you can either open the tool and select variables interactively, or specify the initial fit variables with the `cftool` command.

Enter the following to open Curve Fitting Tool (if necessary) and create a new response surface for Algometry:

```matlab
cftool(Propofol, Remifentanil, Algometry)
```

Review the Curve Fitting Tool X, Y, and Z input and output controls. The tool displays the selected variables Propofol, Remifentanil and Algometry, with a surface fit. The default fit is an interpolating surface that passes through the data points.
4 Create a copy of the current surface fit by either:
   a Selecting **Fit > Duplicate "Current Fit Name"**.
   b Right-clicking a fit in the **Table of Fits**, and selecting **Duplicate**.

5 Select the **Custom Equation** fit type from the drop-down list to define your own equation to fit the data.

6 Select and delete the example custom equation text in the edit box.

You can use the custom equation edit box to enter MATLAB code to define your model. The equation that defines the model must depend on the input
variables \(x\) and \(y\) and a list of fixed parameters, estimable parameters, or both.

The model from the paper is:

\[
E = \frac{E_{\text{max}} \left( \frac{C_A}{IC_{50A}} + \frac{C_B}{IC_{50B}} + \alpha \cdot \frac{C_A}{IC_{50A}} \cdot \frac{C_B}{IC_{50B}} \right)^n}{1 + \left( \frac{C_A}{IC_{50A}} + \frac{C_B}{IC_{50B}} + \alpha \cdot \frac{C_A}{IC_{50A}} \cdot \frac{C_B}{IC_{50B}} \right)^n}
\]

where \(C_A\) and \(C_B\) are the drug concentrations, and \(IC_{50A}\), \(IC_{50B}\), alpha, and \(n\) are the coefficients to be estimated.

You can define this in MATLAB code as:

\[
\text{Effect} = E_{\text{max}} \cdot \left( \frac{CA}{IC_{50A}} + \frac{CB}{IC_{50B}} + \alpha \cdot \frac{CA}{IC_{50A}} \cdot \frac{CB}{IC_{50B}} \right)^n \div \left( \frac{CA}{IC_{50A}} + \frac{CB}{IC_{50B}} + \alpha \cdot \frac{CA}{IC_{50A}} \cdot \frac{CB}{IC_{50B}} \right)^n + 1;
\]

Telling the tool which variables to fit and which parameters to estimate, requires rewriting the variable names \(CA\) and \(CB\) to \(x\) and \(y\). You must include \(x\) and \(y\) when you enter a custom equation in the edit box. Assume \(E_{\text{max}} = 1\) because the effect output is normalized.

**7** Enter the following text in the custom equation edit box.

\[
( \frac{x}{IC_{50A}} + \frac{y}{IC_{50B}} + \alpha \cdot ( \frac{x}{IC_{50A}} \cdot \frac{y}{IC_{50B}} ) ) \div (( \frac{x}{IC_{50A}} + \frac{y}{IC_{50B}} + \alpha \cdot ( \frac{x}{IC_{50A}} \cdot \frac{y}{IC_{50B}} ) ) + 1);
\]

Curve Fitting Tool fits a surface to the data using the custom equation model.
8 Set some of the fit options by clicking **Fit Options** under your custom equation.

In the Fit Options dialog box:

- Set **Robust** to Lar
- Set the **alpha StartPoint** to 1 and lower bound to –5.
Leave the other defaults, and click **Close**.

The tool refits with your new options.

9 Review the **Results** pane. View (and, optionally, copy) any of these results:
- The model equation
- The values of the estimated coefficients
- The goodness-of-fit statistics

10 Display the residuals plot to check the distribution of points relative to the surface by clicking the toolbar button or selecting **View > Residuals Plot**.
To generate code for all fits and plots in your Curve Fitting Tool session, select **File > Generate Code.**

The Curve Fitting Tool generates code from your session and displays the file in the MATLAB Editor. The file includes all fits and plots in your current session.

Save the file with the default name, *createFits.m.*

You can recreate your fits and plots by calling the file from the command line (with your original data or new data as input arguments). In this case, your original data still appears in the workspace.
Highlight the first line of the file (excluding the word function), and evaluate it by either right-clicking and selecting Evaluate, pressing F9, or copying and pasting the following to the command line:

```
[fitresult, gof] = createFits(Propofol,...
   Remifentanil, Algometry)
```

The function creates a figure window for each fit you had in your session. The custom fit figure shows both the surface and residuals plots that you created interactively in the Curve Fitting Tool.

14 Create a new fit to the Tetany response instead of Algometry by entering:

```
[fitresult, gof] = createFits(Propofol,...
   Remifentanil, Tetany)
```

You need to edit the file if you want the new response label on the plots. You can use the generated code as a starting point to change the surface fits and plots to fit your needs. For a list of methods you can use, see sfit.

To see how to programmatically fit surfaces to the same example problem, see “Custom Equation Fitting to Biopharmaceutical Data” on page 5-31.

**Custom Equation Fitting to Biopharmaceutical Data**

- “Load Data” on page 5-32
- “Create the Model Fit Type” on page 5-32
- “Fit a Surface to Algometry” on page 5-33
- “Fit a Surface to Tetany” on page 5-34
- “Fit a Surface to Sedation” on page 5-34
- “Fit a Surface to Laryingoscopy” on page 5-35

The following code, using Curve Fitting Toolbox methods, reproduces the interactive surface building with the Curve Fitting Tool described in “Surface Fitting to Biopharmaceutical Data” on page 5-24.
The following code models the response surfaces of four different measures of the analgesic and sedative response to the drug combination of Propofol and Remifentanil.

**Load Data**

Load the data from file as follows:

```matlab
loaddata( 'OpioidHypnoticSynergy.txt' );
Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Tetany = data.data(:,4);
Sedation = data.data(:,5);
Laryngoscopy = data.data(:,6);
```

**Create the Model Fit Type**

Create the model fit type as follows:

```matlab
ft = fittype( 'Emax*( CA/IC50A + CB/IC50B + alpha*( CA/IC50A ) * ( CB/IC50B ) )^n /(( CA/IC50A + CB/IC50B + alpha*( CA/IC50A ) * ( CB/IC50B ) )^n + 1 )', ...  
    'indep', {'CA', 'CB'}, 'depend', 'z', 'problem', 'Emax' )
```

Output:

```matlab
ft =

General model:
ft(IC50A,IC50B,alpha,n,Emax,CA,CB) = Emax*...
( CA/IC50A + CB/IC50B + alpha*(CA/IC50A )...  
  * ( CB/IC50B ) )^n /(( CA/IC50A + CB/IC50B... 
  + alpha*( CA/IC50A ) * ( CB/IC50B ) )^n + 1 )
```

Assume Emax = 1:

```matlab
Emax = 1;
```
**Fit a Surface to Algometry**

Set fit options as follows:

```matlab
opts = fitoptions( ft );
opts.Lower = [0 0 -5 -0];
opts.Robust = 'LAR';
opts.StartPoint = [0.00893838724332152 0.706165672266879...
1 0.746030748284422];
```

Fit and plot a surface for Algometry:

```matlab
[f, gof] = fit( [Propofol, Remifentanil], Algometry, ft,...
opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Algometry );
```
**Fit a Surface to Tetany**

Fit a surface to Tetany as follows:

```matlab
[f, gof] = fit( [Propofol, Remifentanil], Tetany, ft, opts, 'problem', Emax );
plot( f, [Propofol, Remifentanil], Tetany );
```

**Fit a Surface to Sedation**

Fit a surface to Sedation as follows:

```matlab
[f, gof] = fit( [Propofol, Remifentanil], Sedation, ft, opts, 'problem', Emax );
plot( f, [Propofol, Remifentanil], Sedation );
```
Fit a Surface to Laryngoscopy

Fit a surface to Laryngoscopy as follows:

\[
[f, gof] = \text{fit}([\text{Propofol}, \text{Remifentanil}], \text{Laryngoscopy}, \text{ft, opts, 'problem', Emax})
\]

plot( f, [Propofol, Remifentanil], Laryngoscopy );
Custom Linear Models

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About Custom Linear Models” on page 5-37</td>
</tr>
<tr>
<td>“Example: Legendre Polynomial” on page 5-37</td>
</tr>
<tr>
<td>“Creating Custom Models Using the Legacy Curve Fitting Tool” on page 5-46</td>
</tr>
</tbody>
</table>

About Custom Linear Models

You can use the Curve Fitting Tool custom equation fit to define your own linear or nonlinear equations. The custom equation fit uses the nonlinear least-squares fitting procedure. See “Selecting a Custom Equation Fit Interactively” on page 5-2.

You can define a custom linear equation, but the nonlinear fitting is less efficient and usually slower than linear least-squares fitting. If you need linear least-squares fitting for custom equations, you must use the legacy Curve Fitting Tool. For an example, see “Example: Legendre Polynomial” on page 5-37. For a procedure, see “Creating Custom Models Using the Legacy Curve Fitting Tool” on page 5-46.

Example: Legendre Polynomial

This example uses the legacy Curve Fitting Tool to define custom linear equations.

This example fits data using several custom linear equations. The data is generated, and is based on the nuclear reaction $^{12}\text{C}(e,e'\alpha)^8\text{Be}$. The equations use sums of Legendre polynomial terms.

Consider an experiment in which 124 MeV electrons are scattered from $^{12}\text{C}$ nuclei. In the subsequent reaction, alpha particles are emitted and produce the residual nuclei $^8\text{Be}$. By analyzing the number of alpha particles emitted as a function of angle, you can deduce certain information regarding the nuclear dynamics of $^{12}\text{C}$. The reaction kinematics are shown next.
The data is collected by placing solid state detectors at values of $\Theta_a$ ranging from $10^\circ$ to $240^\circ$ in $10^\circ$ increments.

It is sometimes useful to describe a variable expressed as a function of angle in terms of Legendre polynomials

$$y(x) = \sum_{n=0}^{\infty} a_n P_n(x)$$

where $P_n(x)$ is a Legendre polynomial of degree $n$, $x = \cos(\Theta_a)$, and $a_n$ are the coefficients of the fit. Refer to the `legendre` function for information about generating Legendre polynomials.

For the alpha-emission data, you can directly associate the coefficients with the nuclear dynamics by invoking a theoretical model. Additionally, the theoretical model introduces constraints for the infinite sum shown above. In particular, by considering the angular momentum of the reaction, a fourth-degree Legendre polynomial using only even terms should describe the data effectively.

You can generate Legendre polynomials with Rodrigues’ formula:

$$P_n(x) = \frac{1}{2^n n!} \left( \frac{d}{dx} \right)^n (x^2 - 1)^n$$

\(e\) is the incident electron.
\(^{12}\text{C}\) is the carbon target.
\(q\) is the momentum transferred to $^8\text{Be}$.
\(e'\) is the scattered electron.
\(\alpha\) is the emitted alpha particle.
\(\theta_{e'}\) is the electron scattering angle.
\(\theta_\alpha\) is the alpha scattering angle.
Legendre Polynomials up to Fourth Degree

<table>
<thead>
<tr>
<th>n</th>
<th>( P_n(x) )</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>( x )</td>
</tr>
<tr>
<td>2</td>
<td>((1/2)(3x^2 - 1))</td>
</tr>
<tr>
<td>3</td>
<td>((1/2)(5x^3 - 3x))</td>
</tr>
<tr>
<td>4</td>
<td>((1/8)(35x^4 - 30x^2 + 3))</td>
</tr>
</tbody>
</table>

Fit the data using a fourth-degree Legendre polynomial with only even terms:

\[
y(x) = a_0 + a_2 \left( \frac{1}{2} \right)(3x^2 - 1) + a_4 \left( \frac{1}{8} \right)(35x^4 - 30x^2 + 3)
\]

1. Load the \(^{12}\)C alpha-emission data from the file `carbon12alpha.mat`, which is provided with the toolbox:

   ```
   load carbon12alpha
   ```

   The workspace now contains two new variables:
   - `angle` is a vector of angles (in radians) ranging from 10\(^\circ\) to 240\(^\circ\) in 10\(^\circ\) increments.
   - `counts` is a vector of raw alpha particle counts that correspond to the emission angles in `angle`.

2. Open the legacy Curve Fitting Tool by entering:

   ```
   cftool -v1
   ```

3. Import these two variables into the Curve Fitting Tool.

   In the Curve Fitting Tool, click **Data** to open the Data dialog box.

   In the Data dialog box:
   - **Select** `angle` and `counts` for X and Y.
   - **Name** the data set `C12Alpha`
c Click **Create data set**.

d Click **Close**.

4 In the Curve Fitting Tool, click Fitting to open the Fitting dialog box.

5 In the Fitting dialog box:

a Click **New fit**.

b Specify a meaningful fit name.

c Select the **C12Alpha** data set.

d Select **Custom Equations** for the type of fit.

The Fit Editor for a custom equation fit type is shown following.
e Click **New** to open the New Custom Equation dialog box.

You use the **Linear Equations** tab in the New Custom Equation dialog box, because the Legendre polynomials depend only on the predictor variable and constants. This tab is shown for the model given by $y_1(x)$ (that is, the equation given at the beginning of this procedure). Because angle is given in radians, the argument of the Legendre terms is given by $\cos(\Theta_d)$. 
Edit these until your New Custom Equation dialog box resembles the example shown.

i  Change the coefficient names to \( a_2 \), \( a_4 \), and \( a_0 \) (click Add a term to show the third term).

ii Change the Terms for \( a_2 \) to \( (1/2)*(3*cos(x)^2-1) \).

iii Change the Terms for \( a_4 \) to \( (1/8)*(35*cos(x)^4-30*cos(x)^2+3) \).

iv Specify the Equation name Leg4Even.

v Click OK.

6 In the Fitting dialog box, click Apply to save the changes to the fit.

The fit and residuals appear in the Curve Fitting Tool. The fit appears to follow the trend of the data well, while the residuals appear to be randomly distributed and do not exhibit any systematic behavior.
The numerical fit results in the Fitting dialog box appear next. The 95% confidence bounds indicate that the coefficients associated with $P_0(x)$ and $P_4(x)$ are known fairly accurately, but that the $P_2(x)$ coefficient has a relatively large uncertainty.

**Results**

**Linear model:**

\[ f(x) = a_2 \cdot (1/2)^x \cdot (3 \cdot \cos(x)^2 - 1) + a_4 \cdot (1/8)^x \]

**Coefficients (with 95% confidence bounds):**

- $a_2 = 23.86$ (4.436, 43.29)
- $a_4 = 201.9$ (180.2, 223.6)
- $a_0 = 102.9$ (93.21, 112.5)

**Goodness of fit:**

- SSE: 7968
- R-square: 0.9668
- Adjusted R-square: 0.9637
- RMSE: 19.43

The coefficients associated with $P_0(x)$ and $P_4(x)$ are known accurately, but the $P_2(x)$ coefficient has a larger uncertainty.
To confirm the theoretical argument that the alpha-emission data is best described by a fourth-degree Legendre polynomial with only even terms, fit the data using both even and odd terms:

\[ y_2(x) = y_1(x) + a_1 x + a_3 \left( \frac{1}{2} \right)(5x^3 - 3x) \]

1. In the Fitting dialog box, click **Copy and Edit** to make a modified copy of your previous Legendre polynomial.

2. Use the **Linear Equations** tab of the New Custom Equation dialog box as follows to fit the model given by \( y_2(x) \):
   
   a. Click **Add a term** twice to add the odd Legendre terms.
   
   b. Change the new coefficient names to \( a_1 \) and \( a_3 \).
   
   c. Change the **Terms** for \( a_1 \) to \( \cos(x) \).
   
   d. Change the **Terms** for \( a_3 \) to \( \cos(x) \).
   
   e. Specify the **Equation name** \( \text{Leg4EvenOdd} \).

The Copy and Edit Custom Equation dialog box should resemble this example.
Click **OK** to close the dialog box.

3 In the Fitting dialog box select your new equation **Leg4EvenOdd**, and click **Apply** to save the changes to the new fit. Observe the new fit plotted in Curve Fitting Tool.

The numerical results in the Fitting dialog box indicate that the odd Legendre terms do not contribute significantly to the fit, and the even Legendre terms are essentially unchanged from the previous fit. This confirms that the initial model choice is the best one.
Creating Custom Models Using the Legacy Curve Fitting Tool

If you need linear least-squares fitting for custom equations, open the legacy Curve Fitting Tool by entering:

cftool -v1

Use the **Linear Equations** pane to define custom linear equations.

Create custom equations in the New Custom Equation dialog box. Open the dialog box in one of two ways:

- From the Curve Fitting Tool, select **Tools > Custom Equation**.
- From the Fitting dialog box, select **Custom Equations** from the **Type of fit** list, and then click the **New** button.

The dialog box contains two tabs: one for creating linear custom equations and one for creating general (nonlinear) custom equations.

**Linear Equations**

Linear models are linear combinations of (perhaps nonlinear) terms. They are defined by equations that are linear in the parameters. Use the **Linear Equations** pane on the New Custom Equation dialog box to create custom linear equations.
- **Independent variable** — Symbol representing the independent (predictor) variable. The default symbol is \( x \).

- **Equation** — Symbol representing the dependent (response) variable, followed by the linear equation. The default symbol is \( y \).
  - **Unknown Coefficients** — The unknown coefficients to be determined by the fit. The default symbols are \( a, b, c \), and so on.
  - **Terms** — Functions of the independent variable. These can be nonlinear. Terms might not contain a coefficient to be fitted.
  - **Unknown constant coefficient** — If selected, a constant term (\( y \)-intercept) is included in the equation. Otherwise, a constant term is not included.
- **Add a term** — Add a term to the equation. An unknown coefficient is automatically added for each new term.

- **Remove last term** — Remove the last term added to the equation.

- **Equation name** — The name of the equation. By default, the name is automatically updated to match the custom equation given by *Equation*. If you override the default, the name is no longer automatically updated.

**General Equations**
General models are, in general, nonlinear combinations of (perhaps nonlinear) terms. They are defined by equations that might be nonlinear in the parameters. Use the **General Equations** tab in the New Custom Equation dialog box to create custom general equations.
• **Independent variable** — Symbol representing the independent (predictor) variable. The default symbol is $x$.

• **Equation** — Symbol representing the dependent (response) variable, followed by the general equation. The default symbol is $y$. As you type in the terms of the equation, the unknown coefficients, associated starting values, and constraints automatically populate the table. By default, the starting values are randomly selected on the interval $[0,1]$ and are unconstrained.

You can immediately change the default starting values and constraints in this table, or you can change them later using the Fit Options dialog box.
• **Equation name** — The name of the equation. By default, the name is automatically updated to match the custom equation given by **Equation**. If you override the default, the name is no longer automatically updated.

---

**Tip** If you use the **General Equations** pane to define a linear equation, a nonlinear fitting procedure is used. While this is allowed, it is inefficient, and can result in less than optimal fitted coefficients. Use the **Linear Equations** tab to define custom linear equations.

---

**Editing and Saving Custom Models**

When you click **OK** in the New Custom Equation dialog box, the displayed **Equation name** is saved for the current session in the **Custom Equations** list in the Fitting dialog box. The list is highlighted as shown next.
Custom Linear Models

![Fit Editor Interface]

- **Fit Editor**
  - **Fit name:** fit 1
  - **Data set:**
  - **Exclusion rule:** (none)
  - **Type of fit:** Custom Equations

**Custom Equations**
- \( a \cdot (\sin(x - \pi)) + c \)
- \( a \cdot \exp(-b \cdot x) + c \)

**Fit options...**
- **Immediate apply**
- **Cancel**
- **Apply**

**Results**

Click "Apply" to save the changes to the fit.

**Table of Fits**

<table>
<thead>
<tr>
<th>Fit name</th>
<th>Data set</th>
<th>Equation name</th>
<th>SSE</th>
<th>R...</th>
</tr>
</thead>
<tbody>
<tr>
<td>fit 1</td>
<td>(none)</td>
<td>(none)</td>
<td>NaN</td>
<td>NaN</td>
</tr>
</tbody>
</table>

**Buttons**
- Delete fit
- Save to workspace...
- Table options...

**Options**
- Close
- Help
To edit a custom equation, select the equation in the **Custom Equations** list and click the **Edit** button. The Edit Custom Equation dialog box appears. It is identical to the New Custom Equation dialog box, but is prepopulated with the selected equation. After editing an equation in the Edit Custom Equation dialog box, click **OK** to save it back to the **Custom Equations** list for further use in the current session. A **Copy and Edit** button is also available, if you want to save both the original and edited equations for the current session.

To save custom equations for future sessions, select **File > Save Session** in the Curve Fitting Tool.
Interpolation and Smoothing

- “Nonparametric Fitting” on page 6-2
- “Interpolants” on page 6-3
- “Smoothing Splines” on page 6-8
- “Lowess Smoothing” on page 6-16
- “Filtering and Smoothing Data” on page 6-30
Nonparametric Fitting

In some cases, you are not concerned about extracting or interpreting fitted parameters. Instead, you might simply want to draw a smooth curve through your data. Fitting of this type is called nonparametric fitting. The Curve Fitting Toolbox software supports these nonparametric fitting methods:

- “Interpolants” on page 6-3 — Estimate values that lie between known data points.
- “Smoothing Splines” on page 6-8 — Create a smooth curve through the data. You adjust the level of smoothness by varying a parameter that changes the curve from a least-squares straight-line approximation to a cubic spline interpolant.
- “Lowess Smoothing” on page 6-16 — Create a smooth surface through the data using locally weighted linear regression to smooth data.

For details about interpolation, see “1-D Interpolation” and “Scattered Data Interpolation” in the MATLAB documentation.

You can also use smoothing techniques on response data. See “Filtering and Smoothing Data” on page 6-30.

To view all available model types, see “List of Library Models for Curve and Surface Fitting” on page 4-13.
Interpolants

In this section...

“Interpolation Methods” on page 6-3
“Selecting an Interpolant Fit Interactively” on page 6-5
“Selecting an Interpolant Fit at the Command Line” on page 6-6

Interpolation Methods

Interpolation is a process for estimating values that lie between known data points.

Interpolant Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>Linear interpolation. This method fits a different linear polynomial between each pair of data points for curves, or between sets of three points for surfaces.</td>
</tr>
<tr>
<td>Nearest neighbor</td>
<td>Nearest neighbor interpolation. This method sets the value of an interpolated point to the value of the nearest data point. Therefore, this method does not generate any new data points.</td>
</tr>
<tr>
<td>Cubic spline</td>
<td>Cubic spline interpolation. This method fits a different cubic polynomial between each pair of data points for curves, or between sets of three points for surfaces.</td>
</tr>
<tr>
<td>Shape-preserving</td>
<td>Piecewise cubic Hermite interpolation (PCHIP). This method preserves monotonicity and the shape of the data. For curves only.</td>
</tr>
<tr>
<td>Biharmonic (v4)</td>
<td>MATLAB 4 griddata method. For surfaces only.</td>
</tr>
</tbody>
</table>
For surfaces, the Interpolant fit type uses the MATLAB `scatteredInterpolant` function for linear and nearest methods, and the MATLAB `griddata` function for cubic and biharmonic methods.

The type of interpolant to use depends on the characteristics of the data being fit, the required smoothness of the curve, speed considerations, post-fit analysis requirements, and so on. The linear and nearest neighbor methods are fast, but the resulting curves are not very smooth. The cubic spline and shape-preserving and v4 methods are slower, but the resulting curves are very smooth.

For example, the nuclear reaction data from the `carbon12alpha.mat` file is shown here with a nearest neighbor interpolant fit and a shape-preserving (PCHIP) interpolant fit. Clearly, the nearest neighbor interpolant does not follow the data as well as the shape-preserving interpolant. The difference between these two fits can be important if you are interpolating. However, if you want to integrate the data to get a sense of the total strength of the reaction, then both fits provide nearly identical answers for reasonable integration bin widths.
Interpolants

Note Goodness-of-fit statistics, prediction bounds, and weights are not defined for interpolants. Additionally, the fit residuals are always 0 (within computer precision) because interpolants pass through the data points.

Interpolants are defined as *piecewise polynomials* because the fitted curve is constructed from many “pieces” (except for Biharmonic for surfaces which is a radial basis function interpolant). For cubic spline and PCHIP interpolation, each piece is described by four coefficients, which the toolbox calculates using a cubic (third-degree) polynomial.

- Refer to the `spline` function for more information about cubic spline interpolation.
- Refer to the `pchip` function for more information about shape-preserving interpolation, and for a comparison of the two methods.
- Refer to the `scatteredInterpolant` and `griddata` functions for more information about surface interpolation.

It is possible to fit a single “global” polynomial interpolant to data, with a degree one less than the number of data points. However, such a fit can have wildly erratic behavior between data points. In contrast, the piecewise polynomials described here always produce a well-behaved fit, so they are more flexible than parametric polynomials and can be effectively used for a wider range of data sets.

**Selecting an Interpolant Fit Interactively**

In the Curve Fitting Tool, select Interpolant from the model type list.

The Interpolant fit category fits an interpolating curve or surface that passes through every data point. For surfaces, the Interpolant fit type uses the MATLAB `scatteredInterpolant` function for linear and nearest methods, and the MATLAB `griddata` function for cubic and biharmonic methods.

The settings are shown here.
Interpolation and Smoothing

You can specify the **Method** setting: Nearest neighbor, Linear, Cubic, Shape-preserving (PCHIP) (for curves) or Biharmonic (v4) (for surfaces). For details, see “Interpolation Methods” on page 6-3.

**Tip** If you are fitting a surface and your input variables have different scales, turn the **Center and scale** option on and off to see the difference in the surface fit. Normalizing the inputs can strongly influence the results of the triangle-based (i.e., piecewise Linear and Cubic interpolation) and Nearest neighbor surface interpolation methods.

**Selecting an Interpolant Fit at the Command Line**

Specify the interpolant model method when you call the `fit` function using one of these options.

<table>
<thead>
<tr>
<th>Fitting Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'nearestinterp'</td>
<td>Nearest neighbor interpolation</td>
</tr>
<tr>
<td>'linearinterp'</td>
<td>Linear interpolation</td>
</tr>
<tr>
<td>'cubicinterp'</td>
<td>Cubic spline interpolation</td>
</tr>
<tr>
<td>'pchipinterp'</td>
<td>Piecewise cubic Hermite interpolation (curves only)</td>
</tr>
<tr>
<td>'biharmonicinterp'</td>
<td>Biharmonic (MATLAB 4 <code>griddata</code>) interpolation (surfaces only)</td>
</tr>
</tbody>
</table>

There are no additional fit option parameters for any of the interpolant methods.
For example, to load some data and fit a linear interpolant model:

```matlab
load census;
f = fit(cdate, pop, 'linearinterp')
plot(f,cdate,pop)
```

To create and compare nearest neighbor and pchip interpolant fits on a plot:

```matlab
load carbon12alpha
f1 = fit(angle, counts, 'nearestinterp')
f2 = fit(angle, counts, 'pchip')
p1 = plot(f1, angle, counts)
xlim([min(angle), max(angle)])
hold on
p2 = plot(f2, 'b')
hold off
legend([p1; p2], 'Counts per Angle','Nearest', 'pchip')
```

For an alternative to 'cubicinterp' or 'pchipinterp', you can use other spline functions that allow greater control over what you can create. See “About Splines in Curve Fitting Toolbox” on page 8-2.
Interpolation and Smoothing

Smoothing Splines

In this section...

| “About Smoothing Splines” on page 6-8 |
| “Selecting a Smoothing Spline Fit Interactively” on page 6-9 |
| “Selecting a Smoothing Spline Fit at the Command Line” on page 6-11 |
| “Example: Nonparametric Fitting with Cubic and Smoothing Splines” on page 6-11 |

About Smoothing Splines

If your data is noisy, you might want to fit it using a smoothing spline. Alternatively, you can use one of the smoothing methods described in “Filtering and Smoothing Data” on page 6-30.

The smoothing spline \( s \) is constructed for the specified smoothing parameter \( p \) and the specified weights \( w_i \). The smoothing spline minimizes

\[
p \sum_i w_i (y_i - s(x_i))^2 + (1 - p) \int \left( \frac{d^2 s}{dx^2} \right)^2 dx
\]

If the weights are not specified, they are assumed to be 1 for all data points.

\( p \) is defined between 0 and 1. \( p = 0 \) produces a least-squares straight-line fit to the data, while \( p = 1 \) produces a cubic spline interpolant. If you do not specify the smoothing parameter, it is automatically selected in the “interesting range.” The interesting range of \( p \) is often near \( 1/(1+h^3/6) \) where \( h \) is the average spacing of the data points, and it is typically much smaller than the allowed range of the parameter. Because smoothing splines have an associated smoothing parameter, you might consider these fits to be parametric in that sense. However, smoothing splines are also piecewise polynomials like cubic spline or shape-preserving interpolants and are considered a nonparametric fit type in this guide.
The smoothing spline algorithm is based on the `csaps` function.

The nuclear reaction data from the file `carbon12alpha.mat` is shown here with three smoothing spline fits. The default smoothing parameter ($p = 0.99$) produces the smoothest curve. The cubic spline curve ($p = 1$) goes through all the data points, but is not quite as smooth. The third curve ($p = 0.95$) misses the data by a wide margin and illustrates how small the “interesting range” of $p$ can be.

Selecting a Smoothing Spline Fit Interactively

In the Curve Fitting Tool, select Smoothing Spline from the model type list.
You can specify the following options:

- To make a smoother fit further from the data, click the `< Smoother` button repeatedly until the plot shows the smoothness you want.

- To make a rougher fit closer to the data, click the `Rougher >` button until you are satisfied with the plot.

- Alternatively, specify any value from 0 to 1 for the smoothing parameter. 0 produces a linear polynomial fit (a least-squares straight-line fit to the data), while 1 produces a piecewise cubic polynomial fit that passes through all the data points (a cubic spline interpolant).

- Click `Default` to return to the initial value. The toolbox attempts to select a default value appropriate for your data. See “About Smoothing Splines” on page 6-8.

For example:

1 Load the data in “About Smoothing Splines” on page 6-8 by entering:

   ```matlab
   load carbon12alpha
   ```

2 In the Curve Fitting Tool, select `angle` for `X data` and `counts` for `Y data`.

3 Select the `Smoothing Spline` fit type.

4 Try smoothing parameter values 1, 0.95, and the default value (0.99).
Selecting a Smoothing Spline Fit at the Command Line

Specify the model type 'smoothingspline' when you call the fit function.

For example, to load some data and fit a smoothing spline model:

```matlab
load enso
f = fit(month, pressure, 'smoothingspline')
plot(f, month, pressure)
```

To view the smoothing parameter the toolbox calculates, create the fit using the third output argument that contains data-dependent fit options:

```matlab
[f,gof,out] = fit(month, pressure, 'smoothingspline')
```

The smoothing parameter is the p value in the out structure: `out.p = 0.9`. The default value depends on the data set.

You can specify the smoothing parameter for a new fit with the `SmoothingParam` property. Its value must be between 0 and 1.

For example, to specify a smoothing parameter:

```matlab
f = fit(month, pressure, 'smoothingspline', 'SmoothingParam', 0.6)
plot(f, month, pressure)
```

Alternatively, use `fitoptions` to specify a smoothing parameter before fitting:

```matlab
options = fitoptions('Method','Smooth','SmoothingParam',0.07)
[f,gof,out] = fit(month,pressure,'smooth',options)
```

For an alternative to 'smoothingspline', you can use the csaps cubic smoothing spline function or other spline functions that allow greater control over what you can create. See “About Splines in Curve Fitting Toolbox” on page 8-2.

Example: Nonparametric Fitting with Cubic and Smoothing Splines

This example fits some data using a cubic spline interpolant and several smoothing splines.
1 Create the variables in your workspace:

\[ x = (4 \pi) \cdot [0 \ 1 \ \text{rand}(1,25)]; \]
\[ y = \sin(x) + 0.2 \cdot (\text{rand}(\text{size}(x)) - 0.5); \]

2 Open the Curve Fitting Tool by entering:

\text{cftool}

3 Select \( x \) and \( y \) from the \textbf{X data} and \textbf{Y data} lists.

The Curve Fitting Tool fits and plots the data.

4 Fit the data with a cubic spline interpolant by selecting \textbf{Interpolant} fit type and the \textbf{Method} \textit{Cubic}.

![Image of Curve Fitting Tool settings]

The Curve Fitting Tool fits and plots the cubic spline interpolant.

5 Enter the \textbf{Fit name} \textit{cubicsp}.

6 View the \textbf{Results} pane. Goodness-of-fit statistics such as RMSE are not defined (shown as \textit{NaN}) for interpolants.
A cubic spline interpolation is defined as a piecewise polynomial that results in a structure of coefficients \((p)\). The number of “pieces” in the structure is one less than the number of fitted data points, and the number of coefficients for each piece is four because the polynomial degree is three. You can examine the coefficient structure \(p\) if you export your fit to the workspace (e.g., enter \(fitname.p\)). For information on the structure of coefficients, see “Constructing and Working with ppform Splines” on page 10-12.

7 Create another fit to compare. Right-click your fit in the **Table of Fits** and select **Duplicate ‘cubicsp’**.

8 Fit the data with a smoothing spline by selecting **Smoothing Spline**.
The level of smoothness is given by the **Smoothing Parameter**. The default smoothing parameter value depends on the data set, and is automatically calculated by the toolbox.

For this data set, the default smoothing parameter is close to 1, indicating that the smoothing spline is nearly cubic and comes very close to passing through each data point.

**9** Name the default smoothing parameter fit `Smooth1`. If you do not like the level of smoothing produced by the default smoothing parameter, you can specify any value from 0 to 1. 0 produces a linear polynomial fit, while 1 produces a piecewise cubic polynomial fit that passes through all the data points.

The numerical results for the smoothing spline fit are shown here.

![Results](image)

**10** For comparison purposes, create another smoothing spline fit. Right-click your fit in the **Table of Fits** and select **Duplicate ‘smooth1’**. Change the smoothing parameter to 0.5 and name the fit `Smooth2`.

**11** Compare the plots for your three fits. Explore the fit behavior beyond the data limits by increasing the default abscissa scale. You change the axes limits with **Tools > Axes Limit Control** menu item.

**Note** Your results depend on random start points and may vary from those described.
Note that the default smoothing parameter produces a curve that is smoother than the interpolant, but is a good fit to the data. In this case, decreasing the smoothing parameter from the default value produces a curve that is smoother still, but is not a good fit to the data. As the smoothing parameter increases beyond the default value, the associated curve approaches the cubic spline interpolant. The cubic spline and default smoothing spline are similar for interior points, but diverge at the end points.
Lowess Smoothing

In this section...

| “About Lowess Smoothing” on page 6-16   |
| “Selecting a Lowess Fit Interactively” on page 6-16 |
| “Selecting a Lowess Fit at the Command Line” on page 6-18 |
| “Fitting Automotive Fuel Efficiency Surfaces at the Command Line” on page 6-18 |

About Lowess Smoothing

Use Lowess models to fit smooth surfaces to your data. The names “lowess” and “loess” are derived from the term “locally weighted scatter plot smooth,” as both methods use locally weighted linear regression to smooth data. The process is *weighted* because the toolbox defines a regression weight function for the data points contained within the span. In addition to the regression weight function, the *Robust* option is a weight function that can make the process resistant to outliers.

For more information on these two types of smoothing fit, see “Local Regression Smoothing” on page 6-34.

Selecting a Lowess Fit Interactively

In the Curve Fitting Tool, select Lowess from the model type list.

You can use the Lowess model type to fit smooth surfaces to your data with either lowess or loess methods. The Lowess fits use locally weighted linear regression to smooth data.
You can specify the following options:

- **Select** Linear or Quadratic from the list to specify the type of Polynomial model to use in the regression. In Curve Fitting Toolbox, lowess fitting uses a linear polynomial, while loess fitting uses a quadratic polynomial.

- **Use** Span to specify the span as a percentage of the total number of data points in the data set. The toolbox uses neighboring data points defined within the span to determine each smoothed value. This role of neighboring points is the reason why the smoothing process is called “local.”

  **Tip** Increase the span to make the surface smoother. Reduce the span to make the surface follow the data more closely.

- The Robust linear least-squares fitting method you want to use (Off, LAR, or Bisquare). The local regression uses the Robust option. Using the Robust weight function can make the process resistant to outliers. For details, see Robust on the fitoptions reference page.

  **Tip** If your input variables have very different scales, turn the Center and scale option on and off to see the difference in the surface fit. Normalizing the inputs can strongly influence the results of a Lowess fitting.

For an interactive example using Lowess, see “Surface Fitting to Franke Data” on page 2-36.
Selecting a Lowess Fit at the Command Line

Specify the model type 'lowess' when you call the fit function. For example, to load and fit some data with a lowess model and plot the results:

```matlab
load franke
f=fit([x,y],z, 'lowess')
plot(f,[x,y], z)
```

For a command-line example using Lowess, see the next section, “Fitting Automotive Fuel Efficiency Surfaces at the Command Line” on page 6-18.

Fitting Automotive Fuel Efficiency Surfaces at the Command Line

- “Load and Preprocess Data” on page 6-19
- “Fit and Plot Surfaces of Fuel Efficiency” on page 6-20
- “Create a Table from the Surface” on page 6-24

The toolbox provides sample data generated from a GTPOWER predictive combustion engine model. The model emulates a naturally aspirated spark-ignition, 2-liter, inline 4-cylinder engine. You can use surface fitting methods to fit a response surface to this data to investigate fuel efficiency.

The data set includes the required variables to model response surfaces:

- *Speed* is in revolutions per minute (rpm) units.
- *Load* is the normalized cylinder air mass (the ratio of cylinder aircharge to maximum naturally aspirated cylinder aircharge at standard temperature and pressure).
- *BSFC* is the brake-specific fuel consumption in g/KWh. That is, the energy flow in, divided by mechanical power out (fuel efficiency).

The aim is to model a response surface to find the minimum BSFC as a function of speed and load. You can use this surface as a table, included as part of a hybrid vehicle optimization algorithm combining the use of a motor and your engine. To operate the engine as fuel efficiently as possible, the table must operate the engine near the bottom of the BSFC bowl.
Load and Preprocess Data

1 Load the data from the XLS spreadsheet. Use the 'basic' command option for non-Windows® platforms.

Create a variable \( n \) that has all the numeric data in one array.

\[
n = \text{xlsread( 'Engine_Data_SI_NA_2L_I4.xls', 'SI NA 2L I4', '', 'basic' )};
\]

2 Extract from the variable \( n \) the columns of interest:

\[
\text{SPEED} = n(:,2);
\text{LOAD_CMD} = n(:,3);
\text{LOAD} = n(:,8);
\text{BSFC} = n(:,22);
\]

3 Process the data before fitting, to pick out the \( \min(\text{BSFC}) \) values from each sweep. The data points are organized insweeps on speed/load.

\( \text{a} \) Get a list of the speed/load sites:

\[
\text{SL} = \text{unique( [SPEED, LOAD_CMD], 'rows' )};
n\text{Runs} = \text{size( SL, 1 )};
\]

\( \text{b} \) For each speed/load site, find the data at the site and extract the actual measured load and the minimum BSFC.

\[
\text{minBSFC} = \text{zeros( nRuns, 1 )};
\text{Load} = \text{zeros( nRuns, 1 )};
\text{Speed} = \text{zeros( nRuns, 1 )};
\text{for} \ i = 1:n\text{Runs}
\text{idx} = \text{SPEED} == \text{SL}(i,1) \& \& \text{LOAD_CMD} == \text{SL}(i,2);
\text{minBSFC}(i) = \text{min( BSFC(idx) )};
\text{Load}(i) = \text{mean( LOAD(idx) )};
\text{Speed}(i) = \text{mean( SPEED(idx) )};
\text{end}
\]
Fit and Plot Surfaces of Fuel Efficiency

Follow these steps to fit and plot some surfaces:

1 Fit a surface to the preprocessed data.

   \[ f1 = \text{fit}([\text{Speed, Load}], \text{minBSFC}, 'Lowess', 'Normalize', 'on') \]

   This command results in the following output:

   Locally weighted smoothing linear regression:
   \[ f1(x,y) = \text{lowess (linear) smoothing regression} \]
   computed from \( p \)
   where \( x \) is normalized by mean 3407 and std 1214
   and where \( y \) is normalized by mean 0.5173 and std 0.1766
   Coefficients:
   \[ p = \text{coefficient structure} \]

2 Plot your fit:

   \[ \text{plot}( f1, [\text{Speed, Load}], \text{minBSFC} ); \]
   \[ \text{xlabel}( 'Speed [RPM]' ); \]
   \[ \text{ylabel}( 'Load [%]' ); \]
   \[ \text{zlabel}( 'Minimum BSFC [g/Kwh]' ); \]
3 Review the resulting plot:

- There are points where BSFC is negative because this data is generated by an engine simulation.
- Remove those problem data points and keep points in the range [0, Inf].

\[
\text{out} = \text{excludedata}(\text{Speed}, \text{minBSFC}, 'Range', [0, \text{Inf}]);
\]

\[
f2 = \text{fit}(\text{[Speed, Load]}, \text{minBSFC}, 'Lowess', ...
'\text{Normalize}', 'on', '\text{Exclude}', \text{out})
\]

Examine the following output:

Locally weighted smoothing linear regression:
\[
f2(x,y) = \text{lowess (linear) smoothing regression}
\]
computed from p
where x is normalized by mean 3443 and std 1187
and where y is normalized by mean 0.521 and std 0.175
Coefficients:
p = coefficient structure

4 Plot the new fit:

plot( f2, [Speed, Load], minBSFC, 'Exclude', out );
xlabel( 'Speed [RPM]' );
ylabel( 'Load [%]' );
zlabel( 'Minimum BSFC [g/Kwh]' );

5 Zoom in on the part of the z-axis of interest:

set( gca, 'ZLim', [0, max( minBSFC )] );
Because you want to operate the engine efficiently, create a contour plot to see the region where the BSFC is low. Use the `plot` command, and specify the parameter/value pair `style='Contour'`.

```
plot( f2, [Speed, Load], minBSFC, 'Exclude', out,...
    'Style', 'Contour' );
xlabel( 'Speed [RPM]' );
ylabel( 'Load [%]' );
colorbar
```
Create a Table from the Surface
In this exercise, you generate a table from the original data using model \( f2 \).

1. Create variables for the table breakpoints.

   \[
   \text{speedbreakpoints} = \text{linspace}(1000, 5500, 17);
   \text{loadbreakpoints} = \text{linspace}(0.2, 0.8, 13);
   \]

2. To generate values for the table, evaluate the model over a grid of points.

   \[
   [\text{tSpeed, tLoad}] = \text{meshgrid}(\text{speedbreakpoints},...\text{loadbreakpoints});
   \text{tBSFC} = f2(\text{tSpeed, tLoad});
   \]
3 Examine the rows and columns of the table at the command line.

\[ t_{BSFC}(1:2:end,1:2:end) \]

4 Plot the table against the original model. The grid on the model surface shows the table breakpoints.

\[
\text{h = plot(f2);}
\text{set(h, 'EdgeColor', 'none');}
\text{hold on}
\text{mesh(tSpeed, tLoad, tBSFC, ...}
\text{'LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k', ...}
\text{'FaceColor', 'none', 'FaceAlpha', 1});
\text{hold off}
\text{xlabel('Speed [RPM]');}
\text{ylabel('Load [%]');}
\text{zlabel('Minimum BSFC [g/Kwh]');}
\]
Check the table accuracy:

a. View the difference between the model and the table by plotting the difference between them on a finer grid.

b. Then, use this difference in prediction accuracy between the table and the model to determine the most efficient table size for your accuracy requirements.

The following code evaluates the model over a finer grid and plots the difference between the model and the table:

```matlab
[tfSpeed, tfLoad] = meshgrid( linspace(1000, 5500, 8*17+1), linspace(0.2, 0.8, 8*13+1) );
tfBSFC_model = f2( tfSpeed, tfLoad );
```
tfBSFC_table = interp2( tSpeed, tLoad, tBSFC, tfSpeed,...
    tfLoad, 'linear' );
    tfDiff = tfBSFC_model - tfBSFC_table;

    surf( tfSpeed, tfLoad, tfDiff, 'LineStyle', 'none' );
    hold on
    mesh( tSpeed, tLoad, zeros( size( tBSFC ) ), ...
        'LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k', ...
        'FaceColor', 'none', 'FaceAlpha', 1 );
    hold off
    axis tight
    xlabel( 'Speed [RPM]' );
    ylabel( 'Load [%]' );
    zlabel( 'Difference between model and table [g/Kwh]' );
    title( sprintf( 'Max difference: %g', max( abs( tfDiff(:) ) ) ) );
6 If you have Simulink® software, you can create a Look Up Table block.

   a Create a model with a 2-D Lookup Table block.

      simulink
      new_system('my_model')
      open_system('my_model')
      add_block('Simulink/Lookup Tables/2-D Lookup Table',...
                'my_model/surfaceblock')

   b Populate the Lookup Table with speed breakpoints, load breakpoints, and a lookup table.

      set_param('my_model/surfaceblock',...
                'BreakpointsForDimension1','loadbreakpoints','...
'BreakpointsForDimension2', 'speedbreakpoints', ...
'Table', 'tBSFC');

c Examine the populated Lookup Table block.
Filtering and Smoothing Data

In this section...

“About Data Smoothing and Filtering” on page 6-30
“Moving Average Filtering” on page 6-30
“Savitzky-Golay Filtering” on page 6-32
“Local Regression Smoothing” on page 6-34
“Example: Smoothing Data” on page 6-40
“Example: Smoothing Data Using Loess and Robust Loess” on page 6-42

About Data Smoothing and Filtering
You can use the smooth function to smooth response data. You can use optional methods for moving average, Savitzky-Golay filters, and local regression with and without weights and robustness (lowess, loess, rlowess and rloess). These smoothing methods are discussed in the next five sections.

Moving Average Filtering
A moving average filter smooths data by replacing each data point with the average of the neighboring data points defined within the span. This process is equivalent to lowpass filtering with the response of the smoothing given by the difference equation

\[ y_s(i) = \frac{1}{2N + 1} (y(i + N) + y(i + N - 1) + ... + y(i - N)) \]

where \(y_s(i)\) is the smoothed value for the \(i\)th data point, \(N\) is the number of neighboring data points on either side of \(y_s(i)\), and \(2N + 1\) is the span.

The moving average smoothing method used by Curve Fitting Toolbox follows these rules:

- The span must be odd.
- The data point to be smoothed must be at the center of the span.
• The span is adjusted for data points that cannot accommodate the specified number of neighbors on either side.

• The end points are not smoothed because a span cannot be defined.

Note that you can use `filter` function to implement difference equations such as the one shown above. However, because of the way that the end points are treated, the toolbox moving average result will differ from the result returned by `filter`. Refer to Difference Equations and Filtering in the MATLAB documentation for more information.

For example, suppose you smooth data using a moving average filter with a span of 5. Using the rules described above, the first four elements of $y_s$ are given by

\[
\begin{align*}
y_s(1) &= y(1) \\
y_s(2) &= \frac{(y(1)+y(2)+y(3))}{3} \\
y_s(3) &= \frac{(y(1)+y(2)+y(3)+y(4)+y(5))}{5} \\
y_s(4) &= \frac{(y(2)+y(3)+y(4)+y(5)+y(6))}{5}
\end{align*}
\]

Note that $y_s(1), y_s(2), \ldots, y_s(\text{end})$ refer to the order of the data after sorting, and not necessarily the original order.
The smoothed values and spans for the first four data points of a generated data set are shown below.

![Moving Average Smoothing](image)

Plot (a) indicates that the first data point is not smoothed because a span cannot be constructed. Plot (b) indicates that the second data point is smoothed using a span of three. Plots (c) and (d) indicate that a span of five is used to calculate the smoothed value.

**Savitzky-Golay Filtering**

Savitzky-Golay filtering can be thought of as a generalized moving average. You derive the filter coefficients by performing an unweighted linear least-squares fit using a polynomial of a given degree. For this reason, a Savitzky-Golay filter is also called a digital smoothing polynomial filter or a least-squares smoothing filter. Note that a higher degree polynomial makes
it possible to achieve a high level of smoothing without attenuation of data features.

The Savitzky-Golay filtering method is often used with frequency data or with spectroscopic (peak) data. For frequency data, the method is effective at preserving the high-frequency components of the signal. For spectroscopic data, the method is effective at preserving higher moments of the peak such as the line width. By comparison, the moving average filter tends to filter out a significant portion of the signal’s high-frequency content, and it can only preserve the lower moments of a peak such as the centroid. However, Savitzky-Golay filtering can be less successful than a moving average filter at rejecting noise.

The Savitzky-Golay smoothing method used by Curve Fitting Toolbox software follows these rules:

- The span must be odd.
- The polynomial degree must be less than the span.
- The data points are not required to have uniform spacing.

Normally, Savitzky-Golay filtering requires uniform spacing of the predictor data. However, the Curve Fitting Toolbox algorithm supports nonuniform spacing. Therefore, you are not required to perform an additional filtering step to create data with uniform spacing.

The plot shown below displays generated Gaussian data and several attempts at smoothing using the Savitzky-Golay method. The data is very noisy and the peak widths vary from broad to narrow. The span is equal to 5% of the number of data points.
Plot (a) shows the noisy data. To more easily compare the smoothed results, plots (b) and (c) show the data without the added noise.

Plot (b) shows the result of smoothing with a quadratic polynomial. Notice that the method performs poorly for the narrow peaks. Plot (c) shows the result of smoothing with a quartic polynomial. In general, higher degree polynomials can more accurately capture the heights and widths of narrow peaks, but can do poorly at smoothing wider peaks.

**Local Regression Smoothing**

- “Lowess and Loess” on page 6-35
- “The Local Regression Method” on page 6-35
- “Robust Local Regression” on page 6-38
Lowess and Loess
The names “lowess” and “loess” are derived from the term “locally weighted scatter plot smooth,” as both methods use locally weighted linear regression to smooth data.

The smoothing process is considered local because, like the moving average method, each smoothed value is determined by neighboring data points defined within the span. The process is weighted because a regression weight function is defined for the data points contained within the span. In addition to the regression weight function, you can use a robust weight function, which makes the process resistant to outliers. Finally, the methods are differentiated by the model used in the regression: lowess uses a linear polynomial, while loess uses a quadratic polynomial.

The local regression smoothing methods used by Curve Fitting Toolbox software follow these rules:

- The span can be even or odd.
- You can specify the span as a percentage of the total number of data points in the data set. For example, a span of 0.1 uses 10% of the data points.

The Local Regression Method
The local regression smoothing process follows these steps for each data point:

1. Compute the regression weights for each data point in the span. The weights are given by the tricube function shown below.

   \[ w_i = \left(1 - \frac{|x - x_i|^3}{d(x)}\right)^3 \]

   \(x\) is the predictor value associated with the response value to be smoothed, \(x_i\) are the nearest neighbors of \(x\) as defined by the span, and \(d(x)\) is the distance along the abscissa from \(x\) to the most distant predictor value within the span. The weights have these characteristics:

   - The data point to be smoothed has the largest weight and the most influence on the fit.
• Data points outside the span have zero weight and no influence on the fit.

2 A weighted linear least-squares regression is performed. For lowess, the regression uses a first degree polynomial. For loess, the regression uses a second degree polynomial.

3 The smoothed value is given by the weighted regression at the predictor value of interest.

If the smooth calculation involves the same number of neighboring data points on either side of the smoothed data point, the weight function is symmetric. However, if the number of neighboring points is not symmetric about the smoothed data point, then the weight function is not symmetric. Note that unlike the moving average smoothing process, the span never changes. For example, when you smooth the data point with the smallest predictor value, the shape of the weight function is truncated by one half, the leftmost data point in the span has the largest weight, and all the neighboring points are to the right of the smoothed value.
The weight function for an end point and for an interior point is shown below for a span of 31 data points.

Using the lowess method with a span of five, the smoothed values and associated regressions for the first four data points of a generated data set are shown below.
Interpolation and Smoothing

Notice that the span does not change as the smoothing process progresses from data point to data point. However, depending on the number of nearest neighbors, the regression weight function might not be symmetric about the data point to be smoothed. In particular, plots (a) and (b) use an asymmetric weight function, while plots (c) and (d) use a symmetric weight function.

For the loess method, the graphs would look the same except the smoothed value would be generated by a second-degree polynomial.

**Robust Local Regression**

If your data contains outliers, the smoothed values can become distorted, and not reflect the behavior of the bulk of the neighboring data points. To overcome this problem, you can smooth the data using a robust procedure that
Filtering and Smoothing Data

is not influenced by a small fraction of outliers. For a description of outliers, refer to “Residual Analysis” on page 7-21.

Curve Fitting Toolbox software provides a robust version for both the lowess and loess smoothing methods. These robust methods include an additional calculation of robust weights, which is resistant to outliers. The robust smoothing procedure follows these steps:

1. Calculate the residuals from the smoothing procedure described in the previous section.

2. Compute the robust weights for each data point in the span. The weights are given by the bisquare function,

   \[
   w_i = \begin{cases} 
   \left(1 - \frac{r_i}{6 \text{MAD}}\right)^2, & |r_i| < 6 \text{MAD}, \\
   0, & |r_i| \geq 6 \text{MAD}, 
   \end{cases}
   \]

   where \( r_i \) is the residual of the \( i \)th data point produced by the regression smoothing procedure, and \( \text{MAD} \) is the median absolute deviation of the residuals,

   \[ \text{MAD} = \text{median}(|r|). \]

   The median absolute deviation is a measure of how spread out the residuals are. If \( r_i \) is small compared to \( 6 \text{MAD} \), then the robust weight is close to 1. If \( r_i \) is greater than \( 6 \text{MAD} \), the robust weight is 0 and the associated data point is excluded from the smooth calculation.

3. Smooth the data again using the robust weights. The final smoothed value is calculated using both the local regression weight and the robust weight.

4. Repeat the previous two steps for a total of five iterations.

The smoothing results of the lowess procedure are compared below to the results of the robust lowess procedure for a generated data set that contains a single outlier. The span for both procedures is 11 data points.
Interpolation and Smoothing

Plot (a) shows that the outlier influences the smoothed value for several nearest neighbors. Plot (b) suggests that the residual of the outlier is greater than six median absolute deviations. Therefore, the robust weight is zero for this data point. Plot (c) shows that the smoothed values neighboring the outlier reflect the bulk of the data.

**Example: Smoothing Data**

Load the data in count.dat:

```matlab
load count.dat
```

The 24-by-3 array `count` contains traffic counts at three intersections for each hour of the day.
First, use a moving average filter with a 5-hour span to smooth all of the data at once (by linear index):

```matlab
c = smooth(count(:));
C1 = reshape(c,24,3);
```

Plot the original data and the smoothed data:

```matlab
subplot(3,1,1)
plot(count,:);
hold on
plot(C1,-);
title('Smooth C1 (All Data)')
```

Second, use the same filter to smooth each column of the data separately:

```matlab
C2 = zeros(24,3);
for I = 1:3,
    C2(:,I) = smooth(count(:,I));
end
```

Again, plot the original data and the smoothed data:

```matlab
subplot(3,1,2)
plot(count,:);
hold on
plot(C2,-);
title('Smooth C2 (Each Column)')
```

Plot the difference between the two smoothed data sets:

```matlab
subplot(3,1,3)
plot(C2 - C1,o-)
title('Difference C2 - C1')
```
Example: Smoothing Data Using Loess and Robust Loess

Create noisy data with outliers:

```matlab
x = 15*rand(150,1);
y = sin(x) + 0.5*(rand(size(x))-0.5);
y(ceil(length(x)*rand(2,1))) = 3;
```

Smooth the data using the `loess` and `rloess` methods with a span of 10%:

```matlab
yy1 = smooth(x,y,0.1,'loess');
yy2 = smooth(x,y,0.1,'rloess');
```

Plot original data and the smoothed data.

```matlab
[xx,ind] = sort(x);
subplot(2,1,1)
plot(xx,y(ind),'b.',xx,yy1(ind),'r-')
set(gca,'YLim',[-1.5 3.5])
legend('Original Data','Smoothed Data Using 'loess','rloess','
```
Filtering and Smoothing Data

Note that the outliers have less influence on the robust method.
Fit Postprocessing

- “Exploring and Customizing Plots” on page 7-2
- “Removing Outliers” on page 7-10
- “Selecting Validation Data” on page 7-11
- “Generating Code and Exporting Fits to the Workspace” on page 7-12
- “Evaluating Goodness of Fit” on page 7-16
- “Residual Analysis” on page 7-21
- “Confidence and Prediction Bounds” on page 7-28
- “Differentiating and Integrating a Fit” on page 7-36
Exploring and Customizing Plots

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Displaying Fit and Residual Plots” on page 7-2</td>
</tr>
<tr>
<td>“Viewing Surface Plots and Contour Plots” on page 7-4</td>
</tr>
<tr>
<td>“Using Zoom, Pan, Data Cursor, and Outlier Exclusion” on page 7-6</td>
</tr>
<tr>
<td>“Customizing the Fit Display” on page 7-6</td>
</tr>
<tr>
<td>“Print to MATLAB Figures” on page 7-9</td>
</tr>
</tbody>
</table>

Displaying Fit and Residual Plots

Within each fit figure, you can display up to three plots simultaneously to examine the fit. Use the toolbar or View menu to select the type of plot to display:

- **Main Plot** shows the curve or surface fit.
- **Residuals Plot** shows the errors between your fit and your data
- **Contour Plot** shows a contour map of a surface fit (not available for curve fits).

The next example shows a main plot with a curve fit and prediction bounds, and the residuals plot.
When you select **Tools > Prediction Bounds**, two additional curves (or surfaces) are plotted to show the prediction bounds on both sides of your model fit.

Choose which bounds to display: **None**, **90%**, **95%**, **99%**, or **Custom**. The custom option opens a dialog box where you can enter the required confidence level.

See also “Customizing the Fit Display” on page 7-6.
Residuals Plot
On the residuals plot, you can view the errors between your fit and your data, and you can remove outliers. See “Removing Outliers” on page 7-10. This example shows a residuals plot with some excluded outliers.

Viewing Surface Plots and Contour Plots
If you fit a surface, then the main plot shows your surface fit. Click-and-drag rotation or Rotate 3D is the default mouse mode for surface plots in the Curve Fitting Tool. Rotate mode in the Curve Fitting Tool is the same as Rotate 3D in MATLAB figures. You can change the mouse mode for manipulating plots just as for curve plots. See “Using Zoom, Pan, Data Cursor, and Outlier Exclusion” on page 7-6.

Tip  To return to rotate mode, turn off any other mouse mode.

If you turn on a mouse mode for zoom, pan, data cursor or exclude outliers, turn the mode off again to return to rotate mode. For example, click the Zoom in toolbar button a second time to clear it and return to rotate mode.

If you have a surface fit, use the contour plot to examine a contour map of your surface. Contour plots are not available for curve fits. On a surface fit,
a contour plot makes it easier to see points that have the same height. An example follows.

For polynomial and custom fits, you also can use the Tools menu to display prediction bounds. When you display prediction bounds, two additional surfaces are plotted to show the prediction bounds on both sides of your model fit. The previous example shows prediction bounds. You can see three surfaces on the plot. The top and bottom surfaces show the prediction bounds at the specified confidence level on either side of your model fit surface.

You can also switch your surface plot to a 2-D plot if desired. Your plot cursor must be in rotate mode. Clear any other mouse mode if necessary.
Then, right-click the plot to select **X-Y**, **X-Z**, or **Y-Z** view, or to select **Rotate Options**. All these context menu options are standard MATLAB 3-D plot tools. See “Rotate in 3-D” in the MATLAB Graphics documentation.

**Using Zoom, Pan, Data Cursor, and Outlier Exclusion**

You can change mouse mode for manipulating plots. Use the toolbar or **Tools** menu to switch to **Zoom**, **Pan**, **Data Cursor**, or **Exclude Outliers** modes.

The Curve Fitting Tool remembers your selected mouse mode in each fit figure within a session.

Use the toolbar or **Tools** menu to toggle mouse mode in your plots:

- **Zoom In, Zoom Out, Pan, and Data Cursor** are standard MATLAB plot tools.
  
  On surfaces, turn all these modes off to return to **Rotate 3D** mode. For surface plots, rotation is the default mouse mode in the Curve Fitting Tool. See “Viewing Surface Plots and Contour Plots” on page 7-4.

- **Data Cursor** selects data cursor mode, where you can click points to display input and output values.

- **Exclude Outliers** selects outlier mode, where you can click points to remove or include in your fit. Exclude outliers is a mouse mode for graphically excluding data from your fit. See “Removing Outliers” on page 7-10.

**Customizing the Fit Display**

To customize your plot display, use the toolbar, **Tools** menu, or the **View** menu. See also “Interactive Fit Comparison” on page 2-13.

**Tools Menu and Toolbar**

- **Legend** toggles display of the legend on all plots in the currently selected fit tab.
• **Grid** toggles display of the grid on all plots in the currently selected fit tab.

• **Tools > Prediction Bounds** lets you choose which bounds to display: None, 90%, 95%, 99%, or Custom. The custom option opens a dialog box where you can enter the required confidence level.

• **Axes Limits** opens a dialog box where you can specify upper and lower bounds for the X- and Y-axes of plots. Click **Reset** to return to the default axes limits.

**View Menu and Toolbar**

Use the View controls to customize the display to show or hide the plots, fit settings, results and table of fits.

• Available in the **View** menu and the toolbar:

  - **Main Plot** toggles the display of the main fit plot in the currently selected fit figure. This item is disabled if only the main plot is displayed.

  - **Residuals Plot** toggles the display of the residuals plot in the currently selected fit tab. This item is disabled if only the residuals plot is displayed.

  - **Contour Plot** toggles the display of the contour plot in the currently selected fit tab. This item is disabled if only the contour plot is displayed.

• **View > Fit Settings** toggles the display of the fit controls pane in the currently selected fit tab (**Fit name**, inputs, fit type, and so on).

• **View > Fit Results** toggles the display of the **Results** pane in the currently selected fit tab. When you display the **Results** pane, you can see model terms and coefficients, goodness-of-fit statistics, and information messages about the fit.

• **View > Table of Fits** toggles the display of the **Table of Fits** pane in the Curve Fitting Tool.
Tip For more space to view and compare plots, as shown next, use the View menu to hide or show the Fit Settings, Fit Results, or Table of Fits panes.
See also “Displaying Multiple Fits Simultaneously” on page 2-14.

**Print to MATLAB Figures**

In Curve Fitting Tool, select **File > Print to Figure** to produce MATLAB figures from the results of curve fitting. **Print to Figure** creates a figure containing all plots for the current fit. You can then use the interactive plotting tools to edit the figures showing fitting results for presentation purposes, and export these in different formats.
Removing Outliers

To remove outliers, follow these steps:

1 Select **Tools > Exclude Outliers** or click the toolbar button ![Exclude Outliers](image).

   When you move the mouse cursor to the plot, it changes to a cross-hair to show you are in outlier selection mode.

2 Click a point that you want to exclude in the main plot or residuals plot. Alternatively, click and drag to define a rectangle and remove all enclosed points.

   A removed plot point becomes a red star in the plots. If you have **Auto-fit** selected, the Curve Fitting Tool refits the surface without the point. Otherwise, you can click **Fit** to refit.

3 Repeat for all points you want to exclude.

When removing outliers from surface fits, it can be helpful to display a 2-D residuals plot for examining and removing outliers. With your plot cursor in rotation mode, right-click the plot to select **X-Y**, **X-Z**, or **Y-Z** view.

To replace individual excluded points in the fit, click an excluded point again in **Exclude Outliers** mode. To replace all excluded points in the fit, right-click and select **Clear all exclusions**.

In surface plots, to return to rotation mode, click the **Exclude outliers** toolbar button ![Exclude Outliers](image) again to turn off outlier selection mode.
Selecting Validation Data

To specify validation data for the currently selected fit, follow these steps:

1 Select **Fit > Specify Validation Data**. The Specify Validation Data dialog box opens.

2 Select variables for **X data** and **Y data** (and **Z data** for surfaces).

   When you select two or three variables, depending on whether your fit data is for a curve or a surface, the tool calculates validation statistics (SSE and RMSE) and displays them in the **Results** pane and the **Table of Fits**.

   For definitions of these statistics, see “Using the Statistics in the Table of Fits” on page 2-18. Your validation data points display on the main plot and residual plot along with the original data.

3 Close the dialog box.
Generating Code and Exporting Fits to the Workspace

In this section...

| “Generating Code from the Curve Fitting Tool” on page 7-12 |
| “Exporting a Fit to the Workspace” on page 7-13 |

Generating Code from the Curve Fitting Tool

You can generate and use MATLAB code from an interactive session in the Curve Fitting Tool. In this way, you can transform your interactive analysis into reusable functions for batch processing of multiple data sets. You can use the generated file without modification, or you can edit and customize the file as needed.

To generate code for all fits and plots in your Curve Fitting Tool session follow these steps:

1 Select File > Generate Code.

The Curve Fitting Tool generates code from your session and displays the file in the MATLAB Editor. The file includes all fits and plots in your current session. The file captures the following information:

- Names of fits and their variables
- Fit settings and options
- Plots
- Curve and surface fitting objects and methods used to create the fits:
  - A cell-array of `cfit` or `sfit` objects representing the fits
  - A structure array with goodness-of fit information.

2 Save the file.

To recreate your fits and plots, call the file from the command line with your original data as input arguments. You also can call the file with new data.

For example, enter:
[fitresult, gof] = myFileName(a, b, c)

where a, b, and c are your variable names, and myFileName is the file name.

Calling the file from the command line does not recreate your Curve Fitting Tool GUI and session. When you call the file, you get the same plots you had in your Curve Fitting Tool session in standard MATLAB figure windows. There is one window for each fit. For example, if your fit in the Curve Fitting Tool session displayed main, residual and contour plots, all three plots appear in a single figure window.

**Curve Fitting Objects and Methods**
The curve and surface fit objects (cfit and sfit) store the results from a fitting operation, making it easy to plot and analyze fits at the command line.

cfit and sfit objects are a subclass of fittype objects, so they inherit all the same methods of fittype and provide additional methods. To learn about available methods, see cfit, sfit and fittype.

**Exporting a Fit to the Workspace**
To export a fit to the MATLAB workspace, follow these steps:

1. Select a fit and save it to the MATLAB workspace using one of these methods:

   - Right-click the fit listed in the Table of Fits and select **Save Fit myfitname to Workspace**
   - Select a fit figure in the Curve Fitting Tool and select **Fit > Save to Workspace**.

The Save Fit to MATLAB Workspace dialog box opens.
2 Edit the names as appropriate. If you previously exported fits, the toolbox automatically adds a numbered suffix to the default names so there is no danger of overwriting them.

3 Choose which options you want to export by selecting the check boxes. Check box options are as follows:

- **Save fit to MATLAB object named** **fittedmodel** — This option creates a cfit or sfit object, that encapsulates the result of fitting a curve or surface to data. You can examine the fit coefficients at the command line, for example:

```matlab
fittedmodel
Linear model Poly22:
    fittedmodel1(x,y) = p00 + p10*x + p01*y + p20*x^2...
    + p11*x*y + p02*y^2
Coefficients (with 95% confidence bounds):
p00 = 302.1  (247.3, 356.8)
p10 = -1395  (-1751, -1039)
p01 = 0.03525 (0.01899, 0.05151)
p20 = 1696  (1099, 2293)
p11 = -0.1119 (-0.1624, -0.06134)
p02 = 2.36e-006 (-8.72e-007, 5.593e-006)
```

You also can treat the cfit or sfit object as a function to make predictions or evaluate the fit at values of X (or X and Y). See the cfit and sfit reference page.
• **Save goodness of fit to MATLAB struct named **goodness** —** This option creates a structure array that contains statistical information about the fit, for example:

```
goodness =
    sse: 0.0234
    rsquare: 0.9369
    dfe: 128
    adjrsquare: 0.9345
    rmse: 0.0135
```

• **Save fit output to MATLAB struct named **output** —** This option creates a structure array that contains information such as numbers of observations and parameters, residuals, and so on. For example:

```
output =
    numobs: 134
    numparam: 6
    residuals: [134x1 double]
    Jacobian: [134x6 double]
    exitflag: 1
    algorithm: 'QR factorization and solve'
    iterations: 1
```

**Note** Goodness of fit and Output arrays are outputs of the fit function. See the fit reference page.

4 Click **OK** to save the fit options to the workspace.

After you save your fit to the workspace, you can use fit postprocessing functions. For an example, see “Analyzing Your Best Fit in the Workspace” on page 2-32. For more information and a list of functions, see “Fit Postprocessing”.
Evaluating Goodness of Fit

In this section...

“How to Evaluate Goodness of Fit” on page 7-16
“Goodness-of-Fit Statistics” on page 7-17

How to Evaluate Goodness of Fit

After fitting data with one or more models, you should evaluate the goodness of fit. A visual examination of the fitted curve displayed in Curve Fitting Tool should be your first step. Beyond that, the toolbox provides these methods to assess goodness of fit for both linear and nonlinear parametric fits:

- “Goodness-of-Fit Statistics” on page 7-17
- “Residual Analysis” on page 7-21
- “Confidence and Prediction Bounds” on page 7-28

As is common in statistical literature, the term *goodness of fit* is used here in several senses: A “good fit” might be a model

- that your data could reasonably have come from, given the assumptions of least-squares fitting
- in which the model coefficients can be estimated with little uncertainty
- that explains a high proportion of the variability in your data, and is able to predict new observations with high certainty

A particular application might dictate still other aspects of model fitting that are important to achieving a good fit, such as a simple model that is easy to interpret. The methods described here can help you determine goodness of fit in all these senses.

These methods group into two types: graphical and numerical. Plotting residuals and prediction bounds are graphical methods that aid visual interpretation, while computing goodness-of-fit statistics and coefficient confidence bounds yield numerical measures that aid statistical reasoning.
Generally speaking, graphical measures are more beneficial than numerical measures because they allow you to view the entire data set at once, and they can easily display a wide range of relationships between the model and the data. The numerical measures are more narrowly focused on a particular aspect of the data and often try to compress that information into a single number. In practice, depending on your data and analysis requirements, you might need to use both types to determine the best fit.

Note that it is possible that none of your fits can be considered suitable for your data, based on these methods. In this case, it might be that you need to select a different model. It is also possible that all the goodness-of-fit measures indicate that a particular fit is suitable. However, if your goal is to extract fitted coefficients that have physical meaning, but your model does not reflect the physics of the data, the resulting coefficients are useless. In this case, understanding what your data represents and how it was measured is just as important as evaluating the goodness of fit.

**Goodness-of-Fit Statistics**

After using graphical methods to evaluate the goodness of fit, you should examine the goodness-of-fit statistics. Curve Fitting Toolbox software supports these goodness-of-fit statistics for parametric models:

- The sum of squares due to error (SSE)
- R-square
- Adjusted R-square
- Root mean squared error (RMSE)

For the current fit, these statistics are displayed in the Results list box in the Fit Editor. For all fits in the current curve-fitting session, you can compare the goodness-of-fit statistics in the Table of fits.

**Sum of Squares Due to Error**

This statistic measures the total deviation of the response values from the fit to the response values. It is also called the summed square of residuals and is usually labeled as SSE.
\[ SSE = \sum_{i=1}^{n} w_i (y_i - \hat{y}_i)^2 \]

A value closer to 0 indicates that the model has a smaller random error component, and that the fit will be more useful for prediction.

**R-Square**

This statistic measures how successful the fit is in explaining the variation of the data. Put another way, R-square is the square of the correlation between the response values and the predicted response values. It is also called the square of the multiple correlation coefficient and the coefficient of multiple determination.

R-square is defined as the ratio of the sum of squares of the regression (SSR) and the total sum of squares (SST). SSR is defined as

\[ SSR = \sum_{i=1}^{n} w_i (\hat{y}_i - \bar{y})^2 \]

SST is also called the sum of squares about the mean, and is defined as

\[ SST = \sum_{i=1}^{n} w_i (y_i - \bar{y})^2 \]

where \( SST = SSR + SSE \). Given these definitions, R-square is expressed as

\[ \text{R-square} = \frac{SSR}{SST} = 1 - \frac{SSE}{SST} \]

R-square can take on any value between 0 and 1, with a value closer to 1 indicating that a greater proportion of variance is accounted for by the model. For example, an R-square value of 0.8234 means that the fit explains 82.34% of the total variation in the data about the average.
If you increase the number of fitted coefficients in your model, R-square will increase although the fit may not improve in a practical sense. To avoid this situation, you should use the degrees of freedom adjusted R-square statistic described below.

Note that it is possible to get a negative R-square for equations that do not contain a constant term. Because R-square is defined as the proportion of variance explained by the fit, if the fit is actually worse than just fitting a horizontal line then R-square is negative. In this case, R-square cannot be interpreted as the square of a correlation. Such situations indicate that a constant term should be added to the model.

**Degrees of Freedom Adjusted R-Square**

This statistic uses the R-square statistic defined above, and adjusts it based on the residual degrees of freedom. The residual degrees of freedom is defined as the number of response values $n$ minus the number of fitted coefficients $m$ estimated from the response values.

$$v = n - m$$

$v$ indicates the number of independent pieces of information involving the $n$ data points that are required to calculate the sum of squares. Note that if parameters are bounded and one or more of the estimates are at their bounds, then those estimates are regarded as fixed. The degrees of freedom is increased by the number of such parameters.

The adjusted R-square statistic is generally the best indicator of the fit quality when you compare two models that are nested — that is, a series of models each of which adds additional coefficients to the previous model.

$$\text{adjusted R-square} = 1 - \frac{SSE(n-1)}{SST(v)}$$

The adjusted R-square statistic can take on any value less than or equal to 1, with a value closer to 1 indicating a better fit. Negative values can occur when the model contains terms that do not help to predict the response.
**Root Mean Squared Error**
This statistic is also known as the fit standard error and the standard error of the regression. It is an estimate of the standard deviation of the random component in the data, and is defined as

\[
RMSE = s = \sqrt{MSE}
\]

where \( MSE \) is the mean square error or the residual mean square

\[
MSE = \frac{SSE}{v}
\]

Just as with \( SSE \), an \( MSE \) value closer to 0 indicates a fit that is more useful for prediction.
Residual Analysis

Plotting and Analysing Residuals

The residuals from a fitted model are defined as the differences between the response data and the fit to the response data at each predictor value.

\[ \text{residual} = \text{data} - \text{fit} \]

You display the residuals in Curve Fitting Tool by selecting the toolbar button or menu item View > Residuals Plot.

Mathematically, the residual for a specific predictor value is the difference between the response value \( y \) and the predicted response value \( \hat{y} \).

\[ r = y - \hat{y} \]

Assuming the model you fit to the data is correct, the residuals approximate the random errors. Therefore, if the residuals appear to behave randomly, it suggests that the model fits the data well. However, if the residuals display a systematic pattern, it is a clear sign that the model fits the data poorly. Always bear in mind that many results of model fitting, such as confidence bounds, will be invalid should the model be grossly inappropriate for the data.
A graphical display of the residuals for a first degree polynomial fit is shown below. The top plot shows that the residuals are calculated as the vertical distance from the data point to the fitted curve. The bottom plot displays the residuals relative to the fit, which is the zero line.

The residuals appear randomly scattered around zero indicating that the model describes the data well.
A graphical display of the residuals for a second-degree polynomial fit is shown below. The model includes only the quadratic term, and does not include a linear or constant term.

The residuals are systematically positive for much of the data range indicating that this model is a poor fit for the data.

**Example: Residual Analysis**

This example fits several polynomial models to generated data and evaluates how well those models fit the data and how precisely they can predict. The data is generated from a cubic curve, and there is a large gap in the range of the $x$ variable where no data exist.

```matlab
x = [1:0.1:3 9:0.1:10]';
c = [2.5 -0.5 1.3 -0.1];
y = c(1) + c(2)*x + c(3)*x.^2 + c(4)*x.^3 + (rand(size(x))-0.5);
```
Fit the data in the Curve Fitting Tool using a cubic polynomial and a fifth degree polynomial. The data, fits, and residuals are shown below. Display the residuals in the Curve Fitting Tool by selecting View > Residuals Plot.

Both models appear to fit the data well, and the residuals appear to be randomly distributed around zero. Therefore, a graphical evaluation of the fits does not reveal any obvious differences between the two equations.

Look at the numerical fit results in the Results pane and compare the confidence bounds for the coefficients.

The results show that the cubic fit coefficients are accurately known (bounds are small), while the quintic fit coefficients are not accurately known. As expected, the fit results for poly3 are reasonable because the generated data follows a cubic curve. The 95% confidence bounds on the fitted coefficients indicate that they are acceptably precise. However, the 95% confidence bounds for poly5 indicate that the fitted coefficients are not known precisely.
The goodness-of-fit statistics are shown in the **Table of Fits**. By default, the adjusted R-square and RMSE statistics are displayed in the table. The statistics do not reveal a substantial difference between the two equations. To choose statistics to display or hide, right-click the column headers.

The 95% nonsimultaneous prediction bounds for new observations are shown below. To display prediction bounds in Curve Fitting Tool, select **Tools > Prediction Bounds > 95%**.
The prediction bounds for pol3 indicate that new observations can be predicted with a small uncertainty throughout the entire data range. This is not the case for pol5. It has wider prediction bounds in the area where no data exist, apparently because the data does not contain enough information.
to estimate the higher degree polynomial terms accurately. In other words, a fifth-degree polynomial overfits the data. You can confirm this by using the Analysis GUI to compute bounds for the functions themselves.

The 95% prediction bounds for the fitted function using poly5 are shown below. As you can see, the uncertainty in predicting the function is large in the center of the data. Therefore, you would conclude that more data must be collected before you can make precise predictions using a fifth-degree polynomial.

In conclusion, you should examine all available goodness-of-fit measures before deciding on the fit that is best for your purposes. A graphical examination of the fit and residuals should always be your initial approach. However, some fit characteristics are revealed only through numerical fit results, statistics, and prediction bounds.
Confidence and Prediction Bounds

About Confidence and Prediction Bounds
Curve Fitting Toolbox software lets you calculate confidence bounds for the fitted coefficients, and prediction bounds for new observations or for the fitted function. Additionally, for prediction bounds, you can calculate simultaneous bounds, which take into account all predictor values, or you can calculate nonsimultaneous bounds, which take into account only individual predictor values. The coefficient confidence bounds are presented numerically, while the prediction bounds are displayed graphically and are also available numerically.

The available confidence and prediction bounds are summarized below.

Types of Confidence and Prediction Bounds

<table>
<thead>
<tr>
<th>Interval Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fitted coefficients</td>
<td>Confidence bounds for the fitted coefficients</td>
</tr>
<tr>
<td>New observation</td>
<td>Prediction bounds for a new observation (response value)</td>
</tr>
<tr>
<td>New function</td>
<td>Prediction bounds for a new function value</td>
</tr>
</tbody>
</table>

**Note** Prediction bounds are also often described as confidence bounds because you are calculating a confidence interval for a predicted response.

Confidence and prediction bounds define the lower and upper values of the associated interval, and define the width of the interval. The width of the interval indicates how uncertain you are about the fitted coefficients, the predicted observation, or the predicted fit. For example, a very wide interval for the fitted coefficients can indicate that you should use more data when fitting before you can say anything very definite about the coefficients.

The bounds are defined with a level of certainty that you specify. The level of certainty is often 95%, but it can be any value such as 90%, 99%, 99.9%, and so on. For example, you might want to take a 5% chance of being incorrect
about predicting a new observation. Therefore, you would calculate a 95% prediction interval. This interval indicates that you have a 95% chance that the new observation is actually contained within the lower and upper prediction bounds.

**Confidence Bounds on Coefficients**

The confidence bounds for fitted coefficients are given by

\[ C = b \pm t \sqrt{S} \]

where \( b \) are the coefficients produced by the fit, \( t \) depends on the confidence level, and is computed using the inverse of Student’s \( t \) cumulative distribution function, and \( S \) is a vector of the diagonal elements from the estimated covariance matrix of the coefficient estimates, \((X^T X)^{-1}s^2\). In a linear fit, \( X \) is the design matrix, while for a nonlinear fit \( X \) is the Jacobian of the fitted values with respect to the coefficients. \( X^T \) is the transpose of \( X \), and \( s^2 \) is the mean squared error.

The confidence bounds are displayed in the **Results** pane in the Curve Fitting Tool using the following format.

\[ p_1 = 1.275 \ (1.113, \ 1.437) \]

The fitted value for the coefficient \( p_1 \) is 1.275, the lower bound is 1.113, the upper bound is 1.437, and the interval width is 0.324. By default, the confidence level for the bounds is 95%.

You can calculate confidence intervals at the command line with the `confint` function.

**Prediction Bounds on Fits**

As mentioned previously, you can calculate prediction bounds for the fitted curve. The prediction is based on an existing fit to the data. Additionally, the bounds can be simultaneous and measure the confidence for all predictor values, or they can be nonsimultaneous and measure the confidence only for a single predetermined predictor value. If you are predicting a new observation, nonsimultaneous bounds measure the confidence that the new observation lies within the interval given a single predictor value. Simultaneous bounds
measure the confidence that a new observation lies within the interval regardless of the predictor value.

The nonsimultaneous prediction bounds for a new observation at the predictor value $x$ are given by

$$P_{n,o} = y \pm t \sqrt{s^2 + xSx^T}$$

where $s^2$ is the mean squared error, $t$ depends on the confidence level, and is computed using the inverse of Student’s $t$ cumulative distribution function, and $S$ is the covariance matrix of the coefficient estimates, $(X^TX)^{-1}s^2$. Note that $x$ is defined as a row vector of the design matrix or Jacobian evaluated at a specified predictor value.

The simultaneous prediction bounds for a new observation and for all predictor values are given by

$$P_{s,o} = y \pm f \sqrt{s^2 + xSx^T}$$

where $f$ depends on the confidence level, and is computed using the inverse of the $F$ cumulative distribution function.

The nonsimultaneous prediction bounds for the function at a single predictor value $x$ are given by

$$P_{n,f} = y \pm t \sqrt{xSx^T}$$

The simultaneous prediction bounds for the function and for all predictor values are given by

$$P_{s,f} = y \pm f \sqrt{xSx^T}$$

You can graphically display prediction bounds using Curve Fitting Tool. With Curve Fitting Tool, you can display nonsimultaneous prediction bounds for new observations with **Tools > Prediction Bounds**. By default,
confidence level for the bounds is 95%. You can change this level to any value with Tools > Prediction Bounds > Custom.

You can display numerical prediction bounds of any type at the command line with the `predint` function.

To understand the quantities associated with each type of prediction interval, recall that the data, fit, and residuals are related through the formula

\[ data = fit + residuals \]

where the fit and residuals terms are estimates of terms in the formula

\[ data = model + random \text{ error} \]

Suppose you plan to take a new observation at the predictor value \( x_{n+1} \). Call the new observation \( y_{n+1}(x_{n+1}) \) and the associated error \( \epsilon_{n+1} \). Then

\[ y_{n+1}(x_{n+1}) = f(x_{n+1}) + \epsilon_{n+1} \]

where \( f(x_{n+1}) \) is the true but unknown function you want to estimate at \( x_{n+1} \). The likely values for the new observation or for the estimated function are provided by the nonsimultaneous prediction bounds.

If instead you want the likely value of the new observation to be associated with any predictor value, the previous equation becomes

\[ y_{n+1}(x) = f(x) + \epsilon \]

The likely values for this new observation or for the estimated function are provided by the simultaneous prediction bounds.

The types of prediction bounds are summarized below.
Types of Prediction Bounds

<table>
<thead>
<tr>
<th>Type of Bound</th>
<th>Simultaneous or Non-simultaneous</th>
<th>Associated Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Observation</td>
<td>Non-simultaneous</td>
<td>( y_{n+1}(x_{n+1}) )</td>
</tr>
<tr>
<td></td>
<td>Simultaneous</td>
<td>( y_{n+1}(x) ), for all ( x )</td>
</tr>
<tr>
<td>Function</td>
<td>Non-simultaneous</td>
<td>( f(x_{n+1}) )</td>
</tr>
<tr>
<td></td>
<td>Simultaneous</td>
<td>( f(x) ), for all ( x )</td>
</tr>
</tbody>
</table>

The nonsimultaneous and simultaneous prediction bounds for a new observation and the fitted function are shown below. Each graph contains three curves: the fit, the lower confidence bounds, and the upper confidence bounds. The fit is a single-term exponential to generated data and the bounds reflect a 95% confidence level. Note that the intervals associated with a new observation are wider than the fitted function intervals because of the additional uncertainty in predicting a new response value (the curve plus random errors).
**Example: Prediction Intervals**

The following example computes and plots prediction intervals at the command line.

Generate data with an exponential trend:

```matlab
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));
```

Fit the data using a single-term exponential:
fitresult = fit(x,y,'exp1');

Compute prediction intervals:

p11 = predint(fitresult,x,0.95,'observation','off');
p12 = predint(fitresult,x,0.95,'observation','on');
p21 = predint(fitresult,x,0.95,'functional','off');
p22 = predint(fitresult,x,0.95,'functional','on');

Plot the data, fit, and prediction intervals:

subplot(2,2,1)
plot(fitresult,x,y), hold on, plot(x,p11,'m--'), xlim([0 5])
title('Nonsimultaneous observation bounds','Color','m')
subplot(2,2,2)
plot(fitresult,x,y), hold on, plot(x,p12,'m--'), xlim([0 5])
title('Simultaneous observation bounds','Color','m')
subplot(2,2,3)
plot(fitresult,x,y), hold on, plot(x,p21,'m--'), xlim([0 5])
title('Nonsimultaneous functional bounds','Color','m')
subplot(2,2,4)
plot(fitresult,x,y), hold on, plot(x,p22,'m--'), xlim([0 5])
title('Simultaneous functional bounds','Color','m')
Differentiating and Integrating a Fit

Create a baseline sinusoidal signal:

\[
xdata = (0:.1:2*\pi)';
y0 = \sin(xdata);
\]

Add noise to the signal:

\[
noise = 2*y0.*\text{randn(size(y0))}; \quad \text{% Response-dependent noise}
ydata = y0 + noise;
\]

Fit the noisy data with a custom sinusoidal model:

\[
f = \text{fittype('a*\sin(b*x)' );}
f1 = \text{fit(xdata,ydata,f,'StartPoint',[1 1]);}
\]

Find the derivatives of the fit at the predictors:

\[
[d1,d2] = \text{differentiate(f1,xdata)};
\]

Plot the data, the fit, and the derivatives:

\[
\text{subplot(3,1,1)}
\text{plot(fit1,xdata,ydata) \% cfit plot method}
\text{subplot(3,1,2)}
\text{plot(xdata,d1,'m') \% double plot method}
\text{grid on}
\text{legend('1st derivative')}
\text{subplot(3,1,3)}
\text{plot(xdata,d2,'c') \% double plot method}
\text{grid on}
\text{legend('2nd derivative')}
\]
Differentiating and Integrating a Fit

Note that derivatives can also be computed and plotted directly with the `cfit plot` method, as follows:

```matlab
plot(fit1,xdata,ydata,{'fit','deriv1','deriv2'})
```

The `plot` method, however, does not return data on the derivatives.

Find the integral of the fit at the predictors:
int = integrate(fit1,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)
plot(fit1,xdata,ydata) % cfit plot method
subplot(2,1,2)
plot(xdata,int,'m') % double plot method
grid on
legend('integral')

Note that integrals can also be computed and plotted directly with the cfit plot method, as follows:

plot(fit1,xdata,ydata,{'fit','integral'})

The plot method, however, does not return data on the integral.
Spline Fitting

- Chapter 8, “About Splines”
- Chapter 9, “Simple Spline Examples”
- Chapter 10, “Types of Splines”
- Chapter 11, “Advanced Spline Examples”
- Splines Glossary on page 1
About Splines

- “Introducing Spline Fitting” on page 8-2
- “Curve Fitting Toolbox Splines and MATLAB Splines” on page 8-5
Introducing Spline Fitting

### About Spline in Curve Fitting Toolbox
You can work with splines in Curve Fitting Toolbox in several ways.

Using Curve Fitting Tool or the `fit` function you can:

- Fit cubic spline interpolants to curves or surfaces
- Fit smoothing splines and shape-preserving cubic spline interpolants to curves (but not surfaces)

The toolbox also contains specific splines functions to allow greater control over what you can create. For example, you can use the `csapi` function for cubic spline interpolation. Why would you use `csapi` instead of the `fit` function 'cubicinterp' option? You might require greater flexibility to work with splines for the following reasons:

- You want to combine the results with other splines, e.g., by addition.
- You want vector-valued splines. You can use `csapi` with scalars, vectors, matrices, and ND-arrays. The `fit` function only allows scalar-valued splines.
- You want other types of splines such as ppform, B-form, tensor-product, rational, and stform thin-plate splines.
- You want to create splines without data.
- You want to specify breaks, optimize knot placement, and use specialized functions for spline manipulation such as differentiation and integration.
If you require specialized spline functions, see the following sections for an overview of splines, and interactive and programmatic spline fitting.

**Spline Overview**

The Curve Fitting Toolbox spline functions are a collection of tools for creating, viewing, and analyzing spline approximations of data. Splines are smooth piecewise polynomials that can be used to represent functions over large intervals, where it would be impractical to use a single approximating polynomial.

The spline functionality includes a graphical user interface (GUI) that provides easy access to functions for creating, visualizing, and manipulating splines. The toolbox also contains functions that enable you to evaluate, plot, combine, differentiate, and integrate splines. Because all toolbox functions are implemented in the open MATLAB language, you can inspect the algorithms, modify the source code, and create your own custom functions.

Key spline features:

- GUIs that let you create, view, and manipulate splines and manage and compare spline approximations
- Functions for advanced spline operations, including differentiation, integration, break/knot manipulation, and optimal knot placement
- Support for piecewise polynomial form (ppform) and basis form (B-form) splines
- Support for tensor-product splines and rational splines (including NURBS)

**Interactive Spline Fitting**

You can access all spline functions from the splinetool GUI. You can use the GUI to:

- Vary spline parameters and tolerances
- View and modify data, breaks, knots, and weights
- View the error of the spline, or the spline’s first or second derivative
- Observe the toolbox commands that generated your spline
• Create and import data, including built-in instructive data sets, and save splines to the workspace

See splinetooll.

**Programmatic Spline Fitting**
To programmatically fit splines, see “Construction” for descriptions of types of splines and numerous examples.
Curve Fitting Toolbox Splines and MATLAB Splines

In this section...

“Curve Fitting Toolbox Splines” on page 8-5
“MATLAB Splines” on page 8-7
“Expected Background” on page 8-7
“Vector Data Type Support” on page 8-8
“Spline Function Naming Conventions” on page 8-8
“Arguments for Curve Fitting Toolbox Spline Functions” on page 8-9
“Acknowledgments” on page 8-9

Curve Fitting Toolbox Splines

Curve Fitting Toolbox spline functions contain versions of the essential MATLAB programs of the B-spline package (extended to handle also \textit{vector}-valued splines) as described in \textit{A Practical Guide to Splines}, (Applied Math. Sciences Vol. 27, Springer Verlag, New York (1978), xxiv + 392p; revised edition (2001), xviii+346p), hereafter referred to as \textit{PGS}. The toolbox makes it easy to create and work with piecewise-polynomial functions.

The typical use envisioned for this toolbox involves the construction and subsequent use of a piecewise-polynomial approximation. This construction would involve data fitting, but there is a wide range of possible data that could be fit. In the simplest situation, one is given points \((t_i,y_i)\) and is looking for a piecewise-polynomial function \(f\) that satisfies \(f(t_i) = y_i\), all \(i\), more or less. An exact fit would involve \textit{interpolation}, an approximate fit might involve \textit{least-squares approximation} or the \textit{smoothing spline}. But the function to be approximated may also be described in more implicit ways, for example as the solution of a differential or integral equation. In such a case, the data would be of the form \((Af)(t_i)\), with \(A\) some differential or integral operator. On the other hand, one might want to construct a spline \textit{curve} whose exact location is less important than is its overall shape. Finally, in all of this, one might be looking for functions of more than one variable, such as \textit{tensor product splines}.

Care has been taken to make this work as painless and intuitive as possible. In particular, the user need not worry about just how splines are constructed.
or stored for later use, nor need the casual user worry about such items as
“breaks” or “knots” or “coefficients”. It is enough to know that each function
constructed is just another variable that is freely usable as input (where
appropriate) to many of the commands, including all commands beginning
with \texttt{fn,} which stands for \texttt{function}. At times, it may be also useful to know
that, internal to the toolbox, splines are stored in different forms, with the
command \texttt{fn2fm} available to convert between forms.

At present, the toolbox supports two major forms for the representation of
piecewise-polynomial functions, because each has been found to be superior
to the other in certain common situations. The B-form is particularly useful
during the construction of a spline, while the ppform is more efficient when
the piecewise-polynomial function is to be evaluated extensively. These two
forms are almost exactly the B-representation and the pp representation
used in \textit{A Practical Guide to Splines}.

But, over the years, the Curve Fitting Toolbox spline functions have gone
beyond the programs in \textit{A Practical Guide to Splines}. The toolbox now
supports the ‘scattered translates’ form, or stform, in order to handle the
construction and use of bivariate thin-plate splines, and also two ways to
represent rational splines, the rBform and the rpform, in order to handle
NURBS.

Splines can be very effective for data fitting because the linear systems to be
solved for this are banded, hence the work needed for their solution, done
properly, grows only linearly with the number of data points. In particular,
the MATLAB sparse matrix facilities are used in the Curve Fitting Toolbox
spline functions when that is more efficient than the toolbox’s own equation
solver, \texttt{s1vb1k}, which relies on the fact that some of the linear systems here
are even almost block diagonal.

All polynomial spline construction commands are equipped to produce
bivariate (or even multivariate) piecewise-polynomial functions as tensor
products of the univariate functions used here, and the various \texttt{fn...}
commands also work for these multivariate functions.

There are various examples, all accessible through the Demos tab in the
MATLAB Help browser. You are strongly urged to have a look at some of
them, or at the GUI \texttt{splinetool}, before attempting to use this toolbox, or
even before reading on.
MATLAB Splines

The MATLAB technical computing environment provides spline approximation via the command `spline`. If called in the form `cs = spline(x,y)`, it returns the ppform of the cubic spline with break sequence x that takes the value y(i) at x(i), all i, and satisfies the not-a-knot end condition. In other words, the command `cs = spline(x,y)` gives the same result as the command `cs = csapi(x,y)` available in the Curve Fitting Toolbox spline functions. But only the latter also works when x,y describe multivariate gridded data. In MATLAB, cubic spline interpolation to multivariate gridded data is provided by the command `interp3(x1,...,xd,v,y1,...,yd, 'spline')` which returns values of the interpolating tensor product cubic spline at the grid specified by y1,...,yd.

Further, any of the Curve Fitting Toolbox spline fn... commands can be applied to the output of the MATLAB `spline(x,y)` command, with simple versions of the Curve Fitting Toolbox spline commands `fnval`, `ppmak`, `fnbrk` available directly in MATLAB, as the commands `ppval`, `mkpp`, `unmkpp`, respectively.

Expected Background

The Curve Fitting Toolbox spline functions started out as an extension of the MATLAB environment of interest to experts in spline approximation, to aid them in the construction and testing of new methods of spline approximation. Such people will have mastered the material in A Practical Guide to Splines.

However, the basic commands for constructing and using spline approximations are set up to be usable with no more knowledge than it takes to understand what it means to, say, construct an interpolant or a least squares approximant to some data, or what it means to differentiate or integrate a function.

With that in mind, there are sections, like “Cubic Spline Interpolation” on page 9-2, that are meant even for the novice, while sections devoted to a detailed example, like the one on constructing a Chebyshev spline or on constructing and using tensor products, are meant for users interested in developing their own spline commands.

“Glossary” provides definitions of almost all the mathematical terms used in the splines documentation.
Vector Data Type Support
The Curve Fitting Toolbox spline functions can handle vector-valued splines, i.e., splines whose values lie in $\mathbb{R}^d$. Since MATLAB started out with just one variable type, that of a matrix, there is even now some uncertainty about how to deal with vectors, i.e., lists of numbers. MATLAB sometimes stores such a list in a matrix with just one row, and other times in a matrix with just one column. In the first instance, such a 1-row matrix is called a row-vector; in the second instance, such a 1-column matrix is called a column-vector. Either way, these are merely different ways for storing vectors, not different kinds of vectors.

In this toolbox, vectors, i.e., lists of numbers, may also end up stored in a 1-row matrix or in a 1-column matrix, but with the following agreements.

A point in $\mathbb{R}^d$, i.e., a $d$-vector, is always stored as a column vector. In particular, if you want to supply an $n$-list of $d$-vectors to one of the commands, you are expected to provide that list as the $n$ columns of a matrix of size $[d,n]$.

While other lists of numbers (e.g., a knot sequence or a break sequence) may be stored internally as row vectors, you may supply such lists as you please, as a row vector or a column vector.

Spline Function Naming Conventions
Most of the spline commands in this toolbox have names that follow one of the following patterns:

cs... commands construct cubic splines (in ppform)
sp... commands construct splines in B-form
fn... commands operate on spline functions
..2.. commands convert something
..api commands construct an approximation by interpolation
..aps commands construct an approximation by smoothing
..ap2 commands construct a least-squares approximation


...knt commands construct (part of) a particular knot sequence

...dem commands are examples.

**Note** See the “Glossary” for information about notation.

**Arguments for Curve Fitting Toolbox Spline Functions**

For ease of use, most Curve Fitting Toolbox spline functions have default arguments. In the reference entry under Syntax, we usually first list the function with all *necessary* input arguments and then with all *possible* input arguments. When there is more than one optional argument, then, sometimes, but not always, their exact order is immaterial. When their order does matter, you have to specify every optional argument preceding the one(s) you are interested in. In this situation, you can specify the default value for an optional argument by using [ ] (the empty matrix) as the input for it. The description in the reference page tells you the default value for each optional input argument.

As in MATLAB, only the output arguments explicitly specified are returned to the user.

**Acknowledgments**

MathWorks® would like to acknowledge the contributions of Carl de Boor to the Curve Fitting Toolbox spline functions. Professor de Boor authored the Spline Toolbox™ from its first release until Version 3.3.4 (2008).

Professor de Boor received the John von Neumann Prize in 1996 and the National Medal of Science in 2003. He is a member of both the American Academy of Arts and Sciences and the National Academy of Sciences. He is the author of *A Practical Guide to Splines* (Springer, 2001).

Some of the spline function naming conventions are the result of a discussion with Jörg Peters, then a graduate student in Computer Sciences at the University of Wisconsin-Madison.
Simple Spline Examples

- “Cubic Spline Interpolation” on page 9-2
- “Vector-Valued Functions” on page 9-10
- “Fitting Values at N-D Grid with Tensor-Product Splines” on page 9-13
- “Fitting Values at Scattered 2-D Sites with Thin-Plate Smoothing Splines” on page 9-16
- “Postprocessing Splines” on page 9-18
Cubic Spline Interpolation

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Cubic Spline Interpolant of Smooth Data” on page 9-2</td>
</tr>
<tr>
<td>“Periodic Data” on page 9-3</td>
</tr>
<tr>
<td>“Other End Conditions” on page 9-4</td>
</tr>
<tr>
<td>“General Spline Interpolation” on page 9-4</td>
</tr>
<tr>
<td>“Knot Choices” on page 9-6</td>
</tr>
<tr>
<td>“Smoothing” on page 9-7</td>
</tr>
<tr>
<td>“Least Squares” on page 9-9</td>
</tr>
</tbody>
</table>

Cubic Spline Interpolant of Smooth Data

Suppose you want to interpolate some smooth data, e.g., to

```
rand('seed', 6), x = (4*pi)*[0 1 rand(1,15)]; y = sin(x);
```

You can use the cubic spline interpolant obtained by

```
cs = csapi(x,y);
```

and plot the spline, along with the data, with the following code:

```
fnplt(cs);
hold on
plot(x,y,'o')
legend('cubic spline','data')
hold off
```

This produces a figure like the following.
Cubic Spline Interpolant of Smooth Data

This is, more precisely, the cubic spline interpolant with the not-a-knot end conditions, meaning that it is the unique piecewise cubic polynomial with two continuous derivatives with breaks at all interior data sites except for the leftmost and the rightmost one. It is the same interpolant as produced by the MATLAB spline command, spline(x,y).

Periodic Data

The sine function is 2π-periodic. To check how well your interpolant does on that score, compute, e.g., the difference in the value of its first derivative at the two endpoints,

\[ \text{diff(fnval(fnder(cs),[0 4*pi]))} \]
Simple Spline Examples

\[ \text{ans} = -0.0100 \]

which is not so good. If you prefer to get an interpolant whose first and second derivatives at the two endpoints, 0 and \(4\pi\), match, use instead the command \texttt{csape} which permits specification of many different kinds of end conditions, including periodic end conditions. So, use instead

\[
pce = \text{csape}(x,y, 'periodic');
\]

for which you get

\[
\text{diff(fnval(fnder(pce),[0 \ 4*pi]))}
\]

Output is \texttt{ans = 0} as the difference of end slopes. Even the difference in end second derivatives is small:

\[
\text{diff(fnval(fnder(pce,2),[0 \ 4*pi]))}
\]

Output is \texttt{ans = -4.6074e-015}.

Other End Conditions
Other end conditions can be handled as well. For example,

\[
cs = \text{csape}(x,[3,y,-4],[1 \ 2]);
\]

provides the cubic spline interpolant with breaks at the \(x(i)\) and with its slope at the leftmost data site equal to 3, and its second derivative at the rightmost data site equal to -4.

General Spline Interpolation
If you want to interpolate at sites other than the breaks and/or by splines other than cubic splines with simple knots, then you use the \texttt{spapi} command. In its simplest form, you would say \texttt{sp = spapi(k,x,y)}; in which the first argument, \(k\), specifies the order of the interpolating spline; this is the number of coefficients in each polynomial piece, i.e., 1 more than the nominal degree of its polynomial pieces. For example, the next figure shows a linear, a quadratic, and a quartic spline interpolant to your data, as obtained by the statements

\[
\text{sp2 = spapi(2,x,y); fnplt(sp2,2), hold on}
\]
Cubic Spline Interpolation

Spline Interpolants of Various Orders of Smooth Data

Even the cubic spline interpolant obtained from \texttt{spapi} is different from the one provided by \texttt{csapi} and \texttt{spline}. To emphasize their difference, compute and plot their second derivatives, as follows:

\begin{verbatim}
sp3 = spapi(3,x,y); fnplt(sp3,2,'k--'), set(gca,'Fontsize',16)
sp5 = spapi(5,x,y); fnplt(sp5,2,'r--'), plot(x,y,'o')
legend('linear','quadratic','quartic','data'), hold off
\end{verbatim}

This gives the following graph:
Second Derivative of Two Cubic Spline Interpolants of the Same Smooth Data

Since the second derivative of a cubic spline is a broken line, with vertices at the breaks of the spline, you can see clearly that \texttt{csapi} places breaks at the data sites, while \texttt{spapi} does not.

**Knot Choices**

It is, in fact, possible to specify explicitly just where the spline interpolant should have its breaks, using the command \texttt{sp = spapi(knots,x,y)}; in which the sequence \texttt{knots} supplies, in a certain way, the breaks to be used. For example, recalling that you had chosen \texttt{y} to be \texttt{sin(x)}, the command

\begin{verbatim}
ch = spapi(augknt(x,4,2),[x x],[y cos(x)]);
\end{verbatim}

provides a cubic Hermite interpolant to the sine function, namely the piecewise cubic function, with breaks at all the \texttt{x(i)}’s, that matches the sine function in value \textit{and} slope at all the \texttt{x(i)}’s. This makes the interpolant continuous with continuous first derivative but, in general, it has jumps across the breaks in its second derivative. Just how does this command know which part of the data value array \texttt{[y cos(x)]} supplies the values and which the slopes? Notice that the data site array here is given as \texttt{[x x]}, i.e., each data site appears twice. Also notice that \texttt{y(i)} is associated with the first occurrence of \texttt{x(i)}, and \texttt{cos(x(i))} is associated with the second occurrence of \texttt{x(i)}. The data value associated with the first appearance of a
data site is taken to be a function value; the data value associated with the second appearance is taken to be a slope. If there were a third appearance of that data site, the corresponding data value would be taken as the second derivative value to be matched at that site. See “Constructing and Working with B-form Splines” on page 10-22 for a discussion of the command augknt used here to generate the appropriate "knot sequence".

**Smoothing**

What if the data are noisy? For example, suppose that the given values are

```matlab
noisy = y + .3*(rand(size(x))-.5);
```

Then you might prefer to approximate instead. For example, you might try the cubic smoothing spline, obtained by the command

```matlab
scs = csaps(x,noisy);
```

and plotted by

```matlab
fnplt(scs,2), hold on, plot(x,noisy,'o'), set(gca,'Fontsize',16)
legend('smoothing spline','noisy data'), hold off
```

This produces a figure like this:
If you don't like the level of smoothing done by `csaps(x,y)`, you can change it by specifying the smoothing parameter, `p`, as an optional third argument. Choose this number anywhere between 0 and 1. As `p` changes from 0 to 1, the smoothing spline changes, correspondingly, from one extreme, the least squares straight-line approximation to the data, to the other extreme, the "natural" cubic spline interpolant to the data. Since `csaps` returns the smoothing parameter actually used as an optional second output, you could now experiment, as follows:

```
[scs,p] = csaps(x,noisy); fnplt(scs,2), hold on
fnplt(csaps(x,noisy,p/2),2,'k--'), set(gca,'Fontsize',16)
fnplt(csaps(x,noisy,(1+p)/2),2,'r:'), plot(x,noisy,'o')
legend('smoothing spline','more smoothed','less smoothed','noisy data'), hold off
```

This produces the following picture.

![Graph](image)

**Noisy Data More or Less Smoothed**

At times, you might prefer simply to get the smoothest cubic spline `sp` that is within a specified tolerance `tol` of the given data in the sense that \( \text{norm(noisy - fnval(sp,x))^2 <= tol} \). You create this spline with the command `sp = spaps(x,noisy,tol)` for your defined tolerance `tol`. 
Least Squares

If you prefer a least squares approximant, you can obtain it by the statement

\[ sp = \text{spap2}(\text{knots}, k, x, y); \]

in which both the knot sequence \text{knots} and the order \text{k} of the spline must be provided.

The popular choice for the order is 4, and that gives you a cubic spline. If you have no clear idea of how to choose the knots, simply specify the number of polynomial pieces you want used. For example,

\[ sp = \text{spap2}(3, 4, x, y); \]

gives a cubic spline consisting of three polynomial pieces. If the resulting error is uneven, you might try for a better knot distribution by using \text{newknt} as follows:

\[ sp = \text{spap2}(\text{newknt}(sp), 4, x, y); \]
Vector-Valued Functions

The toolbox supports vector-valued splines. For example, if you want a spline curve through given planar points \((x(i), y(i)),\ i = 1, \ldots, n\), then the following code defines some data and then creates and plots such a spline curve, using chord-length parametrization and cubic spline interpolation with the not-a-knot end condition.

\[
x = [19\ 43\ 62\ 88\ 114\ 120\ 130\ 129\ 113\ 76\ 135\ 182\ 232\ 298 \ldots \n348\ 386\ 420\ 456\ 471\ 485\ 463\ 444\ 414\ 348\ 275\ 192\ 106 \ldots \n30\ 48\ 83\ 107\ 110\ 109\ 92\ 66\ 45\ 23\ 22\ 30\ 40\ 55\ 55\ 52\ 34\ 20\ 16];
\]
\[
y = [306\ 272\ 240\ 215\ 218\ 237\ 275\ 310\ 368\ 424\ 425\ 427\ 428 \ldots \n397\ 353\ 302\ 259\ 200\ 148\ 105\ 77\ 47\ 28\ 17\ 10\ 12\ 23\ 41\ 43 \ldots \n77\ 96\ 133\ 155\ 164\ 157\ 148\ 142\ 162\ 181\ 187\ 192\ 202\ 217\ 245\ 266\ 303];
\]

\[
xy = [x; y]; df = \text{diff}(xy, 1, 2);
t = \text{cumsum}([0, \text{sqrt([1 1]*df.*df))]);
cv = \text{csapi}(t, xy);
\]
\[
\text{fnplt}(cv), \text{hold on, plot}(x, y, 'o'), \text{hold off}
\]
If you then wanted to know the area enclosed by this curve, you would want to evaluate the integral \( \int y(t)dx(t) = \int y(t)Dx(t)dt \), with \((x(t),y(t))\) the point on the curve corresponding to the parameter value \(t\). For the spline curve in \(cv\) just constructed, this can be done exactly in one (somewhat complicated) command:

\[
\text{area} = \text{diff(fnval(fnint(}
\text{fncoeff(fnint(fncmb(fncmb(cv,[0 1]),'*',fnder(fncmb(cv,[1 0])), ...)
\text{fnbrk(cv,'interval')))\));}
\]

To explain, \(y=fncmb(cv,[0 1])\) picks out the second component of the curve in \(cv\), \(Dx=fnder(fncmb(cv,[1 0]))\) provides the derivative of the first component, and \(yDx=fncmb(y,'*',Dx)\) constructs their pointwise product. Then \(IyDx=fnint(yDx)\) constructs the indefinite integral of \(yDx\) and, finally,
diff(fnval(IyDx,fnbrk(cv,'interval'))) evaluates that indefinite integral at the endpoints of the basic interval and then takes the difference of the second from the first value, thus getting the definite integral of yDx over its basic interval. Depending on whether the enclosed area is to the right or to the left as the curve point travels with increasing parameter, the resulting number is either positive or negative.

Further, all the values Y (if any) for which the point (X,Y) lies on the spline curve in cv just constructed can be obtained by the following (somewhat complicated) command:

\[
X=250; \text{ } \% \text{Define a value of } X \\
Y = \text{fnval}(\text{fncmb}(cv,[0 1]), ... \\
\quad \quad \quad \quad \quad \quad \quad \text{mean(} \text{fnzeros}(\text{fncmb}(\text{fncmb}(cv,[1 0]),'-' X)))\text{)}
\]

To explain: \( x = \text{fncmb}(cv,[1 0]) \) picks out the first component of the curve in cv; \( xmX = \text{fncmb}(x,'-',X) \) translates that component by X; \( t = \text{mean(} \text{fnzeros}(xmX) \text{)} \) provides all the parameter values for which \( xmX \) is zero, i.e., for which the first component of the curve equals X; \( y = \text{fncmb}(cv,[0,1]) \) picks out the second component of the curve in cv; and, finally, \( Y = \text{fnval}(y,t) \) evaluates that second component at those parameter sites at which the first component of the curve in cv equals X.

As another example of the use of vector-valued functions, suppose that you have solved the equations of motion of a particle in some specified force field in the plane, obtaining, at discrete times \( t_j = t(j), j = 1:n \), the position \( (x(t_j),y(t_j)) \) as well as the velocity \( (\dot{x}(t_j),\dot{y}(t_j)) \) stored in the 4-vector \( z(:,j) \), as you would if, in the standard way, you had solved the equivalent first-order system numerically. Then the following statement, which uses cubic Hermite interpolation, will produce a plot of the particle path:

\[
\text{fnplt(spapi(augknt(t,4,2),t,reshape(z,2,2*n)))}
\]
Fitting Values at N-D Grid with Tensor-Product Splines

Vector-valued splines are also used in the approximation to gridded data, in any number of variables, using tensor-product splines. The same spline-construction commands are used, only the form of the input differs. For example, if \( x \) is an \( m \)-vector, \( y \) is an \( n \)-vector, and \( z \) is an array of size \( [m,n] \), then \( cs = \text{csapi}([x,y],z) \); describes a bicubic spline \( f \) satisfying \( f(x(i),y(j)) = z(i,j) \) for \( i=1:m, j=1:n \). Such a multivariate spline can be vector-valued. For example,

\[
x = 0:4; \quad y = -2:2; \quad s2 = 1/\text{sqrt}(2);
z(3,:,:) = [0 1 s2 0 -s2 -1 0].'*[1 1 1 1 1];
z(2,:,:) = [1 0 s2 1 s2 0 -1].'*[0 1 0 -1 0];
z(1,:,:) = [1 0 s2 1 s2 0 -1].'*[1 0 -1 0 1];
sph = \text{csape}([x,y],z,\{'\text{clamped}',\'\text{periodic}'\});
\]

\text{fnplt(sph), axis equal, axis off}

gives a perfectly acceptable sphere. Its projection onto the \((x,z)\)-plane is plotted by

\text{fnplt(fncmb(sph,[1 0 0; 0 0 1])), axis equal, axis off}

Both plots are shown below.
A Sphere Made by a 3-D-Valued Bivariate Tensor Product Spline
Planar Projection of Spline Sphere
Fitting Values at Scattered 2-D Sites with Thin-Plate Smoothing Splines

Tensor-product splines are good for gridded (bivariate and even multivariate) data. For work with scattered bivariate data, the toolbox provides the thin-plate smoothing spline. Suppose you have given data values $y(j)$ at scattered data sites $x(:,j)$, $j=1:N$, in the plane. To give a specific example,

```plaintext
n = 65; t = linspace(0,2*pi,n+1);
x = [cos(t);sin(t)]; x(:,end) = [0;0];
```

provides 65 sites, namely 64 points equally spaced on the unit circle, plus the center of that circle. Here are corresponding data values, namely noisy values of the very nice function $g(x) = (x(1)+1/2)^2 + (x(2)+1/2)^2$.

```plaintext
y = (x(1,:)+.5).^2 + (x(2,:)+.5).^2;
noisy = y + (rand(size(y))-.5)/3;
```

Then you can compute a reasonable approximation to these data by

```plaintext
st = tpaps(x,noisy);
```

and plot the resulting approximation along with the noisy data by

```plaintext
fnplt(st); hold on
plot3(x(1,:),x(2,:),noisy,'wo','markerfacecolor','k')
hold off
```

and so produce the following picture:
Thin-Plate Smoothing Spline Approximation to Noisy Data
Postprocessing Splines

You can use the following commands with any example spline, such as the cs, ch and sp examples constructed in the section “Cubic Spline Interpolation” on page 9-2.

First construct a spline, for example:

```matlab
sp = spmak(1:6,0:2)
```

To display a plot of the spline:

```matlab
fnplt(sp)
```

To get the value at a, use the syntax `fnval(f,a)`, for example:

```matlab
fnval(sp,4)
```

To construct the spline’s second derivative:

```matlab
DDf = fnder(fnder(sp))
```

An alternative way to construct the second derivative:

```matlab
DDf = fnder(sp,2);
```

To obtain the spline’s definite integral over an interval [a..b], in this example from 2 to 5:

```matlab
diff(fnval(fnint(sp),[2;5]))
```

To compute the difference between two splines, use the form `fncmb(sp1,'-',sp2)`, for example:

```matlab
fncmb(sp,'-',DDf);
```
Types of Splines

- “Types of Splines: ppform and B-form” on page 10-2
- “B-Splines and Smoothing Splines” on page 10-5
- “Multivariate and Rational Splines” on page 10-8
- “The ppform” on page 10-10
- “Constructing and Working with ppform Splines” on page 10-12
- “The B-form” on page 10-16
- “Constructing and Working with B-form Splines” on page 10-22
- “Multivariate Tensor Product Splines” on page 10-27
- “NURBS and Other Rational Splines” on page 10-30
- “Constructing and Working with Rational Splines” on page 10-32
- “Constructing and Working with stform Splines” on page 10-36
Types of Splines: ppform and B-form

In this section...

“Polynomials vs. Splines” on page 10-2
“ppform” on page 10-3
“B-form” on page 10-3
“Knot Multiplicity” on page 10-3

Polynomials vs. Splines

Polynomials are the approximating functions of choice when a smooth function is to be approximated locally. For example, the truncated Taylor series

\[
\sum_{i=0}^{n} (x-a)^i \frac{D^i f(a)}{i!}
\]

provides a satisfactory approximation for \( f(x) \) if \( f \) is sufficiently smooth and \( x \) is sufficiently close to \( a \). But if a function is to be approximated on a larger interval, the degree, \( n \), of the approximating polynomial may have to be chosen unacceptably large. The alternative is to subdivide the interval \([a..b]\) of approximation into sufficiently small intervals \([\xi_j..\xi_{j+1}]\), with \( a = \xi_1 < \cdots < \xi_{n+1} = b \), so that, on each such interval, a polynomial \( p_j \) of relatively low degree can provide a good approximation to \( f \). This can even be done in such a way that the polynomial pieces blend smoothly, i.e., so that the resulting patched or composite function \( s(x) \) that equals \( p_j(x) \) for \( x \in [\xi_j..\xi_{j+1}] \), all \( j \), has several continuous derivatives. Any such smooth piecewise polynomial function is called a spline. I.J. Schoenberg coined this term because a twice continuously differentiable cubic spline with sufficiently small first derivative approximates the shape of a draftsman’s spline.

There are two commonly used ways to represent a polynomial spline, the ppform and the B-form. In this toolbox, a spline in ppform is often referred to as a piecewise polynomial, while a piecewise polynomial in B-form is often referred to as a spline. This reflects the fact that piecewise polynomials and (polynomial) splines are just two different views of the same thing.
**ppform**

The *ppform* of a polynomial spline of order \( k \) provides a description in terms of its breaks \( \xi_1, \ldots, \xi_{l+1} \) and the *local polynomial coefficients* \( c_{ji} \) of its \( l \) pieces.

\[
p_j(x) = \sum_{i=1}^{k} (x - \xi_j)^{k-i} c_{ji}, \quad j = 1 : l
\]

For example, a cubic spline is of order 4, corresponding to the fact that it requires four coefficients to specify a cubic polynomial. The ppform is convenient for the evaluation and other *uses* of a spline.

**B-form**

The *B-form* has become the standard way to represent a spline during its *construction*, because the B-form makes it easy to build in smoothness requirements across breaks and leads to banded linear systems. The B-form describes a spline as a weighted sum

\[
\sum_{j=1}^{n} B_{j,k} a_j
\]

of B-splines of the required order \( k \), with their number, \( n \), at least as big as \( k-1 \) plus the number of polynomial pieces that make up the spline. Here, \( B_{j,k} = B(\cdot | t_j, \ldots, t_{j+k}) \) is the \( j \)th B-spline of order \( k \) for the knot sequence \( t_1 \leq t_2 \leq \cdots \leq t_{n+k} \).

In particular, \( B_{j,k} \) is piecewise-polynomial of degree \( < k \), with breaks \( t_j, \ldots, t_{j+k} \), is nonnegative, is zero outside the interval \([t_j, t_{j+k}]\), and is so normalized that

\[
\sum_{j=1}^{n} B_{j,k}(x) = 1 \quad \text{on} \quad [t_k, t_{n+1}]
\]

**Knot Multiplicity**

The multiplicity of the knots governs the smoothness, in the following way: If the number \( \tau \) occurs exactly \( r \) times in the sequence \( t_j, \ldots, t_{j+k} \), then \( B_{j,k} \) and its first \( k-r-1 \) derivatives are continuous across the break \( \tau \), while the \((k-r)\)th
derivative has a jump at $\tau$. You can experiment with all these properties of the B-spline in a very visual and interactive way using the command \texttt{bspligui}.
In this section...

“B-Spline Properties” on page 10-5

“Variational Approach and Smoothing Splines” on page 10-6

B-Spline Properties

Because $B_{j,k}$ is nonzero only on the interval $(t_j, t_{j+k})$, the linear system for the B-spline coefficients of the spline to be determined, by interpolation or least squares approximation, or even as the approximate solution of some differential equation, is banded, making the solving of that linear system particularly easy. For example, to construct a spline $s$ of order $k$ with knot sequence $t_1 \leq t_2 \leq \cdots \leq t_{n+k}$ so that $s(x_i) = y_i$ for $i = 1, \ldots, n$, use the linear system

$$\sum_{j=1}^{n} B_{j,k}(x_i) a_j = y_i \quad i = 1 : n$$

for the unknown B-spline coefficients $a_j$ in which each equation has at most $k$ nonzero entries.

Also, many theoretical facts concerning splines are most easily stated and/or proved in terms of B-splines. For example, it is possible to match arbitrary data at sites $x_1 < \cdots < x_n$ uniquely by a spline of order $k$ with knot sequence $(t_1, \ldots, t_{n+k})$ if and only if $B_{j,k}(x_j) \neq 0$ for all $j$ (Schoenberg-Whitney Conditions). Computations with B-splines are facilitated by stable recurrence relations

$$B_{j,k}(x) = \frac{x-t_j}{t_{j+k-1}-t_j} B_{j,k-1}(x) + \frac{t_{j+k}-x}{t_{j+k}-t_{j+1}} B_{j+1,k-1}(x)$$

which are also of help in the conversion from B-form to ppform. The dual functional

$$a_j(s) := \sum_{i<k} (-D)^{k-i-1} \Psi_j(\tau) D^i s(\tau)$$
provides a useful expression for the $j$th B-spline coefficient of the spline $s$ in terms of its value and derivatives at an arbitrary site $\tau$ between $t_j$ and $t_{j+k}$, and with $\psi_j(t):=(t_{j+1}-t)\cdots(t_{j+k-1}-t)/(k-1)!$. It can be used to show that $a_j(s)$ is closely related to $s$ on the interval $[t_j..t_{j+k}]$, and seems the most efficient means for converting from ppform to B-form.

**Variational Approach and Smoothing Splines**

The above constructive approach is not the only avenue to splines. In the variational approach, a spline is obtained as a best interpolant, e.g., as the function with smallest $m$th derivative among all those matching prescribed function values at certain sites. As it turns out, among the many such splines available, only those that are piecewise-polynomials or, perhaps, piecewise-exponentials have found much use. Of particular practical interest is the smoothing spline $s = s_p$ which, for given data $(x_i, y_i)$ with $x \in [a..b]$, all $i$, and given corresponding positive weights $w_i$, and for given smoothing parameter $p$, minimizes

$$p \sum_i w_i |y_i - f(x_i)|^2 + (1-p) \int_a^b |D^m f(t)|^2 \, dt$$

over all functions $f$ with $m$ derivatives. It turns out that the smoothing spline $s$ is a spline of order $2m$ with a break at every data site. The smoothing parameter, $p$, is chosen artfully to strike the right balance between wanting the error measure

$$E(s) = \sum_i w_i |y_i - s(x_i)|^2$$

small and wanting the roughness measure

$$F(D^m s) = \int_a^b |D^m s(t)|^2 \, dt$$

small. The hope is that $s$ contains as much of the information, and as little of the supposed noise, in the data as possible. One approach to this (used in `spaps`) is to make $F(D^m f)$ as small as possible subject to the condition that $E(f)$ be no bigger than a prescribed tolerance. For computational reasons, `spaps`
uses the (equivalent) smoothing parameter $\rho = p/(1-p)$, i.e., minimizes $\rho E(f) + F(D^m f)$. Also, it is useful at times to use the more flexible roughness measure

$$F\left(D^m s\right) = \int_a^b \lambda(t) \left| D^m s(t) \right|^2 dt$$

with $\lambda$ a suitable positive weight function.
### Multivariate and Rational Splines

**In this section...**

“Multivariate Splines” on page 10-8

“Rational Splines” on page 10-9

---

### Multivariate Splines

Multivariate splines can be obtained from univariate splines by the tensor product construct. For example, a trivariate spline in B-form is given by

\[
f(x, y, z) = \sum_{u=1}^{U} \sum_{v=1}^{V} \sum_{w=1}^{W} B_{u,k}(x) B_{v,l}(y) B_{w,m}(z) a_{u,v,w}
\]

with \( B_{u,k} \), \( B_{v,l} \), and \( B_{w,m} \) univariate B-splines. Correspondingly, this spline is of order \( k \) in \( x \), of order \( l \) in \( y \), and of order \( m \) in \( z \). Similarly, the ppform of a tensor-product spline is specified by break sequences in each of the variables and, for each hyper-rectangle thereby specified, a coefficient array. Further, as in the univariate case, the coefficients may be vectors, typically 2-vectors or 3-vectors, making it possible to represent, e.g., certain surfaces in \( \mathbb{R}^3 \).

A very different bivariate spline is the **thin-plate spline**. This is a function of the form

\[
f(x) = \sum_{j=1}^{n-3} \Psi(x - c_j) a_j + x(1) a_{n-2} + x(2) a_{n-1} + a_n
\]

with \( \psi(x) = |x|^2 \log |x|^2 \) the thin-plate spline basis function, and \( |x| \) denoting the Euclidean length of the vector \( x \). Here, for convenience, denote the independent variable by \( x \), but \( x \) is now a vector whose two components, \( x(1) \) and \( x(2) \), play the role of the two independent variables earlier denoted \( x \) and \( y \). Correspondingly, the sites \( c_j \) are points in \( \mathbb{R}^2 \).

Thin-plate splines arise as bivariate **smoothing splines**, meaning a thin-plate spline minimizes
Multivariate and Rational Splines

\[ p \sum_{i=1}^{n-3} \left| y_i - f c_i \right|^2 + (1 - p) \int \left( |D_1 D_1 f|^2 + 2 |D_1 D_2 f|^2 + |D_2 D_2 f|^2 \right) \]

over all sufficiently smooth functions \( f \). Here, the \( y_i \) are data values given at the data sites \( c_i \), \( p \) is the smoothing parameter, and \( D_j f \) denotes the partial derivative of \( f \) with respect to \( x(j) \). The integral is taken over the entire \( \mathbb{R}^2 \). The upper summation limit, \( n-3 \), reflects the fact that 3 degrees of freedom of the thin-plate spline are associated with its polynomial part.

Thin-plate splines are functions in stform, meaning that, up to certain polynomial terms, they are a weighted sum of arbitrary or scattered translates \( \Psi(\cdot - c) \) of one fixed function, \( \Psi \). This so-called basis function for the thin-plate spline is special in that it is radially symmetric, meaning that \( \Psi(x) \) only depends on the Euclidean length, \( |x| \), of \( x \). For that reason, thin-plate splines are also known as RBFs or radial basis functions. See “Constructing and Working with stform Splines” on page 10-36 for more information.

**Rational Splines**

A rational spline is any function of the form \( r(x) = s(x)/w(x) \), with both \( s \) and \( w \) splines and, in particular, \( w \) a scalar-valued spline, while \( s \) often is vector-valued.

Rational splines are attractive because it is possible to describe various basic geometric shapes, like conic sections, exactly as the range of a rational spline. For example, a circle can so be described by a quadratic rational spline with just two pieces.

In this toolbox, there is the additional requirement that both \( s \) and \( w \) be of the same form and even of the same order, and with the same knot or break sequence. This makes it possible to store the rational spline \( r \) as the ordinary spline \( R \) whose value at \( x \) is the vector \([s(x);w(x)]\). Depending on whether the two splines are in B-form or ppform, such a representation is called here the rBform or the rpform of such a rational spline.

It is easy to obtain \( r \) from \( R \). For example, if \( v \) is the value of \( R \) at \( x \), then \( v(1:end-1)/v(end) \) is the value of \( r \) at \( x \). There are corresponding ways to express derivatives of \( r \) in terms of derivatives of \( R \).
The ppform

In this section...

“Introduction to ppform” on page 10-10
“Definition of ppform” on page 10-10

Introduction to ppform

A univariate piecewise polynomial $f$ is specified by its break sequence $\text{breaks}$ and the coefficient array $\text{coefs}$ of the local power form (see equation in “Definition of ppform” on page 10-10) of its polynomial pieces; see “Multivariate Tensor Product Splines” on page 10-27 for a discussion of multivariate piecewise-polynomials. The coefficients may be (column-)vectors, matrices, even ND-arrays. For simplicity, the present discussion deals only with the case when the coefficients are scalars.

The break sequence is assumed to be strictly increasing,

$\text{breaks}(1) < \text{breaks}(2) < \ldots < \text{breaks}(l+1)$

with $l$ the number of polynomial pieces that make up $f$.

While these polynomials may be of varying degrees, they are all recorded as polynomials of the same order $k$, i.e., the coefficient array $\text{coefs}$ is of size $[1,k]$, with $\text{coefs}(j,:)$ containing the $k$ coefficients in the local power form for the $j$th polynomial piece, from the highest to the lowest power; see equation in “Definition of ppform” on page 10-10.

Definition of ppform

The items $\text{breaks}$, $\text{coefs}$, $l$, and $k$, make up the ppform of $f$, along with the dimension $d$ of its coefficients; usually $d$ equals 1. The basic interval of this form is the interval $[\text{breaks}(1) \ldots \text{breaks}(l+1)]$. It is the default interval over which a function in ppform is plotted by the plot command $\text{fnplt}$.

In these terms, the precise description of the piecewise-polynomial $f$ is
\[ f(t) = \text{polyval(coefs}(j,:), t - \text{breaks}(j)) \]  \hspace{1cm} (10-1)

for \( \text{breaks}(j) \leq t < \text{breaks}(j+1) \).

Here, \text{polyval}(a,x) is the MATLAB function; it returns the number

\[
\sum_{j=1}^{k} a(j)x^{k-j} = a(1)x^{k-1} + a(2)x^{k-2} + \ldots + a(k)x^0
\]

This defines \( f(t) \) only for \( t \) in the half-open interval \([\text{breaks}(1) .. \text{breaks}(1+1))\). For any other \( t \), \( f(t) \) is defined by

\[
f(t) = \text{polyval(coefs}(j,:), t - \text{breaks}(j)) \quad j = \begin{cases} 1, & t < \text{breaks}(1) \\ l, & t \geq \text{breaks}(l+1) \end{cases}
\]

i.e., by extending the first, respectively last, polynomial piece. In this way, a function in ppform has possible jumps, in its value and/or its derivatives, only across the interior breaks, \text{breaks}(2:l). The end breaks, \text{breaks}([1,1+1]), mainly serve to define the basic interval of the ppform.
Constructing and Working with ppform Splines

In this section...

“Constructing a ppform” on page 10-12
“Working With ppform Splines” on page 10-13
“Example ppform” on page 10-14

Constructing a ppform

A piecewise-polynomial is usually constructed by some command, through a process of interpolation or approximation, or conversion from some other form e.g., from the B-form, and is output as a variable. But it is also possible to make one up from scratch, using the statement

\[
\text{pp} = \text{ppmak(breaks,coefs)}
\]

For example, if you enter \( \text{pp=ppmak(-5:-1,-22:-11)} \), or, more explicitly,

\[
\text{breaks} = \text{-5:-1;}
\]
\[
\text{coefs} = \text{-22:-11; pp = ppmak(breaks,coefs)};
\]

you specify the uniform break sequence \(-5:-1\) and the coefficient sequence \(-22:-11\). Because this break sequence has 5 entries, hence 4 break intervals, while the coefficient sequence has 12 entries, you have, in effect, specified a piecewise-polynomial of order 3 (= 12/4). The command

\[
\text{fnbrk(pp)}
\]

prints out all the constituent parts of this piecewise-polynomial, as follows:

\[
\text{breaks(1:l+1)}
\]
\[
-5 -4 -3 -2 -1
\]
\[
\text{coefficients(d*l,k)}
\]
\[
-22 -21 -20
\]
\[
-19 -18 -17
\]
\[
-16 -15 -14
\]
\[
-13 -12 -11
\]

\[
\text{pieces number 1}
\]
Further, \texttt{fnbrk} can be used to supply each of these parts separately. But the point of Curve Fitting Toolbox spline functionality is that you usually need not concern yourself with these details. You simply use \texttt{pp} as an argument to commands that evaluate, differentiate, integrate, convert, or plot the piecewise-polynomial whose description is contained in \texttt{pp}.

### Working With ppform Splines

Here are some functions for operations you can perform on a piecewise-polynomial.

\[
\begin{align*}
    v &= \texttt{fnval(pp,x)} & \text{Evaluates} \\
    \text{dpp} &= \texttt{fnder(pp)} & \text{Differentiates} \\
    \text{dirpp} &= \texttt{fndir(pp,dir)} & \text{Differentiates in the direction } \texttt{dir} \\
    \text{ipp} &= \texttt{fnint(pp)} & \text{Integrates} \\
    \text{fnmin(pp,}[a,b]) & & \text{Finds the minimum value in given interval} \\
    \text{fnzeros(pp,}[a,b]) & & \text{Finds the zeros in the given interval} \\
    \text{pj} &= \texttt{fnbrk(pp,j)} & \text{Pulls out the } j \text{th polynomial piece} \\
    \text{pc} &= \texttt{fnbrk(pp,}[a\:b]) & \text{Restricts/extends to the interval } [a..b] \\
    \text{po} &= \texttt{fnxtr(pp,order)} & \text{Extends outside its basic interval by polynomial of specified order} \\
    \text{fnplt(pp,}[a,b]) & & \text{Plots on given interval} \\
    \text{sp} &= \texttt{fn2fm(pp,'B-')} & \text{Converts to B-form} \\
    \text{pr} &= \texttt{fnrfn(pp,morebreaks)} & \text{Inserts additional breaks}
\end{align*}
\]
Inserting additional breaks comes in handy when you want to add two piecewise-polynomials with different breaks, as is done in the command `fncomb`.

**Example ppform**

Execute the following commands to create and plot the particular piecewise-polynomial (ppform) described in the “Constructing a ppform” on page 10-12 section.

1. Create the piecewise-polynomial with break sequence `-5:-1` and coefficient sequence `-22:-11`:
   
   ```
   pp=ppmak(-5:-1,-22:-11)
   ```

2. Create the basic plot:
   
   ```
   x = linspace(-5.5,-.5,101);
   plot(x, fnval(pp,x),'x')
   ```

3. Add the break lines to the plot:
   
   ```
   breaks=fnbrk(pp,'b'); yy=axis; hold on
   for j=1:fnbrk(pp,'l')+1
       plot(breaks([j j]),yy(3:4))
   end
   ```

4. Superimpose the plot of the polynomial that supplies the third polynomial piece:
   
   ```
   plot(x,fnval(fnbrk(pp,3),x),'linew',1.3)
   set(gca,'ylim',[-60 -10]), hold off
   ```
A Piecewise-Polynomial Function, Its Breaks, and the Polynomial Giving Its Third Piece

The figure above is the final picture. It shows the piecewise-polynomial as a sequence of points and, solidly on top of it, the polynomial from which its third polynomial piece is taken. It is quite noticeable that the value of a piecewise-polynomial at a break is its limit from the right, and that the value of the piecewise-polynomial outside its basic interval is obtained by extending its leftmost, respectively its rightmost, polynomial piece.

While the ppform of a piecewise-polynomial is efficient for evaluation, the construction of a piecewise-polynomial from some data is usually more efficiently handled by determining first its B-form, i.e., its representation as a linear combination of B-splines.
The B-form

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Introduction to B-form” on page 10-16</td>
</tr>
<tr>
<td>“Definition of B-form” on page 10-16</td>
</tr>
<tr>
<td>“B-form and B-Splines” on page 10-17</td>
</tr>
<tr>
<td>“B-Spline Knot Multiplicity” on page 10-19</td>
</tr>
<tr>
<td>“Choice of Knots for B-form” on page 10-20</td>
</tr>
</tbody>
</table>

Introduction to B-form

A univariate spline \( f \) is specified by its nondecreasing knot sequence \( t \) and by its B-spline coefficient sequence \( a \). See “Multivariate Tensor Product Splines” on page 10-27 for a discussion of multivariate splines. The coefficients may be (column-)vectors, matrices, even ND-arrays. When the coefficients are 2-vectors or 3-vectors, \( f \) is a curve in \( \mathbb{R}^2 \) or \( \mathbb{R}^3 \) and the coefficients are called the control points for the curve.

Roughly speaking, such a spline is a piecewise-polynomial of a certain order and with breaks \( t(i) \). But knots are different from breaks in that they may be repeated, i.e., \( t \) need not be strictly increasing. The resulting knot multiplicities govern the smoothness of the spline across the knots, as detailed below.

With \([d,n] = \text{size}(a)\), and \( n+k = \text{length}(t) \), the spline is of order \( k \). This means that its polynomial pieces have degree \(< k \). For example, a cubic spline is a spline of order 4 because it takes four coefficients to specify a cubic polynomial.

Definition of B-form

These four items, \( t, a, n, \) and \( k \), make up the B-form of the spline \( f \).

This means, explicitly, that
\[ f = \sum_{i=1}^{n} B_{i,k} a(:,i) \]

with \( B_{i,k} = B(\cdot | t(i:i+k)) \) the \( i \)th B-spline of order \( k \) for the given knot sequence \( t \), i.e., the B-spline with knots \( t(i),...,t(i+k) \). The basic interval of this B-form is the interval \([t(1)..t(n+k)]\). It is the default interval over which a spline in B-form is plotted by the command \( \text{fnplt} \). Note that a spline in B-form is zero outside its basic interval while, after conversion to ppform via \( \text{fn2fm} \), this is usually not the case because, outside its basic interval, a piecewise-polynomial is defined by extension of its first or last polynomial piece. In particular, a function in B-form may have jumps in value and/or one of its derivative not only across its interior knots, i.e., across \( t(i) \) with \( t(1)<t(i)<t(n+k) \), but also across its end knots, \( t(1) \) and \( t(n+k) \).

**B-form and B-Splines**

The building blocks for the B-form of a spline are the B-splines. A B-Spline of Order 4, and the Four Cubic Polynomials from Which It Is Made on page 10-18 shows a picture of such a B-spline, the one with the knot sequence \([0 1.5 2.3 4 5]\), hence of order 4, together with the polynomials whose pieces make up the B-spline. The information for that picture could be generated by the command

\( \text{bspline}([0 1.5 2.3 4 5]) \)
A B-Spline of Order 4, and the Four Cubic Polynomials from Which It Is Made

To summarize: The B-spline with knots \( t(i) \leq \cdots \leq t(i+k) \) is positive on the interval \((t(i), t(i+k))\) and is zero outside that interval. It is piecewise-polynomial of order \( k \) with breaks at the sites \( t(i), \ldots, t(i+k) \). These knots may coincide, and the precise multiplicity governs the smoothness with which the two polynomial pieces join there.

**Definition of B-Splines**

The shorthand

\[
f \in S_{k,t}
\]

is one of several ways to indicate that \( f \) is a spline of order \( k \) with knot sequence \( t \), i.e., *a linear combination of the B-splines* of order \( k \) for the knot sequence \( t \).

A word of caution: The term *B-spline* has been expropriated by the Computer-Aided Geometric Design (CAGD) community to mean what is called here a *spline in B-form*, with the unhappy result that, in any discussion between mathematicians/approximation theorists and people in CAGD, one now always has to check in what sense the term is being used.
B-Spline Knot Multiplicity

The rule is

\[
\text{knot multiplicity} + \text{condition multiplicity} = \text{order}
\]

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot Multiplicities

For example, for a B-spline of order 3, a simple knot would mean two smoothness conditions, i.e., continuity of function and first derivative, while a double knot would only leave one smoothness condition, i.e., just continuity, and a triple knot would leave no smoothness condition, i.e., even the function would be discontinuous.

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot Multiplicities on page 10-19 shows a picture of all the third-order B-splines for a certain mystery knot sequence \( t \). The breaks are indicated by vertical lines. For each break, try to determine its multiplicity in the knot sequence (it is 1,2,1,1,3), as well as its multiplicity as a knot in each of the B-splines. For example, the second break has multiplicity 2 but appears only with multiplicity 1 in the third B-spline and not at all, i.e., with multiplicity 0, in the last two B-splines. Note that only one of the B-splines shown has all its knots simple. It is the only one having three different nontrivial polynomial pieces. Note also that you can tell the knot-sequence multiplicity of a knot by the number of B-splines whose nonzero part begins or ends there. The
picture is generated by the following MATLAB statements, which use the command `spcol` from this toolbox to generate the function values of all these B-splines at a fine net \( x \).

\[
t=[0,1,1,3,4,6,6,6]; x=linspace(-1,7,81);
c=spcol(t,3,x);[l,m]=size(c);
c=c+ones(l,1)*[0:m-1];
axis([-1 7 0 m]); hold on
for tt=t, plot([tt tt],[0 m],'--'), end
plot(x,c,'linew',2), hold off, axis off
\]

Further illustrated examples are provided by the example ”Construct and Work with the B-form”. You can also use the GUI `bspligui` to study the dependence of a B-spline on its knots experimentally.

### Choice of Knots for B-form

The rule “knot multiplicity + condition multiplicity = order” has the following consequence for the process of choosing a knot sequence for the B-form of a spline approximant. Suppose the spline \( s \) is to be of order \( k \), with basic interval \([a..b]\), and with interior breaks \( \xi_2 < \cdots < \xi_l \). Suppose, further, that, at \( \xi_i \), the spline is to satisfy \( \mu_i \) smoothness conditions, i.e.,

\[
\text{jump}_{\xi_i} D^j s := D^j s(\xi_{i+}) - D^j s(\xi_{i-}) = 0, \quad 0 \leq j < \mu_i, \quad i = 2, \ldots, l
\]

Then, the appropriate knot sequence \( t \) should contain the break \( \xi_i \) exactly \( k - \mu_i \) times, \( i = 2, \ldots, l \). In addition, it should contain the two endpoints, \( a \) and \( b \), of the basic interval exactly \( k \) times. This last requirement can be relaxed, but has become standard. With this choice, there is exactly one way to write each spline \( s \) with the properties described as a weighted sum of the B-splines of order \( k \) with knots a segment of the knot sequence \( t \). This is the reason for the \( B \) in \( B \)-spline: \( B \)-splines are, in Schoenberg’s terminology, basic splines.

For example, if you want to generate the B-form of a cubic spline on the interval \([1..3]\), with interior breaks 1.5, 1.8, 2.6, and with two continuous derivatives, then the following would be the appropriate knot sequence:

\[
t = [1, 1, 1, 1.5, 1.8, 2.6, 3, 3, 3, 3];
\]
This is supplied by \texttt{augknt([1, 1.5, 1.8, 2.6, 3], 4)}. If you wanted, instead, to allow for a corner at 1.8, i.e., a possible jump in the first derivative there, you would triple the knot 1.8, i.e., use

\[
t = [1, 1, 1, 1.5, 1.8, 1.8, 1.8, 2.6, 3, 3, 3, 3];
\]

and this is provided by the statement

\[
t = \texttt{augknt([1, 1.5, 1.8, 2.6, 3], 4, [1, 3, 1]});
\]
Constructing and Working with B-form Splines

In this section...

“Construction of B-form” on page 10-22
“Working With B-form Splines” on page 10-23
“Example: B-form Spline Approximation to a Circle” on page 10-24

Construction of B-form

Usually, a spline is constructed from some information, like function values and/or derivative values, or as the approximate solution of some ordinary differential equation. But it is also possible to make up a spline from scratch, by providing its knot sequence and its coefficient sequence to the command spmak.

For example, if you enter

```matlab
sp = spmak(1:10,3:8);
```

you supply the uniform knot sequence 1:10 and the coefficient sequence 3:8. Because there are 10 knots and 6 coefficients, the order must be 4 (= 10 – 6), i.e., you get a cubic spline. The command

```matlab
fnbrk(sp)
```

prints out the constituent parts of the B-form of this cubic spline, as follows:

```
knots(1:n+k)
    1 2 3 4 5 6 7 8 9 10
coefficients(d,n)
    3 4 5 6 7 8
number n of coefficients
    6
order k
    4
dimension d of target
    1
```
Further, `fnbrk` can be used to supply each of these parts separately.

But the point of the Curve Fitting Toolbox spline functionality is that there shouldn’t be any need for you to look up these details. You simply use `sp` as an argument to commands that evaluate, differentiate, integrate, convert, or plot the spline whose description is contained in `sp`.

**Working With B-form Splines**

The following commands are available for spline work. There is `spmak` and `fnbrk` to make up a spline and take it apart again. Use `fn2fm` to convert from B-form to ppform. You can evaluate, differentiate, integrate, minimize, find zeros of, plot, refine, or selectively extrapolate a spline with the aid of `fnval`, `fnder`, `fn2dir`, `fnint`, `fnmin`, `fnzeros`, `fnplt`, `fnrbf`, and `fnxtr`.

There are five commands for generating knot sequences:

- `augknt` for providing boundary knots and also controlling the multiplicity of interior knots
- `brk2knt` for supplying a knot sequence with specified multiplicities
- `aptknt` for providing a knot sequence for a spline space of given order that is suitable for interpolation at given data sites
- `optknt` for providing an optimal knot sequence for interpolation at given sites
- `newknt` for a knot sequence perhaps more suitable for the function to be approximated

In addition, there is:

- `aveknt` to supply certain knot averages (the Greville sites) as recommended sites for interpolation
- `chbpnt` to supply such sites
- `knt2brk` and `knt2mlt` for extracting the breaks and/or their multiplicities from a given knot sequence

To display a spline curve with given two-dimensional coefficient sequence and a uniform knot sequence, use `spcrv`.
You can also write your own spline construction commands, in which case you will need to know the following. The construction of a spline satisfying some interpolation or approximation conditions usually requires a collocation matrix, i.e., the matrix that, in each row, contains the sequence of numbers \( D^r B_{j,k}(\tau) \), i.e., the \( r \)th derivative at \( \tau \) of the \( j \)th B-spline, for all \( j \), for some \( r \) and some site \( \tau \). Such a matrix is provided by \texttt{spcol}. An optional argument allows for this matrix to be supplied by \texttt{spcol} in a space-saving spline-almost-block-diagonal-form or as a MATLAB sparse matrix. It can be fed to \texttt{s1vblk}, a command for solving linear systems with an almost-block-diagonal coefficient matrix. If you are interested in seeing how \texttt{spcol} and \texttt{s1vblk} are used in this toolbox, have a look at the commands \texttt{spapi}, \texttt{spap2}, and \texttt{spaps}.

In addition, there are routines for constructing cubic splines. \texttt{csapi} and \texttt{csape} provide the cubic spline interpolant at knots to given data, using the not-a-knot and various other end conditions, respectively. A parametric cubic spline curve through given points is provided by \texttt{cscvn}. The cubic smoothing spline is constructed in \texttt{csaps}.

**Example: B-form Spline Approximation to a Circle**

As another simple example,

```
points = .95*[0 -1 0 1;1 0 -1 0];
sp = spmak(-4:8,[points points]);
```

provides a planar, quartic, spline curve whose middle part is a pretty good approximation to a circle, as the plot on the next page shows. It is generated by a subsequent

```
plot(points(1,:),points(2,:),'x'), hold on
fnplt(sp,[0,4]), axis equal square, hold off
```

Insertion of additional control points \((\pm 0.95, \pm 0.95)/\sqrt{1.9}\) would make a visually perfect circle.

Here are more details. The spline curve generated has the form \( \sum_{j=1}^{8} B_{j,5}(\cdot, j) \), with \(-4:8\) the uniform knot sequence, and with its control points \( a(:,j) \) the sequence \((0,a),(-\alpha,0),(0,-\alpha),(a,0),(0,a),(-\alpha,0),(0,-\alpha),(a,0)\) with \( \alpha=0.95 \). Only the curve part between the parameter values 0 and 4 is actually plotted.
To get a feeling for how close to circular this part of the curve actually is, compute its unsigned curvature. The curvature $\kappa(t)$ at the curve point $\gamma(t) = (x(t), y(t))$ of a space curve $\gamma$ can be computed from the formula

$$\kappa = \frac{|x'y'' - y'x''|}{(x'^2 + y'^2)^{3/2}}$$

in which $x'$, $x''$, $y'$, and $y''$ are the first and second derivatives of the curve with respect to the parameter used ($t$). Treat the planar curve as a space curve in the $(x,y)$-plane, hence obtain the maximum and minimum of its curvature at 21 points as follows:

```matlab
t = linspace(0,4,21);zt = zeros(size(t));
dsp = fnder(sp); dspt = fnval(dsp,t); ddspt = fnval(fnder(dsp),t);
kappa = abs(dspt(1,:).*ddspt(2,:)-dspt(2,:).*ddspt(1,:))./...  
     (sum(dspt.^2)).^(3/2);
[min(kappa),max(kappa)]
```

ans =

```
  1.6747   1.8611
```

So, while the curvature is not quite constant, it is close to $1$/radius of the circle, as you see from the next calculation:

$$1/norm(fnval(sp,0))$$

ans =

```
  1.7864
```
Spline Approximation to a Circle; Control Points Are Marked $x$
Multivariate Tensor Product Splines

In this section...

“Introduction to Multivariate Tensor Product Splines” on page 10-27
“B-form of Tensor Product Splines” on page 10-27
“Construction With Gridded Data” on page 10-28
“ppform of Tensor Product Splines” on page 10-28
“Example: The Mobius Band” on page 10-28

Introduction to Multivariate Tensor Product Splines

The toolbox provides (polynomial) spline functions in any number of variables, as tensor products of univariate splines. These multivariate splines come in both standard forms, the B-form and the ppform, and their construction and use parallels entirely that of the univariate splines discussed in previous sections, “Constructing and Working with ppform Splines” on page 10-12 and “Constructing and Working with B-form Splines” on page 10-22. The same commands are used for their construction and use.

For simplicity, the following discussion deals just with bivariate splines.

B-form of Tensor Product Splines

The tensor-product idea is very simple. If \( f \) is a function of \( x \), and \( g \) is a function of \( y \), then their tensor-product \( p(x,y) = f(x)g(y) \) is a function of \( x \) and \( y \), i.e., a bivariate function. More generally, with \( s=(s_1,...,s_{m+h}) \) and \( t=(t_1,...,t_{n+k}) \) knot sequences and \( a_{ij};i=1,...,m;j=1,...,n \) a corresponding coefficient array, you obtain a bivariate spline as

\[
f(x,y) = \sum_{i=1}^{m} \sum_{j=1}^{n} B(x \mid s_i,...,s_{i+h}) B(y \mid t_j,...,t_{j+k}) a_{ij}
\]

The B-form of this spline comprises the cell array \([s,t]\) of its knot sequences, the coefficient array \( a \), the numbers vector \([m,n]\), and the orders vector \([h,k]\). The command
sp = spmak({s,t},a);

constructs this form. Further, fnplt, fnval, fnder, fndir, fnrfn, and fn2fm can be used to plot, evaluate, differentiate and integrate, refine, and convert this form.

**Construction With Gridded Data**
You are most likely to construct such a form by looking for an interpolant or approximant to gridded data. For example, if you know the values \( z(i,j) = g(x(i),y(j)), i=1:m, j=1:n \), of some function \( g \) at all the points in a rectangular grid, then, assuming that the strictly increasing sequence \( x \) satisfies the Schoenberg-Whitney conditions with respect to the above knot sequence \( s \), and that the strictly increasing sequence \( y \) satisfies the Schoenberg-Whitney conditions with respect to the above knot sequence \( t \), the command

\[
sp = spapi({s,t},[h,k],{x,y},z);
\]

constructs the unique bivariate spline of the above form that matches the given values. The command \( \text{fnplt}(sp) \) gives you a quick plot of this interpolant. The command \( \text{pp} = \text{fn2fm}(sp,'pp') \) gives you the ppform of this spline, which is probably what you want when you want to evaluate the spline at a fine grid \((xx(i),yy(j))\) for \( i=1:M, j=1:N \), by the command:

\[
\text{values} = \text{fnval}(pp,{xx,yy});
\]

**ppform of Tensor Product Splines**
The ppform of such a bivariate spline comprises, analogously, a cell array of break sequences, a multidimensional coefficient array, a vector of number pieces, and a vector of polynomial orders. Fortunately, the toolbox is set up in such a way that there is usually no reason for you to concern yourself with these details of either form. You use interpolation, approximation, or smoothing to construct splines, and then use the \( \text{fn...} \) commands to make use of them.

**Example: The Mobius Band**
Here is an example of a surface constructed as a 3-D-valued bivariate spline. The surface is the famous Möbius band, obtainable by taking a longish strip
of paper and gluing its narrow ends together, but with a twist. The figure is obtained by the following commands:

\[
x = 0:1; \quad y = 0:4; \quad h = 1/4; \quad \alpha_2 = 1/\sqrt{2}; \quad s = 2; \quad ss = 4;
\]
\[
v(3,:,:), v(2,:,:), v(1,:,:) = h*[0, -1, -\alpha_2, 0, \alpha_2, 1, 0; 0, 1, \alpha_2, 0, -\alpha_2, -1, 0];
\]
\[
v(1,:,:), v(2,:,:), v(1,:,:) = s*[0, 1, 0, -1+h, 0, 1, 0; 0, 1, 0, -1-h, 0, 1, 0];
\]
\[
cs = csape({x,y},v,\{'variational','clamped'\});
\]
\[
fnplt(cs), axis([-2 2 -2.5 2.5 -.5 .5]), shading interp
axis off, hold on
\]
\[
values = squeeze(fnval(cs,\{1, linspace(y(1),y(end),51)}));
\]
\[
plot3(values(1,:), values(2,:), values(3,:),'k','linew',2)
view(-149,28), hold off
\]
NURBS and Other Rational Splines

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Introduction to Rational Splines” on page 10-30</td>
</tr>
<tr>
<td>“rsform: rpform, rBform” on page 10-30</td>
</tr>
</tbody>
</table>

Introduction to Rational Splines

A rational spline is, by definition, any function that is the ratio of two splines:

\[ r(x) = \frac{s(x)}{w(x)} \]

This requires \( w \) to be scalar-valued, but \( s \) is often chosen to be vector-valued. Further, it is desirable that \( w(x) \) be not zero for any \( x \) of interest.

Rational splines are popular because, in contrast to ordinary splines, they can be used to describe certain basic design shapes, like conic sections, exactly.

rsform: rpform, rBform

The two splines, \( s \) and \( w \), in the rational spline \( r(x)=s(x)/w(x) \) need not be related to one another. They could even be of different forms. But, in the context of this toolbox, it is convenient to restrict them to be of the same form, and even of the same order and with the same breaks or knots. For, under that assumption, you can represent such a rational spline by the (vector-valued) spline function

\[ R(x) = \begin{bmatrix} s(x); w(x) \end{bmatrix} \]

whose values are vectors with one more entry than the values of the rational spline \( r \), and call this the \textit{rsform} of the rational spline, or, more precisely, the \textit{rpform} or \textit{rBform}, depending on whether \( s \) and \( w \) are in ppform or in B-form. Internally, the only thing that distinguishes these rational forms from their corresponding ordinary spline forms, rpform and B-form, is their form part, i.e., the string obtained via \texttt{fnbrk(r,'form')}. This is enough to alert the \texttt{fn...} commands to act appropriately on a function in one of the rsforms.
For example, as is done in \texttt{fnval}, it is very easy to obtain \( r(x) \) from \( R(x) \). If \( v \) is the value of \( R \) at \( x \), then \( v(1:end-1)/v(end) \) is the value of \( r \) at \( x \). If, in addition, \( dv \) is \( DR(x) \), then \( (dv(1:end-1)-dv(end)*v(1:end-1))/v(end) \) is \( Dr(x) \). More generally, by Leibniz’s formula,

\[
D^j s = D^j (wr) = \sum_{i=0}^{j} \binom{j}{i} D^i w D^{j-i} r
\]

Therefore,

\[
D^j r = \left( D^j s - \sum_{i=1}^{j} \binom{j}{i} D^i w D^{j-i} r \right) / w
\]

This shows that you can compute the derivatives of \( r \) inductively, using the derivatives of \( s \) and \( w \) (i.e., the derivatives of \( R \)) along with the derivatives of \( r \) of order less than \( j \) to compute the \( j \)th derivative of \( r \). This inductive scheme is used in \texttt{fnt1r} to provide the first so many derivatives of a rational spline. There is a corresponding formula for partial and directional derivatives for multivariate rational splines.
Constructing and Working with Rational Splines

In this section...

| “Rational Spline Example: Circle” on page 10-32 |
| “Rational Spline Example: Sphere” on page 10-33 |
| “Functions for Working With Rational Splines” on page 10-34 |

Rational Spline Example: Circle

For example,

circle = rsmak('circle');

provides a rational spline whose values on its basic interval trace out the unit circle, i.e., the circle of radius 1 with center at the origin, as the command

fnplt(circle), axis square

readily shows; the resulting output is the circle in the figure A Circle and an Ellipse, Both Given by a Rational Spline on page 10-33.

It is easy to manipulate this circle to obtain related shapes. For example, the next commands stretch the circle into an ellipse, rotate the ellipse 45 degrees, and translate it by (1,1), and then plot it on top of the circle.

ellipse = fncmb(circle, [2 0;0 1]);
s45 = 1/sqrt(2);
rtellipse = fncmb(fncmb(ellipse, [s45 -s45;s45 s45]), [1;1] );
hold on, fnplt(rtellipse), hold off

As a further example, the "circle" just constructed is put together from four pieces. To highlight the first such piece, use the following commands:

quarter = fnbrk(fn2fm(circle,'rp'),1);
hold on, fnplt(quarter,3), hold off

In the first command, fn2fm is used to change forms, from one based on the B-form to one based on the ppform, and then fnbrk is used to extract the first piece, and this piece is then plotted on top of the circle in A Circle and
an Ellipse, Both Given by a Rational Spline on page 10-33, with linewidth 3 to make it stand out.

![Ellipse and Circle](image)

**A Circle and an Ellipse, Both Given by a Rational Spline**

**Rational Spline Example: Sphere**

As a surface example, the command `rsmak('southcap')` provides a 3-vector valued rational bicubic polynomial whose values on the unit square \([-1 .. 1]^2\] fill out a piece of the unit sphere. Adjoin to it five suitable rotates of it and you get the unit sphere exactly. For illustration, the following commands generate two-thirds of that sphere, as shown in Part of a Sphere Formed by Four Rotates of a Quartic Rational on page 10-34.

```matlab
southcap = rsmak('southcap'); fnplt(southcap)
xpcap = fncmb(southcap,[0 0 -1;0 1 0;1 0 0]);
ypcap = fncmb(xpcap,[0 -1 0; 1 0 0; 0 0 1]);
northcap = fncmb(southcap,-1);
hold on, fnplt(xpcap), fnplt(ypcap), fnplt(northcap)
axis equal, shading interp, view(-115,10), axis off, hold off
```

10-33
Part of a Sphere Formed by Four Rotates of a Quartic Rational

Functions for Working With Rational Splines

Having chosen to represent the rational spline \( r = s/w \) in this way by the ordinary spline \( R=[s;w] \) makes it easy to apply to a rational spline all the `fn...` commands in the Curve Fitting Toolbox spline functions, with the following exceptions. The integral of a rational spline need not be a rational spline, hence there is no way to extend `fnint` to rational splines. The derivative of a rational spline is again a rational spline but one of roughly twice the order. For that reason, `fnder` and `fndir` will not touch rational splines. Instead, there is the command `fntlr` for computing the value at a given \( x \) of all derivatives up to a given order of a given function. If that function is rational, the needed calculation is based on the considerations given in the preceding paragraph.

The command \( r = rsmak(\text{shape}) \) provides rational splines in rBform that describe exactly certain standard geometric shapes, like 'circle', 'arc', 'cylinder', 'sphere', 'cone', 'torus'. The command `fncomb(r,trans)` can be used to apply standard transformations to the resulting shape. For example, if `trans` is a column-vector of the right length, the shape would be translated by that vector while, if `trans` is a suitable matrix like a rotation, the shape would be transformed by that matrix.

The command \( r = rscvn(p) \) constructs the quadratic rBform of a tangent-continuous curve made up of circular arcs and passing through the given sequence, \( p \), of points in the plane.
A special rational spline form, called a NURBS, has become a standard tool in CAGD. A NURBS is, by definition, any rational spline for which both $s$ and $w$ are in the same B-form, with each coefficient for $s$ containing explicitly the corresponding coefficient for $w$ as a factor:

$$s = \sum_i B_i v(i) a(:,i), \quad w = \sum_i B_i v(i)$$

The normalized coefficients $a(:,i)$ for the numerator spline are more readily used as control points than the unnormalized coefficients $v(i) a(:,i)$ used in the rBform. Nevertheless, this toolbox provides no special NURBS form, but only the more general rational spline, but in both B-form (called rBform internally) and in ppform (called rpform internally).

The rational spline circle used earlier is put together in rsmak by code like the following.

```matlab
x = [1 1 0 -1 -1 0 1 1]; y = [0 1 1 1 0 -1 -1 -1 0];
s45 = 1/sqrt(2); w = [1 s45 1 s45 1 s45 1 s45 1];
circle = rsmak(augknt(0:4,3,2), [w.*x;w.*y;w]);
```

Note the appearance of the denominator spline as the last component. Also note how the coefficients of the denominator spline appear here explicitly as factors of the corresponding coefficients of the numerator spline. The normalized coefficient sequence $[x;y]$ is very simple; it consists of the vertices and midpoints, in proper order, of the "unit square". The resulting control polygon is tangent to the circle at the places where the four quadratic pieces that form the circle abut.

Constructing and Working with stform Splines

In this section...

“Introduction to the stform” on page 10-36
“Construction and Properties of the stform” on page 10-37
“Working with the stform” on page 10-38

Introduction to the stform

A multivariate function form quite different from the tensor-product construct is the scattered translates form, or stform for short. As the name suggests, it uses arbitrary or scattered translates $\psi(\cdot - c_j)$ of one fixed function $\psi$, in addition to some polynomial terms. Explicitly, such a form describes a function

$$f(x) = \sum_{j=1}^{n-k} \psi(x - c_j) a_j + p(x)$$

in terms of the basis function $\psi$, a sequence $(c)$ of sites called centers and a corresponding sequence $(a_j)$ of $n$ coefficients, with the final $k$ coefficients, $a_{n-k+1}, \ldots, a_n$, involved in the polynomial part, $p$.

When the basis function is radially symmetric, meaning that $\psi(x)$ depends only on the Euclidean length $|x|$ of its argument, $x$, then $\psi$ is called a radial basis function, and, correspondingly, $f$ is then often called an RBF.

At present, the toolbox works with just one kind of stform, namely a bivariate thin-plate spline and its first partial derivatives. For the thin-plate spline, the basis function is $\psi(x) = \varphi(|x|^2)$, with $\varphi(t) = t \log t$, i.e., a radial basis function. Its polynomial part is a linear polynomial, i.e., $p(x) = x(1) a_{n-2} + x(2) a_n - 1 + a_n$. The first partial derivative with respect to its first argument uses, correspondingly, the basis function $\psi(x) = \varphi(|x|^2)$, with $\varphi(t) = (D_1 t) (\log t + 1)$ and $D_1 t = D_1 t(x) = 2x(1)$, and $p(x) = a_n$. 

Construction and Properties of the stform

A function in stform can be put together from its center sequence `centers` and its coefficient sequence `coefs` by the command

\[
f = \text{stmak}(\text{centers, coefs, type});
\]

with the string `type` one of `'tp00'`, `'tp10'`, `'tp01'`, to indicate, respectively, a thin-plate spline, a first partial of a thin-plate spline with respect to the first argument, and a first partial of a thin-plate spline with respect to the second argument. There is one other choice, `'tp'`; it denotes a thin-plate spline without any polynomial part and is likely to be used only during the construction of a thin-plate spline, as in `tpaps`.

A function \( f \) in stform depends linearly on its coefficients, meaning that

\[
f(x) = \sum_{j=1}^{n} \psi_j(x) a_j
\]

with \( \psi_j \) either a translate of the basis function \( \Psi \) or else some polynomial. Suppose you wanted to determine these coefficients \( a_j \) so that the function \( f \) matches prescribed values at prescribed sites \( x_i \). Then you would need the collocation matrix \( (\psi_j(x_i)) \). You can obtain this matrix by the command `stcol(centers, x, type)`. In fact, because the stform has \( a_j \) as the \( j \)th column, \( \text{coefs}(:,j) \), of its coefficient array, it is worth noting that `stcol` can also supply the transpose of the collocation matrix. Thus, the command

\[
\text{values} = \text{coefs*stcol(centers, x, type, 'tr');}
\]

would provide the values at the entries of \( x \) of the st function specified by \( \text{centers and type} \).

The stform is attractive because, in contrast to piecewise polynomial forms, its complexity is the same in any number of variables. It is quite simple, yet, because of the complete freedom in the choice of centers, very flexible and adaptable.

On the negative side, the most attractive choices for a radial basis function share with the thin-plate spline that the evaluation at any site involves all coefficients. For example, plotting a scalar-valued thin-plate spline via
fnplt involves evaluation at a 51-by-51 grid of sites, a nontrivial task when there are 1000 coefficients or more. The situation is worse when you want to determine these 1000 coefficients so as to obtain the stform of a function that matches function values at 1000 data sites, as this calls for solving a full linear system of order 1000, a task requiring $O(10^9)$ flops if done by a direct method. Just the construction of the collocation matrix for this linear system (by stcol) takes $O(10^6)$ flops.

The command tpaps, which constructs thin-plate spline interpolants and approximants, uses iterative methods when there are more than 728 data points, but convergence of such iteration may be slow.

**Working with the stform**

After you have constructed an approximating or interpolating thin-plate spline st with the aid of tpaps (or directly via stmak), you can use the following commands:

- fnbrk to obtain its parts or change its basic interval,
- fnval to evaluate it
- fnplt to plot it
- fnnder to construct its two first partial derivatives, but no higher order derivatives as they become infinite at the centers.

This is just one indication that the stform is quite different in nature from the other forms in this toolbox, hence other fn... commands by and large don’t work with stforms. For example, it makes no sense to use fnjmp, and fnmin or fnzeros only work for univariate functions. It also makes no sense to use fnint on a function in stform because such functions cannot be integrated in closed form.

- The command Ast = fncmb(st,A) can be used on st, provided A is something that can be applied to the values of the function described by st. For example, A might be 'sin', in which case Ast is the stform of the function whose coefficients are the sine of the coefficients of st. In effect, Ast describes the function obtained by composing A with st. But, because of the singularities in the higher-order derivatives of a thin-plate spline, there seems little point to make fndir or fntlr applicable to such a st.
Advanced Spline Examples

- “Least-Squares Approximation by Natural Cubic Splines” on page 11-2
- “Solving A Nonlinear ODE” on page 11-8
- “Construction of the Chebyshev Spline” on page 11-14
- “Approximation by Tensor Product Splines” on page 11-20
Least-Squares Approximation by Natural Cubic Splines

The construction of a least-squares approximant usually requires that one have in hand a basis for the space from which the data are to be approximated. As the example of the space of “natural” cubic splines illustrates, the explicit construction of a basis is not always straightforward.

This section makes clear that an explicit basis is not actually needed; it is sufficient to have available some means of interpolating in some fashion from the space of approximants. For this, the fact that the Curve Fitting Toolbox spline functions support work with vector-valued functions is essential.

This section discusses these aspects of least-squares approximation by “natural” cubic splines.

- “Problem” on page 11-2
- “General Resolution” on page 11-2
- “Need for a Basis Map” on page 11-3
- “A Basis Map for “Natural” Cubic Splines” on page 11-3
- “The One-line Solution” on page 11-4
- “The Need for Proper Extrapolation” on page 11-4
- “The Correct One-Line Solution” on page 11-6
- “Least-Squares Approximation by Cubic Splines” on page 11-7

Problem

You want to construct the least-squares approximation to given data \((x,y)\) from the space \(S\) of “natural” cubic splines with given breaks \(b(1) < \ldots < b(l+1)\).

General Resolution

If you know a basis, \((f_1,f_2,\ldots,f_m)\), for the linear space \(S\) of all “natural” cubic splines with break sequence \(b\), then you have learned to find the least-squares approximation in the form \(c_0 f_1 + c_1 f_2 + \ldots + c_m f_m\), with the vector \(c\) the least-squares solution to the linear system \(A*c = y\), whose coefficient matrix is given by
A(i,j) = f_j(x(i)), \quad i=1:length(x), \quad j=1:m.

In other words, c = A\ y.

**Need for a Basis Map**

The general solution seems to require that you know a basis. However, in order to construct the coefficient sequence c, you only need to know the matrix A. For this, it is sufficient to have at hand a basis map, namely a function F say, so that F(c) returns the spline given by the particular weighted sum c(1)f_1 + c(2)f_2 + ... + c(m)f_m. For, with that, you can obtain, for j=1:m, the j-th column of A as fnval(F(e_j),x), with e_j the j-th column of eye(m), the identity matrix of order m.

Better yet, the Curve Fitting Toolbox spline functions can handle vector-valued functions, so you should be able to construct the basis map F to handle vector-valued coefficients c(i) as well. However, by agreement, in this toolbox, a vector-valued coefficient is a column vector, hence the sequence c is necessarily a row vector of column vectors, i.e., a matrix. With that, F(eye(m)) is the vector-valued spline whose i-th component is the basis element f_i, \quad i=1:m. Hence, assuming the vector x of data sites to be a row vector, fnval(F(eye(m)),x) is the matrix whose (i,j)-entry is the value of f_i at x(j), i.e., the transpose of the matrix A you are seeking. On the other hand, as just pointed out, your basis map F expects the coefficient sequence c to be a row vector, i.e., the transpose of the vector A\ y. Hence, assuming, correspondingly, the vector y of data values to be a row vector, you can obtain the least-squares approximation from S to data (x,y) as

F(y/fnval(F(eye(m)),x))

To be sure, if you wanted to be prepared for x and y to be arbitrary vectors (of the same length), you would use instead

F(y(:).'/fnval(F(eye(m)),x(:).'))

**A Basis Map for “Natural” Cubic Splines**

What exactly is required of a basis map F for the linear space S of “natural” cubic splines with break sequence b(1) < ... < b(1+1)? Assuming the dimension of this linear space is m, the map F should set up a linear one-to-one
correspondence between m-vectors and elements of S. But that is exactly what \texttt{csape(b, . , 'var')} does.

To be explicit, consider the following function \texttt{F}:

\begin{verbatim}
function s = F(c)
s = csape(b,c,'var');
\end{verbatim}

For given vector \texttt{c} (of the same length as \texttt{b}), it provides the \textit{unique} “natural” cubic spline with break sequence \texttt{b} that takes the value \texttt{c(i)} at \texttt{b(i)}, \(i=1:1+1\). The uniqueness is key. It ensures that the correspondence between the vector \texttt{c} and the resulting spline \texttt{F(c)} is one-to-one. In particular, \(m = \text{length(b)}\). More than that, because the value \(f(t)\) of a function \texttt{f} at a point \(t\) depends linearly on \(f\), this uniqueness ensures that \(F(c)\) depends linearly on \texttt{c} (because \texttt{c equals fnval(F(c),b)} and the inverse of an invertible linear map is again a linear map).

\section*{The One-line Solution}

Putting it all together, you arrive at the following code

\begin{verbatim}
csape(b,y(:).'/fnval(csape(b,eye(length(b)),'var'),x(:).'),...
'var')
\end{verbatim}

for the least-squares approximation by “natural” cubic splines with break sequence \texttt{b}.

\section*{The Need for Proper Extrapolation}

Let’s try it on some data, the census data, say, which is provided in MATLAB by the command

\begin{verbatim}
load census
\end{verbatim}

and which supplies the years, 1790:10:1990, as \texttt{cdate} and the values as \texttt{pop}. Use the break sequence 1810:40:1970.

\begin{verbatim}
b = 1810:40:1970;
s = csape(b, ... 
pop(:)'/fnval(csape(b,eye(length(b))),'var'),cdate(:)'),'var');
fnplt(s, [1750,2050],2.2);
\end{verbatim}
hold on
plot(cdate,pop,'or');
hold off

Have a look at Least-Squares Approximation by “Natural” Cubic Splines With Three Interior Breaks on page 11-6 which shows, in thick blue, the resulting approximation, along with the given data.

This looks like a good approximation, -- except that it doesn’t look like a “natural” cubic spline. A “natural” cubic spline, to recall, must be linear to the left of its first break and to the right of its last break, and this approximation satisfies neither condition. This is due to the following facts.

The “natural” cubic spline interpolant to given data is provided by csape in ppform, with the interval spanned by the data sites its basic interval. On the other hand, evaluation of a ppform outside its basic interval is done, in MATLAB ppval or Curve Fitting Toolbox spline function fnval, by using the relevant polynomial end piece of the ppform, i.e., by full-order extrapolation. In case of a “natural” cubic spline, you want instead second-order extrapolation. This means that you want, to the left of the first break, the straight line that agrees with the cubic spline in value and slope at the first break. Such an extrapolation is provided by fnxtr. Because the “natural” cubic spline has zero second derivative at its first break, such an extrapolation is even third-order, i.e., it satisfies three matching conditions. In the same way, beyond the last break of the cubic spline, you want the straight line that agrees with the spline in value and slope at the last break, and this, too, is supplied by fnxtr.
Least-Squares Approximation by “Natural” Cubic Splines With Three Interior Breaks

The Correct One-Line Solution
The following one-line code provides the correct least-squares approximation to data \((x, y)\) by “natural” cubic splines with break sequence \(b\):

\[
\text{fnxtr}(\text{csape}(b, y(:))'/ \ldots \text{fnval}(\text{fnxtr}(\text{csape}(b, \text{eye(length(b))}, 'var'))\text{,} x(:)'\text{,} 'var'))
\]

But it is, admittedly, a rather long line.

The following code uses this correct formula and plots, in a thinner, red line, the resulting approximation on top of the earlier plots, as shown in Least-Squares Approximation by “Natural” Cubic Splines With Three Interior Breaks on page 11-6.

\[
\text{ss} = \text{fnxtr}(\text{csape}(b, \text{pop}(:))'/ \ldots \text{fnval}(\text{fnxtr}(\text{csape}(b, \text{eye(length(b))}, 'var'))\text{,} \text{cdate}(:)'\text{,} 'var')) \text{hold on, fnplt(ss,[1750,2050],1.2,'r'),grid, hold off legend('incorrect approximation','population','correct approximation')}
\]
Least-Squares Approximation by Cubic Splines

The one-line solution works perfectly if you want to approximate by the space $S$ of all cubic splines with the given break sequence $b$. You don’t even have to use the Curve Fitting Toolbox spline functions for this because you can rely on the MATLAB `spline`. You know that, with $c$ a sequence containing two more entries than does $b$, `spline(b,c)` provides the unique cubic spline with break sequence $b$ that takes the value $c(i+1)$ at $b(i)$, all $i$, and takes the slope $c(1)$ at $b(1)$, and the slope $c(\text{end})$ at $b(\text{end})$. Hence, `spline(b,:)` is a basis map for $S$.

More than that, you know that `spline(b,c,xi)` provides the value(s) at $xi$ of this interpolating spline. Finally, you know that `spline` can handle vector-valued data. Therefore, the following one-line code constructs the least-squares approximation by cubic splines with break sequence $b$ to data $(x,y)$:

`spline(b,y(:)'/spline(b,eye(length(b)),x(:)'))`
Solving A Nonlinear ODE

This section discusses these aspects of a nonlinear ODE problem:

- “Problem” on page 11-8
- “Approximation Space” on page 11-8
- “Discretization” on page 11-9
- “Numerical Problem” on page 11-9
- “Linearization” on page 11-10
- “Linear System to Be Solved” on page 11-10
- “Iteration” on page 11-11

You can run this example: “Solving a Nonlinear ODE with a Boundary Layer by Collocation”.

Problem

Consider the nonlinear singularly perturbed problem:

\[ \varepsilon D^2 g(x) + (g(x))^2 = 1 \quad \text{on} \quad [0..1] \]

\[ Dg(0) = g(1) = 0 \]

Approximation Space

Seek an approximate solution by collocation from \( C^1 \) piecewise cubics with a suitable break sequence; for instance,

\[ \text{breaks} = (0:4)/4; \]

Because cubics are of order 4, you have

\[ k = 4; \]

Obtain the corresponding knot sequence as
knots = augknt(breaks,k,2);

This gives a quadruple knot at both 0 and 1, which is consistent with the fact that you have cubics, i.e., have order 4.

This implies that you have

\[ n = \text{length}(\text{knots}) - k; \]
\[ n = 10; \]

i.e., 10 degrees of freedom.

**Discretization**

You collocate at two sites per polynomial piece, i.e., at eight sites altogether. This, together with the two side conditions, gives us 10 conditions, which matches the 10 degrees of freedom.

Choose the two Gaussian sites for each interval. For the *standard* interval \([-0.5,0.5]\) of length 1, these are the two sites

\[ \text{gauss} = 0.5773502692\times[-1/2; 1/2]; \]

From this, you obtain the whole collection of collocation sites by

\[ \text{ninterv} = \text{length}(\text{breaks}) - 1; \]
\[ \text{temp} = ((\text{breaks}(2:\text{ninterv}+1)+\text{breaks}(1:\text{ninterv}))/2); \]
\[ \text{temp} = \text{temp}([1 1],:) + \text{gauss} \times \text{diff}(\text{breaks}); \]
\[ \text{colsites} = \text{temp}(::).'; \]

**Numerical Problem**

With this, the numerical problem you want to solve is to find \( y \in S_{4,\text{knots}} \) that satisfies the nonlinear system

\[
Dy(0) = 0 \\
(y(x))^2 + \varepsilon D^2 y(x) = 1 \text{ for } x \in \text{colsites} \\
y(1) = 0
\]
Linearization
If \( y \) is your current approximation to the solution, then the linear problem for the supposedly better solution \( z \) by Newton’s method reads

\[
Dz(0) = 0 \\
w_0(x)z(x) + \varepsilon D^2z(x) = b(x) \quad \text{for } x \in \text{colsites} \\
z(1)=0
\]

with \( w_0(x) = 2y(x), b(x) = (y(x))^2 + 1 \). In fact, by choosing

\[
w_0(1) := 1, \quad w_1(0) := 1 \\
w_1(x) := 0, \quad w_2(x) := \varepsilon \quad \text{for } x \in \text{colsites}
\]

and choosing all other values of \( w_0, w_1, w_2, b \) not yet specified to be zero, you can give your system the uniform shape

\[
w_0(x)z(x) + w_1(x)Dz(x) + w_2(x)D^2z(x) = b(x), \quad \text{for } x \in \text{sites}
\]

with

\[
sites = [0,\text{colsites},1];
\]

Linear System to Be Solved
Because \( z \in \mathcal{S}_{4,K} \), convert this last system into a system for the B-spline coefficients of \( z \). This requires the values, first, and second derivatives at every \( x \in \text{sites} \) and for all the relevant B-splines. The command \texttt{spcol} was expressly written for this purpose.

Use \texttt{spcol} to supply the matrix

\[
colmat = ... \\
spcol(knots,k,brk2knt(sites,3));
\]

From this, you get the collocation matrix by combining the row triple of \texttt{colmat} for \( x \) using the weights \( w_0(x), w_1(x), w_2(x) \) to get the row for \( x \) of the actual matrix. For this, you need a current approximation \( y \). Initially, you get it by interpolating some reasonable initial guess from your piecewise-polynomial
Solving A Nonlinear ODE

space at the sites. Use the parabola \( x^2 - 1 \), which satisfies the end conditions as the initial guess, and pick the matrix from the full matrix \( \text{colmat} \). Here it is, in several cautious steps:

\[
\begin{align*}
\text{intmat} &= \text{colmat}([2 \ 1+(1:(n-2))*3,1+(n-1)*3],:); \\
\text{coefs} &= \text{intmat}\{0 \ \text{colsites}.*\text{colsites}-1 \ 0\}.'; \\
\text{y} &= \text{spmak}(\text{knots},\text{coefs}.');
\end{align*}
\]

Plot the initial guess, and turn hold on for subsequent plotting:

\[
\begin{align*}
\text{fnplt}(\text{y},'g'); \\
\text{legend('Initial Guess } (x^2-1)' , 'location', 'NW'); \\
\text{axis([-0.01 1.01 -1.01 0.01]);}
\end{align*}
\]

\textbf{Iteration}

You can now complete the construction and solution of the linear system for the improved approximate solution \( z \) from your current guess \( y \). In fact, with the initial guess \( y \) available, you now set up an iteration, to be terminated when the change \( z - y \) is \textit{small enough}. Choose a relatively mild \( \varepsilon = .1 \).

\[
\begin{align*}
tolerance &= 6.e-9; \\
epsilon &= .1; \\
\text{while 1} \\
\quad \text{vtau} &= \text{fnval}(\text{y},\text{colsites}); \\
\quad \text{weights} = [0 \ 1 \ 0; \\
\quad &\quad [2*\text{vtau}.' \ \text{zeros(n-2,1)} \ \text{repmat(epsilon,n-2,1)];} \\
\quad &\quad 1 \ 0 \ 0]; \\
\quad \text{colloc} &= \text{zeros(n,n)}; \\
\quad \text{for } j=1:n \\
\quad \quad \text{colloc}(j,:) &= \text{weights}(j,:)*\text{colmat}(3*(j-1)+(1:3),:); \\
\quad \text{end} \\
\quad \text{coefs} &= \text{colloc}\{0 \ \text{vtau}.*\text{vtau}+1 \ 0\}.'; \\
\quad \text{z} &= \text{spmak}(\text{knots},\text{coefs}.'); \\
\quad \text{fnplt}(\text{z},'k'); \\
\quad \text{maxdif} &= \max(\max(\abs(\text{z.coefs}-\text{y.coefs})))); \\
\quad \text{fprintf('maxdif = %g\n',maxdif) \\
\quad if (maxdif<\text{tolerance}), break, end} \\
\quad \% \text{now reiterate} \\
\quad \text{y} &= \text{z};
\end{align*}
\]
end
legend({'Initial Guess (x^2-1)' 'Iterates'},'location','NW');

The resulting printout of the errors is:

maxdif = 0.206695
maxdif = 0.01207
maxdif = 3.95151e-005
maxdif = 4.43216e-010

If you now decrease $\varepsilon$, you create more of a boundary layer near the right endpoint, and this calls for a nonuniform mesh.

Use `newknt` to construct an appropriate finer mesh from the current approximation:

```
knots = newknt(z, ninterv+1); breaks = knt2brk(knots);
knots = augknt(breaks,4,2);
n = length(knots)-k;
```

From the new break sequence, you generate the new collocation site sequence:

```
ninterv = length(breaks)-1;
temp = ((breaks(2:ninterv+1)+breaks(1:ninterv))/2);
temp = temp([1 1], :) + gauss*diff(breaks);
colpnts = temp(:,);
sites = [0,colpnts,1];
```

Use `spcol` to supply the matrix

```
colmat = spcol(knots,k,sort([sites sites sites]));
```

and use your current approximate solution $z$ as the initial guess:

```
intmat = colmat([2 1+(1:(n-2))*3,1+(n-1)*3,:]);
y = spmak(knots,[0 fnval(z,colpnts) 0]/intmat.');
```

Thus set up, divide $\varepsilon$ by 3 and repeat the earlier calculation, starting with the statements

```
tolerance=1.e-9;
while 1
```
vtau=fnval(y,colpnts);

Repeated passes through this process generate a sequence of solutions, for $\varepsilon = 1/10, 1/30, 1/90, 1/270, 1/810$. The resulting solutions, ever flatter at 0 and ever steeper at 1, are shown in the example plot. The plot also shows the final break sequence, as a sequence of vertical bars. To view the plots, run the example “Solving a Nonlinear ODE with a Boundary Layer by Collocation”.

In this example, at least, newknt has performed satisfactorily.
**Construction of the Chebyshev Spline**

This section discusses these aspects of the Chebyshev spline construction:

- “What Is a Chebyshev Spline?” on page 11-14
- “Choice of Spline Space” on page 11-14
- “Initial Guess” on page 11-15
- “Remez Iteration” on page 11-16

**What Is a Chebyshev Spline?**

The *Chebyshev spline* \( C = Ct \in C_{k,t} \) of order \( k \) for the knot sequence \( t = (t_i; i=1:n+k) \) is the unique element of \( S_{k,t} \) of max-norm 1 that maximally oscillates on the interval \([t_k..t_{n+1}]\) and is positive near \( t_{n+1} \). This means that there is a unique strictly increasing \( n \)-sequence \( \tau \) so that the function \( C = Ct \in C_{k,t} \) given by \( C(\tau) = (-1)^{n-1} \), all \( i \), has max-norm 1 on \([t_k..t_{n+1}]\). This implies that \( \tau_i = t_k, t_n = t_{n+1}, \) and that \( t_i < \tau_i < t_{k+i} \), for all \( i \). In fact, \( t_{i+1} \leq \tau_i \leq t_{i+k-1} \), all \( i \). This brings up the point that the knot sequence is assumed to make such an inequality possible, i.e., the elements of \( S_{k,t} \) are assumed to be continuous.

In short, the Chebyshev spline \( C \) looks just like the Chebyshev polynomial. It performs similar functions. For example, its extreme sites \( \tau \) are particularly good sites to interpolate at from \( S_{k,t} \) because the norm of the resulting projector is about as small as can be; see the toolbox command `chbpnt`.

You can run the example Construction of a Chebyshev Spline to construct \( C \) for a particular knot sequence \( t \).

**Choice of Spline Space**

You deal with cubic splines, i.e., with order

\[ k = 4; \]

and use the break sequence

\[ \text{breaks} = [0 1 1.1 3 5 5.5 7 7.1 7.2 8]; \]
\[ \text{lp1} = \text{length(breaks)}; \]
and use simple interior knots, i.e., use the knot sequence

\[
t = \text{breaks}([\text{ones}(1,k) \ 2:(lp1-1) \ lp1(:,\text{ones}(1,k))]);
\]
\[
n = \text{length}(t) - k;
\]

Note the quadruple knot at each end. Because \( k = 4 \), this makes \([0..8]\) = \([\text{breaks}(1)..\text{breaks}(lp1)]\) the interval \([t_k..t_{n+1}]\) of interest, with \( n = \text{length}(t) - k \) the dimension of the resulting spline space \( S_{k,t} \). The same knot sequence would have been supplied by

\[
t = \text{augknt}(\text{breaks},k);
\]

**Initial Guess**

As the initial guess for the \( \tau \), use the knot averages

\[
t_i = (t_{i+1} + ... + t_{i+k-1})/(k-1)
\]

recommended as good interpolation site choices. These are supplied by

\[
tau = \text{aveknt}(t,k);
\]

Plot the resulting first approximation to \( C \), i.e., the spline \( c \) that satisfies \( c(\tau_i)=(-1)^{n-i} \), all \( i \):

\[
b = \text{cumprod}(	ext{repmat}(-1,1,n)); b = b*b(\text{end});
\]
\[
c = \text{spapi}(t,tau,b);
\]
\[
\text{fnplt}(c,'-.')
\]
\[
\text{grid}
\]

Here is the resulting plot.
First Approximation to a Chebyshev Spline

Remez Iteration
Starting from this approximation, you use the Remez algorithm to produce a sequence of splines converging to \( C \). This means that you construct new \( \tau \) as the extrema of your current approximation \( c \) to \( C \) and try again. Here is the entire loop.

You find the new interior \( \tau_i \) as the zeros of \( Dc \), i.e., the first derivative of \( c \), in several steps. First, differentiate:

\[
Dc = fnder(c);
\]

Next, take the zeros of the control polygon of \( Dc \) as your first guess for the zeros of \( Dc \). For this, you must take apart the spline \( Dc \).

\[
[knots, coefs, np, kp] = fnbrk(Dc, 'knots', 'coefs', 'n', 'order');
\]
The control polygon has the vertices \((t\text{star}(i),\text{coefs}(i))\), with \(t\text{star}\) the knot averages for the spline, provided by \(\text{aveknt}\):

\[
t\text{star} = \text{aveknt}(\text{knots},\text{kp});
\]

Here are the zeros of the resulting control polygon of \(Dc\):

\[
npp = (1:\text{np}-1);
guess = t\text{star}(npp) - \text{coefs}(npp).*(\text{diff}(t\text{star})./\text{diff}(\text{coefs}));
\]

This provides already a very good first guess for the actual zeros.

Refine this estimate for the zeros of \(Dc\) by two steps of the secant method, taking \(\text{tau}\) and the resulting \(\text{guess}\) as your first approximations. First, evaluate \(Dc\) at both sets:

\[
sites = \text{tau}(\text{ones}(4,1),2:\text{n}-1);
sites(1,:) = \text{guess};
\text{values} = \text{zeros}(4,\text{n}-2);
\text{values}(1:2,:) = \text{reshape}(\text{fnval}(Dc,\text{sites}(1:2,:)),2,\text{n}-2);
\]

Now come two steps of the secant method. You guard against division by zero by setting the function value difference to 1 in case it is zero. Because \(Dc\) is strictly monotone near the sites sought, this is harmless:

\[
\text{for } j=2:3
\quad \text{rows} = [j,j-1];\text{Dcd}=\text{diff}(\text{values(rows,:)});
\quad \text{Dcd(find(}\text{Dcd)==0))} = 1;
\quad \text{sites}(j+1,:) = \text{sites}(j,:) ... -\text{values}(j,:).*(\text{diff(}\text{sites(rows,:))}.\text{Dcd});
\quad \text{values}(j+1,:) = \text{fnval}(Dc,\text{sites}(j+1,:));
\text{end}
\]

The check

\[
\text{max(abs(}\text{values.'})
\quad \text{ans} = 4.1176 5.7789 0.4644 0.1178
\]

shows the improvement.

Now take these sites as your new \(\text{tau},\)
\[ \tau = [\tau(1) \ sites(4,:) \ tau(n)]; \]

and check the extrema values of your current approximation there:

\[ \text{extremes} = \text{abs}(\text{fnval}(c, \ tau)); \]

The difference

\[ \text{max}(\text{extremes}) - \text{min}(\text{extremes}) \]

\[ \text{ans} = 0.6905 \]

is an estimate of how far you are from total leveling.

Construct a new spline corresponding to the new choice of \( \tau \) and plot it on top of the old:

\[ c = \text{spapi}(t, \tau, b); \]
\[ \text{sites} = \text{sort}([\tau (0:100)*(t(n+1)-t(k))/100]); \]
\[ \text{values} = \text{fnval}(c, \text{sites}); \]
\[ \text{hold on, plot(sites,values)} \]

The following code turns on the grid and plots the locations of the extrema.

\[ \text{grid on} \]
\[ \text{plot(} \ tau(2:end-1), \text{zeros(1, np-1)}, 'o' \) \]
\[ \text{hold off} \]
\[ \text{legend( 'Initial Guess', 'Current Guess', 'Extreme Locations',... 'location', 'NorthEastOutside')}; \]

Following is the resulting figure (legend not shown).
A More Nearly Level Spline

If this is not close enough, one simply reiterates the loop. For this example, the next iteration already produces C to graphic accuracy.
Approximation by Tensor Product Splines

Because the toolbox can handle splines with vector coefficients, it is easy to implement interpolation or approximation to gridded data by tensor product splines, as the following illustration is meant to show. You can also run the example “Bivariate Tensor Product Splines”.

To be sure, most tensor product spline approximation to gridded data can be obtained directly with one of the spline construction commands, like `spapi` or `csape`, in this toolbox, without concern for the details discussed in this example. Rather, this example is meant to illustrate the theory behind the tensor product construction, and this will be of help in situations not covered by the construction commands in this toolbox.

This section discusses these aspects of the tensor product spline problem:

- “Choice of Sites and Knots” on page 11-20
- “Least Squares Approximation as Function of y” on page 11-21
- “Approximation to Coefficients as Functions of x” on page 11-22
- “The Bivariate Approximation” on page 11-27
- “Switch in Order” on page 11-25
- “Approximation to Coefficients as Functions of y” on page 11-26
- “The Bivariate Approximation” on page 11-27
- “Comparison and Extension” on page 11-28

Choice of Sites and Knots

Consider, for example, least squares approximation to given data \( z(i,j) = f(x(i),y(j)), i=1:Nx, j=1:Ny \). You take the data from a function used extensively by Franke for the testing of schemes for surface fitting (see R. Franke, “A critical comparison of some methods for interpolation of scattered data,” Naval Postgraduate School Techn. Rep. NPS-53-79-003, March 1979). Its domain is the unit square. You choose a few more data sites in the \( x \)-direction than the \( y \)-direction; also, for a better definition, you use higher data density near the boundary.

\[
x = \text{sort}([(0:10)/10,.03 .07, .93 .97]);
\]
Approximation by Tensor Product Splines

\[
y = \text{sort}([(0:6)/6,.03 .07, .93 .97]);
\]
\[
[xx,yy] = \text{ndgrid}(x,y); z = \text{franke}(xx,yy);
\]

**Least Squares Approximation as Function of y**

Treat these data as coming from a vector-valued function, namely, the function of \( y \) whose value at \( y(j) \) is the vector \( z(:,j) \), all \( j \). For no particular reason, choose to approximate this function by a vector-valued parabolic spline, with three uniformly spaced interior knots. This means that you choose the spline order and the knot sequence for this vector-valued spline as

\[
ky = 3; \text{knotsy} = \text{augknt}([0,.25,.5,.75,1],ky);
\]

and then use \text{spap2} to provide the least squares approximant to the data:

\[
\text{sp} = \text{spap2}(\text{knotsy},ky,y,z);
\]

In effect, you are finding simultaneously the discrete least squares approximation from \( S_{ky,\text{knotsy}} \) to each of the \( Nx \) data sets

\[
(y(j),z(i,j))_{j=1}^{Ny}, \quad i = 1:Nx
\]

In particular, the statements

\[
\text{yy} = -.1:.05:1.1;
\]
\[
\text{vals} = \text{fnval}(:\text{sp},\text{yy});
\]

provide the array \text{vals}, whose entry \text{vals}(i,j) can be taken as an approximation to the value \( f(x(i),yy(j)) \) of the underlying function \( f \) at the mesh-point \( x(i),yy(j) \) because \text{vals}(:,j) is the value at \( yy(j) \) of the approximating spline curve in \text{sp}.

This is evident in the following figure, obtained by the command:

\[
\text{mesh}(x,yy,\text{vals}.'), \text{view}(150,50)
\]

Note the use of \text{vals}.', in the \text{mesh} command, needed because of the MATLAB matrix-oriented view when plotting an array. This can be a serious problem in bivariate approximation because there it is customary to think of \( z(i,j) \) as
the function value at the point \((x(i), y(j))\), while MATLAB thinks of \(z(i, j)\) as the function value at the point \((x(j), y(i))\).

A Family of Smooth Curves Pretending to Be a Surface

Note that both the first two and the last two values on each smooth curve are actually zero because both the first two and the last two sites in \(yy\) are outside the basic interval for the spline in \(sp\).

Note also the ridges. They confirm that you are plotting smooth curves in one direction only.

Approximation to Coefficients as Functions of \(x\)

To get an actual surface, you now have to go a step further. Look at the coefficients \(coefs\) of the spline in \(sp\):

\[
coefs = fnbrk(sp,'coefs');
\]
Abstractly, you can think of the spline in \( \text{sp} \) as the function
\[
y \mapsto \sum_r \text{coeff}_y(:,r) B_{r,ky}(y)
\]
with the \( i \)th entry \( \text{coeff}_y(i,r) \) of the vector coefficient \( \text{coeff}_y(:,r) \) corresponding to \( x(i) \), for all \( i \). This suggests approximating each coefficient vector \( \text{coeff}_y(q,:) \) by a spline of the same order \( k_x \) and with the same appropriate knot sequence \( \text{knots}_x \). For no particular reason, this time use cubic splines with four uniformly spaced interior knots:

\[
k_x = 4; \text{knots}_x = \text{augknt}([0:.2:1],k_x); \text{sp2} = \text{spap2}(\text{knots}_x,k_x,x,\text{coeff}_y.');
\]

Note that \( \text{spap2}(\text{knots},k,x,fx) \) expects \( fx(:,j) \) to be the datum at \( x(j) \), i.e., expects each column of \( fx \) to be a function value. To fit the datum \( \text{coeff}_y(q,:) \) at \( x(q) \), for all \( q \), present \( \text{spap2} \) with the transpose of \( \text{coeff}_y \).

**The Bivariate Approximation**

Now consider the transpose of the coefficients \( c_{xy} \) of the resulting spline curve:

\[
\text{coefs} = \text{fnbrk}(\text{sp2},'\text{coefs}').');
\]

It provides the bivariate spline approximation
\[
(x,y) \mapsto \sum_q \sum_r \text{coefs}(q,r) B_{q,kx}(x) B_{r,ky}(y)
\]
to the original data
\[
(x(i),y(j)) \mapsto z(x(i),y(j)), i = 1:Nx, j = 1:Ny
\]

To plot this spline surface over a grid, e.g., the grid
\[
xv = 0:.025:1; \text{yv} = 0:.025:1;
\]
you can do the following:
values = spcol(knotsx,kx,xv)*coefs*spcol(knotsy,ky,yv).';
mesh(xv,yv,values.'), view(150,50);

This results in the following figure.

![Spline Approximation to Franke's Function](image)

**Spline Approximation to Franke's Function**

This makes good sense because \( \text{spcol}(\text{knotsx}, \text{kx}, \text{xv}) \) is the matrix whose \((i,q)\)th entry equals the value \( B_{q,kx}(xv(i)) \) at \( xv(i) \) of the \( q \)th B-spline of order \( kx \) for the knot sequence \( \text{knotsx} \).

Because the matrices \( \text{spcol}(\text{knotsx}, \text{kx}, \text{xv}) \) and \( \text{spcol}(\text{knotsy}, \text{ky}, \text{yv}) \) are banded, it may be more efficient, though perhaps more memory-consuming, for large \( xv \) and \( yv \) to make use of \( \text{fnval} \), as follows:

```matlab
value2 = ...
    fnval(spmak(knotsx,fnval(spmak(knotsy,coefs),yv).'),xv).';
```

This is, in fact, what happens internally when \( \text{fnval} \) is called directly with a tensor product spline, as in

```matlab
value2 = fnval(spmak({knotsx,knotsy},coefs),{xv,yv});
```

Here is the calculation of the relative error, i.e., the difference between the given data and the value of the approximation at those data sites as compared with the magnitude of the given data:
errors = z - spcol(knotsx,kx,x)*coefs*spcol(knotsy,ky,y).';
disp( max(max(abs(errors)))/max(max(abs(z))) )

The output is 0.0539, perhaps not too impressive. However, the coefficient array was only of size 8 6

disp(size(coefs))

to fit a data array of size 15 11.

disp(size(z))

**Switch in Order**

The approach followed here seems *biased*, in the following way. First think of the given data \( z \) as describing a vector-valued function of \( y \), and then treat the matrix formed by the vector coefficients of the approximating curve as describing a vector-valued function of \( x \).

What happens when you take things in the opposite order, i.e., think of \( z \) as describing a vector-valued function of \( x \), and then treat the matrix made up from the vector coefficients of the approximating curve as describing a vector-valued function of \( y \)?

Perhaps surprisingly, the final approximation is the same, up to roundoff. Here is the numerical experiment.

**Least Squares Approximation as Function of \( x \)**

First, fit a spline curve to the data, but this time with \( x \) as the independent variable, hence it is the *rows* of \( z \) that now become the data values. Correspondingly, you must supply \( z.' \), rather than \( z \), to `spap2`,

```matlab
spb = spap2(knotsx,kx,x,z.');
```

thus obtaining a spline approximation to all the curves \((x;z(:,j))\). In particular, the statement

```matlab
valsb = fnval(spb,xv).';
```
provides the matrix vals, whose entry vals(i, j) can be taken as an approximation to the value $f(xv(i),y(j))$ of the underlying function $f$ at the mesh-point $(xv(i),y(j))$. This is evident when you plot vals using mesh:

```
mesh(xv,y,vals.'), view(150,50)
```

![Graph showing the approximation of a surface using vals.]

**Another Family of Smooth Curves Pretending to Be a Surface**

Note the ridges. They confirm that you are, once again, plotting smooth curves in one direction only. But this time the curves run in the other direction.

**Approximation to Coefficients as Functions of y**

Now comes the second step, to get the actual surface. First, extract the coefficients:

```
coefs = fnbrk(spb,'coefs');
```

Then fit each coefficient vector `coefs(r,:)` by a spline of the same order $k_y$ and with the same appropriate knot sequence $knotsy$:

```
spb2 = spap2(knotsy,k_y,y,coefs.');
```

Note that, once again, you need to transpose the coefficient array from spb, because spap2 takes the columns of its last input argument as the data values.
Correspondingly, there is now no need to transpose the coefficient array 
coefsb of the resulting curve:

coefsb = fnbrk(spb2,'coefs');

**The Bivariate Approximation**

The claim is that coefsb equals the earlier coefficient array coefs, up to 
round-off, and here is the test:

```matlab
disp( max(max(abs(coefs - coefsb))) )
```

The output is 1.4433e-15.

The explanation is simple enough: The coefficients c of the spline s contained
in
```matlab
sp = spap2(knots,k,x,y)
```
depend linearly on the input values y. This implies, given that both c and y are 1-row matrices, that there is some matrix 

```matlab
A=A_{knots,k,x}
```

so that

```matlab
c = yA_{knots,k,x}
```

for any data y. This statement even holds when y is a matrix, of size d-by-N,
say, in which case each datum y(:,j) is taken to be a point in $\mathbb{R}^d$, and the
resulting spline is correspondingly d-vector-valued, hence its coefficient array 
c is of size d-by-n, with n = length(knots) - k.

In particular, the statements

```matlab
sp = spap2(knotsy,ky,y,z);
coefs = fnbrk(sp,'coefs');
```

provide us with the matrix coefsy that satisfies

```matlab
coefs = z.A_{knotsy,ky,y}
```

The subsequent computations

```matlab
sp2 = spap2(knotsx,kx,x,coefs.');
coefs = fnbrk(sp2,'coefs').';
```
generate the coefficient array `coefs`, which, taking into account the two transpositions, satisfies

\[
\text{coefs} = \left( (zA_{\text{knotsy,ky,y}})'A_{\text{knotsx,kx,x}} \right)'
\]

\[
= (A_{\text{knotsx,kx,x}})'zA_{\text{knotsy,ky,y}}
\]

In the second, alternative, calculation, you first computed

\[
\text{spb} = \text{spap2}(\text{knotsx,kx,x,z}.');
\]

\[
\text{coefsx} = \text{fnbrk}(\text{spb,}'\text{coefs'});
\]

hence `coefsx = z'.A_{\text{knotsx,kk,x}}`. The subsequent calculation

\[
\text{spb2} = \text{spap2}(\text{knotsy,ky,y,coefsx}.');
\]

\[
\text{coefs}b = \text{fnbrk}(\text{spb,}'\text{coefs'});
\]

then provided

\[
\text{coefs}b = \text{coefsx}.'A_{\text{knotsy,ky,y}} = (A_{\text{knotsx,kx,x}})'zA_{\text{knotsy,ky,y}}
\]

Consequently, `coefs` = `coefs`.

**Comparison and Extension**

The second approach is more symmetric than the first in that transposition takes place in each call to `spap2` and nowhere else. This approach can be used for approximation to gridded data in any number of variables.

If, for example, the given data over a three-dimensional grid are contained in some three-dimensional array `v` of size `[Nx,Ny,Nz]`, with `v(i,j,k)` containing the value `f(x(i),y(j),z(k))`, then you would start off with

\[
\text{coefs} = \text{reshape}(v,Nx,Ny*Nz);
\]

Assuming that \(n_j = \text{knots}j - kj\), for \(j = x,y,z\), you would then proceed as follows:

\[
\text{sp} = \text{spap2}(\text{knotsx,kx,x,coefs}.');
\]
coefs = reshape(fnbrk(sp,'coefs'),Ny,Nz*nx);
sp = spap2(knotsy,ky,y,coefs.');
coefs = reshape(fnbrk(sp,'coefs'),Nz,nx*ny);
sp = spap2(knotsz,kz,z,coefs.');
coefs = reshape(fnbrk(sp,'coefs'),nx,ny*nz);

See Chapter 17 of PGS or [C. de Boor, “Efficient computer manipulation of tensor products,” *ACM Trans. Math. Software* 5 (1979), 173-182; Corrigenda, 525] for more details. The same references also make clear that there is nothing special here about using least squares approximation. Any approximation process, including spline interpolation, whose resulting approximation has coefficients that depend linearly on the given data, can be extended in the same way to a multivariate approximation process to gridded data.

This is exactly what is used in the spline construction commands csapi, csape, spapi, spaps, and spap2, when gridded data are to be fitted. It is also used in fnval, when a tensor product spline is to be evaluated on a grid.
List of Terms for Spline Fitting

This glossary provides brief definitions of the basic mathematical terms and notation used in this guide to splines. The terms are not in alphabetical order. Terms and definitions are presented in order such that the explanation of each term only uses terms discussed earlier.

In this way, you may, the first time around, choose to read the entire glossary from start to finish, for a cohesive introduction to these terms.

**Intervals**

Because MATLAB uses the notation \([a,b]\) to indicate a matrix with the two columns, \(a\) and \(b\), this guide uses the notation \([a..b]\) to indicate the closed interval with endpoints \(a\) and \(b\). This guide does the same for open and half-open intervals. For example, \([a..b)\) denotes the interval that includes its left endpoint, \(a\), and excludes its right endpoint, \(b\).

**Vectors**

A \(d\)-vector is a list of \(d\) real numbers, i.e., a point in \(\mathbb{R}^d\). In MATLAB, a \(d\)-vector is stored as a matrix of size \([1,d]\), i.e., as a row-vector, or as a matrix of size \([d,1]\), i.e., as a column-vector. In the Curve Fitting Toolbox spline functions, vectors are column vectors.

**Functions**

In this toolbox, the term *function* is used in its mathematical sense, and so describes any rule that associates, to each element of a certain set called its *domain*, some element in a certain set called its *target*. Common examples in this toolbox are polynomials and splines. But even a point \(x\) in \(\mathbb{R}^d\), i.e., a \(d\)-vector, may be thought of as a function, namely the function, with domain the set \(\{1,...,d\}\) and target the real numbers \(\mathbb{R}\), that, for \(i = 1,...,d\), associates to \(i\) the real number \(x(i)\).

The *range* of a function is the set of its values.

There are scalar-valued, vector-valued, matrix-valued, and \(ND\)-valued splines. Scalar-valued functions have the real numbers \(\mathbb{R}\) (or, more generally, the complex numbers) as their target, while \(d\)-vector-valued functions have \(\mathbb{R}^d\) as their target; if, more generally, \(d\) is a vector of positive integers, then \(d\)-valued functions have the \(d\)-dimensional real arrays as their target. Curve Fitting Toolbox spline functions can deal
with univariate and multivariate functions. The former have some real
interval, or, perhaps, all of $\mathbb{R}$ as their domain, while $m$-variate functions
have some subset, or perhaps all, of $\mathbb{R}^m$ as their domain.

**Placeholder notation**

If $f$ is a bivariate function, and $y$ is some specific value of its second
variable, then

$$f(\cdot, y)$$

is the univariate function whose value at $x$ is $f(x, y)$.

**Curves and surfaces vs. functions**

In this toolbox, the term *function* usually refers to a scalar-valued
function. A vector-valued function is called here a:

- *curve* if its domain is some interval
- *surface* if its domain is some rectangle

To be sure, to a mathematician, a curve is *not* a vector-valued function
on some interval but, rather, the range of such a (continuous) function,
with the function itself being just one of infinitely many possible
parametrizations of that curve.

**Tensor products**

A bivariate tensor product is any weighted sum of products of a function
in the first variable with a function in the second variable, i.e., any
function of the form

$$f(x, y) = \sum_i \sum_j a(i, j)g_i(x)h_j(y).$$

More generally, an $m$-variate tensor product is any weighted sum of
products $g_1(x_1)g_2(x_2)\ldots g_m(x_m)$ of $m$ univariate functions.

**Polynomials**

A univariate scalar-valued polynomial is specified by the list of its
polynomial coefficients. The length of that list is the order of that
polynomial, and, in this toolbox, the list is always stored as a row vector.
Hence an $m$-list of polynomials of order $k$ is always stored as a matrix
of size $[m, k]$. 
The coefficients in a list of polynomial coefficients are listed from "highest" to "lowest", to conform to the MATLAB convention, as in the command \texttt{polyval(a,x)}. To recall: assuming that \(x\) is a scalar and that \(a\) has \(k\) entries, this command returns the number

\[ a(1)x^{k-1} + a(2)x^{k-2} + \cdots + a(k-1)x + a(k). \]

In other words, the command treats the list \(a\) as the coefficients in a \textit{power form}. For reasons of numerical stability, such a coefficient list is treated in this toolbox, more generally, as the coefficients in a \textit{shifted}, or, \textit{local} power form, for some given \textit{center} \(c\). This means that the value of the polynomial at some point \(x\) is supplied by the command \texttt{polyval(a,x-c)}.

A vector-valued polynomial is treated in exactly the same way, except that now each polynomial coefficient is a vector, say a \(d\)-vector. Correspondingly, the coefficient list now becomes a matrix of size \([d,k]\).

Multivariate polynomials appear in this toolbox mainly as \textit{tensor products}. Assuming first, for simplicity, that the polynomial in question is scalar-valued but \(m\)-variate, this means that its coefficient “list” \(a\) is an \(m\)-dimensional array, of size \([k_1,\ldots,k_m]\) say, and its value at some \(m\)-vector \(x\) is, correspondingly, given by

\[
\sum_{i_1=1}^{k_1} \cdots \sum_{i_m=1}^{k_m} a(i_1,\ldots,i_m)(x(i_1)-c(i_1))^{k_1-i_1} \cdots (x(i_m)-c(i_m))^{k_m-i_m},
\]

for some "center" \(c\).

\textbf{Piecewise-polynomials}

A \textit{piecewise-polynomial} function refers to a function put together from polynomial pieces. If the function is univariate, then, for some strictly increasing sequence \(\xi_1 < \cdots < \xi_{l+1}\), and for \(i = 1:l\), it agrees with some polynomial \(p_i\) on the interval \([\xi_i..\xi_{i+1})\). Outside the interval \([\xi_i..\xi_{i+1})\), its value is given by its first, respectively its last, polynomial piece. The \(\xi_i\) are its \textit{breaks}. All the multivariate piecewise-polynomials in this toolbox are tensor products of univariate ones.

\textbf{B-splines}

In this toolbox, the term \textit{B-spline} is used in its original meaning only, as given to it by its creator, I. J. Schoenberg, and further amplified in
his basic 1966 article with Curry, and used in PGS and many other
books on splines. According to Schoenberg, the B-spline with knots
t_j, ..., t_{j+k} is given by the following somewhat obscure formula (see, e.g.,
IX(1) in PGS):

\[ B_{j,k}(x) = B(x | t_j, ..., t_{j+k}) = (t_{j+k} - t_j)(t_j, ..., t_{j+k})(x - t_j)^{k-1}. \]

To be sure, this is only one of several reasonable normalizations of the
B-spline, but it is the one used in this toolbox. It is chosen so that

\[ \sum_{j=1}^{n} B_{j,k}(x) = 1, \quad t_k \leq x \leq t_{n+1}. \]

But, instead of trying to understand the above formula for the B-spline,
look at the reference pages for the GUI bspligui for some of the basic
properties of the B-spline, and use that GUI to gain some firsthand
experience with this intriguing function. Its most important property
for the purposes of this toolbox is also the reason Schoenberg used the
letter B in its name:

*Every space of (univariate) piecewise-polynomials of a given order has a
Basis consisting of B-splines (hence the “B” in B-spline).*

**Splines**

Consider the set

\[ S := \Pi_{\xi_j,k}^{\mu} \]

of all (scalar-valued) piecewise-polynomials of order \( k \) with breaks
\( \xi_1 < ... < \xi_{l+1} \) that, for \( i = 2...l \), may have a jump across \( \xi_i \) in its \( \mu_i \)th
derivative but have no jump there in any lower order derivative. This
set is a linear space, in the sense that any scalar multiple of a function
in \( S \) is again in \( S \), as is the sum of any two functions in \( S \).

Accordingly, \( S \) contains a basis (in fact, infinitely many bases), that is, a
sequence \( f_1, ..., f_n \) so that every \( f \) in \( S \) can be written *uniquely* in the form

\[ f(x) = \sum_{j=1}^{n} f_j(x)a_j, \]
for suitable coefficients $a_j$. The number $n$ appearing here is the \textit{dimension} of the linear space $S$. The coefficients $a_j$ are often referred to as the \textit{coordinates} of $f$ with respect to this basis.

In particular, according to the Curry-Schoenberg Theorem, our space $S$ has a basis consisting of B-splines, namely the sequence of all B-splines of the form $B(\cdot \mid t_j, \ldots, t_{j+k})$, $j = 1 \ldots n$, with the knot sequence $t$ obtained from the break sequence $\xi$ and the sequence $\mu$ by the following conditions:

- Have both $\xi_1$ and $\xi_{l+1}$ occur in $t$ exactly $k$ times
- For each $i = 2 : l$, have $\xi_i$ occur in $t$ exactly $k – \mu_i$ times
- Make sure the sequence is nondecreasing and only contains elements from $\xi$

Note the correspondence between the multiplicity of a knot and the smoothness of the spline across that knot. In particular, at a simple knot, that is a knot that appears exactly once in the knot sequence, only the $(k – 1)$st derivative may be discontinuous.

Rational splines

A \textit{rational spline} is any function of the form $r(x) = s(x)/w(x)$, with both $s$ and $w$ splines and, in particular, $w$ a scalar-valued spline, while $s$ often is vector-valued. In this toolbox, there is the additional requirement that both $s$ and $w$ be of the same form and even of the same order, and with the same knot or break sequence. This makes it possible to store the rational spline $r$ as the ordinary spline $R$ whose value at $x$ is the vector $[s(x); w(x)]$. It is easy to obtain $r$ from $R$. For example, if $v$ is the value of $R$ at $x$, then $v(1:\text{end}-1)/v(\text{end})$ is the value of $r$ at $x$. As another example, consider getting derivatives of $r$ from those of $R$. Because $s = wr$, Leibniz’ rule tells us that

$$D^m s = \sum_{j=0}^{m} \binom{m}{j} D^j w D^{m-j} r.$$

Hence, if $v(:,j)$ contains $D^{j-1}R(x)$, $j = 1 \ldots m + 1$, then
\[
\left( v(1: \text{end} - 1,m + 1) - \sum_{j=1}^{m} \binom{m}{j} v(\text{end}, j + 1)v(1: \text{end} - 1,j + 1) \right) / v(\text{end},1)
\]

provides the value of \( D^mR(x) \).

**Thin-plate splines**

A bivariate thin-plate spline is of the form

\[
f(x) = \sum_{j=1}^{n-3} \varphi\left(\| x - c_j \|^2 \right) a_j + x(1) a_{n-2} + x(2) a_{n-1} + a_n,
\]

with \( \varphi(t) = t \log t \) a univariate function, and \( \| y \| \) denoting the Euclidean length of the vector \( y \). The sites \( c_j \) are called the centers, and the radially symmetric function \( \psi(x) := \varphi(\| x \|^2) \) is called the basis function, of this particular form.

**Interpolation**

Interpolation is the construction of a function \( f \) that matches given data values, \( y_i \), at given data sites, \( x_i \), in the sense that \( f(x_i) = y_i \), all \( i \).

The interpolant, \( f \), is usually constructed as the unique function of the form

\[
f(x) = \sum_{j} f_j(x) a_j
\]

that matches the given data, with the functions \( f_j \) chosen "appropriately". Many considerations might enter that choice. One of these considerations is sure to be that one can match in this way arbitrary data. For example, polynomial interpolation is popular because, for arbitrary \( n \) data points \( (x_i,y_i) \) with distinct data sites, there is exactly one polynomial of order \( n - 1 \) that matches these data. Explicitly, choose the \( f_j \) in the above "model" to be

\[
f_j(x) = \prod_{i \neq j} (x - x_i),
\]

which is an \( n - 1 \) degree polynomial for each \( j \). \( f_j(x_i) = 0 \) for every \( i \neq j \), but \( f_j(x_j) \neq 0 \) as long as the \( x_i \) are all distinct. Set \( a_j = y_j / f_j(x_j) \) so that

\[
f(x_j) = f_j(x_j) a_j = y_j \text{ for all } j.
\]
Advanced Spline Examples

In spline interpolation, one chooses the $f_j$ to be the $n$ consecutive B-splines $B_j(x) = B(x \mid t_j, \ldots, t_{j+k})$, $j = 1:n$, of order $k$ for some knot sequence $t_1 \leq t_2 \leq \ldots \leq t_{n+k}$. For this choice, there is the following important theorem.

**Schoenberg-Whitney Theorem**

Let $x_1 < x_2 < \ldots < x_n$. For arbitrary corresponding values $y_i$, $i = 1\ldots n$, there exists exactly one spline $f$ of order $k$ with knot sequence $t_j$, $j = 1\ldots n+k$, so that $f(x_i) = y_i$, $i = 1\ldots n$ if and only if the sites satisfy the Schoenberg-Whitney conditions of order $k$ with respect to that knot sequence $t$, namely

$$t_i \leq x_i \leq t_{i+k}, \quad i = 1\ldots n,$$

with equality allowed only if the knot in question has multiplicity $k$, i.e., appears $k$ times in $t$. In that case, the spline being constructed may have a jump discontinuity across that knot, and it is its limit from the right or left at that knot that matches the value given there.

**Least-squares approximation**

In least-squares approximation, the data may be matched only approximately. Specifically, the linear system

$$f(x_i) = \sum_j f_j(x_i)a_j = y_i, \quad i = 1\ldots n,$$

is solved in the least-squares sense. In this, some weighting is involved, i.e., the coefficients $a_j$ are determined so as to minimize the error measure

$$E(f) = \sum_i w_i \left| y_i - f(x_i) \right|^2$$

for certain nonnegative weights $w_i$ at the user’s disposal, with the default being to have all these weights the same.

**Smoothing**

In spline smoothing, one also tries to make such an error measure small, but tries, at the same time, to keep the following roughness measure small,
\[ F(D^m f) = \int_{x_i}^{x_a} \lambda(x)|D^m f(x)|^2 \, dx, \]

with \( \lambda \) a nonnegative weight function that is usually just the constant function 1, and \( D^m f \) the \( m \)th derivative of \( f \). The competing claims of small \( E(f) \) and small \( F(D^m f) \) are mediated by a smoothing parameter, for example, by minimizing

\[ \rho E(f) + F(D^m f) \text{ or } p E(f) + (1-p) F(D^m f), \]

for some choice of \( \rho \) or of \( p \), and over all \( f \) for which this expression makes sense.

Remarkably, if the roughness weight \( \lambda \) is constant, then the unique minimizer \( f \) is a spline of order \( 2m \), with knots only at the data sites, and all the interior knots simple, and with its derivatives of orders \( m, \ldots, 2m-2 \) equal to zero at the two extreme data sites, the so-called “natural” end conditions. The larger the smoothing parameter \( \rho \geq 0 \) or \( p \in [0..1] \) used, the more closely \( f \) matches the given data, and the larger is its \( m \)th derivative.

For data values \( y_i \) at sites \( c_i \) in the plane, one uses instead the error measure and roughness measure

\[ E(f) = \sum_i |y_i - f(c_i)|^2, \quad F(D^2 f) = \int \left( |D_{11} f|^2 + 2 |D_{12} f|^2 + |D_{22} f|^2 \right), \]

and, correspondingly, the minimizer of the sum \( \rho E(f) + F(D^2 f) \) is not a polynomial spline, but is a thin-plate spline.

Note that the unique minimizer of \( \rho E(f) + F(D^2 f) \) for given \( 0 < \rho < \infty \) is also the unique minimizer of \( p E(f) + (1-p) F(D^2 f) \) for \( p = \rho/(1+\rho) \in (0..1) \) and vice versa.

2D, 3D, ND

Terms such as “a 2D problem” or “a 3D problem” are not used in this toolbox, because they are not well defined. For example a 2D problem could be any one of the following:

- Points on some curve, where you must construct a spline curve, i.e., a vector-valued spline function of one variable.
• Points on the graph of some function, where you must construct a scalar-valued spline function of one variable.

• Data sites in the plane, where you must construct a bivariate scalar-valued spline function.

A “3D problem” is similarly ambiguous. It could involve a curve, a surface, a function of three variables, ... Better to classify problems by the domain and target of the function(s) to be constructed.

Almost all the spline construction commands in this toolbox can deal with ND-valued data, meaning that the data values are ND-arrays. If $d$ is the size of such an array, then the resulting spline is called $d$-valued.
Functions — Alphabetical List
**Purpose**

Acceptable knot sequence

**Syntax**

\[
\text{knots} = \text{aptknt}(\tau, k) \\
[\text{knots}, k] = \text{aptknt}(\tau, k)
\]

**Description**

\[
\text{knots} = \text{aptknt}(\tau, k)
\]

returns a knot sequence suitable for interpolation at the data sites \( \tau \) by splines of order \( k \) with that knot sequence, provided \( \tau \) has at least \( k \) entries, is nondecreasing, and satisfies \( \tau(i) < \tau(i+k-1) \) for all \( i \). In that case, there is exactly one spline of order \( k \) with knot sequence \( \text{knots} \) that matches given values at those sites. This is so because the sequence \( \text{knots} \) returned satisfies the Schoenberg-Whitney conditions

\[
\text{knots}(i) < \tau(i) < \text{knots}(i+k), \quad i=1:\text{length}(\tau)
\]

with equality only at the extreme knots, each of which occurs with exact multiplicity \( k \).

If \( \tau \) has fewer than \( k \) entries, then \( k \) is reduced to the value \( \text{length}(\tau) \). An error results if \( \tau \) fails to be nondecreasing and/or \( \tau(i) \) equals \( \tau(i+k-1) \) for some \( i \).

\[
[\text{knots}, k] = \text{aptknt}(\tau, k)
\]

also returns the actual \( k \) used (which equals the smaller of the input \( k \) and \( \text{length}(\tau) \)).

**Examples**

If \( \tau \) is equally spaced, e.g., equal to \( \text{linspace}(a, b, n) \) for some \( n \geq 4 \), and \( y \) is a sequence of the same size as \( \tau \), then \( \text{sp} = \text{spapi}(\text{aptknt}(\tau, 4), \tau, y) \) gives the cubic spline interpolant with the not-a-knot end condition. This is the same cubic spline as produced by the command \( \text{spline}(\tau, y) \), but in B-form rather than ppform.

**Algorithms**

The \( (k-1) \)-point averages \( \text{sum}(\tau(i+1:i+k-1))/(k-1) \) of the sequence \( \tau \), as supplied by \( \text{aveknt}(\tau, k) \), are augmented by a \( k \)-fold \( \tau(1) \) and a \( k \)-fold \( \tau(\text{end}) \). In other words, the command gives the same result as \( \text{augknt}([\tau(1), \text{aveknt}(\tau, k), \tau(\text{end})], k) \), provided \( \tau \) has at least \( k \) entries and \( k \) is greater than 1.
Cautionary Note  If \( \tau \) is very nonuniform, then use of the resulting knot sequence for interpolation to data at the sites \( \tau \) may lead to unsatisfactory results.

See Also  augknt | aveknt | newknt | optknt
Input argument names of `cfit`, `sfit`, or `fittype` object

```
args = argnames(fun)
```

**Description**

`args = argnames(fun)` returns the input argument (variable and coefficient) names of the `cfit`, `sfit`, or `fittype` object `fun` as an `n`-by-1 cell array of strings `args`, where `n = numargs(fun)`.

```matlab
f = fittype('a*x^2+b*exp(n*x)');
nargs = numargs(f)
nargs =
    4
args = argnames(f)
args =
    'a'
    'b'
    'n'
    'x'
```

**See Also**

`fittype` | `formula` | `numargs`
**Purpose**

Augment knot sequence

**Syntax**

```
augknt(knots,k)
augknt(knots,k,mults)
[augknot,addl] = augknt(...)
```

**Description**

`augknt(knots,k)` returns a nondecreasing and augmented knot sequence that has the first and last knot with exact multiplicity `k`. (This may actually shorten the knot sequence.)

`augknt(knots,k,mults)` makes sure that the augmented knot sequence returned will, in addition, contain each interior knot `mults` times. If `mults` has exactly as many entries as there are interior knots, then the `j`th one will appear `mults(j)` times. Otherwise, the uniform multiplicity `mults(1)` is used. If `knots` is strictly increasing, this ensures that the splines of order `k` with knot sequence `augknot` satisfy `k-mults(j)` smoothness conditions across `knots(j+1), j=1:length(knots)-2`.

`[augknot,addl] = augknt(...)` also returns the number `addl` of knots added on the left. (This number may be negative.)

**Examples**

If you want to construct a cubic spline on the interval `[a..b]`, with two continuous derivatives, and with the interior break sequence `xi`, then `augknt([a,b,xi],4)` is the knot sequence you should use.

If you want to use Hermite cubics instead, i.e., a cubic spline with only one continuous derivative, then the appropriate knot sequence is `augknt([a,xi,b],4,2)`.

`augknt([1 2 3 3 3],2)` returns the vector `[1 1 2 3 3]`, as does `augknt([3 2 3 1 3],2)`. In either case, `addl` would be 1.
**Purpose**

Provide knot averages

**Syntax**

\[ t_{star} = \text{aveknt}(t, k) \]

**Description**

\[ t_{star} = \text{aveknt}(t, k) \]

returns the averages of successive \( k - 1 \) knots, i.e., the sites

\[
t^* = \frac{t_{i+1} + \cdots + t_{i+k-1}}{(k-1)}, \quad i = 1 : n
\]

which are recommended as good interpolation site choices when interpolating from splines of order \( k \) with knot sequence \( t = (t_i)_{i=1}^{n+k} \).

**Examples**

\( \text{aveknt([1 2 3 3 3], 3)} \) returns the vector \([2.5000 3.0000]\), while \( \text{aveknt([1 2 3], 3)} \) returns the empty vector.

With \( k \) and the strictly increasing sequence \( \text{breaks} \) given, the statements

\[
t = \text{augknt}(	ext{breaks}, k); \quad x = \text{aveknt}(t); \quad \text{sp} = \text{spapi}(t, x, \sin(x));
\]

provide a spline interpolant to the sine function on the interval \([\text{breaks}(1) .. \text{breaks}(\text{end})]\).

For \( \text{sp} \) the B-form of a scalar-valued univariate spline function, and with \( t_{\text{star}} \) and \( a \) computed as

\[
t_{\text{star}} = \text{aveknt}(\text{fnbrk}(\text{sp}, 'knots'), \text{fnbrk}(\text{sp}, 'order')); \quad a = \text{fnbrk}(\text{sp}, 'coefs');
\]

the points \((t_{\text{star}}(i), a(i))\) constitute the control points of the spline, i.e., the vertices of the spline’s control polygon.

**See Also**

aptknt | chbpnt | optknt
**Purpose**  
Part(s) of almost block-diagonal matrix

**Syntax**  
```matlab
[nb, rows, ncols, last, blocks] = bkbrk(blokmat)
bkbrk(blokmat)
```

**Description**  
```matlab
[nb, rows, ncols, last, blocks] = bkbrk(blokmat) returns the details of the almost block-diagonal matrix contained in blokmat, with rows and last nb-vectors, and blocks a matrix of size [sum(rows), ncols].
```

This utility program is not likely to be of interest to the casual user. It is used in `slvblk` to decode the information, provided by `spcol`, about a spline collocation matrix in an almost block diagonal form especially suited for splines. But `bkbrk` can also decode the almost block-diagonal form used in [1].

```matlab
bkbrk(blokmat) returns nothing, but the details are printed out. This is of use when trying to understand what went wrong with such a matrix.
```

**References**  

**See Also**  
`slvblk` | `spcol`
**Purpose**
Convert breaks with multiplicities into knots

**Syntax**
[knots,index] = brk2knt(breaks,mults)

**Description**
[knots,index] = brk2knt(breaks,mults) returns the sequence knots that is the sequence breaks but with breaks(i) occurring mults(i) times, all i. In particular, breaks(i) will not appear unless mults(i)>0. If, as one would expect, breaks is a strictly increasing sequence, then knots contains each breaks(i) exactly mults(i) times.

If mults does not have exactly as many entries as does breaks, then all mults(i) are set equal to mults(1).

If, as one would expect, breaks is strictly increasing and all multiplicities are positive, then, for each i, index(i) is the first place in knots at which breaks(i) appears.

**Examples**
The statements

```matlab
t = [1 1 2 2 2 3 4 5 5];
[xi,m] = knt2brk(t);
tt = brk2knt(xi,m)
```

give [1 2 3 4 5] for xi, [2 3 1 1 2] for m, and, finally, t for tt.

**See Also**
augknt
bspligui

**Purpose**

Experiment with B-spline as function of its knots

**Syntax**

bspligui

**Description**

bspligui starts a graphical user interface (GUI) for exploring how a B-spline depends on its knots. As you add, move, or delete knots, you see the B-spline and its first three derivatives change accordingly.

You observe the following basic facts about the B-spline with knot sequence \( t_0 \leq \cdots \leq t_k \):

- The B-spline is positive on the open interval \( (t_0..t_k) \). It is zero at the end knots, \( t_0 \) and \( t_k \), unless they are knots of multiplicity \( k \). The B-spline is also zero outside the closed interval \( [t_0..t_k] \), but that part of the B-spline is not shown in the GUI.

- Even at its maximum, the B-spline is never bigger than 1. It reaches the value 1 inside the interval \( (t_0..t_k) \) only at a knot of multiplicity at least \( k-1 \). On the other hand, that maximum cannot be arbitrarily small; it seems smallest when there are no interior knots.

- The B-spline is piecewise polynomial of order \( k \), i.e., its polynomial pieces all are of degree \(<k\). For \( k = 1:4 \), you can even observe that all its nonzero polynomial pieces are of exact degree \( k - 1 \), by looking at the first three derivatives of the B-spline. This means that the degree goes up/down by 1 every time you add/delete a knot.

- Each knot \( t_j \) is a break for the B-spline, but it is permissible for several knots to coincide. Therefore, the number of nontrivial polynomial pieces is maximally \( k \) (when all the knots are different) and minimally 1 (when there are no “interior” knots), and any number between 1 and \( k \) is possible.

- The smoothness of the B-spline across a break depends on the multiplicity of the corresponding knot. If the break occurs in the knot sequence \( m \) times, then the \((k-m)\)th derivative of the B-spline has a jump across that break, while all derivatives of order lower than \((k-m)\) are continuous across that break. Thus, by varying the
multiplicity of a knot, you can control the smoothness of the B-spline across that knot.

- As one knot approaches another, the highest derivative that is continuous across both develops a jump and the higher derivatives become unbounded. But nothing dramatic happens in any of the lower-order derivatives.

- The B-spline is bell-shaped in the following sense: if the first derivative is not identically zero, then it has exactly one sign change in the interval \((t_0..t_k)\), hence the B-spline itself is unimodal, meaning that it has exactly one maximum. Further, if the second derivative is not identically zero, then it has exactly two sign changes in that interval. Finally, if the third derivative is not identically zero, then it has exactly three sign changes in that interval. This illustrates the fact that, for \(j = 0:k - 1\), if the \(j\)th derivative is not identically zero, then it has exactly \(j\) sign changes in the interval \((t_0..t_k)\); it is this property that is meant by the term “bell-shaped”. For this claim to be strictly true, one has to be careful with the meaning of “sign change” in case there are knots with multiplicities. For example, the \((k-1)st\) derivative is piecewise constant, hence it cannot have \(k-1\) sign changes in the straightforward sense unless there are \(k\) polynomial pieces, i.e., unless all the knots are simple.

**See Also** b spline | chbpnt | spcol
Purpose
Plot B-spline and its polynomial pieces

Syntax
bspline(t)
bspline(t,window)
pp = bspline(t)

Description
bspline(t) plots the B-spline with knot sequence t, as well as the polynomial pieces of which it is composed.

bspline(t,window) does the plotting in the subplot window specified by window; see the MATLAB command subplot for details.

pp = bspline(t) plots nothing but returns the ppform of the B-spline.

Examples
The statement pp=fn2fm(spmak(t,1), 'pp') has the same effect as the statement pp=bspline(t).

See Also
bspligui
### Purpose
Category of fit of cfit, sfit, or fittype object

### Syntax
```
cname = category(fun)
```

### Description
`cname = category(fun)` returns the fit category `cname` of the `cfit`, `sfit`, or `fittype` object `fun`, where `cname` is one of 'custom', 'interpolant', 'library', or 'spline'.

### Examples
```
f1 = fittype('a*x^2+b*exp(n*x)');
category(f1)
ans =
custom

f2 = fittype('pchipinterp');
category(f2)
ans =
interplont

f3 = fittype('fourier4');
category(f3)
ans =
library

f4 = fittype('smoothingspline');
category(f4)
ans =
spline
```

### See Also
fittype | type

### How To
- “List of Library Models for Curve and Surface Fitting” on page 4-13
Purpose
Constructor for cfit object

Syntax
```matlab
cfun = cfit(ffun,coeff1,coeff2,...)
```

Description
`cfun = cfit(ffun,coeff1,coeff2,...)` constructs the `cfit` object `cfun` using the model type specified by the `fittype` object `ffun` and the coefficient values `coeff1`, `coeff2`, etc.

**Note**
`cfit` is called by the `fit` function when fitting `fittype` objects to data. To create a `cfit` object that is the result of a regression, use `fit`.

You should only call `cfit` directly if you want to assign values to coefficients and problem parameters of a `fittype` object *without* performing a fit.

Examples
```matlab
f = fittype('a*x^2+b*exp(n*x)')
f =
  General model:
  f(a,b,n,x) = a*x^2+b*exp(n*x)
c = cfit(f,1,10.3,-1e2)
c =
  General model:
  c(x) = a*x^2+b*exp(n*x)
  Coefficients:
  a = 1
  b = 10.3
  n = -100
```

See Also
`fit` | `fittype` | `feval`
**Purpose**
Open Curve Fitting Tool

**Syntax**

cftool

cftool( x, y )
cftool( x, y, z )
cftool( x, y, [], w )
cftool( x, y, z, w )
cftool( filename )
cftool -v1

cftool( '-v1', x, y )
cftool( '-v1', x, y, w )

**Description**
cftool opens Curve Fitting Tool or brings focus to the tool if it is already open.

cftool( x, y ) creates a curve fit to x input and y output. x and y must be numeric, have two or more elements, and have the same number of elements. cftool opens Curve Fitting Tool if necessary.

cftool( x, y, z ) creates a surface fit to x and y inputs and z output. x, y, and z must be numeric, have two or more elements, and have compatible sizes. Sizes are compatible if x, y, and z all have the same number of elements or x and y are vectors, z is a 2D matrix, length(x) = n, and length(y) = m where [m,n] = size(z). cftool opens Curve Fitting Tool if necessary.

cftool( x, y, [], w ) creates a curve fit with weights w. w must be numeric and have the same number of elements as x and y.

cftool( x, y, z, w ) creates a surface fit with weights w. w must be numeric and have the same number of elements as z.

cftool( filename ) loads the surface fitting session in filename into Curve Fitting Tool. The filename should have the extension .sfit.

cftool -v1 opens the legacy Curve Fitting Tool.
Note The -v1 option warns that the legacy Curve Fitting Tool will be removed in a future release. Use cftool instead.

cftool( '-v1', x, y ) starts the legacy Curve Fitting Tool with an initial data set containing the x and y data you supply. x and y must be numeric vectors having the same length.

cftool( '-v1', x, y, w ) also includes the weight vector w in the initial data set. w must have the same length as x and y.

Infs, NaNs, and imaginary parts of complex numbers are ignored in the data.

Curve Fitting Tool provides a flexible graphical user interface where you can interactively fit curves and surfaces to data and view plots. You can:

- Create, plot, and compare multiple fits
- Use linear or nonlinear regression, interpolation, local smoothing regression, or custom equations
- View goodness-of-fit statistics, display confidence intervals and residuals, remove outliers and assess fits with validation data
- Automatically generate code for fitting and plotting surfaces, or export fits to workspace for further analysis

How To

- “Interactive Curve and Surface Fitting” on page 2-2
### Purpose
Good data sites, Chebyshev-Demko points

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>tau = chbpnt(t,k)</code></td>
<td><code>tau = chbpnt(t,k)</code> are the extreme sites of the Chebyshev spline of order <code>k</code> with knot sequence <code>t</code>. These are particularly good sites at which to interpolate data by splines of order <code>k</code> with knot sequence <code>t</code> because the resulting interpolant is often quite close to the best uniform approximation from that spline space to the function whose values at <code>tau</code> are being interpolated.</td>
</tr>
<tr>
<td><code>chbpnt(t,k,tol)</code></td>
<td><code>chbpnt(t,k,tol)</code> also specifies the tolerance <code>tol</code> to be used in the iterative process that constructs the Chebyshev spline. This process is terminated when the relative difference between the absolutely largest and the absolutely smallest local extremum of the spline is smaller than <code>tol</code>. The default value for <code>tol</code> is <code>.001</code>.</td>
</tr>
<tr>
<td><code>[tau,sp] = chbpnt(...)</code></td>
<td><code>[tau,sp] = chbpnt(...)</code> also returns, in <code>sp</code>, the Chebyshev spline.</td>
</tr>
</tbody>
</table>

### Examples

```matlab
cchbpnt([-ones(1,k),ones(1,k)],k) provides (approximately) the extreme sites on the interval [–1 .. 1] of the Chebyshev polynomial of degree `k-1`.
```

If you have decided to approximate the square-root function on the interval [0 .. 1] by cubic splines, with knot sequence `t` as given by

```matlab
k = 4; n = 10; t = augknt(((0:n)/n).^8,k);
```

then a good approximation to the square-root function from that specific spline space is given by

```matlab
x = chbpnt(t,k); sp = spapi(t,x,sqrt(x));
```

as is evidenced by the near equi-oscillation of the error.
**Algorithms**  
The Chebyshev spline for the given knot sequence and order is constructed iteratively, using the Remez algorithm, using as initial guess the spline that takes alternately the values 1 and −1 at the sequence aveknt(t,k). The example “Constructing the Chebyshev Spline” gives a detailed discussion of one version of the process as applied to a particular example.

**See Also**  
aveknt
Purpose
Coefficient names of cfit, sfit, or fittype object

Syntax
coeffs = coeffnames(fun)

Description
coeffs = coeffnames(fun) returns the coefficient (parameter) names of the cfit, sfit, or fittype object fun as an n-by-1 cell array of strings coeffs, where n = numcoeffs(fun).

Examples
f = fittype('a*x^2+b*exp(n*x)');
ncoeffs = numcoeffs(f)
ncoeffs =
    3
coeffs = coeffnames(f)
coeffs =
    'a'
    'b'
    'n'

See Also
fittype | formula | numcoeffs | probnames | coeffvalues
**Purpose**  
Coefficient values of `cfit` or `sfit` object

**Syntax**  
`coeffvals = coeffvalues(fun)`

**Description**  
`coeffvals = coeffvalues(fun)` returns the values of the coefficients (parameters) of the `cfit` object `fun` as a 1-by-`n` vector `coeffvals`, where `n = numcoeffs(fun)`.

**Examples**  
load census

```matlab
f = fittype('poly2');
coeffnames(f)
ans =
    'p1'
    'p2'
    'p3'
formula(f)
ans =
p1*x^2 + p2*x + p3

c = fit(cdate,pop,f);
coeffvalues(c)
ans =
    1.0e+004 *
    0.0000   -0.0024    2.1130
```

**See Also**  
`coeffnames` | `confint` | `predint` | `probvalues`
Purpose

Confidence intervals for fit coefficients of cfit or sfit object

Syntax

\[
\begin{align*}
\text{ci} &= \text{confint}(	ext{fitresult}) \\
\text{ci} &= \text{confint}(	ext{fitresult}, \text{level})
\end{align*}
\]

Description

\[
\text{ci} = \text{confint}(	ext{fitresult}) \text{ returns 95\% confidence bounds } \text{ci} \text{ on the coefficients associated with the cfit or sfit object } \text{fitresult}. \\
\text{fitresult must be an output from the fit function to contain the necessary information for ci. ci is a 2-by-n array where } n = \text{numcoeffs(fitresult). The top row of ci contains the lower bound for each coefficient; the bottom row contains the upper bound.}
\]

\[
\text{ci} = \text{confint}(	ext{fitresult}, \text{level}) \text{ returns confidence bounds at the confidence level specified by level. level must be between 0 and 1. The default value of level is 0.95.}
\]

Tips

To calculate confidence bounds, confint uses \( R^{-1} \) (the inverse \( R \) factor from QR decomposition of the Jacobian), the degrees of freedom for error, and the root mean squared error. This information is automatically returned by the fit function and contained within fitresult.

If coefficients are bounded and one or more of the estimates are at their bounds, those estimates are regarded as fixed and do not have confidence bounds.

Note that you cannot calculate confidence bounds if \( \text{category(fitresult)} \) is 'spline' or 'interpolant'.

Examples

load census

\[
\begin{align*}
\text{fitresult} &= \text{fit}(\text{cdate}, \text{pop}, \text{'poly2'}) \\
\text{fitresult} &=
\text{Linear model Poly2:} \\
& \quad \text{fitresult}(x) = p1*x^2 + p2*x + p3 \\
\text{Coefficients (with 95\% confidence bounds):} \\
& p1 = \quad 0.006541 \ (0.006124, \ 0.006958) \\
& p2 = \quad -23.51 \ (-25.09, \ -21.93)
\end{align*}
\]
p3 = 2.113e+004  (1.964e+004, 2.262e+004)

ci = confint(fitresult,0.95)

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0061242</td>
<td>-25.086</td>
<td>19641</td>
</tr>
<tr>
<td>0.0069581</td>
<td>-21.934</td>
<td>22618</td>
</tr>
</tbody>
</table>

Note that `fit` and `confint` display the confidence bounds in slightly different formats.

**See Also**

`fit` | `predint`
Purpose
Cubic spline interpolation with end conditions

Syntax
pp = csape(x,y)
pp = csape(x,y,conds)

Description
pp = csape(x,y) is the ppform of a cubic spline s with knot sequence x that satisfies s(x(j)) = y(:,j) for all j, as well as an additional end condition at the ends (meaning the leftmost and at the rightmost data site), namely the default condition listed below. The data values y(:,j) may be scalars, vectors, matrices, even ND-arrays. Data values at the same data site are averaged.

pp = csape(x,y,conds) lets you choose the end conditions to be used, from a rather large and varied catalog, by proper choice of conds. If needed, you supply the corresponding end condition values as additional data values, with the first (last) data value taken as the end condition value at the left (right) end. In other words, in that case, s(x(j)) matches y(:,j+1) for all j, and the variable endcondvals used in the detailed description below is set to y(:,[1 end]). For some choices of conds, these end condition values need not be present and/or are ignored when present.

conds may be a string whose first character matches one of the following: 'complete' or 'clamped', 'not-a-knot', 'periodic', 'second', 'variational', with the following meanings.

'complete' or 'clamped'  Match endslopes (as given, with default as under "default").

'not-a-knot'  Make second and second-last sites inactive knots (ignoring end condition values if given).

'periodic'  Match first and second derivatives at left end with those at right end.

'second'  Match end second derivatives (as given, with default [0 0], i.e., as in 'variational').
'variational'  Set end second derivatives equal to zero (ignoring end condition values if given).

default  Match endslopes to the slope of the cubic that matches the first four data at the respective end (i.e., Lagrange).

By giving conds as a 1-by-2 matrix instead, it is possible to specify different conditions at the two ends. Explicitly, the $i$th derivative, $D^i s$, is given the value endcondvals(:, $j$) at the left ($j$ is 1) respectively right ($j$ is 2) end in case conds($j$) is $i,i = 1:2$. There are default values for conds and/or endcondvals.

Available conditions are:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Expression</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>clamped</td>
<td>$D s(e) = \text{endcondvals(:, }j\text{)}$</td>
<td>if conds($j$) == 1</td>
</tr>
<tr>
<td>curved</td>
<td>$D^2 s(e) = \text{endcondvals(:, }j\text{)}$</td>
<td>if conds($j$) == 2</td>
</tr>
<tr>
<td>Lagrange</td>
<td>$D s(e) = Dp(e)$</td>
<td>default</td>
</tr>
<tr>
<td>periodic</td>
<td>$D^r s(a) = D^r s(b), r = 1,2$</td>
<td>if conds == [0 0]</td>
</tr>
<tr>
<td>variational</td>
<td>$D^2 s(e) = 0$</td>
<td>if conds($j$) == 2 &amp; endcondvals(:, $j$) == 0</td>
</tr>
</tbody>
</table>

Here, $e$ is a ($e$ is $b$), i.e., the left (right) end, in case $j$ is 1 ($j$ is 2), and (in the Lagrange condition) $P$ is the cubic polynomial that interpolates to the given data at $e$ and the three sites nearest $e$.

If conds($j$) is not specified or is different from 0, 1, or 2, then it is taken to be 1 and the corresponding endcondvals(:, $j$) is taken to be the corresponding default value.

The default value for endcondvals(:, $j$) is the derivative of the cubic interpolant at the nearest four sites in case conds($j$) is 1, and is 0 otherwise.

It is also possible to handle gridded data, by having $x$ be a cell array containing $m$ univariate meshes and, correspondingly, having $y$ be an $m$-dimensional array (or an $m+r$-dimensional array if the function is to be $r$-valued). Correspondingly, conds is a cell array with $m$ entries,
and end condition values may be correspondingly supplied in each of the \( m \) variables. This, as the last example below, of bicubic spline interpolation, makes clear, may require you to supply end conditions for end conditions.

This command calls on a much expanded version of the Fortran routine CUBSPL in \( PGS \).

**Examples**

\( \text{csape}(x,y) \) provides the cubic spline interpolant with the Lagrange end conditions, while \( \text{csape}(x,y,[2\ 2]) \) provides the variational, or natural cubic spline interpolant, as does \( \text{csape}(x,y,'v') \).

\( \text{csape}([-1\ 1],[3\ -1\ 1\ 6],[1\ 2]) \) provides the cubic polynomial \( p \) for which \( Dp(-1) = 3, p(-1) = -1, p(1) = 1, D^2p(1) = 6 \), i.e., \( p(x) = x^3 \).

Finally, \( \text{csape}([-1\ 1],[\ -1\ 1]) \) provides the straight line \( p \) for which \( p(\pm 1) = \pm 1 \), i.e., \( p(x) = x \).

End conditions other than the ones listed earlier can be handled along the following lines. Suppose that you want to enforce the condition

\[
\lambda(s) := aDs(e) + bD^2s(e) = c
\]

for given scalars \( a, b, \) and \( c \), and with \( e \) equal to \( x(1) \). Then one could compute the cubic spline interpolant \( s_1 \) to the given data using the default end condition as well as the cubic spline interpolant \( s_0 \) to zero data and some (nontrivial) end condition at \( e \), and then obtain the desired interpolant in the form

\[
s = s_1 + ((c - \lambda(s_1))/\lambda(s_0))s_0
\]

Here are the (not inconsiderable) details (in which the first polynomial piece of \( s_1 \) and \( s_0 \) is pulled out to avoid differentiating all of \( s_1 \) and \( s_0 \)):

\[
% \text{ Data: x and y}
[x, y] = \text{titanium}();
\]

\[
% \text{ Scalars } a, b, \text{ and } c
a = -2;
b = -1;
\]
c = 0;

% End condition at left
e = x(1);

e = x(1);

% The cubic spline interpolant s1 to the
% given data using the default end
% condition
s1 = csape(x,y);

% The cubic spline interpolant s0 to
% zero data and some (nontrivial) end
% condition at e
s0 = csape(x,[1,zeros(1,length(y)),0],[1,0]);

% Compute the derivatives of the first
% polynomial piece of s1 and s0
ds1 = fnder(fnbrk(s1,1));
ds0 = fnder(fnbrk(s0,1));

% Compute interpolant with desired end conditions
lam1 = a*fnval(ds1,e) + b*fnval(fnder(ds1),e);
lam0 = a*fnval(ds0,e) + b*fnval(fnder(ds0),e);
pp = fnctab(s0,(c-lam1)/lam0,s1);

Plot to see the results:

fnplt( pp, [594, 632] )
hold on
fnplt( s1, 'b--', [594, 632] )
plot( x, y, 'ro', 'MarkerFaceColor', 'r' )
hold off
axis( [594, 632, 0.62, 0.655] )
legend 'Desired end-conditions' ...
'Default end-conditions' 'Data' ...
As a multivariate vector-valued example, here is a sphere, done as a parametric bicubic spline, 3D-valued, using prescribed slopes in one direction and periodic end conditions in the other:

\[ x = 0:4; \quad y = -2:2; \quad s2 = 1/\sqrt{2}; \]

\[ v = \text{zeros}(3, 7, 5); \]
\[ v(1,:, :) = [1 \quad 0 \quad s2 \quad 1 \quad s2 \quad 0 \quad -1]'*[1 \quad 0 \quad -1 \quad 0 \quad 1]; \]
\[ v(2,:, :) = [1 \quad 0 \quad s2 \quad 1 \quad s2 \quad 0 \quad -1]'*[0 \quad 1 \quad 0 \quad -1 \quad 0]; \]
\[ v(3,:, :) = [0 \quad 1 \quad s2 \quad 0 \quad -s2 \quad -1 \quad 0]'*[1 \quad 1 \quad 1 \quad 1]; \]

\[ \text{sph} = \text{csape}({x,y},v,\{'\text{clamped}', '\text{periodic}'\}); \]

\[ \text{values} = \text{fnval}(\text{sph},\{0:.1:4,-2:.1:2\}); \]

\[ \text{surf}(\text{squeeze(values(1,:, :))}, \ldots \text{squeeze(values(2,:, :))}, \text{squeeze(values(3,:, :))}); \]

\[ \text{axis equal} \]
\[ \text{axis off} \]

The lines involving \text{fnval} and \text{surf} could have been replaced by the simple command: \text{fnplt(sph)}. Note that \( v \) is a 3-dimensional array, with \( v(:,i+1,j) \) the 3-vector to be matched at \((x(i),y(j))\), \(i=1:5, j=1:5\). Note further that, in accordance with \text{conds{1}} being 'clamped', size \( v,2 \) is 7 (and not 5), with the first and last entry of \( v(r,:,j) \) specifying the end slopes to be matched.

Here is a bivariate example that shows the need for supplying end conditions of end conditions when supplying end conditions in both variables. You reproduce the bicubic polynomial \( g(x,y) = x^3y^3 \) by complete bicubic interpolation. You then derive the needed data, including end condition values, directly from \( g \) in order to make it easier for you to see just how the end condition values must be placed. Finally, you check the result.

\[ \text{sites} = \{[0 \quad 1],[0 \quad 2]\}; \quad \text{coefs} = \text{zeros}(4, 4); \quad \text{coefs(1,1)} = 1; \]
\[ g = \text{ppmak(sites,coefs)}; \]
\[ \text{Dxg} = \text{fnval(fnder(g,[1 0]),sites)}; \]
Dyg = fnval(fnder(g,[0 1]),sites);
Dxyg = fnval(fnder(g,[1 1]),sites);

f = csape(sites,[Dxyg(1,1), Dxg(:,1), Dyg(:,1), fnval(g,sites), Dyg(:,2) ; 
Dxg(1,:), Dxyg(1,2), Dyg(1,:), Dxyg(:,1), Dxyg(1,2) ; 
Dxyg(2,1), Dxg(2,:), Dxyg(2,2)], ... 
{ 'complete','complete' });

if any(squeeze(fnbrk(f,'c'))-coefs)
    disp( 'this is wrong' )
end

Algorithms
The relevant tridiagonal linear system is constructed and solved using
the sparse matrix capabilities of MATLAB.

Cautionary Note

csape recognizes that you supplied explicit end condition values by the
fact that you supplied exactly two more data values than data sites. In
particular, even when using different end conditions at the two ends,
if you wish to supply an end condition value at one end, you must also
supply one for the other end.

See Also

csapi | spapi | spline
Purpose
Cubic spline interpolation

Syntax
pp=csapi(x,y)
values = csapi(x,y,xx)

Description
pp=csapi(x,y) returns the ppform of a cubic spline s with knot
sequence x that takes the value y(:,j) at x(j) for j=1:length(x).
The values y(:,j) can be scalars, vectors, matrices, even ND-arrays.
Data points with the same data site are averaged and then sorted by
their sites. With x the resulting sorted data sites, the spline s satisfies
the not-a-knot end conditions, namely \( \text{jump}_{x(2)}D^3s = 0 = \text{jump}_{x(\text{end}-1)}D^3s \)
(with \( D^3s \) the third derivative of \( s \)).

If x is a cell array, containing sequences x1, ..., xm, of lengths n1, ..., nm
respectively, then y is expected to be an array, of size \([n1,\ldots,nm]\)
(or of size \([d,n1,\ldots,nm]\) if the interpolant is to be d-valued). In that
case, pp is the ppform of an m-cubic spline interpolant s to such data. In
particular, now \( s(xl(i_1), ..., xm(i_m)) \) equals \( y(:,i_1, ..., i_m) \) for \( i_1 = 1:nl, ..., i_m = 1:nm. \)

You can use the structure pp, in fnval, fn2d, fnpl, etc, to evaluate,
differentiate, plot, etc, this interpolating cubic spline.

values = csapi(x,y,xx) is the same as fnval(csapi(x,y),xx), i.e.,
the values of the interpolating cubic spline at the sites specified by
xx are returned.

This command is essentially the MATLAB function spline, which, in
turn, is a stripped-down version of the Fortran routine CUBSPL in PGS,
except that csapi (and now also spline) accepts vector-valued data and
can handle gridded data.

Examples
See the example “Spline Interpolation” for various examples.

Up to rounding errors, and assuming that x is a vector with at least four
entries, the statement pp = csapi(x,y) should put the same spline
into pp as does the statement

pp = fn2fmspapi(augknt(x([1 3:(end-2) end]),4),x,y,'pp');
except that the description of the spline obtained this second way will use no break at \( x(2) \) and \( x(n-1) \).

Here is a simple bivariate example, a bicubic spline interpolant to the Mexican Hat function being plotted:

```matlab
x = .0001+[-4:.2:4]; y = -3:.2:3;
[yy,xx] = meshgrid(y,x); r = pi*sqrt(xx.^2+yy.^2); z = sin(r)./r;
wcs = csapi( {x,y}, z ); fnplt( wcs ), axis([-5 5 -5 5 -.5 1])
```

Note the reversal of \( x \) and \( y \) in the call to `meshgrid`, needed because MATLAB likes to think of the entry \( z(i,j) \) as the value at \( (x(j),y(i)) \) while this toolbox follows the Approximation Theory standard of thinking of \( z(i,j) \) as the value at \( (x(i),y(j)) \). Similar caution has to be exerted when values of such a bivariate spline are to be plotted with the aid of the MATLAB `mesh` function, as is shown here (note the use of the transpose of the matrix of values obtained from `fnval`).

```matlab
xf = linspace(x(1),x(end),41); yf = linspace(y(1),y(end),41);
mesh(xf, yf, fnval( wcs, {xf, yf}).').`
```

### Algorithms

The relevant tridiagonal linear system is constructed and solved, using the MATLAB sparse matrix capability.

The not-a-knot end condition is used, thus forcing the first and second polynomial piece of the interpolant to coincide, as well as the second-to-last and the last polynomial piece.

### See Also

csape | spapi | spline
**Purpose**

Cubic smoothing spline

**Syntax**

\[
pp = \text{csaps}(x,y)
\]

\[
\text{csaps}(x,y,p)
\]

\[
[\ldots,p] = \text{csaps}(\ldots)
\]

\[
\text{csaps}(x,y,p,[],w)
\]

\[
\text{values} = \text{csaps}(x,y,p,xx)
\]

\[
\text{csaps}(x,y,p,xx,w)
\]

\[
[\ldots] = \text{csaps}({x1,\ldots,xm},y,\ldots)
\]

**Description**

\[
pp = \text{csaps}(x,y)
\]

returns the ppform of a cubic smoothing spline \( f \) to the given data \( x,y \), with the value of \( f \) at the data site \( x(j) \) approximating the data value \( y(:,j) \), for \( j=1:\text{length}(x) \). The values may be scalars, vectors, matrices, even ND-arrays. Data points with the same site are replaced by their (weighted) average, with its weight the sum of the corresponding weights.

This smoothing spline \( f \) minimizes

\[
P \sum_{j=1}^{n} w(j) |y(:,j) - f(x(j))|^2 + (1 - p) \int \lambda(t) |D^2 f(t)|^2 \, dt
\]

Here, \( |z|^2 \) stands for the sum of the squares of all the entries of \( z \), \( n \) is the number of entries of \( x \), and the integral is over the smallest interval containing all the entries of \( x \). The default value for the weight vector \( w \) in the error measure is \( \text{ones(size}(x)) \). The default value for the piecewise constant weight function \( \lambda \) in the roughness measure is the constant function 1. Further, \( D^2 f \) denotes the second derivative of the function \( f \). The default value for the smoothing parameter, \( p \), is chosen in dependence on the given data sites \( x \).

If the smoothing spline is to be evaluated outside its basic interval, it must first be properly extrapolated, by the command \( pp = \text{fnxtr}(pp) \), to ensure that its second derivative is zero outside the interval spanned by the data sites.
\texttt{csaps}(x, y, p) \textbf{let}s you supply the smoothing parameter. The smoothing parameter determines the relative weight you would like to place on the contradictory demands of having \( f \) be smooth \textit{vs} having \( f \) be close to the data. For \( p = 0 \), \( f \) is the least-squares straight line fit to the data, while, at the other extreme, i.e., for \( p = 1 \), \( f \) is the variational, or ‘natural’ cubic spline interpolant. As \( p \) moves from 0 to 1, the smoothing spline changes from one extreme to the other. The interesting range for \( p \) is often near \( 1/(1 + h^3/6) \), with \( h \) the average spacing of the data sites, and it is in this range that the default value for \( p \) is chosen. For uniformly spaced data, one would expect a close following of the data for \( p = 1(1 + h^3/60) \) and some satisfactory smoothing for \( p = 1/(1 + h^3/0.6) \). You can input a \( p > 1 \), but this leads to a smoothing spline even rougher than the variational cubic spline interpolant.

If the input \( p \) is negative or empty, then the default value for \( p \) is used.

\[ [..., p] = \texttt{csaps}(...) \] also returns the value of \( p \) actually used whether or not you specified \( p \). This is important for experimentation which you might start with \([pp,p]=\texttt{csaps}(x,y)\) in order to obtain a 'reasonable' first guess for \( p \).

If you have difficulty choosing \( p \) but have some feeling for the size of the noise in \( y \), consider using instead \( \texttt{spaps}(x,y,\text{tol}) \) which, in effect, chooses \( p \) in such a way that the roughness measure

\[ \int \lambda(t)|D^2s(t)|^2 dt \]

is as small as possible subject to the condition that the error measure

\[ \sum w(j)|y(:,j)-s(x(j))|^2 \]

does not exceed the specified \( \text{tol} \). This usually means that the error measure equals the specified \( \text{tol} \).

The weight function \( \lambda \) in the roughness measure can, optionally, be specified as a (nonnegative) piecewise constant function, with breaks at the data sites \( x \), by inputting for \( p \) a \textit{vector} whose \( i \)th entry provides the value of \( \lambda \) on the interval \((x(i-1) .. x(i))\) for \( i = 2:\text{length}(x) \). The first
entry of the input vector \( p \) continues to be used as the desired value of
the smoothness parameter \( p \). In this way, it is possible to insist that the
resulting smoothing spline be smoother (by making the weight function
larger) or closer to the data (by making the weight functions smaller)
in some parts of the interval than in others.

\[
\text{csaps}(x,y,p,[],w) \text{ lets you specify the weights } w \text{ in the error
measure, as a vector of nonnegative entries of the same size as } x.
\]

\[
\text{values } = \text{csaps}(x,y,p,xx) \text{ is the same as } \text{fnval(csaps}(x,y,p),xx).
\]

\[
\text{csaps}(x,y,p,xx,w) \text{ is the same as } \text{fnval(csaps}(x,y,p,[],w),xx).
\]

\[
[... ] = \text{csaps}({x1,...,xm},y,...) \text{ provides the ppform of an
m-variate tensor-product smoothing spline to data on a rectangular
grid. Here, the first argument is a cell-array, containing the vectors
x1, ..., xm, of lengths n1, ..., nm, respectively. Correspondingly, y is an
array of size [n1,...,nm] (or of size [d,n1,...,nm] in case the data
are d-valued), with y(:,i1,...,im) the given (perhaps noisy) value at the
grid site xl(i1), ...,xm(im).
\]

In this case, \( p \) if input must be a cell-array with \( m \) entries or else an
\( m \)-vector, except that it may also be a scalar or empty, in which case it
is taken to be the cell-array whose \( m \) entries all equal the \( p \) input. The
optional second output argument will always be a cell-array with \( m \)
entries.

Further, \( w \) if input must be a cell-array with \( m \) entries, with \( w\{i\} \) either
empty, to indicate the default choice, or else a nonnegative vector of
the same size as \( x_i \).

**Examples**

**Example 1.**

\[
x = \text{linspace}(0,2*\text{pi},21); 
y = \sin(x)+\text{(rand(1,21)-.5)*.1};
pp = \text{csaps}(x,y, .4, [], [\text{ones}(1,10), \text{repmat}(5,1,10), 0] ) ;
\]

returns a smooth fit to the (noisy) data that is much closer to the data
in the right half, because of the much larger error weight there, except
for the last data point, for which the weight is zero.
uses the same data, smoothing parameter, and error weight but chooses the roughness weight to be only .2 in the right half of the interval and gives, correspondingly, a rougher but better fit there, except for the last data point, which is ignored.

A plot showing both examples for comparison can now be obtained by

```matlab
fnplt(pp); hold on, fnplt(pp1,'r--'), plot(x,y,'ok'), hold off
title(['cubic smoothing spline, with right half treated ',...
       'differently:'])
xlabel(['blue: larger error weights; ', ...
       'red dashed: also smaller roughness weights'])
```

The resulting plot is shown below.
Example 2. This bivariate example adds some uniform noise, from the interval \([-1/2 .. 1/2]\), to values of the MATLAB `peaks` function on a 51-by-61 uniform grid, obtain smoothed values for these data from `csaps`, along with the smoothing parameters chosen by `csaps`, and then plot these smoothed values.

```matlab
x = {linspace(-2,3,51),linspace(-3,3,61)};
[xx,yy] = ndgrid(x{1},x{2}); y = peaks(xx,yy);
rand('state',0), noisy = y+(rand(size(y))-.5);
[smooth,p] = csaps(x,noisy,[],x);
surf(x{1},x{2},smooth.'), axis off
```

Note the need to transpose the array `smooth`. For a somewhat smoother approximation, use a slightly smaller value of `p` than the one, \(.9998889\), used above by `csaps`. The final plot is obtained by the following:

```matlab
smoother = csaps(x,noisy,.996,x);
figure, surf(x{1},x{2},smoother.'), axis off
```
 Algorithms  

csaps is an implementation of the Fortran routine SMOOTH from PGS.

The default value for p is determined as follows. The calculation of
the smoothing spline requires the solution of a linear system whose
coefficient matrix has the form $pA + (1-p)B$, with the matrices $A$
and $B$ depending on the data sites $x$. The default value of $p$ makes
$p\cdot\text{trace}(A) = (1-p)\cdot\text{trace}(B)$.

 See Also  

csape | spap2 | spaps | tpaps
Purpose

“Natural” or periodic interpolating cubic spline curve

Syntax

curve = cscvn(points)

Description

curve = cscvn(points) returns a parametric variational, or natural, cubic spline curve (in ppform) passing through the given sequence points(j), j = 1:end. The parameter value t(j) for the jth point is chosen by Eugene Lee’s [1] centripetal scheme, i.e., as accumulated square root of chord length:

$$
\sum_{i<j} \sqrt{\| \text{points}(;,i+1) - \text{points}(;,i) \|_2}
$$

If the first and last point coincide (and there are no other repeated points), then a periodic cubic spline curve is constructed. However, double points result in corners.

Examples

The following provides the plot of a questionable curve through some points (marked as circles):

points=[0 1 1 0 -1 -1 0 0; 0 0 1 2 1 0 -1 -2];
fnplt(cscvn(points)); hold on,
plot(points(1,:),points(2,:),'o'), hold off

Here is a closed curve, good for 14 February, with one double point:

c=fnplt(cscvn([0 .82 .92 0 0 -.92 -.82 0; .66 .9 0 ... -.83 -.83 0 .9 .66])); fill(c(1,:),c(2,:),repmat('r',1,4)), axis equal

Algorithms

The break sequence t is determined as

$$
t = \text{cumsum}([0;((\text{diff(points.').}^2)\text{ones(d,1)}.^{(1/4)})].');
$$

and csape (with either periodic or variational end conditions) is used to construct the smooth pieces between double points (if any).
References


See Also

csape | fnplt | getcurve
datastats

Purpose
Data statistics

Syntax
xds = datastats(x)
[xds, yds] = datastats(x, y)

Description
xds = datastats(x) returns statistics for the column vector x to the structure xds. Fields in xds are listed in the table below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>num</td>
<td>The number of data values</td>
</tr>
<tr>
<td>max</td>
<td>The maximum data value</td>
</tr>
<tr>
<td>min</td>
<td>The minimum data value</td>
</tr>
<tr>
<td>mean</td>
<td>The mean value of the data</td>
</tr>
<tr>
<td>median</td>
<td>The median value of the data</td>
</tr>
<tr>
<td>range</td>
<td>The range of the data</td>
</tr>
<tr>
<td>std</td>
<td>The standard deviation of the data</td>
</tr>
</tbody>
</table>

[xds, yds] = datastats(x, y) returns statistics for the column vectors x and y to the structures xds and yds, respectively. xds and yds contain the fields listed in the table above. x and y must be of the same size.

Tips
If x or y contains complex values, only the real parts are used in computing the statistics. Data containing Inf or NaN are processed using the usual MATLAB rules.

Examples
Compute statistics for the census data in census.mat:

load census
[xds, yds] = datastats(cdate, pop)
xds =
    num: 21
    max: 1990
    min: 1790
mean: 1890
median: 1890
range: 200
  std: 62.048
yds =
  num: 21
  max: 248.7
  min: 3.9
  mean: 85.729
  median: 62.9
  range: 244.8
  std: 78.601

See Also

excludedata, smooth
Purpose

Dependent variable of cfit, sfit, or fittype object

Syntax

dep = dependnames(fun)

Description

dep = dependnames(fun) returns the (single) dependent variable name of the cfit, sfit, or fittype object fun as a 1-by-1 cell array of strings dep.

Examples

f1 = fittype('a*x^2+b*exp(n*x)');
dep1 = dependnames(f1)
dep1 =
   'y'

f2 = fittype('a*x^2+b*exp(n*x)', 'dependent', 'power');
dep2 = dependnames(f2)
dep2 =
   'power'

See Also

indepnames | fittype | formula
**Purpose**
Differentiate cfit or sfit object

**Syntax**

- `fx = differentiate(FO, X)`
- `[fx, fxx] = differentiate(...)`
- `[fx, fy] = differentiate(FO, X, Y)`
- `[fx, fy] = differentiate(FO, [x, y])`
- `[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...)`

**Description**

**For Curves**

`fx = differentiate(FO, X)` differentiates the cfit object `FO` at the points specified by the vector `X` and returns the result in `fx`.

`[fx, fxx] = differentiate(...)` also returns the second derivative in `fxx`.

All return arguments are the same size and shape as `X`.

**For Surfaces**

`[fx, fy] = differentiate(FO, X, Y)` differentiates the surface `FO` at the points specified by `X` and `Y` and returns the result in `fx` and `fy`.

`FO` is a surface fit (sfit) object generated by the `fit` function.

`X` and `Y` must be double-precision arrays and the same size and shape as each other.

All return arguments are the same size and shape as `X` and `Y`.

If `FO` represents the surface $z = f(x, y)$, then `FX` contains the derivatives with respect to $x$, that is, $\frac{df}{dx}$, and `FY` contains the derivatives with respect to $y$, that is, $\frac{df}{dy}$.

`[fx, fy] = differentiate(FO, [x, y])`, where `X` and `Y` are column vectors, allows you to specify the evaluation points as a single argument.

`[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...)` computes the first and second derivatives of the surface fit object `FO`. 
fx contains the second derivatives with respect to x, that is, \( \frac{\partial^2 f}{\partial x^2} \).

fy contains the second derivatives with respect to y, that is, \( \frac{\partial^2 f}{\partial y^2} \).

Tips

For library models with closed forms, the toolbox calculates derivatives analytically. For all other models, the toolbox calculates the first derivative using the centered difference quotient

\[
\frac{df}{dx} = \frac{f(x + \Delta x) - f(x - \Delta x)}{2\Delta x}
\]

where \( x \) is the value at which the toolbox calculates the derivative, \( \Delta x \) is a small number (on the order of the cube root of \( \text{eps} \)), \( f(x + \Delta x) \) is \( \text{fun} \) evaluated at \( x + \Delta x \), and \( f(x - \Delta x) \) is \( \text{fun} \) evaluated at \( x - \Delta x \).

The toolbox calculates the second derivative using the expression

\[
\frac{d^2 f}{dx^2} = \frac{f(x + \Delta x) + f(x - \Delta x) - 2f(x)}{\Delta x^2}
\]

The toolbox calculates the mixed derivative for surfaces using the expression

\[
\frac{\partial^2 f}{\partial x \partial y}(x, y) = \frac{f(x + \Delta x, y + \Delta y) - f(x - \Delta x, y + \Delta y) - f(x + \Delta x, y - \Delta y) + f(x - \Delta x, y - \Delta y)}{4\Delta x \Delta y}
\]

Examples

For Curves

Create a baseline sinusoidal signal:
xdata = (0:.1:2*pi)';
y0 = sin(xdata);

Add noise to the signal:
noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:
f = fittype('a*sin(b*x)');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);

Find the derivatives of the fit at the predictors:
[d1,d2] = differentiate(fit1,xdata);

Plot the data, the fit, and the derivatives:
subplot(3,1,1)
plot(fit1,xdata,ydata) % cfit plot method
subplot(3,1,2)
plot(xdata,d1,'m') % double plot method
grid on
legend('1st derivative')
subplot(3,1,3)
plot(xdata,d2,'c') % double plot method
grid on
legend('2nd derivative')
You can also compute and plot derivatives directly with the `cfit plot` method, as follows:

```matlab
plot(fit1,xdata,ydata,'fit','deriv1','deriv2')
```

The `plot` method, however, does not return data on the derivatives, unlike the `differentiate` method.
For Surfaces

You can use the differentiate method to compute the gradients of a fit and then use the quiver function to plot these gradients as arrows. The following example plots the gradients over the top of a contour plot.

```matlab
x = [0.64;0.95;0.21;0.71;0.24;0.61;0.45;0.46;... 0.66;0.77;0.35;0.66];
y = [0.42;0.84;0.83;0.26;0.61;0.58;0.54;0.87;0.26;... 0.32;0.12;0.94;0.65];
z = [0.49;0.051;0.27;0.59;0.35;0.41;0.3;0.084;0.6;... 0.58;0.37;0.19;0.19];
fo = fit( [x, y], z, 'poly32', 'normalize', 'on' );
[xx, yy] = meshgrid( 0:0.04:1, 0:0.05:1 );

[fx, fy] = differentiate( fo, xx, yy );

plot( fo, 'Style', 'Contour' );
hold on
h = quiver( xx, yy, fx, fy, 'r', 'LineWidth', 2 );
hold off
colormap( copper )
```
If you want to use derivatives in an optimization, you can, for example, implement an objective function for `fmincon` as follows.

```matlab
function [z, g, H] = objectiveWithHessian( xy )
    % The input xy represents a single evaluation point
    z = f( xy );
    if nargout > 1
        [fx, fy, fxx, fxy, fyy] = differentiate( f, xy );
        g = [fx, fy];
        H = [fxx, fxy; fxy, fyy];
    end
end
```

**See Also**

`fit` | `plot` | `integrate`
**Purpose**

Exclude data from fit

**Syntax**

```matlab
outliers = excludedata(xdata, ydata, MethodName, MethodValue)
```

**Description**

`outliers = excludedata(xdata, ydata, MethodName, MethodValue)` identifies data to be excluded from a fit using the specified `MethodName` and `MethodValue`. `outliers` is a logical vector, with 1 marking predictors (`xdata`) to exclude and 0 marking predictors to include. Supported `MethodName` and `MethodValue` pairs are given in the table below.

<table>
<thead>
<tr>
<th>MethodName</th>
<th>MethodValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>'box'</td>
<td>A four-element vector specifying the edges of a closed box in the <code>xy</code>-plane, outside of which data is to be excluded from a fit. The vector has the form <code>[xmin xmax ymin ymax]</code>.</td>
</tr>
<tr>
<td>'domain'</td>
<td>A two-element vector specifying the endpoints of a closed interval on the <code>x</code>-axis, outside of which data is to be excluded from a fit. The vector has the form <code>[xmin xmax]</code>.</td>
</tr>
<tr>
<td>'indices'</td>
<td>A vector of indices specifying the data points to be excluded.</td>
</tr>
<tr>
<td>'range'</td>
<td>A two-element vector specifying the endpoints of a closed interval on the <code>y</code>-axis, outside of which data is to be excluded from a fit. The vector has the form <code>[ymin ymax]</code>.</td>
</tr>
</tbody>
</table>

**Tips**

You can combine data exclusion rules using logical operators. For example, to exclude data *inside* the box `[-1 1 -1 1]` or *outside* the domain `[-2 2]`, use:

```matlab
outliers1 = excludedata(xdata,ydata,'box',[-1 1 -1 1]);
outliers2 = excludedata(xdata,ydata,'domain',[-2 2]);
outliers = ~outliers1|outliers2;
```
You can visualize the combined exclusion rule using random data:

\[
xdata = -3 + 6 \times \text{rand}(1,1e4);
\]

\[
ydata = -3 + 6 \times \text{rand}(1,1e4);
\]

\[
\text{plot}(xdata(-\text{outliers}),ydata(-\text{outliers}),'.')
\]

\[
\text{axis}([[-3 3 -3 3]])
\]

\[
\text{axis square}
\]

Examples

Load the vote counts and county names for the state of Florida from the 2000 U.S. presidential election:

\[
\text{load flvote2k}
\]

Use the vote counts for the two major party candidates, Bush and Gore, as predictors for the vote counts for third-party candidate Buchanan, and plot the scatters:

\[
\text{plot}(\text{bush},\text{buchanan},'rs')
\]

\[
\text{hold on}
\]

\[
\text{plot}(\text{gore},\text{buchanan},'bo')
\]
Assume a model where a fixed proportion of Bush or Gore voters choose to vote for Buchanan:

\[ f = \text{fittype}('x') \]
\[ f = \]
\[ \text{Linear model:} \]
\[ f(a,x) = ax \]

Exclude the data from absentee voters, who did not use the controversial “butterfly” ballot:

`absentee = find(strcmp(counties,'Absentee Ballots'));`  
`nobutterfly = excludedata(bush,buchanan,... 'indices',absentee);`

Perform a bisquare weights robust fit of the model to the two data sets, excluding absentee voters:
bushfit = fit(bush,buchanan,f,...
   'Exclude',nobutterfly,'Robust','on');
gorefit = fit(gore,buchanan,f,...
   'Exclude',nobutterfly,'Robust','on');

Robust fits give outliers a low weight, so large residuals from a robust fit can be used to identify the outliers:

figure
plot(bushfit,bush,buchanan,'rs','residuals')
hold on
plot(gorefit,gore,buchanan,'bo','residuals')

The residuals in the plot above can be computed as follows:

bushres = buchanan - feval(bushfit,bush);
goreres = buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [-500 500]:

12-50
bushoutliers = excludedata(bush, bushres, ...
   'range', [-500 500]);
goreoutliers = excludedata(gore, goreres, ...
   'range', [-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =
   'Miami-Dade'
   'Palm Beach'

counties(goreoutliers)
ans =
   'Broward'
   'Miami-Dade'
   'Palm Beach'

Miami-Dade and Broward counties correspond to the largest predictor values. Palm Beach county, the only county in the state to use the “butterfly” ballot, corresponds to the largest residual values.

See Also
fit | fitoptions
### Purpose
Evaluate `cfit`, `sfit`, or `fittype` object

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>y = feval(cfun,x)</code></td>
<td><code>feval</code> method to evaluate the estimated function, either at your original data points, or at new locations. The latter is often referred to as interpolation or prediction, depending on the type of model. You can also use <code>feval</code> to extrapolate the estimated function’s value at new locations that are not within the range of the original data.</td>
</tr>
<tr>
<td><code>z = feval(sfun,[x,y])</code></td>
<td></td>
</tr>
<tr>
<td><code>z = feval(sfun,x,y)</code></td>
<td></td>
</tr>
<tr>
<td><code>y = feval(ffun,coeff1,coeff2,...,x)</code></td>
<td></td>
</tr>
<tr>
<td><code>z = feval(ffun,coeff1,coeff2,...,x,y)</code></td>
<td></td>
</tr>
</tbody>
</table>

Alternatively, you can use the `feval` method to evaluate the estimated function, either at your original data points, or at new locations. The latter is often referred to as interpolation or prediction, depending on the type of model. You can also use `feval` to extrapolate the estimated function’s value at new locations that are not within the range of the original data.

`y = feval(cfun,x)` evaluates the `cfit` object `cfun` at the predictor values in the column vector `x` and returns the response values in the column vector `y`.

`z = feval(sfun,[x,y])` evaluates the `sfit` object `sfun` at the predictor values in the two column matrix `[x,y]` and returns the response values in the column vector `z`.

`z = feval(sfun,x,y)` evaluates the `sfit` object `sfun` at the predictor values in the matrices `x` and `y` that must be the same size. It returns the response values in the matrix `z` that will be the same size as `x` and `y`. 
y = feval(ffun,coeff1,coeff2,...,x) assigns the coefficients coeff1, coeff2, etc. to the fittype object ffun, evaluates it at the predictor values in the column vector x, and returns the response values in the column vector y. ffun cannot be a cfit object in this syntax. To evaluate cfit objects, use the first syntax.

z = feval(ffun,coeff1,coeff2,...,x,y) achieves a similar result for a fittype object for a surface.

**Examples**

```matlab
f = fittype('a*x^2+b*exp(n*x)');
c = cfit(f,1,10.3,-1e2);
X = rand(2)
X =
    0.0579    0.8132
    0.3529    0.0099

y1 = feval(f,1,10.3,-1e2,X)
y1 =
    0.0349    0.6612
    0.1245    3.8422

y1 = f(1,10.3,-1e2,X)
y1 =
    0.0349    0.6612
    0.1245    3.8422

y2 = feval(c,X)
y2 =
    0.0349
    0.1245
    0.6612
    3.8422

y2 = c(X)
y2 =
    0.0349
    0.1245
    0.6612
    3.8422
```
See Also

fit | fitype | cfit
Purpose

Fit curve or surface to data

Syntax

fitobject = fit(x,y,fitType)
fitobject = fit([x,y],z,fitType)
fitobject = fit(x,y,fitType,fitOptions)
fitobject = fit(x,y,fitType,Name,Value)
[fitobject,gof] = fit(x,y,fitType)
[fitobject,gof,output] = fit(x,y,fitType)

Description

fitobject = fit(x,y,fitType) creates the fit to the data in x and y with the model specified by fitType.

fitobject = fit([x,y],z,fitType) creates a surface fit to the data in vectors x, y, and z.

fitobject = fit(x,y,fitType,fitOptions) creates a fit to the data using the algorithm options specified by the fitOptions object.

fitobject = fit(x,y,fitType,Name,Value) creates a fit to the data using the library model fitType with additional options specified by one or more Name,Value pair arguments. Use fitoptions to display available property names and default values for the specific library model.

[fitobject,gof] = fit(x,y,fitType) returns goodness-of-fit statistics in the structure gof.

[fitobject,gof,output] = fit(x,y,fitType) returns fitting algorithm information in the structure output.
Input Arguments

\(x\) - Data to fit

matrix

Data to fit, specified as a matrix with either one (curve fitting) or two (surface fitting) columns. Cannot contain Inf or NaN. Only the real parts of complex data are used in the fit.

Example: \(x\)

Example: \([x,y]\)

Data Types
double

\(y\) - Data to fit

vector

Data to fit, specified as a column vector with the same number of rows as \(x\). Cannot contain Inf or NaN. Only the real parts of complex data are used in the fit.

Data Types
double

\(z\) - Data to fit

vector

Data to fit, specified as a column vector with the same number of rows as \(x\). Cannot contain Inf or NaN. Only the real parts of complex data are used in the fit.

Data Types
double | double

\(\text{fitType}\) - Model type to fit

string | cell array of strings | anonymous function | fittype

Model type to fit, specified as a library model name string, a MATLAB expression, a cell array of linear models terms, an anonymous function, or a fittype constructed with the fittype function. You can use any of the valid first inputs to fittype as an input to fit.
For a list of library model names, see “Model Names and Equations” on page 4-14. This table shows some common examples.

<table>
<thead>
<tr>
<th>Library Model Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'poly1'</td>
<td>Linear polynomial curve</td>
</tr>
<tr>
<td>'poly11'</td>
<td>Linear polynomial surface</td>
</tr>
<tr>
<td>'poly2'</td>
<td>Quadratic polynomial curve</td>
</tr>
<tr>
<td>'linearinterp'</td>
<td>Piecewise linear interpolation</td>
</tr>
<tr>
<td>'cubicinterp'</td>
<td>Piecewise cubic interpolation</td>
</tr>
<tr>
<td>'smoothingspline'</td>
<td>Smoothing spline (curve)</td>
</tr>
<tr>
<td>'lowess'</td>
<td>Local linear regression (surface)</td>
</tr>
</tbody>
</table>

To fit custom models, use a MATLAB expression, a cell array of linear model terms, an anonymous function, or create a `fittype` with the `fittype` function and use this as the `fitType` argument. For an example, see “Fit a Custom Model Using an Anonymous Function” on page 12-72.

Example: 'poly2'

**fitOptions - Algorithm options**

`fitoptions`

Algorithm options constructed using the `fitoptions` function. This is an alternative to specifying name-value pair arguments for fit options.

**Name-Value Pair Arguments**

Specify optional comma-separated pairs of `Name,Value` arguments. `Name` is the argument name and `Value` is the corresponding value. `Name` must appear inside single quotes ('). You can specify several name and value pair arguments in any order as `Name1,Value1,...,NameN,ValueN`. 
Example: 'Lower',[0,0],'Upper',[Inf,max(x)],'StartPoint',[1 1] specifies fitting method, bounds, and start points.

Options for All Fitting Methods

‘Normalize’ - Option to center and scale data
'off' (default) | 'on'

Option to center and scale the data, specified as the comma-separated pair consisting of 'Normalize' and 'on' or 'off'.

Data Types
char

‘Exclude’ - Points to exclude from fit
expression | index vector | logical vector | empty

Points to exclude from the fit, specified as the comma-separated pair consisting of 'Exclude' and one of:

- An expression describing a logical vector, e.g., x > 10.
- A vector of integers indexing the points you want to exclude, e.g., [1 10 25].
- A logical vector for all data points where true represents an outlier, created by excludedata.

For an example, see “Exclude Points from Fit” on page 12-69.

Data Types
logical | double

‘Weights’ - Weights for fit
[] (default) | vector

Weights for the fit, specified as the comma-separated pair consisting of 'Weights' and a vector the same size as the response data y (curves) or z (surfaces).

Data Types
double
'problem' - Values to assign to problem-dependent constants

Values to assign to the problem-dependent constants, specified as the comma-separated pair consisting of 'problem' and a cell array with one element per problem dependent constant. For details, see fittype.

Data Types

cell | double

Smoothing Options

'SmoothingParam' - Smoothing parameter

Smoothing parameter, specified as the comma-separated pair consisting of 'SmoothingParam' and a scalar value between 0 and 1. The default value depends on the data set. Only available if the fit type is smoothingspline.

Data Types

double

'Span' - Proportion of data points to use in local regressions

Proportion of data points to use in local regressions, specified as the comma-separated pair consisting of 'Span' and a scalar value between 0 and 1. Only available if the fit type is lowess or loess.

Data Types

double

Linear and Nonlinear Least-Squares Options

'Robust' - Robust linear least-squares fitting method

Robust linear least-squares fitting method, specified as the comma-separated pair consisting of 'Robust' and one of these values:
- 'LAR' specifies the least absolute residual method.
- 'Bisquare' specifies the bisquare weights method.

Available when the fit type Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types
char

'Lower' - Lower bounds on coefficients to be fitted
[ ] (default) | vector

Lower bounds on the coefficients to be fitted, specified as the comma-separated pair consisting of 'Lower' and a vector. The default value is an empty vector, indicating that the fit is unconstrained by lower bounds. If bounds are specified, the vector length must equal the number of coefficients. Find the order of the entries for coefficients in the vector value by using the coeffnames function. For an example, see “Find Coefficient Order to Set Start Points and Bounds” on page 12-73. Individual unconstrained lower bounds can be specified by -Inf.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types
double

'Upper' - Upper bounds on coefficients to be fitted
[ ] (default) | vector

Upper bounds on the coefficients to be fitted, specified as the comma-separated pair consisting of 'Upper' and a vector. The default value is an empty vector, indicating that the fit is unconstrained by upper bounds. If bounds are specified, the vector length must equal the number of coefficients. Find the order of the entries for coefficients in the vector value by using the coeffnames function. For an example, see “Find Coefficient Order to Set Start Points and Bounds” on page 12-73. Individual unconstrained upper bounds can be specified by -Inf.
Available when the Method is `LinearLeastSquares` or `NonlinearLeastSquares`.

**Data Types**

logical

**Nonlinear Least-Squares Options**

`'StartPoint' - Initial values for the coefficients`

Initial values for the coefficients, specified as the comma-separated pair consisting of `'StartPoint'` and a vector. Find the order of the entries for coefficients in the vector value by using the `coeffnames` function. For an example, see “Find Coefficient Order to Set Start Points and Bounds” on page 12-73.

If no start points (the default value of an empty vector) are passed to the `fit` function, starting points for some library models are determined heuristically. For rational and Weibull models, and all custom nonlinear models, the toolbox selects default initial values for coefficients uniformly at random from the interval (0,1). As a result, multiple fits using the same data and model might lead to different fitted coefficients. To avoid this, specify initial values for coefficients with a `fitoptions` object or a vector value for the `StartPoint` value.

Available when the Method is `NonlinearLeastSquares`.

**Data Types**

double

`'Algorithm' - Algorithm to use for fitting procedure`

`'Levenberg-Marquardt'` (default) | `'Trust-Region'`

Algorithm to use for the fitting procedure, specified as the comma-separated pair consisting of `'Algorithm'` and either `'Levenberg-Marquardt'` or `'Trust-Region'`.

Available when the Method is `NonlinearLeastSquares`. 
Data Types
char

‘DiffMaxChange’ - Maximum change in coefficients for finite difference gradients
$10^{-8}$ (default)

Maximum change in coefficients for finite difference gradients, specified as the comma-separated pair consisting of 'DiffMaxChange' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

‘DiffMinChange’ - Minimum change in coefficients for finite difference gradients
$10^{-8}$ (default)

Minimum change in coefficients for finite difference gradients, specified as the comma-separated pair consisting of 'DiffMinChange' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

‘Display’ - Display option in Command Window
‘notify’ (default) | ‘final’ | ‘iter’ | ‘off’

Display option in the command window, specified as the comma-separated pair consisting of 'Display' and one of these options:

- 'notify' displays output only if the fit does not converge.
- 'final' displays only the final output.
- 'iter' displays output at each iteration.
- 'off' displays no output.
Available when the Method is NonlinearLeastSquares.

Data Types
char

'MaxFunEvals' - Maximum number of evaluations of model allowed
600 (default)

Maximum number of evaluations of the model allowed, specified as the comma-separated pair consisting of 'MaxFunEvals' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

'MaxIter' - Maximum number of iterations allowed for fit
400 (default)

Maximum number of iterations allowed for the fit, specified as the comma-separated pair consisting of 'MaxIter' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

'TolFun' - Termination tolerance on model value
$10^{-6}$ (default)

Termination tolerance on the model value, specified as the comma-separated pair consisting of 'TolFun' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

'TolX' - Termination tolerance on coefficient values
$10^{-6}$ (default)
Termination tolerance on the coefficient values, specified as the comma-separated pair consisting of 'TolX' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

**Output Arguments**

**fitobject - Fit result**

Fit result, returned as a cfit (for curves) or sfit (for surfaces) object. See “Fit Postprocessing” for functions for plotting, evaluating, calculating confidence intervals, integrating, differentiating, or modifying your fit object.

**gof - Goodness-of-fit statistics**

Goodness-of-fit statistics, returned as the gof structure including the fields in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sse</td>
<td>Sum of squares due to error</td>
</tr>
<tr>
<td>R2</td>
<td>R-squared (coefficient of determination)</td>
</tr>
<tr>
<td>adjustedR2</td>
<td>Degree-of-freedom adjusted coefficient of determination</td>
</tr>
<tr>
<td>stdError</td>
<td>Root mean squared error (standard error)</td>
</tr>
</tbody>
</table>

**output - Fitting algorithm information**

Fitting algorithm information, returned as the output structure containing information associated with the fitting algorithm.

Fields depend on the algorithm. For example, the output structure for nonlinear least-squares algorithms includes the fields shown in this table.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>numobs</td>
<td>Number of observations (response values)</td>
</tr>
<tr>
<td>numparam</td>
<td>Number of unknown parameters (coefficients) to fit</td>
</tr>
<tr>
<td>residuals</td>
<td>Vector of residuals</td>
</tr>
<tr>
<td>Jacobian</td>
<td>Jacobian matrix</td>
</tr>
<tr>
<td>exitflag</td>
<td>Describes the exit condition of the algorithm. Positive flags indicate convergence, within tolerances. Zero flags indicate that the maximum number of function evaluations or iterations was exceeded. Negative flags indicate that the algorithm did not converge to a solution.</td>
</tr>
<tr>
<td>iterations</td>
<td>Number of iterations</td>
</tr>
<tr>
<td>funcCount</td>
<td>Number of function evaluations</td>
</tr>
<tr>
<td>firstorderopt</td>
<td>Measure of first-order optimality (absolute maximum of gradient components)</td>
</tr>
<tr>
<td>algorithm</td>
<td>Fitting algorithm employed</td>
</tr>
</tbody>
</table>

### Examples

#### Fit a Quadratic Curve

Load some data, fit a quadratic curve to variables `cdate` and `pop`, and plot the fit and data.

```matlab
load census;
f = fit(cdate, pop, 'poly2');
plot(f, cdate, pop)
```

For a list of library model names, see “Model Names and Equations” on page 4-14.
Fit a Polynomial Surface

Load some data and fit a polynomial surface of degree 2 in x and degree 3 in y. Plot the fit and data.

```matlab
load franke
sf = fit( [x, y], z, 'poly23');
plot(sf, [x,y], z)
```

Create Fit Options and Fit Type Before Fitting

Load and plot the data, create fit options and fit type using the `fittype` and `fitoptions` functions, then create and plot the fit.

Load and plot the data in `census.mat`.

```matlab
load census
plot(cdate,pop,'o')
```

Create a fit options object and a fit type for the custom nonlinear model
\[ y = a(x-b)^n, \]
where a and b are coefficients and \( n \) is a problem-dependent parameter.

```matlab
fo = fitoptions('Method','NonlinearLeastSquares',...'
'Lower',[0,0],...
'Upper',[Inf,max(cdate)],...
'StartPoint',[1 1]);
ft = fittype('a*(x-b)^n','problem','n','options',fo);
```

Fit the data using the fit options and a value of \( n = 2 \).

```matlab
[curve2,gof2] = fit(cdate,pop,ft,'problem',2)
```

```matlab
curve2 =
General model:
c2(x) = a*(x-b)^n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
```
Fit the data using the fit options and a value of \( n = 3 \).

\[
[curve3,gof3] = \text{fit}(\text{cdate}, \text{pop}, \text{ft}, '\text{problem}', 3)
\]

curve3 =

General model:
\[ c3(x) = a*(x-b)^n \]

Coefficients (with 95% confidence bounds):
\[ a = 1.359e-005 \ (1.245e-005, \ 1.474e-005) \]
\[ b = 1725 \ (1718, \ 1731) \]

Problem parameters:
\[ n = 3 \]

gof3 =

\[
\begin{align*}
\text{sse: } & 232.0058 \\
\text{rsquare: } & 0.9981 \\
\text{dfe: } & 19 \\
\text{adjrsquare: } & 0.9980 \\
\text{rmse: } & 3.4944
\end{align*}
\]

Plot the fit results with the data.

\[
\begin{align*}
\text{hold on} & \\
\text{plot}(\text{curve2}, 'm') & \\
\text{plot}(\text{curve3}, 'c') & \\
\text{legend('Data', 'n=2', 'n=3')} & \\
\text{hold off} &
\end{align*}
\]
**Fit a Cubic Polynomial Specifying Normalize and Robust Options**

Load some data and fit and plot a cubic polynomial with center and scale (Normalize) and robust fitting options.

```matlab
load census;
f=fit(cdate,pop,'poly3','Normalize','on','Robust','Bisquare')
plot(f,cdate,pop)
```

**Fit a Curve Defined by a File**

Define a function in a file and use it to create a fit type and fit a curve.

Define a function in a MATLAB file.

```matlab
function y = piecewiseLine(x,a,b,c,d,k)
% PIECEWISELINE A line made of two pieces
% that is not continuous.

y = zeros(size(x));

% This example includes a for-loop and if statement
% purely for example purposes.
for i = 1:length(x)
    if x(i) < k,
        y(i) = a + b.* x(i);
    else
        y(i) = c + d.* x(i);
    end
end
end
```

Save the file.

Define some data, create a fit type specifying the function `piecewiseLine`, create a fit using the fit type `ft`, and plot the results.

```matlab
x = [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;... 0.96;0.96;0.16;0.97;0.96];
```
y = [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56;...
0.15;-0.046;0.17;-0.091;-0.071];
ft = fittype( 'piecewiseLine( x, a, b, c, d, k )' )
f = fit( x, y, ft, 'StartPoint', [1, 0, 1, 0, 0.5] )
plot( f, x, y )

**Exclude Points from Fit**

Load some data and fit a custom equation specifying points to exclude. Plot the results.

Load data and define a custom equation and some start points.

[x, y] = titanium;

gaussEqn = 'a*exp(-((x-b)/c)^2)+d'
startPoints = [1.5 900 10 0.6]

Create two fits using the custom equation and start points, and define two different sets of excluded points, using an index vector and an expression. Use Exclude to remove outliers from your fit.

f1 = fit(x',y',gaussEqn,'Start', startPoints, 'Exclude', [1 10 25])
f2 = fit(x',y',gaussEqn,'Start', startPoints, 'Exclude', x < 800)

Plot both fits.

plot(f1,x,y)
title('Fit with data points 1, 10, and 25 excluded')
figure
plot(f2,x,y)
title('Fit with data points excluded such that x < 800')

**Exclude Points and Plot Fit Showing Excluded Data**

You can define the excluded points as variables before supplying them as inputs to the fit function. The following steps recreate the fits in
Load data and define a custom equation and some start points.

\[
[x, y] = \text{titanium};
\]

\[
gaussEqn = 'a'*\exp(-((x-b)/c)^2)+d'
\]

\[
\text{startPoints} = [1.5 900 10 0.6]
\]

Define two sets of points to exclude, using an index vector and an expression.

\[
\text{exclude1} = [1 10 25];
\]

\[
\text{exclude2} = x < 800;
\]

Create two fits using the custom equation, startpoints, and the two different excluded points.

\[
f1 = \text{fit}(x',y',\text{gaussEqn},'Start', \text{startPoints}, 'Exclude', \text{exclude1});
\]

\[
f2 = \text{fit}(x',y',\text{gaussEqn},'Start', \text{startPoints}, 'Exclude', \text{exclude2});
\]

Plot both fits and highlight the excluded data.

\[
\text{plot}(f1,x,y,\text{exclude1})
\]

\[
title('Fit with data points 1, 10, and 25 excluded')
\]

\[
\text{figure;}
\]

\[
\text{plot}(f2,x,y,\text{exclude2})
\]

\[
title('Fit with data points excluded such that x < 800')
\]

For a surface fitting example with excluded points, load some surface data and create and plot fits specifying excluded data.

\[
\text{load Franke}
\]

\[
f1 = \text{fit}([x y],z,'\text{poly23}', 'Exclude', [1 10 25]);
\]

\[
f2 = \text{fit}([x y],z,'\text{poly23}', 'Exclude', z > 1);
\]

\[
\text{figure}
\]
plot(f1, [x y], z, 'Exclude', [1 10 25]);
title('Fit with data points 1, 10, and 25 excluded')

figure
plot(f2, [x y], z, 'Exclude', z > 1);
title('Fit with data points excluded such that z > 1')

**Fit a Smoothing Spline Curve and Return Goodness-of-Fit Information**

Load some data and fit a smoothing spline curve through variables month and pressure, and return goodness of fit information and the output structure. Plot the fit and the residuals against the data.

load enso;
[curve, goodness, output] = fit(month,pressure,'smoothingspline');
plot(curve,month,pressure);
xlabel('Month');
ylabel('Pressure');

Plot the residuals against the x-data (month).

plot( curve, month, pressure, 'residuals' )
xlabel( 'Month' )
ylabel( 'Residuals' )

Use the data in the output structure to plot the residuals against the y-data (pressure).

plot( pressure, output.residuals, '.' )
xlabel( 'Pressure' )
ylabel( 'Residuals' )

**Fit a Single-Term Exponential**

Generate data with an exponential trend, and then fit the data using the first equation in the curve fitting library of exponential models (a single-term exponential). Plot the results.
```matlab
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));
f = fit(x,y,'exp1');
plot(f,x,y)
```

**Fit a Custom Model Using an Anonymous Function**

You can use anonymous functions to make it easier to pass other data into the `fit` function.

Load data and set $E_{\text{max}}$ to 1 before defining your anonymous function:

```matlab
data = importdata( 'OpioidHypnoticSynergy.txt' );
Propofol    = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry   = data.data(:,3);
Emax = 1;
```

Define the model equation as an anonymous function:

```matlab
Effect = @(IC50A, IC50B, alpha, n, x, y) ...
    Emax*( x/IC50A + y/IC50B + alpha*( x/IC50A )... 
    .* ( y/IC50B ) ).^n ./(( x/IC50A + y/IC50B + ...
    alpha*( x/IC50A ) .* ( y/IC50B ) ).^n + 1);
```

Use the anonymous function `Effect` as an input to the `fit` function, and plot the results:

```matlab
AlgometryEffect = fit( [Propofol, Remifentanil], Algometry, Effect, ...
    'StartPoint', [2, 10, 1, 0.8], ... 
    'Lower', [-Inf, -Inf, -5, -Inf], ... 
    'Robust', 'LAR' )
plot( AlgometryEffect, [Propofol, Remifentanil], Algometry )
```

For more examples using anonymous functions and other custom models for fitting, see the `fittype` function.
Find Coefficient Order to Set Start Points and Bounds

For the properties Upper, Lower, and StartPoint, you need to find the order of the entries for coefficients.

Create a fit type.

```matlab
ft = fittype('b*x^2+c*x+a');
```

Get the coefficient names and order using the `coeffnames` function.

```matlab
coefficientNames = coeffnames(ft);
```

```matlab
ans =
    'a'
    'b'
    'c'
```

Note that this is different from the order of the coefficients in the expression used to create `ft` with `fittype`.

Load data, create a fit and set the start points.

```matlab
load enso:
fit(month,pressure,ft,'StartPoint',[1,3,5])
```

This assigns initial values to the coefficients as follows: \( a = 1 \), \( b = 3 \), \( c = 5 \).

Alternatively, you can get the fit options and set start points and lower bounds, then refit using the new options.

```matlab
options = fitoptions(ft);
options.StartPoint = [10 1 3];
options.Lower = [0 -Inf 0];
fit(month,pressure,ft,options);
```

See Also  
`fittype` `fitoptions` `feval` `plot` `confint`
Related Examples

- “Fit Postprocessing”
- “List of Library Models for Curve and Surface Fitting” on page 4-13
**Purpose**
Create or modify fit options object

**Syntax**

```matlab
fitOptions = fitoptions

fitOptions = fitoptions(libraryModelName)
fitOptions = fitoptions(libraryModelName,Name,Value)

fitOptions = fitoptions(fitType)

fitOptions = fitoptions(Name,Value)

newOptions = fitoptions(fitOptions,Name,Value)
newOptions = fitoptions(options1,options2)
```

**Description**

`fitOptions = fitoptions` creates the default fit options object `fitOptions`.

`fitOptions = fitoptions(libraryModelName)` creates the default fit options object for the library model.

`fitOptions = fitoptions(libraryModelName,Name,Value)` creates fit options for the specified library model with additional options specified by one or more `Name,Value` pair arguments.

`fitOptions = fitoptions(fitType)` gets the fit options object for the specified `fitType`. Use this syntax to work with fit options for custom models.

`fitOptions = fitoptions(Name,Value)` creates fit options with additional options specified by one or more `Name,Value` pair arguments.

`newOptions = fitoptions(fitOptions,Name,Value)` modifies the existing fit options object `fitOptions` and returns updated fit options.
in newOptions with new options specified by one or more Name,Value pair arguments.

newOptions = fitoptions(options1,options2) combines the existing fit options objects options1 and options2 in newOptions.

- If `Method` agrees, the nonempty values for the properties in options2 override the corresponding values in options1 in newOptions.
- If `Method` differs, newOptions contains the options1 value for Method and values from options2 for Normalize, Exclude, and Weights.

**Input Arguments**

`libraryModelName` - Library model to fit

string

Library model to fit, specified as a string. This table shows some common examples.

<table>
<thead>
<tr>
<th>Library Model Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'poly1'</td>
<td>Linear polynomial curve</td>
</tr>
<tr>
<td>'poly11'</td>
<td>Linear polynomial surface</td>
</tr>
<tr>
<td>'poly2'</td>
<td>Quadratic polynomial curve</td>
</tr>
<tr>
<td>'linearinterp'</td>
<td>Piecewise linear interpolation</td>
</tr>
<tr>
<td>'cubicinterp'</td>
<td>Piecewise cubic interpolation</td>
</tr>
<tr>
<td>'smoothingspline'</td>
<td>Smoothing spline (curve)</td>
</tr>
<tr>
<td>'lowess'</td>
<td>Local linear regression (surface)</td>
</tr>
</tbody>
</table>

For a list of library model names, see “Model Names and Equations” on page 4-14.

Example: 'poly2'
Data Types
char

**fitType - Model type to fit**

*fittype*

Model type to fit, specified as a *fittype* constructed with the *fittype* function. Use this to work with fit options for custom models.

**fitOptions - Algorithm options**

*fitoptions*

Algorithm options, specified as a *fitoptions* object created using the *fitoptions* function.

**options1 - Algorithm options to combine**

*fitoptions*

Algorithm options to combine, constructed using the *fitoptions* function.

**options2 - Algorithm options to combine**

*fitoptions*

Algorithm options to combine, constructed using the *fitoptions* function.

**Name-Value Pair Arguments**

Specify optional comma-separated pairs of *Name*, *Value* arguments. *Name* is the argument name and *Value* is the corresponding value. *Name* must appear inside single quotes (' '). You can specify several name and value pair arguments in any order as *Name1*,*Value1*,...,*NameN*,*ValueN*.

Example:
'Method','NonlinearLeastSquares','Lower',[0,0],'Upper',[Inf,max(x)],'StartPoint',[1]
specifies fitting method, bounds, and start points.
Options for All Fitting Methods

‘Normalize’ - Option to center and scale data
'off' (default) | 'on'

Option to center and scale the data, specified as the comma-separated pair consisting of 'Normalize' and 'on' or 'off'.

Data Types
char

‘Exclude’ - Points to exclude from fit
expression | index vector | logical vector | empty

Points to exclude from the fit, specified as the comma-separated pair consisting of 'Exclude' and one of:

- An expression describing a logical vector, e.g., \( x > 10 \).
- A vector of integers indexing the points you want to exclude, e.g., [1 10 25].
- A logical vector for all data points where true represents an outlier, created by excludedata.

For examples, see fit.

‘Weights’ - Weights for fit
[] (default) | vector

Weights for the fit, specified as the comma-separated pair consisting of 'Weights' and a vector the same size as number of data points.

Data Types
double

‘Method’ - Fitting method
'None' (default) | string

Fitting method, specified as the comma-separated pair consisting of 'Method' and one of the fitting methods in this table.
Fitting Method | Description
---------------|-----------------|
'NearestInterpolant' | Nearest neighbor interpolation |
'LinearInterpolant' | Linear interpolation |
'PchipInterpolant' | Piecewise cubic Hermite interpolation (curves only) |
'CubicSplineInterpolant' | Cubic spline interpolation |
'BiharmonicInterpolant' | Biharmonic surface interpolation |
'SmoothingSpline' | Smoothing spline |
'LowessFit' | Lowess smoothing (surfaces only) |
'LinearLeastSquares' | Linear least squares |
'NonlinearLeastSquares' | Nonlinear least squares |

Data Types
char

‘problem’ - Values to assign to problem-dependent constants
cell array | scalar

Values to assign to the problem-dependent constants, specified as the comma-separated pair consisting of ‘problem’ and a cell array with one element per problem dependent constant. For details, see fittype.

Data Types
cell | double

Smoothing Options

‘SmoothingParam’ - Smoothing parameter
scalar value in the range (0,1)

Smoothing parameter, specified as the comma-separated pair consisting of 'SmoothingParam' and a scalar value between 0 and 1. The default value depends on the data set. Only available if the Method is SmoothingSpline.
fitoptions

Data Types
double

'Span' - Proportion of data points to use in local regressions
0.25 (default) | scalar value in the range (0,1)

Proportion of data points to use in local regressions, specified as the comma-separated pair consisting of 'Span' and a scalar value between 0 and 1. Only available if the Method is LowessFit.

Data Types
double

Linear and Nonlinear Least-Squares Options

'Robust' - Robust linear least-squares fitting method
'off' (default) | 'LAR' | 'Bisquare'

Robust linear least-squares fitting method, specified as the comma-separated pair consisting of 'Robust' and one of these values:

- 'LAR' specifies the least absolute residual method.
- 'Bisquare' specifies the bisquare weights method.

Available when the Method is LinearLeastSquares or NonlinearLeastSquares.

Data Types
char

'Lower' - Lower bounds on coefficients to be fitted
[] (default) | vector

Lower bounds on the coefficients to be fitted, specified as the comma-separated pair consisting of 'Lower' and a vector. The default value is an empty vector, indicating that the fit is unconstrained by lower bounds. If bounds are specified, the vector length must equal the number of coefficients. Find the order of the entries for coefficients in the vector value by using the coeffnames function. For an example, see fit. Individual unconstrained lower bounds can be specified by -Inf.
Available when the Method is **LinearLeastSquares** or **NonlinearLeastSquares**.

### Data Types
- **double**

#### ‘Upper’ - Upper bounds on coefficients to be fitted

[ | ] (default) | vector

Upper bounds on the coefficients to be fitted, specified as the comma-separated pair consisting of 'Upper' and a vector. The default value is an empty vector, indicating that the fit is unconstrained by upper bounds. If bounds are specified, the vector length must equal the number of coefficients. Find the order of the entries for coefficients in the vector value by using the `coeffnames` function. For an example, see `fit`. Individual unconstrained upper bounds can be specified by `-Inf`.

Available when the Method is **LinearLeastSquares** or **NonlinearLeastSquares**.

### Data Types
- **logical**

#### Nonlinear Least-Squares Options

#### ‘StartPoint’ - Initial values for coefficients

[ | ] (default) | vector

Initial values for the coefficients, specified as the comma-separated pair consisting of 'StartPoint' and a vector. Find the order of the entries for coefficients in the vector value by using the `coeffnames` function. For an example, see `fit`.

If no start points (the default value of an empty vector) are passed to the `fit` function, starting points for some library models are determined heuristically. For rational and Weibull models, and all custom nonlinear models, the toolbox selects default initial values for coefficients uniformly at random from the interval (0,1). As a result, multiple fits using the same data and model might lead to different
fitted coefficients. To avoid this, specify initial values for coefficients with a vector value for the StartPoint property.

Available when the Method is NonlinearLeastSquares.

Data Types
double

'Algorithm' - Algorithm to use for fitting procedure
'Levenberg-Marquardt' (default) | 'Trust-Region'

Algorithm to use for the fitting procedure, specified as the comma-separated pair consisting of 'Algorithm' and either 'Levenberg-Marquardt' or 'Trust-Region'.

Available when the Method is NonlinearLeastSquares.

Data Types
char

'DiffMaxChange' - Maximum change in coefficients for finite difference gradients
10^-8 (default)

Maximum change in coefficients for finite difference gradients, specified as the comma-separated pair consisting of 'DiffMaxChange' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

'DiffMinChange' - Minimum change in coefficients for finite difference gradients
10^-8 (default)

Minimum change in coefficients for finite difference gradients, specified as the comma-separated pair consisting of 'DiffMinChange' and a scalar.

Available when the Method is NonlinearLeastSquares.
Data Types
double

`Display' - Display option in the Command Window

'notify' (default) | 'final' | 'iter' | 'off'

Display option in the command window, specified as the comma-separated pair consisting of 'Display' and one of these options:

- 'notify' displays output only if the fit does not converge.
- 'final' displays only the final output.
- 'iter' displays output at each iteration.
- 'off' displays no output.

Available when the Method is NonlinearLeastSquares.

Data Types
char

`MaxFunEvals' - Maximum number of evaluations of model allowed

600 (default)

Maximum number of evaluations of the model allowed, specified as the comma-separated pair consisting of 'MaxFunEvals' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

`MaxIter' - Maximum number of iterations allowed for fit

400 (default)

Maximum number of iterations allowed for the fit, specified as the comma-separated pair consisting of 'MaxIter' and a scalar.

Available when the Method is NonlinearLeastSquares.
Data Types
double

‘TolFun’ - Termination tolerance on model value
$10^{-6}$ (default)

Termination tolerance on the model value, specified as the comma-separated pair consisting of 'TolFun' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

‘TolX’ - Termination tolerance on coefficient values
$10^{-6}$. (default)

Termination tolerance on the coefficient values, specified as the comma-separated pair consisting of 'TolX' and a scalar.

Available when the Method is NonlinearLeastSquares.

Data Types
double

Output Arguments

fitOptions - Algorithm options
fitoptions
Algorithm options, returned as a fitoptions object.

newOptions - New algorithm options
fitoptions
New algorithm options, returned as a fitoptions object.

Examples

Modify Default Fit Options to Normalize Data

Create the default fit options object and set the option to center and scale the data before fitting.

options = fitoptions;
options.Normal = 'on'

options =
    Normalize: 'on'
    Exclude: [1x0 double]
    Weights: [1x0 double]
    Method: 'None'

Create Default Fit Options for Gaussian Fit

options = fitoptions('gauss2')

options =
    Normalize: 'off'
    Exclude: []
    Weights: []
    Method: 'NonlinearLeastSquares'
    Robust: 'Off'
    StartPoint: [1x0 double]
    Lower: [-Inf -Inf 0 -Inf -Inf 0]
    Upper: [1x0 double]
    Algorithm: 'Trust-Region'
    DiffMinChange: 1.0000e-08
    DiffMaxChange: 0.1000
    Display: 'Notify'
    MaxFunEvals: 600
    MaxIter: 400
    TolFun: 1.0000e-06
    TolX: 1.0000e-06

Set Polynomial Fit Options

Create fit options for a cubic polynomial and set center and scale and robust fitting options.

options = fitoptions('poly3', 'Normalize', 'on', 'Robust', 'Bisquare')
options = fitoptions('Method', 'LinearLeastSquares')

options =

    Normalize: 'off'
    Exclude: []
    Weights: []
    Method: 'LinearLeastSquares'
    Robust: 'Off'
    Lower: [1x0 double]
    Upper: [1x0 double]

**Create Fit Options for Linear Least Squares**

options = fitoptions('Method', 'LinearLeastSquares')

options =

    Normalize: 'off'
    Exclude: []
    Weights: []
    Method: 'LinearLeastSquares'
    Robust: 'Off'
    Lower: [1x0 double]
    Upper: [1x0 double]

**Use Identical Fit Options in Multiple Fits**

Modifying the default fit options object is useful when you want to set the Normalize, Exclude, or Weights properties, and then fit your data using the same options with different fitting methods. For example, the following uses the same fit options to fit different library model types.

load census
options = fitoptions;
options.Normalize = 'on';
f1 = fit(cdate,pop,'poly3',options);
f2 = fit(cdate,pop,'exp1',options);
f3 = fit(cdate,pop,'cubicspline',options)
**Find and Change the Smoothing Fit Option**

Find the smoothing parameter. Data-dependent fit options such as the `smooth` parameter are returned in the third output argument of the `fit` function.

```matlab
load census
[f,gof,out] = fit(cdate,pop,'SmoothingSpline');
smoothparam = out.p
```

```matlab
smoothparam =
0.0089
```

Modify the default smoothing parameter for a new fit.

```matlab
options = fitoptions('Method','SmoothingSpline',
    'SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop,'SmoothingSpline',options);
```

**Apply Coefficient Bounds to Improve Gaussian Fit**

Create a Gaussian fit, inspect the confidence intervals, and specify lower bound fit options to help the algorithm.

Create a noisy sum of two Gaussian peaks—one with a small width, and one with a large width.

```matlab
a1 = 1; b1 = -1; c1 = 0.05;
a2 = 1; b2 = 1; c2 = 50;
x = (-10:0.02:10)';
gdata = a1*exp(-((x-b1)/c1).^2) + ...
    a2*exp(-((x-b2)/c2).^2) + ...
    0.1*(rand(size(x))-.5);
plot(x,gdata)
```
Fit the data using the two-term Gaussian library model.

gfit = fit(x,gdata,'gauss2')

gfit =
    General model Gauss2:
      gfit(x) = a1*exp(-((x-b1)/c1)^2) +
               a2*exp(-((x-b2)/c2)^2)
    Coefficients (with 95% confidence bounds):
      a1 =  -0.05388  (-0.136, 0.02826)
      b1 =   -2.651    (-2.718, -2.584)
      c1 =   0.05373  (-0.04106, 0.1485)
      a2 =    1.012    (1.006, 1.018)
      b2 =    0.6703   (0.06681, 1.274)
      c2 =    41.2    (36.54, 45.85)

The algorithm is having difficulty, as indicated by the wide confidence intervals for several coefficients.
To help the algorithm, specify lower bounds for the nonnegative amplitudes \(a_1\) and \(a_2\) and widths \(c_1\), \(c_2\).

\[
\text{options} = \text{fitoptions}('gauss2', 'Lower', [0 -Inf 0 0 -Inf 0]);
\]

Alternatively, you can set properties of the fit options using the form
\[
\text{options.Property} = \text{NewPropertyValue}.
\]

\[
\text{options} = \text{fitoptions}('gauss2');
\text{options.Lower} = [0 -Inf 0 0 -Inf 0];
\]

Recompute the fit using the bound constraints on the coefficients.

\[
gfit = \text{fit}(x, gdata, 'gauss2', \text{options})
\]

\[
gfit =
\begin{align*}
\text{General model Gauss2:} \\
gfit(x) &= a_1 \exp(-((x-b_1)/c_1)^2) + a_2 \exp(-((x-b_2)/c_2)^2)
\end{align*}
\]

Coefficients (with 95% confidence bounds):
\[
\begin{align*}
a_1 &= 1.003 (0.9641, 1.042) \\
b_1 &= -1 (-1.002, -0.9987) \\
c_1 &= 0.04972 (0.04748, 0.05197) \\
a_2 &= 1.002 (0.999, 1.004) \\
b_2 &= 1.136 (0.725, 1.547) \\
c_2 &= 48.89 (45.32, 52.47)
\end{align*}
\]

This is a much better fit. You can further improve the fit by assigning reasonable values to other properties in the fit options object.

### Copy and Combine Fit Options

Create fit options and set lower bounds.

\[
\text{options} = \text{fitoptions}('gauss2', 'Lower', [0 -Inf 0 0 -Inf 0]);
\]

Make a new copy of the fit options and modify the robust parameter.

\[
\text{newoptions} = \text{fitoptions}(<\text{options}, 'Robust', 'Bisquare'>);
\]
Combine fit options.

options2 = fitoptions(options, newoptions);

**Change Custom Model Fit Options**

Create a linear model fit type.

lft = fittype({'x','sin(x)','1'})

Get the fit options for the fit type lft.

fo = fitoptions(lft)

Set the normalize fit option.

fo.Normalize = 'on'

**See Also**
fitfittypegetsetsetoptions

**Related Examples**
- “Specifying Fit Options and Optimized Starting Points” on page 4-7
- “Fit Postprocessing”
- “List of Library Models for Curve and Surface Fitting” on page 4-13
**Purpose**
Fit type for curve and surface fitting

**Syntax**

```
aFitttype = fittype(libraryModelName)
```

```
aFitttype = fittype(expression)
aFitttype = fittype(expression,Name,Value)
```

```
aFitttype = fittype(linearModelTerms)
aFitttype = fittype(linearModelTerms,Name,Value)
```

```
aFitttype = fittype(anonymousFunction)
aFitttype = fittype(anonymousFunction,Name,Value)
```

**Description**

```
aFitttype = fittype(libraryModelName) creates the fittype object for the model specified by libraryModelName.
```

```
aFitttype = fittype(expression) creates a fit type for the model specified by the MATLAB expression.
```

```
aFitttype = fittype(expression,Name,Value) constructs the fit type with additional options specified by one or more Name,Value pair arguments.
```

```
aFitttype = fittype(linearModelTerms) creates a fit type for a custom linear model with terms specified by the cell array of string expressions in linearModelTerms.
```

```
aFitttype = fittype(linearModelTerms,Name,Value) constructs the fit type with additional options specified by one or more Name,Value pair arguments.
```

```
aFitttype = fittype(anonymousFunction) creates a fit type for the model specified by anonymousFunction.
```
fittype

aFittype = fittype(anonymousFunction,Name,Value) constructs the fit type with additional options specified by one or more Name,Value pair arguments.

**Input Arguments**

**libraryModelName** - Library model to fit

string

Library model to fit, specified as a string. This table shows some common examples.

<table>
<thead>
<tr>
<th>Library Model Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'poly1'</td>
<td>Linear polynomial curve</td>
</tr>
<tr>
<td>'poly11'</td>
<td>Linear polynomial surface</td>
</tr>
<tr>
<td>'poly2'</td>
<td>Quadratic polynomial curve</td>
</tr>
<tr>
<td>'linearinterp'</td>
<td>Piecewise linear interpolation</td>
</tr>
<tr>
<td>'cubicinterp'</td>
<td>Piecewise cubic interpolation</td>
</tr>
<tr>
<td>'smoothingspline'</td>
<td>Smoothing spline (curve)</td>
</tr>
<tr>
<td>'lowess'</td>
<td>Local linear regression (surface)</td>
</tr>
</tbody>
</table>

For a list of library model names, see “Model Names and Equations” on page 4-14.

Example: 'poly2'

**Data Types**

char

**expression** - Model to fit

string

Model to fit, specified as a string. You can specify any MATLAB command and therefore any .m file. See “Fit a Curve Defined by a File” on page 12-96.

**Data Types**

char
linearModelTerms - Model to fit
cell array of strings

Model to fit, specified as a cell array of strings. Specify the model terms by the expressions in the strings. Do not include coefficients in the expressions for the terms. See “Linear Model Terms” on page 12-104.

Data Types
cell

anonymousFunction - Model to fit
anonymous function

Model to fit, specified as an anonymous function. For details, see “Input Order for Anonymous Functions” on page 12-103.

Data Types
char

Name-Value Pair Arguments

Specify optional comma-separated pairs of Name,Value arguments. Name is the argument name and Value is the corresponding value. Name must appear inside single quotes (' '). You can specify several name and value pair arguments in any order as Name1,Value1,...,NameN,ValueN.

Example: 'coefficients',{'a1','a2'}

‘coefficients’ - Coefficient names
string | cell array of strings

Coefficient names, specified as the comma-separated pair consisting of 'coefficients' and a string, or a cell array of strings for multiple names. You can use multicharacter symbol names. You cannot use these names: i, j, pi, inf, nan, eps.

Data Types
char | cell

‘dependent’ - Dependent (response) variable name
fittype

y (default) | string

Dependent (response) variable name, specified as the comma-separated pair consisting of 'dependent' and a string. If you do not specify the dependent variable, the function assumes y is the dependent variable.

Data Types
char

‘independent’ - Independent (response) variable names
x (default) | string | cell array of strings

Independent (response) variable names, specified as the comma-separated pair consisting of 'independent' and a string or cell array of strings. If you do not specify the independent variable, the function assumes x is the independent variable.

Data Types
char

‘options’ - Fit options
fitoptions

Fit options, specified as the comma-separated pair consisting of 'options' and the name of a fitoptions object.

‘problem’ - Problem-dependent (fixed) parameter names

Problem-dependent (fixed) parameter names, specified as the comma-separated pair consisting of 'problem' and a string, or cell array or strings with one element per problem dependent constant.

Data Types
char | cell

Output Arguments

aFittype - Model to fit

fittype object

Model to fit, returned as a fittype. A fittype encapsulates information describing a model. To create a fit, you need data, a
**Examples**

**Create Fit Types for Library Models**

Construct fit types by specifying library model names.

Construct a `fittype` object for the cubic polynomial library model.

```matlab
f = fittype('poly3')
```

```matlab
f =  
    Linear model Poly3:  
    f(p1,p2,p3,p4,x) = p1*x^3 + p2*x^2 + p3*x + p4
```

Construct a fit type for the library model `rat33` (a rational model of the third degree for both the numerator and denominator).

```matlab
f = fittype('rat33')
```

```matlab
f =  
    General model Rat33:  
    f(p1,p2,p3,p4,q1,q2,q3,x) =  
        (p1*x^3 + p2*x^2 + p3*x + p4)/  
        (x^3 + q1*x^2 + q2*x + q3)
```

For a list of library model names, see “Model Names and Equations” on page 4-14.

**Create a Custom Nonlinear Model**

```matlab
g = fittype('a*cosh((x-x0)/a)+y0')
```

```matlab
g =  
    General model:  
    g(a,x0,y0,x) = a*cosh((x-x0)/a)+y0
```
You can specify any MATLAB command and therefore any .m file. For an example, see “Fit a Curve Defined by a File” on page 12-96.

**Create Custom Nonlinear Models and Specify Problem Parameters and Independent Variables**

Construct a fit type for a custom nonlinear model, designating \( n \) as a problem-dependent parameter and \( u \) as the independent variable.

\[
g = \text{fittype}('a*u+b*exp(n*u)',...'
  'problem','n',...'
  'independent','u')
\]

\[
g =
  \text{General model:}
  g(a,b,n,u) = a*u+b*exp(n*u)
\]

Construct a fit type for a custom nonlinear model, designating time as the independent variable.

\[
g = \text{fittype('a*time^2+b*time+c','independent','time','dependent','height')}
\]

Construct a fit type for a logarithmic fit to some data, use the fit type to create a fit, and plot the fit.

\[
x = \text{linspace}(1,100)
y = 5 + 7*\log(x);
myfittype = \text{fittype('a + b*log(x)'),'dependent','y','independent','x','coefficients',{'}a','b'});
myfit = \text{fit(x',y',myfittype)}
\text{plot(myfit,x,y)}
\]

You can specify any MATLAB command and therefore any .m file. For an example, see “Fit a Curve Defined by a File” on page 12-96.

**Fit a Curve Defined by a File**

Define a function in a file and use it to create a fit type and fit a curve.
Define a function in a MATLAB file.

```matlab
function y = piecewiseLine(x,a,b,c,d,k)
% PIECEWISELINE  A line made of two pieces
% that is not continuous.

y = zeros(size(x));

% This example includes a for-loop and if statement
% purely for example purposes.
for i = 1:length(x)
    if x(i) < k,
        y(i) = a + b.* x(i);
    else
        y(i) = c + d.* x(i);
    end
end
end
```

Save the file.

Define some data, create a fit type specifying the function `piecewiseLine`, create a fit using the fit type `ft`, and plot the results.

```matlab
x = [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;...  
     0.96;0.96;0.16;0.97;0.96];
y = [0.17;0.12;0.16;0.0035;0.37;0.34;0.56;...  
     0.15;-0.046;0.17;-0.091;-0.071];
ft = fittype( 'piecewiseLine( x, a, b, c, d, k )' )
f = fit( x, y, ft, 'StartPoint', [1, 0, 1, 0, 0.5] )
plot( f, x, y )
```

**Create Custom Linear Model**

To use a linear fitting algorithm, specify a cell array of terms.

Identify the linear model terms you need to input to `fittype`.

```matlab
a*x + b*sin(x) + c
```
The model is linear in $a$, $b$ and $c$. It has three terms $x$, $\sin(x)$ and 1 (because $c=c*1$). To specify this model you use this cell array of terms.

\[
\text{LinearModelTerms} = \{ 'x', '\sin(x)', '1' \}
\]

Use the cell array of linear model terms as the input to \text{fittype}.

\[
\text{ft} = \text{fittype}(\{ 'x', '\sin(x)', '1' \})
\]

\[
\text{ft} = \\
\text{Linear model:} \\
\text{linearfittype}(a,b,c,x) = a*x + b*\sin(x) + c
\]

Create a linear model fit type for $a\cos(x) + b$.

\[
\text{ft2} = \text{fittype}(\{ '\cos(x)', '1' \})
\]

\[
\text{ft2} = \\
\text{Linear model:} \\
g(a,b,x) = a*\cos(x) + b
\]

Create the fit again and specify coefficient names.

\[
\text{ft3} = \text{fittype}(\{ '\cos(x)', '1' \}, 'coefficients', \{ 'a1', 'a2' \})
\]

\[
\text{ft3} = \\
\text{Linear model:} \\
h(a1,a2,x) = a1*\cos(x) + a2
\]

For details, see “Linear Model Terms” on page 12-104.

**Create Fit Types Using Anonymous Functions**

Create a fit type using an anonymous function.

\[
g = \text{fittype}( @(a, b, c, x) a*x.^2+b*x+c )
\]
Create a fit type using an anonymous function and specify independent and dependent parameters.

\[
g = \text{fittype}( @(a, b, c, d, x, y) a*x.^2+b*x+c*\exp(- (y-d).^2) ), \ 'independent', \ {\ 'x'}, \ {\ 'y'}\}, \ ...
\ 'dependent', \ {\ 'z'}\);
\]

Create a fit type for a surface using an anonymous function and specify independent and dependent parameters, and problem parameters that you will specify later when you call \texttt{fit}.

\[
g = \text{fittype}( @(a,b,c,d,x,y) a*x.^2+b*x+c*\exp(-(y-d).^2) ), \ ...
\ 'problem', \ {\ 'c','d'}\}, \ 'independent', \ {\ 'x'}, \ {\ 'y'}\}, \ ...
\ 'dependent', \ {\ 'z'}\);
\]

For details about inputs, see “Input Order for Anonymous Functions” on page 12-103.

**Use an Anonymous Function to Pass in Workspace Data to the Fit**

Use an anonymous function to pass workspace data into the \texttt{fittype} and \texttt{fit} functions.

Create and plot an S-shaped curve. In later steps, you stretch and move this curve to fit to some data.

```matlab
% Breakpoints.
xs = (0:0.1:1).';
% Height of curve at breakpoints.
ys = [0; 0; 0.04; 0.1; 0.2; 0.5; 0.8; 0.9; 0.96; 1; 1];
% Plot S-shaped curve.
xi = linspace( 0, 1, 241 );
plot( xi, interp1( xs, ys, xi, 'pchip' ), 'LineWidth', 2 )
hold on
plot( xs, ys, 'o', 'MarkerFaceColor', 'r' )
hold off
title S-curve
```
Create a fit type using an anonymous function, taking the values from the workspace for the curve breakpoints (xs) and the height of the curve at the breakpoints (ys). Coefficients are \( b \) (base) and \( h \) (height).

\[
ft = \text{fittype}( @(b, h, x) \text{interp1}( xs, b+h*ys, x, 'pchip' ) )
\]

Plot the fittype specifying example coefficients of base \( b=1.1 \) and height \( h=-0.8 \).

\[
\text{plot( xi, ft( 1.1, -0.8, xi ), 'LineWidth', 2 )}
\]
\[
\text{title 'Fittype with } b=1.1 \text{ and } h=-0.8'
\]

Load and fit some data, using the fit type \( ft \) created using workspace values.

% Load some data
xdata = [0.012;0.054;0.13;0.16;0.31;0.34;0.47;0.53;0.53;...
        0.57;0.78;0.79;0.93];
ydata = [0.78;0.87;1;1.1;0.96;0.88;0.56;0.5;0.5;0.63;...
        0.62;0.39];
% Fit the curve to the data
f = fit( xdata, ydata, ft, 'Start', [0, 1] )
% Plot fit
plot( f, xdata, ydata )
% title 'Fitted S-curve'

For another example, see “Use Anonymous Functions to Work with Problem Parameters and Workspace Variables” on page 12-100.

**Use Anonymous Functions to Work with Problem Parameters and Workspace Variables**

This example shows the differences between using anonymous functions with problem parameters and workspace variable values.

Load data, create a fit type for a curve using an anonymous function with problem parameters, and call fit specifying the problem parameters.
% Load some data.
xdata = [0.098;0.13;0.16;0.28;0.55;0.63;0.81;0.91;0.91;...
  0.96;0.96;0.96;0.97];
ydata = [0.52;0.53;0.53;0.48;0.33;0.36;0.39;0.28;0.28;...
  0.21;0.21;0.21;0.2];

% Create a fittype that has a problem parameter.
g = fittype( @(a,b,c,x) a*x.^2+b*x+c, 'problem', 'c' )

% Examine coefficients. Observe c is not a coefficient.
coeffnames( g )

% Examine arguments. Observe that c is an argument.
argnames( g )

% Call fit and specify the value of c.
f1 = fit( xdata, ydata, g, 'problem', 0, 'StartPoint', [1, 2] )

% Note: Specify start points in the calls to fit to
% avoid warning messages about random start points
% and to ensure repeatability of results.

% Call fit again and specify a different value of c,
% to get a new fit.
f2 = fit( xdata, ydata, g, 'problem', 1, 'start', [1, 2] )

% Plot results. Observe the specified c constants
% do not make a good fit.
plot( f1, xdata, ydata )
hold on
plot( f2, 'b' )
hold off

Modify the previous example to create the same fits using workspace
values for variables, instead of using problem parameters. Using the
same data, create a fit type for a curve using an anonymous function with a workspace value for variable \( c \):

```matlab
% Remove \( c \) from the argument list.
try
g = fittype( @(a,b,x) a*x.^2+b*x+c )
catch e
disp( e.message )
end
% Observe error because now \( c \) is undefined.
% Define \( c \) and create fittype:
c = 0;
g1 = fittype( @(a,b,x) a*x.^2+b*x+c )

% Call fit (now no need to specify problem parameter).
f1 = fit( xdata, ydata, g1, 'StartPoint', [1, 2] )
% Note that this f1 is the same as the f1 above.
% To change the value of \( c \), recreate the fittype.
c = 1;
g2 = fittype( @(a,b,x) a*x.^2+b*x+c ) % uses \( c = 1 \)
f2 = fit( xdata, ydata, g2, 'StartPoint', [1, 2] )
% Note that this f2 is the same as the f2 above.
% Plot results
plot( f1, xdata, ydata )
hold on
plot( f2, 'b' )
hold off

See “Input Order for Anonymous Functions” on page 12-103.
```

**Algorithms**

If the fit type expression input is a string or anonymous function, then the toolbox uses a nonlinear fitting algorithm to fit the model to data.

If the fit type expression input is a cell array of terms, then the toolbox uses a linear fitting algorithm to fit the model to data.
Definitions

Dependent and Independent Variables

To determine dependent and independent variables and coefficients, consider this equation:

\[ y = f(x) = a + (b \times x) + (c \times x^2). \]

- \( y \) is the dependent variable.
- \( x \) is the independent variable.
- \( a, b, \) and \( c \) are the coefficients.

The 'independent' variable is what you control. The 'dependent' variable is what you measure, i.e., it depends on the independent variable. The 'coefficients' are the parameters that the fitting algorithm estimates.

For example, if you have census data, then the year is the independent variable because it does not depend on anything. Population is the dependent variable, because its value depends on the year in which the census is taken. If a parameter like growth rate is part of the model, so the fitting algorithm estimates it, then the parameter is one of the 'coefficients'.

The `fittype` function determines input arguments by searching the fit type expression input for variable names. `fittype` assumes \( x \) is the independent variable, \( y \) is the dependent variable, and all other variables are coefficients of the model. \( x \) is used if no variable exists.

Input Order for Anonymous Functions

If the fit type expression input is an anonymous function, then the order of inputs must be correct. The input order enables the `fittype` function to determine which inputs are coefficients to estimate, problem-dependent parameters, and independent variables. The order of the input arguments to the anonymous function must be:

\[ \text{fcn} = @(\text{coefficients,problemparameters,}x,y) \text{ expression} \]
You need at least one coefficient. The problem parameters and y are optional. The last arguments, x and y, represent the independent variables: just x for curves, but x and y for surfaces. If you don't want to use x and/or y to name the independent variables, then specify different names using the 'independent' argument name-value pair. However, whatever name or names you choose, these arguments must be the last arguments to the anonymous function.

Anonymous functions make it easier to pass other data into the `fittype` and `fit` functions.

Create a fit type using an anonymous function and a variable value (c) from the workspace.

```matlab
c = 1;
g = fittype( @(a, b, x) a*x.^2+b*x+c )
```

The `fittype` function can use the variable values in your workspace when you create the fit type. To pass in new data from the workspace, recreate the fit type, e.g.,

```matlab
c=5 % Change value of c.
g = fittype( @(a, b, x) a*x.^2+b*x+c )
```

Here, the value of c is fixed when you create the fit type. To specify the value of c at the time you call fit, you can use problem parameters. For example, make a fit with c = 2 and then a new fit with c = 3.

```matlab
g = fittype( @(a,b,x) a*x.^2+b*x+c, 'problem', 'c' )
f1 = fit( xdata, ydata, g, 'problem', 2 )
f2 = fit( xdata, ydata, g, 'problem', 3 )
```

**Linear Model Terms**

To use a linear fitting algorithm, specify `linearModelTerms` as a cell array of terms.

```matlab
afittype = fittype({expr1,...,exprn})
```
Specify the model terms by the expressions in the strings `expr2,...,exprn`. Do not include coefficients in the expressions for the terms. If there is a constant term, use '1' as the corresponding expression in the cell array.

To specify a linear model of the following form:

\[ \text{coeff1} \times \text{term1} + \text{coeff2} \times \text{term2} + \text{coeff3} \times \text{term3} + \ldots \]

where no coefficient appears within any of \text{term1}, \text{term2}, etc., use a cell array where each term, without coefficients, is specified in a cell of `expr`, as follows:

```matlab
LinearModelTerms = {'term1', 'term2', 'term3', ... }  
```

For example, the model

\[ a \times x + b \times \sin(x) + c \]

is linear in \( a \), \( b \), and \( c \). It has three terms \( x \), \( \sin(x) \) and 1 (because \( c = c \times 1 \)) and therefore `expr` is:

```matlab
LinearModelTerms = {'x','\sin(x)','1'}  
```

**See Also**  `fit`, `fitoptions`

**Concepts**

- “Parametric Fitting” on page 4-2
fn2fm

**Purpose**
Convert to specified form

**Syntax**
```
g = fn2fm(f,form)
sp = fn2fm(f,'B-',sconds)
fn2fm(f)
```

**Description**
g = fn2fm(f,form) describes the same function as is described by f, but in the form specified by the string form. Choices for form are 'B-', 'pp', 'BB', 'rB', 'rp', for the B-form, the ppform, the BBform, and the two rational spline forms, respectively.

The B-form describes a function as a weighted sum of the B-splines of a given order k for a given knot sequence, and the BBform (or, Bernstein-Bézier form) is the special case when each knot in that sequence appears with maximal multiplicity, k. The ppform describes a function in terms of its local polynomial coefficients. The B-form is good for constructing and/or shaping a function, while the ppform is cheaper to evaluate.

Conversion from a polynomial form to the corresponding rational form is possible only if the function in the polynomial form is vector-valued, in which case its last component is designated as the denominator. Converting from a rational form to the corresponding polynomial form simply reverses this process by reinterpreting the denominator of the function in the rational form as an additional component of the piecewise polynomial function.

Conversion to or from the stform is not possible at present.

If form is 'B-' (and f is in ppform), then the actual smoothness of the function in f across each of its interior breaks has to be guessed. This is done by looking, for each interior break, for the first derivative whose jump across that break is not small compared to the size of that derivative nearby. The default tolerance used in this is 1.e-12.

sp = fn2fm(f,'B-',sconds) permits you to supply, as the input argument sconds, a tolerance (strictly between 0 and 1) to be used in the conversion from ppform to B-form.
Alternatively, you can input \texttt{sconds} as a vector with integer entries, with at least as many entries as the \texttt{ppform} in \texttt{f} has \textit{interior} breaks. In that case, \texttt{sconds(i)} specifies the number of smoothness conditions to be used across the \textit{i}th \textit{interior} break. If the function in \texttt{f} is a tensor product, then \texttt{sconds}, if given, must be a cell array.

\texttt{fn2fm(f)} converts a possibly old version of a form into its present version.

\textbf{Examples}

\begin{verbatim}
sp = fn2fm(spline(x,y),'B-')
gives the interpolating cubic spline provided by the MATLAB command \texttt{spline}, but in B-form rather than in \texttt{ppform}.

p0 = ppmak([0 1],[3 0 0]);
p1 = fn2fm(fn2fm(fnrfn(p0,[.4 .6]),'B-'),'pp');
\end{verbatim}

gives \texttt{p1} identical to \texttt{p0} (up to round-off in the coefficients) since the spline has no discontinuity in any derivative across the additional breaks introduced by \texttt{fnrfn}, hence conversion to B-form ignores these additional breaks, and conversion to \texttt{ppform} does not retain any knot multiplicities (like the knot multiplicities introduced, by conversion to B-form, at the endpoints of the spline’s basic interval).

\textbf{Algorithms}

For a multivariate (tensor-product) function, univariate algorithms are applied in each variable.

For the conversion from B-form (or BBform) to \texttt{ppform}, the utility command \texttt{sprpp} is used to convert the B-form of all polynomial pieces to their local power form, using repeated knot insertion at the left endpoint.

The conversion from B-form to BBform is accomplished by inserting each knot enough times to increase its multiplicity to the order of the spline.

The conversion from \texttt{ppform} to B-form makes use of the dual functionals discussed in \texttt{}. Without further information, such a conversion has to ascertain the actual smoothness across each interior break of the function in \texttt{f}.
Cautionary Note
When going from B-form to ppform, any jump discontinuity at the first and last knot, \( t(1) \) or \( t(\text{end}) \), will be lost since the ppform considers \( f \) to be defined outside its basic interval by extension of the first, respectively, the last polynomial piece. For example, while
\[
\text{sp} = \text{spmak}([0 \ 1],1)
\]
gives the characteristic function of the interval \([0..1]\), \( \text{pp} = \text{fn2fm}(\text{spmak}([0 \ 1],1), 'pp') \) is the constant polynomial, \( x |\rightarrow 1 \).

See Also
ppmak | spmak | rsmak | stmak
Purpose
Name and part(s) of form

Syntax
\[ \text{[out1,...,outn]} = \text{fnbrk}(\text{f,part1,...,partm}) \]
\( \text{fnbrk}(\text{f,interval}) \)
\( \text{fnbrk}(\text{pp,j}) \)
\( \text{fnbrk}(\text{f}) \)

Description
\[ \text{[out1,...,outn]} = \text{fnbrk}(\text{f,part1,...,partm}) \]
returns the part(s) of the form in \( \text{f} \) specified by \( \text{part1,...,partn} \) (assuming that \( n<=m \)). These are the parts used when the form was put together, in \( \text{spmak} \) or \( \text{ppmak} \) or \( \text{rpmak} \) or \( \text{rsmak} \) or \( \text{stmak} \), but also other parts derived from these.

You only need to specify the beginning character(s) of the relevant string.

Regardless of what particular form \( \text{f} \) is in, \( \text{parti} \) can be one of the following.

<table>
<thead>
<tr>
<th>'form'</th>
<th>The particular form used</th>
</tr>
</thead>
<tbody>
<tr>
<td>'variables'</td>
<td>The dimension of the function’s domain</td>
</tr>
<tr>
<td>'dimension'</td>
<td>The dimension of the function’s target</td>
</tr>
<tr>
<td>'coefficients'</td>
<td>The coefficients in that particular form</td>
</tr>
<tr>
<td>'interval'</td>
<td>The basic interval of that form</td>
</tr>
</tbody>
</table>

Depending on the form in \( \text{f} \), additional parts may be asked for.

If \( \text{f} \) is in B-form (or BBform or RBform), then additional choices for \( \text{parti} \) are

<table>
<thead>
<tr>
<th>'knots'</th>
<th>The knot sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>'coefficients'</td>
<td>The B-spline coefficients</td>
</tr>
<tr>
<td>'number'</td>
<td>The number of coefficients</td>
</tr>
<tr>
<td>'order'</td>
<td>The polynomial order of the spline</td>
</tr>
</tbody>
</table>

12-109
If \( f \) is in ppform (or rpform), then additional choices for \texttt{parti} are

| 'breaks' | The break sequence |
| 'coefficients' | The local polynomial coefficients |
| 'pieces' | The number of polynomial pieces |
| 'order' | The polynomial order of the spline |
| 'guide' | The local polynomial coefficients, but in the form needed for \texttt{PPVALU} in PGS |

If the function in \( f \) is multivariate, then the corresponding multivariate parts are returned. This means, e.g., that knots, breaks, and the basic interval, are cell arrays, the coefficient array is, in general, higher than two-dimensional, and order, number and pieces are vectors.

If \( f \) is in stform, then additional choices for \texttt{parti} are

| 'centers' | The centers |
| 'coefficients' | The coefficients |
| 'number' | Number of coefficients or terms |
| 'type' | The particular type |

\texttt{fnbrk(f,interval)} with \texttt{interval} a 1-by-2 matrix \([a\ b]\) with \(a<b\) does not return a particular part. Rather, it returns a description of the univariate function described by \( f \) and in the same form but with the basic interval changed, to the interval given. If, instead, \texttt{interval} is \([\ ]\), \( f \) is returned unchanged. This is of particular help when the function in \( f \) is \( m \)-variate, in which case \texttt{interval} must be a cell array with \( m \) entries, with the \( i \)th entry specifying the desired interval in the \( i \)th dimension. If that \( i \)th entry is \([\ ]\), the basic interval in the \( i \)th dimension is unchanged.

\texttt{fnbrk(pp,j)}, with \texttt{pp} the ppform of a univariate function and \( j \) a positive integer, does not return a particular part, but returns the
ppform of the jth polynomial piece of the function in pp. If pp is the ppform of an m-variate function, then j must be a cell array of length m. In that case, each entry of j must be a positive integer or else an interval, to single out a particular polynomial piece or else to specify the basic interval in that dimension.

fnbrk(f) returns nothing, but a description of the various parts of the form is printed at the command line instead.

**Examples**

If p1 and p2 contain the B-form of two splines of the same order, with the same knot sequence, and the same target dimension, then

\[
p1plusp2 = spmak(fnbrk(p1,'k'),fnbrk(p1,'c')+fnbrk(p2,'c'));
\]

provides the (pointwise) sum of those two functions.

If pp contains the ppform of a bivariate spline with at least four polynomial pieces in the first variable, then

\[
ppp=fnbrk(pp,[4,[-1 1]]);
\]

gives the spline that agrees with the spline in pp on the rectangle \([b4 \ldots b5] \times [-1 \ldots 1]\), where b4, b5 are the fourth and fifth entry in the break sequence for the first variable.

**See Also**

ppmak | rpmak | rsmak | spmak | stmak
Purpose

Change part(s) of form

Syntax

\[ f = \text{fnchg}(f, \text{part}, \text{value}) \]

Description

\[ f = \text{fnchg}(f, \text{part}, \text{value}) \]
returns the given function description \( f \) but with the specified \text{part} changed to the specified \text{value}.

The string \text{part} can be (the beginning character(s) of):

<table>
<thead>
<tr>
<th>'dimension'</th>
<th>The dimension of the function’s target</th>
</tr>
</thead>
<tbody>
<tr>
<td>'interval'</td>
<td>The basic interval of that form</td>
</tr>
</tbody>
</table>

The specified \text{value} for \text{part} is not checked for consistency with the rest of the description in \( f \) in case the string \text{part} terminates with the letter \text{z}.

Examples

\( \text{fndir}(f, \text{directions}) \) returns a vector-valued function even when the function described by \( f \) is ND-valued. You can correct this by using \text{fnchg} as follows:

\[
\text{fdir} = \text{fnchg}( \text{fndir}(f, \text{directions}),... \\
'\text{dim}', [\text{fnbrk}(f, '\text{dim}'), \text{size}(\text{directions},2)] )
\]

See Also

\text{fnbrk}
### Purpose

Arithmetic with function(s)

### Syntax

- `fn = fncmb(function,operation)`
- `f = fncmb(function,function)`
- `fncmb(function,matrix,function)`
- `fncmb(function,matrix,function,matrix)`
- `f = fncmb(function,op,function)`

### Description

The intent is to make it easy to carry out the standard linear operations of scaling and adding within a spline space without having to deal explicitly with the relevant parts of the function(s) involved.

`fn = fncmb(function,operation)` returns (a description of) the function obtained by applying to the values of the function in `function` the operation specified by `operation`. The nature of the operation depends on whether `operation` is a **scalar**, a **vector**, a **matrix**, or a **string**, as follows.

<table>
<thead>
<tr>
<th>Scalar</th>
<th>Multiply the function by that scalar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector</td>
<td>Add that vector to the function’s values; this requires the function to be vector-valued.</td>
</tr>
<tr>
<td>Matrix</td>
<td>Apply that matrix to the function’s coefficients.</td>
</tr>
<tr>
<td>String</td>
<td>Apply the function specified by that string to the function’s coefficients.</td>
</tr>
</tbody>
</table>

The remaining options only work for **univariate** functions. See Limitations for more information.

`f = fncmb(function,function)` returns (a description of) the pointwise sum of the two functions. The two functions must be of the same form. This particular case of just two input arguments is not included in the above table since it only works for univariate functions.

`fncmb(function,matrix,function)` is the same as `fncmb(fncmb(function,matrix),function).`
fnfmb(function, matrix, function, matrix) is the same as
fnfmb(fnfmb(function, matrix), fnfmb(function, matrix)).

f = fnfmb(function, op, function) returns the ppform of the spline
obtained by the pointwise combining of the two functions, as specified
by the string op. op can be one of the strings '+', '-', '*'. If the
second function is to be a constant, it is sufficient simply to supply
here that constant.

**Examples**

```
fnfmb(fn, 3.5) multiplies (the coefficients of) the function in fn by 3.5.
fnfmb(f, 3, g, -4) returns the linear combination, with weights 3 and
-4, of the function in f and the function in g.
fnfmb(f, 3, g) adds 3 times the function in f to the function in g.

If the function f in f happens to be scalar-valued, then
f3 = fnfmb(f, [1; 2; 3]) contains the description of the function whose
value at x is the 3-vector (f(x), 2f(x), 3f(x)). Note that, by the convention
throughout this toolbox, the subsequent statement fnval(f3, x) returns
a 1-column-matrix.

If f describes a surface in R³, i.e., the function in f is 3-vector-valued
bivariate, then f2 = fnfmb(f, [1 0 0; 0 0 1]) describes the projection
of that surface to the (x, z)-plane.

The following commands produce the picture of a ... spirochete?
```
c = rsmak('circle');
fnplt(fnmcmb(c, diag([1.5, 1]))); axis equal, hold on
sc = fnmcmb(c, .4);
fnplt(fnmcmb(sc, [-.2; -.5]))
fnplt(fnmcmb(sc, [-.2, -.5]))
hold off, axis off

```
If t is a knot sequence of length n+k and a is a matrix with n columns,
then fnmcmb(spmak(t, eye(n)), a) is the same as spmak(t, a).

fnmcmb(spmak([0:4], 1), '+', ppmak([-1 5], [1 -1])) is the
piecewise-polynomial with breaks -1:5 that, on the interval [0 .. 4],

12-114
agrees with the function \( x \mapsto B(x|0,1,2,3,4) + x \) (but has no active break at 0 or 1, hence differs from this function outside the interval \([0 .. 4]\)).

\[
\text{fncmb}([0:4],1,\)'-',0) \text{ has the same effect as }
\text{fn2fm}([0:4],1,\)'pp').
\]

Assuming that \( sp \) describes the B-form of a spline of order <\( k \), the output of

\[
\text{fn2fm}([0:4],1,\)'pp'), \text{fnbrk}([0:4],1,\)'interv'), \text{zeros}(1,k))\) describes the B-form of the same spline, but with its order raised to \( k \).

### Algorithms

The coefficients are extracted (via \text{fnbrk}) and operated on by the specified matrix or operation (and, possibly, added), then recombined with the rest of the function description (via \text{ppmak}, \text{spmak}, \text{rpmak}, \text{rsmak}, \text{stmak}). To be sure, when the function is rational, the matrix is only applied to the coefficients of the numerator. Again, if we are to translate the function values by a given vector and the function is in ppform, then only the coefficients corresponding to constant terms are so translated.

If there are two functions input, then they must be of the same type (see Limitations, below) except for the following.

\[
\text{fncmb}(f1,op,f2) \text{ returns the ppform of the function }
\]

\[
x \mapsto f1(x) \text{ op } f2(x)
\]

with \text{op} one of '+', '-', '*', and \( f1, f2 \) of arbitrary polynomial form. If, in addition, \( f2 \) is a scalar or vector, it is taken to be the function that is constantly equal to that scalar or vector.

### Limitations

\text{fncmb} only works for univariate functions, except for the case \text{fncmb}(function,operation), i.e., when there is just one function in the input.

Further, if two functions are involved, then they must be of the same type. This means that they must either both be in B-form or both be in
ppform, and, moreover, have the same knots or breaks, the same order, and the same target. The only exception to this is the command of the form \texttt{fncmb(function,op,function)}.
Purpose
Differentiate function

Syntax
\[
\text{fprime} = \text{fnder}(\text{f}, \text{dorder})
\]
\[
\text{fnder}(\text{f})
\]

Description
\(\text{fprime} = \text{fnder}(\text{f}, \text{dorder})\) is the description of the \(\text{dorder}\)th derivative of the function whose description is contained in \(\text{f}\). The default value of \(\text{dorder}\) is 1. For negative \(\text{dorder}\), the particular \(|\text{dorder}|\)th indefinite integral is returned that vanishes \(|\text{dorder}|\)-fold at the left endpoint of the basic interval.

The output is of the same form as the input, i.e., they are both ppforms or both B-forms or both stforms. \text{fnder} does not work for rational splines; for them, use \text{fntlr} instead. \text{fnder} works for stforms only in a limited way: if the type is \text{tp00}, then \(\text{dorder}\) can be \([1,0]\) or \([0,1]\).

\text{fnder}(\text{f})\) is the same as \text{fnder}(\text{f},1).

If the function in \(\text{f}\) is multivariate, say \(m\)-variate, then \(\text{dorder}\) must be given, and must be of length \(m\).

Examples
If \(\text{f}\) is in ppform, or in B-form with its last knot of sufficiently high multiplicity, then, up to rounding errors, \(\text{f}\) and \(\text{fnder(fnint(f))}\) are the same.

If \(\text{f}\) is in ppform and \(\text{fa}\) is the value of the function in \(\text{f}\) at the left end of its basic interval, then, up to rounding errors, \(\text{f}\) and \(\text{fnint(fnder(f),fa)}\) are the same, unless the function described by \(\text{f}\) has jump discontinuities.

If \(\text{f}\) contains the B-form of \(\text{f}\), and \(t_1\) is its leftmost knot, then, up to rounding errors, \(\text{fnint(fnder(f))}\) contains the B-form of \(f - f(t_1)\). However, its leftmost knot will have lost one multiplicity (if it had multiplicity > 1 to begin with). Also, its rightmost knot will have full multiplicity even if the rightmost knot for the B-form of \(\text{f}\) in \(\text{f}\) doesn’t.

Here is an illustration of this last fact. The spline in \(\text{sp} = \text{spmak}([0,0,0,1],1)\) is, on its basic interval \([0..1]\), the straight line that is 1 at 0 and 0 at 1. Now integrate its derivative: \(\text{spdi} = \text{fnint(fnder(sp))}\). As
you can check, the spline in spdi has the same basic interval, but, on that interval, it agrees with the straight line that is 0 at 0 and –1 at 1. See the examples “Intro to B-form” and “Intro to ppform” for examples.

**Algorithms**

For differentiation of either polynomial form, the derivatives are found in the piecewise-polynomial sense. This means that, in effect, each polynomial piece is differentiated separately, and jump discontinuities between polynomial pieces are ignored during differentiation.

For the B-form, the formulas [PGS; (X.10)] for differentiation are used.

For the stform, differentiation relies on knowing a formula for the relevant derivative of the basis function of the particular type.

**See Also**

fndir | fnint | fnplt | fnval
Purpose

Directional derivative of function

Syntax

\[ df = fndir(f,y) \]

Description

\[ df = fndir(f,y) \] is the ppform of the directional derivative, of the function \( f \) in \( f \), in the direction of the (column-)vector \( y \). This means that \( df \) describes the function \( D_y f(x) := \lim_{t \to 0} (f(x + ty) - f(x))/t \).

If \( y \) is a matrix, with \( n \) columns, and \( f \) is \( d \)-valued, then the function in \( df \) is \( \text{prod}(d) \times n \)-valued. Its value at \( x \), reshaped to be of size \([d,n]\), has in its \( j \)th “column” the directional derivative of \( f \) at \( x \) in the direction of the \( j \)th column of \( y \). If you prefer \( df \) to reflect explicitly the actual size of \( f \), use instead

\[ df = fnchg( fndir(f,y), 'dim', [fnbrk(f,'dim'),size(y,2)] ); \]

Since \( fndir \) relies on the ppform of the function in \( f \), it does not work for rational functions nor for functions in stform.

Examples

For example, if \( f \) describes an \( m \)-variate \( d \)-vector-valued function and \( x \) is some point in its domain, then, e.g., with this particular ppform \( f \) that describes a scalar-valued bilinear polynomial,

\[
\begin{align*}
  f &= ppmak([0:1,0:1],[1 0;0 1]); x = [0;0]; \\
  [d,m] &= fnbrk(f,'dim','var'); \\
  jacobian &= reshape(fnval(fndir(f,eye(m)),x),d,m)
\end{align*}
\]

is the Jacobian of that function at that point (which, for this particular scalar-valued function, is its gradient, and it is zero at the origin).

As a related example, the next statements plot the gradients of (a good approximation to) the Franke function at a regular mesh:

\[
\begin{align*}
  xx &= linspace(-.1,1.1,13); yy = linspace(0,1,11); \\
  [x,y] &= ndgrid(xx,yy); z = franke(x,y); \\
  pp2dir &= fndir(csapi({xx,yy},z),eye(2)); \\
  grads &= reshape(fnval(pp2dir,[x(:) y(:)].'),...)
\end{align*}
\]
The function in f is converted to ppform, and the directional derivative of its polynomial pieces is computed formally and in one vector operation, and put together again to form the ppform of the directional derivative of the function in f.

See Also

fnchg | fnder | fnint | franke
Purpose
Integrate function

Syntax
\[ \text{intgrf} = \text{fnint}(f, \text{value}) \]
\[ \text{fnint}(f) \]

Description
\( \text{intgrf} = \text{fnint}(f, \text{value}) \) is the description of an indefinite integral of the univariate function whose description is contained in \( f \). The integral is normalized to have the specified value at the left endpoint of the function’s basic interval, with the default value being zero.

The output is of the same type as the input, i.e., they are both ppforms or both B-forms. \text{fnint} does not work for rational splines nor for functions in stform.

\( \text{fnint}(f) \) is the same as \( \text{fnint}(f, 0) \). Indefinite integration of a multivariate function, in coordinate directions only, is available via \( \text{fnnder}(f, \text{dorder}) \) with \( \text{dorder} \) having nonpositive entries.

Examples
The statement \( \text{diff(fnval(fnint(f)), [a b])} \) provides the definite integral over the interval \([a .. b]\) of the function described by \( f \).

If \( f \) is in ppform, or in B-form with its last knot of sufficiently high multiplicity, then, up to rounding errors, \( f \) and \( \text{fnnder(fnint(f))} \) are the same.

If \( f \) is in ppform and \( fa \) is the value of the function in \( f \) at the left end of its basic interval, then, up to rounding errors, \( f \) and \( \text{fnint(fnnder(f), fa)} \) are the same, unless the function described by \( f \) has jump discontinuities.

If \( f \) contains the B-form of \( f \), and \( t_1 \) is its leftmost knot, then, up to rounding errors, \( \text{fnint(fnnder(f))} \) contains the B-form of \( f - f(t_1) \).
However, its leftmost knot will have lost one multiplicity (if it had multiplicity > 1 to begin with). Also, its rightmost knot will have full multiplicity even if the rightmost knot for the B-form of \( f \) in \( f \) doesn’t.

Here is an illustration of this last fact. The spline in \( \text{sp} = \text{spmak}([0 0 1], 1) \) is, on its basic interval \([0..1]\), the straight line that is 1 at 0 and
0 at 1. Now integrate its derivative: \( \text{spdi} = \text{fnint}(\text{fnder}(\text{sp})) \). As you can check, the spline in \( \text{spdi} \) has the same basic interval, but, on that interval, it agrees with the straight line that is 0 at 0 and -1 at 1.

See the examples “Intro to B-form” and “Intro to ppform” for examples.

**Algorithms**

For the B-form, the formula [PGS; (X.22)] for integration is used.

**See Also**

\( \text{fnder} \) | \( \text{fnplt} \) | \( \text{fnval} \)
Purpose
Jumps, i.e., \( f(x^+) - f(x^-) \)

Syntax
\[
jumps = \text{fnjmp}(f, x)
\]

Description
\( \text{fnjmp}(f, x) \) is like \( \text{fnval}(f, x) \) except that it returns the jump \( f(x^+) - f(x^-) \) across \( x \) (rather than the value at \( x \)) of the function \( f \) described by \( f \) and that it only works for univariate functions.

This is a function for spline specialists.

Examples
\[
\text{fnjmp}(\text{ppmak}(1:4, 1:3), 1:4)
\]
returns the vector \([0, 1, 1, 0]\) since the \text{pp} function here is 1 on \([1 .. 2]\), 2 on \([2 .. 3]\), and 3 on \([3 .. 4]\), hence has zero jump at 1 and 4 and a jump of 1 across both 2 and 3.

If \( x \) is \( \cos([4:-1:0]*\pi/4) \), then \( \text{fnjmp}(\text{fnder}(\text{spmak}(x, 1), 3), x) \)
returns the vector \([12, -24, 24, -24, 12]\) (up to round-off). This is consistent with the fact that the spline in question is a so called perfect cubic B-spline, i.e., has an absolutely constant third derivative (on its basic interval). The modified command

\[
\text{fnjmp}(\text{fnder}(\text{fn2fm}(\text{spmak}(x, 1), 'pp'), 3), x)
\]
returns instead the vector \([0, -24, 24, -24, 0]\), consistent with the fact that, in contrast to the B-form, a spline in ppform does not have a discontinuity in any of its derivatives at the endpoints of its basic interval. Note that \( \text{fnjmp}(\text{fnder}(\text{spmak}(x, 1), 3), -x) \) returns the vector \([12, 0, 0, 0, 12]\) since \(-x\), though theoretically equal to \( x \), differs from \( x \) by roundoff, hence the third derivative of the B-spline provided by \text{spmak}(x, 1)\) does not have a jump across \(-x(2), -x(3), \) and \(-x(4)\).
Purpose

Minimum of function in given interval

Syntax

fnmin(f)
fnmin(f,interv)
[minval,minsite] = fnmin(f,...)

Description

fnmin(f) returns the minimum value of the scalar-valued univariate spline in f on its basic interval.

fnmin(f,interv) returns the minimum value on the interval [a..b] specified by interv.

[minval,minsite] = fnmin(f,...) also returns a location, minsite, at which the function in f takes that minimum value, minval.

Examples

Example 1. We construct and plot a spline f with many local extrema, then compute its maximum as the negative of the minimum of –f. We indicate this maximum value by adding a horizontal line to the plot at the height of the computed maximum.

    rand('seed',21);
    f = spmak(1:21,rand(1,15)-.5);
    fnplt(f)
    maxval = -fnmin(fncmb(f,-1));
    hold on, plot(fnbrk(f,'interv'),maxval([1 1])), hold off
Example 2. Since spmak(1:5,-1) provides the negative of the cubic B-spline with knot sequence 1:5, we expect the command

\[ [y,x] = \text{fnmin}(\text{spmak}(1:5,-1)) \]

to return $-2/3$ for $y$ and $3$ for $x$.

Algorithm fnmin first changes the basic interval of the function to the given interval, if any. On the interval, fnmin then finds all local extrema of the function as left and right limits at a jump and as zeros of the function’s first derivative. It then evaluates the function at these extrema and at the endpoints of the interval, and determines the minimum over all these values.
Purpose

Plot function

Syntax

fnplt(f)
fnplt(f,arg1,arg2,arg3,arg4)
points = fnplt(f,...)
[points, t] = fnplt(f,...)

Description

fnplt(f) plots the function, described by f, on its basic interval.
If f is univariate, the following is plotted:
• If f is scalar-valued, the graph of f is plotted.
• If f is 2-vector-valued, the planar curve is plotted.
• If f is d-vector-valued with d > 2, the space curve given by the first three components of f is plotted.

If f is bivariate, the following is plotted:
• If f is scalar-valued, the graph of f is plotted (via surf).
• If f is 2-vector-valued, the image in the plane of a regular grid in its domain is plotted.
• If f is d-vector-valued with d > 2, then the parametric surface given by the first three components of its values is plotted (via surf).

If f is a function of more than two variables, then the bivariate function, obtained by choosing the midpoint of the basic interval in each of the variables other than the first two, is plotted.

fnplt(f,arg1,arg2,arg3,arg4) permits you to modify the plotting by the specification of additional input arguments. You can place these arguments in whatever order you like, chosen from the following list:

• A string that specifies a plotting symbol, such as ' - ' or '*'; the default is ' - '.
• A scalar to specify the linewidth; the default value is 1.
• A string that starts with the letter 'j' to indicate that any jump in
the univariate function being plotted should actually appear as a
jump. The default is to fill in any jump by a (near-)vertical line.

• A vector of the form [a,b], to indicate the interval over which to plot
the univariate function in f. If the function in f is m-variate, then
this optional argument must be a cell array whose ith entry specifies
the interval over which the ith argument is to vary. In effect, for
this arg, the command fnplt(f, arg, ...) has the same effect as
the command fnplt(fnbrk(f, arg), ...). The default is the basic
interval of f.

• An empty matrix or string, to indicate use of default(s). You will
find this option handy when your particular choice depends on some
other variables.

points = fnplt(f, ...) plots nothing, but the two-dimensional
points or three-dimensional points it would have plotted are returned
instead.

[points, t] = fnplt(f, ...) also returns, for a vector-valued f, the
corresponding vector t of parameter values.

**Algorithms**

A vector x of evaluation points is generated by the union of:

1. 101 equally spaced sites filling out the plotting interval

2. Any breakpoints in the plotting interval

The univariate function f described by f is evaluated at these x
evaluation points. If f is real-valued, the points (x,f(x)) are plotted. If f is
vector-valued, then the first two or three components of f(x) are plotted.

The bivariate function f described by f is evaluated on a 51-by-51
uniform grid if f is scalar-valued or d-vector-valued with d > 2 and
the result plotted by surf. In the contrary case, f is evaluated along
the meshlines of a 11-by-11 grid, and the resulting planar curves are
plotted.
Cautionary Note

The basic interval for \( f \) in B-form is the interval containing all the knots. This means that, e.g., \( f \) is sure to vanish at the endpoints of the basic interval unless the first and the last knot are both of full multiplicity \( k \), with \( k \) the order of the spline \( f \). Failure to have such full multiplicity is particularly annoying when \( f \) is a spline curve, since the plot of that curve as produced by \texttt{fnplt} is then bound to start and finish at the origin, regardless of what the curve might otherwise do.

Further, since B-splines are zero outside their support, any function in B-form is zero outside the basic interval of its form. This is very much in contrast to a function in ppform whose values outside the basic interval of the form are given by the extension of its leftmost, respectively rightmost, polynomial piece.

See Also

\texttt{fnder} | \texttt{fnint} | \texttt{fnval}
Purpose
Refine partition of form

Syntax
\[ g = \text{fnrfn}(f, \text{addpts}) \]

Description
\( g = \text{fnrfn}(f, \text{addpts}) \) describes the same function as does \( f \), but uses more terms to do it. This is of use when the sum of two or more functions of different forms is wanted or when the number of degrees of freedom in the form is to be increased to make fine local changes possible. The precise action depends on the form in \( f \).

If the form in \( f \) is a B-form or BBform, then the entries of \( \text{addpts} \) are inserted into the existing knot sequence, subject to the following restriction: The multiplicity of no knot exceed the order of the spline. The equivalent B-form with this refined knot sequence for the function given by \( f \) is returned.

If the form in \( f \) is a ppform, then the entries of \( \text{addpts} \) are inserted into the existing break sequence, subject to the following restriction: The break sequence be strictly increasing. The equivalent ppform with this refined break sequence for the function in \( f \) is returned.

\text{fnrfn} does not work for functions in \text{stform}.

If the function in \( f \) is m-variate, then \( \text{addpts} \) must be a cell array, \{\text{addpts}_1, \ldots, \text{addpts}_m\}, and the refinement is carried out in each of the variables. If the \( i \)th entry in this cell array is empty, then the knot or break sequence in the \( i \)th variable is unchanged.

Examples
Construct a spline in B-form, plot it, then apply two midpoint refinements, and also plot the control polygon of the resulting refined spline, expecting it to be quite close to the spline itself:

\begin{verbatim}
 k = 4; sp = spapi( k, [1,1:10,10], [cos(1),sin(1:10),cos(10)] );
 fnplt(sp), hold on
 sp3 = fnrfn(fnrfn(sp));
 plot( aveknt( fnbrk(sp3,'knots'),k), fnbrk(sp3,'coefs'), 'r')
 hold off
\end{verbatim}

A third refinement would have made the two curves indistinguishable.
Use `fnrfn` to add two B-splines of the same order:

```matlab
B1 = spmak([0:4],1); B2 = spmak([2:6],1);
    B1r = fnrfn(B1,fnbrk(B2,'knots'));
    B2r = fnrfn(B2,fnbrk(B1,'knots'));
    B1pB2 = spmak(fnbrk(B1r,'knots'),fnbrk(B1r,'c')+fnbrk(B2r,'c'));
    fnplt(B1,'r'),hold on, fnplt(B2,'b'), fnplt(B1pB2,'y',2)
    hold off
```

**Algorithms**

The standard *knot insertion* algorithm is used for the calculation of the B-form coefficients for the refined knot sequence, while Horner’s method is used for the calculation of the local polynomial coefficients at the additional breaks in the refined break sequence.

**See Also**

`fncmb` | `ppmak` | `spmak`
Purpose  
Taylor coefficients or polynomial

Syntax  
taylor = fntlr(f,dorder,x)
p = fntlr(f,dorder,x,interv)

Description  
taylor = fntlr(f,dorder,x) returns the unnormalized Taylor coefficients, up to the given order dorder and at the given x, of the function described in f.

For a univariate function and a scalar x, this is the vector

\[ T(f, d\text{order}, x) := [f(x); Df(x); \ldots; D^{d\text{order}-1}f(x)] \]

If, more generally, the function in f is d-valued with d>1 or even \( \text{prod}(d)>1 \) and/or is m-variate for some m>1, then dorder is expected to be an m-vector of positive integers, x is expected to be a matrix with m rows, and, in that case, the output is of size \([\text{prod}(d) \cdot \text{prod}(\text{dorder}), \text{size}(x, 2)]\), with its j-th column containing

\[ T(f, d\text{order}, x(:, j))(i1, \ldots, im) = D^{i1-1}_1 \ldots D^{im-1}_m f(x(:, j)) \]

for \( i1=1: d\text{order}(1), \ldots, im=1: d\text{order}(m) \). Here, Df is the partial derivative of f with respect to its ith argument.

p = fntlr(f,dorder,x,interv) returns instead a ppform of the Taylor polynomial at x of order dorder for the function described by f. The basic interval for this ppform is as specified by interv. In this case and assuming that the function described by f is m-variate, x is expected to be of size \([m, 1]\), and interv is either of size \([m, 2]\) or else a cell array of length m containing m vectors of size \([1, 2]\).

Examples  
If f contains a univariate function and x is a scalar or a 1-row matrix, then fntlr(f,3,x) produces the same output as the statements

\[ df = \text{fnder}(f); [\text{fnval}(f,x); \text{fnval}(df,x); \text{fnval(fnder(df),x))]; \]
As a more complicated example, look at the Taylor vectors of order 3 at 21 equally spaced points for the rational spline whose graph is the unit circle:

```matlab
ci = rsmak('circle'); in = fnbrk(ci,'interv');
t = linspace(in(1),in(2),21); t(end)=[];
v = fntlr(ci,3,t);
```

We plot ci along with the points v(1:2,:), to verify that these are, indeed, points on the unit circle.

```matlab
fnplt(ci), hold on, plot(v(1,:),v(2,:), 'o')
```

Next, to verify that v(3:4,j) is a vector tangent to the circle at the point v(1:2,j), we use the MATLAB quiver command to add the corresponding arrows to our plot:

```matlab
quiver(v(1,:),v(2,:),v(3,:),v(4,:))
```

Finally, what about v(5:6,:)? These are second derivatives, and we add the corresponding arrows by the following quiver command, thus finishing First and Second Derivative of a Rational Spline Giving a Circle on page 12-133.

```matlab
quiver(v(1,:),v(2,:),v(5,:),v(6,:)), axis equal, hold off
```
First and Second Derivative of a Rational Spline Giving a Circle

Now, our curve being a circle, you might have expected the 2nd derivative arrows to point straight to the center of that circle, and that would have been indeed the case if the function in \( c_I \) had been using arclength as its independent variable. Since the parameter used is not arclength, we use the formula, given in “Example: B-form Spline Approximation to a Circle” on page 10-24, to compute the curvature of the curve given by \( c_I \) at these selected points. For ease of comparison, we switch over to the variables used there and then simply use the commands from there.

\[
\text{dspt} = v(3:4,:); \quad \text{ddspt} = v(5:6,:);
\]

\[
\begin{align*}
\kappa &= \frac{\left| dspt(1,:).*ddspt(2,:)-dspt(2,:).*ddspt(1,:).\right|}{(\sum dspt.^2).^{3/2}}. \\
\max(\text{abs}(\kappa-1)) &= 2.2204\times10^{-16}
\end{align*}
\]

The numerical answer is reassuring: at all the points tested, the curvature is 1 to within roundoff.
The Function $1/(1+x^2+y^2)$ and Its Taylor Polynomial of Order $[3,3]$ at the Origin

As a final example, we start with a bivariate version of the Runge function, obtaining, for variety, a ppform for its denominator, $1 + x^2 + y^2$, by bicubic spline interpolation:

$$w = \text{csapi}([-1:1,-1:1],[3 2 3;2 1 2;3 2 3]);$$

Next, we make up the coefficient array for the numerator, 1, using exactly the same size, and put the two together into a rational spline:

$$wcoefs = \text{fnbrk}(w,\text{'coef'});$$
$$scoefs = \text{zeros(size(wcoefs))}; scoefs(end)=1;$$
$$\text{runge2} = \text{rpmak}(\text{fnbrk}(w,\text{'breaks'}),[scoefs;wcoefs]);$$

Then we enlarge the basic interval for this rational spline, plot it and plot, on top of it, its Taylor polynomial at (0,0) of order $[3,3]$.

$$\text{fnplt}(\text{fnbrk}(\text{runge2},[-2 2],[-2 2])); \quad \text{shading interp, hold on}$$
$$\text{fnplt}(\text{fntlr}(\text{runge2},[3 3],[0;0],[-.7 .7; -.7 .7]));$$
$$\text{axis off, hold off}$$
Since we shaded the function but not the Taylor polynomial, we can easily distinguish the two in the previous figure. We can also see that, in contrast to the function, the Taylor polynomial fails to be rotationally symmetric. This is due to the fact that it is a polynomial of order \([3,3]\) rather than a polynomial of total order 3.

To obtain the Taylor polynomial of order 3, we get the Taylor polynomial of order \([3,3]\), but with \((0,0)\) the left point of its basic interval, set all its coefficients of total order bigger than 3 equal to zero, and then reconstruct the polynomial, and plot it, choosing a different view in order to show off the Taylor polynomial better. Here are the commands and the resulting figure.

```matlab
taylor = fntlr(runge2,[3 3],[0;0],[0 1;0 1]);
tcoef = fnbrk(taylor,'coe'); tcoef([1 2 4]) = 0;
taylor2 = fnbrk(ppmak(fnbrk(taylor,'br'),tcoef),{[-1 1],[-1 1]});
fnplt(fnbrk(runge2,{-2 2},{-2 2})); shading interp, hold on
fnplt(taylor2), view(-28,-26), axis off, hold off
```
The Function $1/(1+x^2+y^2)$ and Its Taylor Polynomial of Order 3 at the Origin

See Also

fnder | fndir
Purpose
Evaluate function

Syntax
\[
\begin{align*}
v &= \text{fnval}(f,x) \\
    \text{fnval}(x,f) \\
    \text{fnval}(\ldots,'1')
\end{align*}
\]

Description
\(v = \text{fnval}(f,x)\) and \(v = \text{fnval}(x,f)\) both provide the value \(f(x)\) at the points in \(x\) of the function \(f\) whose description is contained in \(f\).

Roughly speaking, the output \(v\) is obtained by replacing each entry of \(x\) by the value of \(f\) at that entry. This is literally true in case the function in \(f\) is scalar-valued and univariate, and is the intent in all other cases, except that, for a \(d\)-valued \(m\)-variate function, this means replacing \(m\)-vectors by \(d\)-vectors. The full details are as follows.

For a univariate \(f\): 
- If \(f\) is scalar-valued, then \(v\) is of the same size as \(x\).
- If \(f\) is \([d_1,\ldots,d_r]\)-valued, and \(x\) has size \([n_1,\ldots,n_s]\), then \(v\) has size \([d_1,\ldots,d_r, n_1,\ldots,n_s]\), with \(v(:,\ldots,:, j_1,\ldots,j_s)\) the value of \(f\) at \(x(j_1,\ldots,j_s)\), except that
  - (1) \(n_1\) is ignored if it is 1 and \(s\) is 2, i.e., if \(x\) is a row vector; and
  - (2) MATLAB ignores any trailing singleton dimensions of \(x\).

For an \(m\)-variate \(f\) with \(m\geq1\), with \(f\) \([d_1,\ldots,d_r]\)-valued, \(x\) may be either an array, or else a cell array \(\{x_1,\ldots,x_m\}\).
- If \(x\) is an array, of size \([n_1,\ldots,n_s]\) say, then \(n_1\) must equal \(m\), and \(v\) has size \([d_1,\ldots,d_r, n_2,\ldots,n_s]\), with \(v(:,\ldots,:, j_2,\ldots,j_s)\) the value of \(f\) at \(x(:,j_2,\ldots,j_s)\), except that
  - (1) \(d_1,\ldots,d_r\) is ignored in case \(f\) is scalar-valued, i.e., both \(r\) and \(n_1\) are 1;
  - (2) MATLAB ignores any trailing singleton dimensions of \(x\).
- If \(x\) is a cell array, then it must be of the form \(\{x_1,\ldots,x_m\}\), with \(x_j\) a vector, of length \(n_j\), and, in that case, \(v\) has size \([d_1,\ldots,d_r, n_1,\ldots,n_m]\), with \(v(:,\ldots,:, j_1,\ldots,j_m)\) the value of \(f\) at \((x_1(j_1),\ldots)\).
fnval

..., x(m(jm)), – except that d1, ..., dr is ignored in case f is scalar-valued, i.e., both r and n1 are 1.

If f has a jump discontinuity at x, then the value f(x +), i.e., the limit from the right, is returned, except when x equals the right end of the basic interval of the form; for such x, the value f(x –), i.e., the limit from the left, is returned.

fnval(x,f) is the same as fnval(f,x).

fnval(...,'l') treats f as continuous from the left. This means that if f has a jump discontinuity at x, then the value f(x –), i.e., the limit from the left, is returned, except when x equals the left end of the basic interval; for such x, the value f(x +) is returned.

If the function is multivariate, then the above statements concerning continuity from the left and right apply coordinatewise.

Examples

The statement fnval(csapi(x,y),xx) has the same effect as the statement csapi(x,y,xx).

Algorithms

For each entry of x, the relevant break- or knot-interval is determined and the relevant information assembled. Depending on whether f is in ppform or in B-form, nested multiplication or the B-spline recurrence (see, e.g., [PGS; X.(3)]) is then used vector-fashion for the simultaneous evaluation at all entries of x. Evaluation of a multivariate polynomial spline function takes full advantage of the tensor product structure.

Evaluation of a rational spline follows up evaluation of the corresponding vector-valued spline by division of all but its last component by its last component.

Evaluation of a function in stform makes essential use of stcol, and tries to keep the matrices involved to reasonable size.

See Also

fnbrk | ppmak | rsmak | spmak | stmak
<table>
<thead>
<tr>
<th>Purpose</th>
<th>Extrapolate function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax</td>
<td>g = fnxtr(f,order)</td>
</tr>
<tr>
<td></td>
<td>fnxtr(f)</td>
</tr>
<tr>
<td>Description</td>
<td>g = fnxtr(f,order) returns the spline (in ppform) that agrees with</td>
</tr>
<tr>
<td></td>
<td>the spline in f on the latter's basic interval but is a polynomial of</td>
</tr>
<tr>
<td></td>
<td>the given order outside it, with 2 the default for order, in such a</td>
</tr>
<tr>
<td></td>
<td>way that the spline in g satisfies at least order smoothness conditions</td>
</tr>
<tr>
<td></td>
<td>at the ends of f's basic interval, i.e., at the new breaks.</td>
</tr>
<tr>
<td></td>
<td>f must be in B-form, BBform, or ppform.</td>
</tr>
<tr>
<td></td>
<td>While order can be any nonnegative integer, fnxtr is useful mainly</td>
</tr>
<tr>
<td></td>
<td>when order is positive but less than the order of f.</td>
</tr>
<tr>
<td></td>
<td>If order is zero, then g describes the same spline as fn2fm(f, 'B-') but</td>
</tr>
<tr>
<td></td>
<td>is in ppform and has a larger basic interval.</td>
</tr>
<tr>
<td></td>
<td>If order is at least as big as f's order, then g describes the same pp as</td>
</tr>
<tr>
<td></td>
<td>fn2fm(f, 'pp') but uses two more pieces and has a larger basic interval.</td>
</tr>
<tr>
<td></td>
<td>If f is m-variate, then order may be an m-vector, in which case</td>
</tr>
<tr>
<td></td>
<td>order(i) specifies the matching order to be used in the i-th variable,</td>
</tr>
<tr>
<td></td>
<td>i = 1:m.</td>
</tr>
<tr>
<td></td>
<td>If order&lt;0, then g is exactly the same as fn2fm(f, 'pp'). This unusual</td>
</tr>
<tr>
<td></td>
<td>option is useful when, in the multivariate case, extrapolation is to take</td>
</tr>
<tr>
<td></td>
<td>place in only some but not all variables.</td>
</tr>
<tr>
<td></td>
<td>fnxtr(f) is the same as fnxtr(f,2).</td>
</tr>
</tbody>
</table>

**Examples**

**Example 1.** The cubic smoothing spline for given data x,y is, like any |
other ‘natural’ cubic spline, required to have zero second derivative |/outside the interval spanned by the data sites. Hence, if such a spline is |/to be evaluated outside that interval, it should be constructed as s = |nxtr(csaps(x,y)). A Cubic Smoothing Spline Properly Extrapolated |/on page 12-140, generated by the following code, shows the difference. |

```matlab |
rand('seed',6); x = rand(1,21); s = csaps(x,x.^3); sn = fnxtr(s); |
```
fnplt(s,[-.5 1.4],3), hold on, fnplt(sn,[-.5 1.4],.5,'r',2)
legend('cubic smoothing spline','... properly extrapolated')
set(gca,'Fontsize',16), axis off, hold off

A Cubic Smoothing Spline Properly Extrapolated

Example 2. Here is the plot of a bivariate B-spline, quadratically extrapolated in the first variable and not at all extrapolated in the second, as generated by

fnplt(fnxtr(spmak({0:3,0:4},1),[3,-1]))
A Bivariate B-spline Quadratically Extrapolated In One Direction

See Also

ppmak | spmak | fn2fm
**Purpose**

Find zeros of function in given interval

**Syntax**

\[
z = \text{fnzeros}(f, [a \ b])
\]

\[
z = \text{fnzeros}(f)
\]

**Description**

\[
z = \text{fnzeros}(f, [a \ b])\]

is an ordered list of the zeros of the univariate spline \( f \) in the interval \([a .. b]\).

\[
z = \text{fnzeros}(f)\]

is a list of the zeros in the basic interval of the spline \( f \).

A spline zero is either a maximal closed interval over which the spline is zero, or a zero crossing (a point across which the spline changes sign).

The list of zeros, \( z \), is a matrix with two rows. The first row is the left endpoint of the intervals and the second row is the right endpoint. Each column \( z(:,j) \) contains the left and right endpoint of a single interval.

These intervals are of three kinds:

- If the endpoints are different, then the function is zero on the entire interval. In this case the maximal interval is given, regardless of knots that may be in the interior of the interval.

- If the endpoints are the same and coincident with a knot, then the function in \( f \) has a zero at that point. The spline could cross zero, touch zero or be discontinuous at this point.

- If the endpoints are the same and not coincident with a knot, then the spline has a zero crossing at this point.

If the spline, \( f \), touches zero at a point that is not a knot, but does not cross zero, then this zero may not be found. If it is found, then it may be found twice.

**Examples**

**Example 1.** The following code constructs and plots a piecewise linear spline that has each of the three kinds of zeros: touch zero, cross zero, and zero for an interval. `fnzeros` computes all the zeros, and then the code plots the results on the graph.

\[
\text{sp} = \text{spmak}([\text{augknt}(1:7,2),[1,0,1,-1,0,0,1]]);
\]

\[
\text{fnplt(sp)}
\]
\[ z = \text{fnzeros}(\text{sp}) \]
\[ \text{nz} = \text{size}(z,2); \]
\[ \text{hold on} \]
\[ \text{plot}(z(:,1),\text{zeros}(1,\text{nz}),'>',z(:,2),\text{zeros}(1,\text{nz}),'<'), \text{hold off} \]

This gives the following list of zeros:

\[
\begin{array}{ccc}
2.0000 & 3.5000 & 5.0000 \\
2.0000 & 3.5000 & 6.0000 \\
\end{array}
\]

In this simple example, even for the second kind of zero, the two endpoints agree to all places.

Example 2. The following code generates and plots a spline function with many extrema and locates all extrema by computing the zeros of the spline function’s first derivative there.

\[
f = \text{spmak}(1:21, \text{rand}(1,15)-0.5); \]
\[
\text{interval} = \text{fnbrk}(f, 'interval'); \]
\[
z = \text{fnzeros}(\text{fnder}(f)); \]
\[
z = z(1,:); \]
values = fnval( f, [interval, z] );
min( values )
fnplt(f)
hold on
plot(z,fnval(f,z),'ro')
hold off

Your plot will be different to the example following because of the use of rand to generate random coefficients.
**Example 3.** We construct a spline with a zero at a jump discontinuity and in B-form and find all the spline's zeros in an interval that goes beyond its basic interval.

```
sp = spmak([0 0 1 1 2],[1 0 -.2]);
fnplt(sp)
z = fnzeros(sp,[.5, 2.7])
zy = zeros(1,size(z,2));
hold on, plot(z(1,:),zy,'>',z(2,:),zy,'<'), hold off
```

This gives the following list of zeros:

```
z =
     1.0000  2.0000
     1.0000  2.7000
```

Notice the resulting zero interval [2..2.7], due to the fact that, by definition, a spline in B-form is identically zero outside its basic interval, [0..2].

**Example 4.** The following example shows the use of `fnzeros` with a discontinuous function. The following code creates and plots a discontinuous piecewise linear function, and finds the zeros.

```
sp = spmak([0 0 1 1 2 2],[-1 1 -1 1]);
fnplt(sp);
fnzeros(sp)
```

This gives the following list of zeros, in (1..2) and (0..1) and the jump through zero at 1:

```
ans =
     0.5000   1.0000   1.5000
     0.5000   1.0000   1.5000
```
fnzeros

**Algorithms**  
fnzeros first converts the function to B-form. The function performs some preprocessing to handle discontinuities, and then uses the algorithm of Mørken and Reimers.


**See Also**  
fnmin | fnval
**Purpose**
Formula of `cfit`, `sfit`, or `fittype` object

**Syntax**
`formula(fun)`

**Description**
`formula(fun)` returns the formula of the `cfit`, `sfit`, or `fittype` object `fun` as a character array.

**Examples**
```matlab
f = fittype('weibull');
formula(f)
ans =
a*b*x^(b-1)*exp(-a*x^b)

g = fittype('cubicspline');
formula(g)
ans =
piecewise polynomial
```

**See Also**
`fittype` | `coeffnames` | `numcoeffs` | `probnames` | `coeffvalues`
**Purpose**

Franke’s bivariate test function

**Syntax**

\[ z = \text{franke}(x,y) \]

**Description**

\[ z = \text{franke}(x,y) \] returns the value \( z(i) \) of Franke’s function at the site \((x(i),y(i))\), \(i=1:\text{numel}(x)\), with \( z \) of the same size as \( x \) and \( y \) (which must be of the same size).

Franke’s function is the following weighted sum of four exponentials:

\[
\frac{3}{4} e^{-((9x-2)^2+(9y-2)^2)/4} + \frac{3}{4} e^{-((9x+1)^2/49-(9y+1)/10)} \\
+ \frac{1}{2} e^{-((9x-7)^2+(9y-3)^2)/4} - \frac{1}{5} e^{-((9x-4)^2+(9y-7)^2)}
\]

**Examples**

The following commands provide a plot of Franke’s function:

\[
\text{pts} = (0:50)/50; \ [x,y] = \text{ndgrid}(\text{pts},\text{pts}); \ z = \text{franke}(x,y); \ \text{surf}(x,y,z), \ \text{view}(145,-2), \ \text{set(gca,'Fontsize',16)}
\]

![Plot of Franke's function](image)

**References**

Purpose
Get fit options structure property names and values

Syntax
get(options)
s = get(options)
value = get(options, fld)

Description
get(options) displays all property names and values of the fit options structure options.
s = get(options) returns a copy of the fit options structure options as the structure s.
value = get(options, fld) returns the value of the property fld of the fit options structure options. fld can be a cell array of strings, in which case value is also a cell array.

Examples
options = fitoptions('fourier1');
get(options,'Method')
ans =
    NonlinearLeastSquares
get(options,'MaxIter')
ans =
    400
set(options,'Maxiter',1e3);
get(options,'MaxIter')
ans =
    1000

Property values can also be referenced and assigned using the dot notation. For example:

options.MaxIter
ans =
    1000
options.MaxIter = 500;
options.MaxIter
ans =
    500
get

See Also  
fitoptions | set
Purpose
Interactive creation of cubic spline curve

Syntax
[xy,spcv] = getcurve

Description
[xy,spcv] = getcurve displays a gridded window and asks you for
input. As you click on points in the gridded window, the broken line
connecting these points is displayed. To indicate that you are done, click
outside the gridded window. Then a cubic spline curve, spcv, through
the point sequence, xy, is computed (via cscvn) and drawn. The point
sequence and, optionally, the spline curve are output.

If you want a closed curve, place the last point close to the initial point.
If you would like the curve to have a corner at some point, click on that
point twice (or more times) in succession.

See Also
cscvn
**Purpose**
Independent variable of cfit, sfit, or fittype object

**Syntax**

```matlab
indep = indepnames(fun)
```

**Description**

`indep = indepnames(fun)` returns the independent variable name or names (`indep`) of the cfit, sfit, or fittype object `fun`. For curves `indep` is a 1-by-1 cell array of strings, and for surfaces `indep` is a 2-by-1 cell array of strings.

**Examples**

```matlab
f1 = fittype('a*x^2+b*exp(n*x)');
indep1 = indepnames(f1)
indep1 =
    'x'

f2 = fittype('a*x^2+b*exp(n*x)','independent','n');
indep2 = indepnames(f2)
indep2 =
    'n'
```

**See Also**

dependnames | fittype | formula
**Purpose**
Integrate cfit object

**Syntax**
```
int = integrate(fun,x,x0)
```

**Description**
```
int = integrate(fun,x,x0) integrates the cfit object fun at the points specified by the vector x, starting from x0, and returns the result in int. int is a vector the same size as x. x0 is a scalar.
```

**Examples**
Create a baseline sinusoidal signal:
```
xdata = (0:.1:2*pi)';
y0 = sin(xdata);
```
Add noise to the signal:
```
noise = 2*y0.*randn(size(y0)); % Response-dependent Gaussian noise
ydata = y0 + noise;
```
Fit the noisy data with a custom sinusoidal model:
```
f = fittype('a*sin(b*x)');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
```
Find the integral of the fit at the predictors:
```
int = integrate(fit1,xdata,0);
```
Plot the data, the fit, and the integral:
```
subplot(2,1,1)
plot(fit1,xdata,ydata) % cfit plot method
subplot(2,1,2)
plot(xdata,int,'m') % double plot method
grid on
legend('integral')
```
Note that integrals can also be computed and plotted directly with the `cfit plot` method, as follows:

```matlab
plot(fit1,xdata,ydata,{'fit','integral'})
```

The `plot` method, however, does not return data on the integral.

**See Also**

`fit` | `plot` | `differentiate`
Purpose
Determine if cfit, sfit, or fittype object is linear

Syntax
flag = islinear(fun)

Description
flag = islinear(fun) returns a flag of 1 if the cfit, sfit, or fittype object fun represents a linear model, and a flag of 0 if it does not.

Note islinear assumes that all custom models specified by the fittype function using the syntax ftype = fittype('expr') are nonlinear models. To create a linear model with fittype that will be recognized as linear by islinear (and, importantly, by the algorithms of fit), use the syntax ftype = fittype({'expr1', 'expr2', ..., 'exprn'}).

Examples
f = fittype('a*x+b')
f =
   General model:
   f(a,b,x) = a*x+b

g = fittype({'x', '1'})
g =
   Linear model:
   g(a,b,x) = a*x + b

h = fittype('poly1')
h =
   Linear model Poly1:
   h(p1,p2,x) = p1*x + p2

islinear(f)
ans =
0
islinear(g)
ans =
islinear

1

islinear(h)
ans =
1

See Also

fittype
**Purpose**
Convert knots to breaks and their multiplicities

**Syntax**
knt2brk(knots)
[breaks,mults] = knt2brk(knots)
m = knt2mlt(t)
[m,sortedt] = knt2mlt(t)

**Description**
The commands extract the distinct elements from a sequence, as well as their multiplicities in that sequence, with multiplicity taken in two slightly different senses.

knt2brk(knots) returns the distinct elements in knots, and in increasing order, hence is the same as unique(knots).

[breaks,mults] = knt2brk(knots) additionally provides, in mults, the multiplicity with which each distinct element occurs in knots. Explicitly, breaks and mults are of the same length, and knt2brk is complementary to brk2knt in that, for any knot sequence knots, the two commands [xi,mlts] = knt2brk(knots);
knots1 = brk2knt(xi,mlts); give knots1 equal to knots.

m = knt2mlt(t) returns a vector of the same length as t, with m(i) counting, in the vector sort(t), the number of entries before its ith entry that are equal to that entry. This kind of multiplicity vector is needed in spapi or spcol where such multiplicity is taken to specify which particular derivatives are to be matched at the sites in t. Precisely, if t is nondecreasing and z is a vector of the same length, then sp = spapi(knots, t, z) attempts to construct a spline s (with knot sequence knots) for which \( D^{m(i)}s(t(i)) \) equals \( z(i) \), all \( i \).

[m,sortedt] = knt2mlt(t) also returns the output from sort(t).
Neither knt2brk nor knt2mlt is likely to be used by the casual user of this toolbox.

**Examples**
[xi,mlts]=knt2brk([1 2 3 3 1 3]) returns [1 2 3] for xi and [2 1 3] for mlts.
[m,t]=knt2mlt([1 2 3 3 1 3]) returns [0 1 0 0 1 2] for m and [1 1 2 3 3 3] for t.

See Also

brk2knt | spapi | spcol
Purpose

New break distribution

Syntax

newknots = newknt(f,newl)
newknt(f)
[... , distfn] = newknt(...)

Description

newknots = newknt(f,newl) returns the knot sequence whose interior knots cut the basic interval of f into newl pieces, in such a way that a certain piecewise linear monotone function related to the high derivative of f is equidistributed.

The intent is to choose a knot sequence suitable to the fine approximation of a function g whose rough approximation in f is assumed to contain enough information about g to make this feasible.

newknt(f) uses for newl its default value, namely the number of polynomial pieces in f.

[... , distfn] = newknt(...) also returns, in distfn, the ppform of that piecewise linear monotone function being equidistributed.

Examples

If the error in the least-squares approximation sp to some data x, y by a spline of order k seems uneven, you might try for a more equitable distribution of knots by using

spap2(newknt(sp),k,x,y);

For another example, see the last part of the example “Solving an ODE by Collocation”.

Algorithms

This is the Fortran routine NEWNOT in PGS. With k the order of the piecewise-polynomial function f in pp, the function $|D^k f|$ is approximated by a piecewise constant function obtained by local, discrete, differentiation of the variation of $D^{k-1} f$. The new break sequence is chosen to subdivide the basic interval of the piecewise-polynomial f in such a way that
\[
\int_{\text{newknots}(i)}^{\text{newknots}(i+1)} |D^k f|^{1/k} = \text{const}, \ i = k : k + \text{newl} - 1
\]
Purpose  Number of input arguments of `cfit`, `sfit`, or `fittype` object

Syntax  \[ nargs = \text{numargs}(\text{fun}) \]

Description  \( nargs = \text{numargs}(\text{fun}) \) returns the number of input arguments \( nargs \) of the `cfit`, `sfit`, or `fittype` object `fun`.

Examples  \[
\begin{align*}
f &= \text{fittype('a*x^2+b*exp(n*x)');} \\
nargs &= \text{numargs}(f) \\
nargs &= 4 \\
\text{args} &= \text{argnames}(f) \\
\text{args} &= ['a', 'b', 'n', 'x']
\end{align*}
\]

See Also  `fittype` | `formula` | `argnames`
Purpose
Number of coefficients of `cfit`, `sfit`, or `fittype` object

Syntax
`ncoeffs = numcoeffs(fun)`

Description
`ncoeffs = numcoeffs(fun)` returns the number of coefficients `ncoeffs` of the `cfit`, `sfit`, or `fittype` object `fun`.

Examples
```matlab
f = fittype('a*x^2+b*exp(n*x)');
ncoeffs = numcoeffs(f)
ncoeffs =
    3
coeffs = coeffnames(f)
coeffs =
    'a'
    'b'
    'n'
```

See Also
`fittype` | `formula` | `coeffnames`
**Purpose**
Knot distribution “optimal” for interpolation

**Syntax**
knots = optknt(tau,k,maxiter)
optknt(tau,k)

**Description**
knots = optknt(tau,k,maxiter) provides the knot sequence $t$ that is best for interpolation from $S_{k,t}$ at the site sequence $tau$, with 10 the default for the optional input maxiter that bounds the number of iterations to be used in this effort. Here, best or optimal is used in the sense of Micchelli/Rivlin/Winograd and Gaffney/Powell, and this means the following: For any recovery scheme $R$ that provides an interpolant $Rg$ that matches a given $g$ at the sites $tau(1)$, ..., $tau(n)$, we may determine the smallest constant $const_R$ for which $|g - Rg| \leq const_R ||D^k_g||$ for all smooth functions $g$.

Here, $f := \sup_{tau(1) < x < tau(n)} |f(x)|$. Then we may look for the optimal recovery scheme as the scheme $R$ for which $const_R$ is as small as possible. Micchelli/Rivlin/Winograd have shown this to be interpolation from $S_{k,t}$, with $t$ uniquely determined by the following conditions:

1. $t(1) = \ldots = t(k) = tau(1)$;
2. $t(n+1) = \ldots = t(n+k) = tau(n)$;
3. Any absolutely constant function $h$ with sign changes at the sites $t(k+1)$, ..., $t(n)$ and nowhere else satisfies

$$\int_{tau(1)}^{tau(n)} f(x)h(x)dx = 0$$

for all $f \in S_{k,t}$

Gaffney/Powell called this interpolation scheme optimal since it provides the center function in the band formed by all interpolants to the given data that, in addition, have their $k$th derivative between $M$ and $-M$ (for large $M$).

optknt(tau,k) is the same as optknt(tau,k,10).
Examples

See the last part of the example “Spline Interpolation” for an illustration. For the following highly nonuniform knot sequence

\[ t = [0, 0.0012 + [0, 1, 2+[0, .1], 4] * 1e-5, 0.002, 1]; \]

the command `optknt(t,3)` will fail, while the command `optknt(t,3,20)`, using a high value for the optional parameter `maxiter`, will succeed.

Algorithms

This is the Fortran routine `SPLOPT` in PGS. It is based on an algorithm described in , for the construction of that sign function \( h \) mentioned above. It is essentially Newton’s method for the solution of the resulting nonlinear system of equations, with \( aveknt(tau,k) \) providing the first guess for \( t(k+1), \ldots, t(n) \), and some damping used to maintain the Schoenberg-Whitney conditions.

References


See Also

aptknt | aveknt | newknt
Purpose

Plot cfit or sfit object

Syntax

plot(sfit)
plot(sfit, [x, y], z)
plot(sfit, [x, y], z, 'Exclude', outliers)
H = plot(sfit, ..., 'Style', Style)
H = plot(sfit, ..., 'Level', Level)
H = plot(sfit, ..., 'XLim', XLIM)
H = plot(sfit, ..., 'YLim', YLIM)
H = plot(sfit, ...)
H = plot(sfit, ..., 'Parent', HAXES )
plot(cfit)
plot(cfit,x,y)
plot(cfit,x,y,DataLineSpec)
plot(cfit,FitLineSpec,x,y,DataLineSpec)
plot(cfit,x,y,outliers)
plot(cfit,x,y,outliers,OutlierLineSpec)
plot(...,ptype,...)
plot(...,ptype,level)
h = plot(...)

Description

For surfaces:

- `plot(sfit)` plots the sfit object over the range of the current axes, if any, or otherwise over the range stored in the fit.

- `plot(sfit, [x, y], z)` plots z versus x and y and plots sfit over the range of x and y.

- `plot(sfit, [x, y], z, 'Exclude', outliers)` plots the excluded data in a different color. `outliers` can be an expression describing a logical vector, e.g., `x > 10`, a vector of integers indexing the points you want to exclude, e.g., `[1 10 25]`, or a logical array where true represents an outlier. You can create the array with `excludedata`.

- `H = plot(sfit, ..., 'Style', Style)` selects which way to plot the surface fit object sfit.

`Style` may be any of the following strings
- 'Surface' Plot the fit object as a surface (default)
- 'PredFunc' Surface with prediction bounds for function
- 'PredObs' Surface with prediction bounds for new observation
- 'Residuals' Plot the residuals (fit is the plane Z=0)
- 'Contour' Make a contour plot of the surface

- \( H = \text{plot}(sfit, \ldots, 'Level', \text{Level}) \) sets the confidence level to be used in the plot. \text{Level} is a positive value less than 1, and has a default of 0.95 (for 95% confidence). This option only applies to the 'PredFunc' and 'PredObs' plot styles.

- \( H = \text{plot}(sfit, \ldots, 'XLim', \text{XLIM}) \) and \( H = \text{plot}(sfit, \ldots, 'YLim', \text{YLIM}) \) sets the limits of the axes used for the plot. By default the axes limits are taken from the data, \( XY \). If no data is given, then the limits are taken from the surface fit object, \( sfit \).

- \( H = \text{plot}(sfit, \ldots) \) returns a vector of handles of the plotted objects.

- \( H = \text{plot}(sfit, \ldots, 'Parent', \text{HAXES}) \) plots the fit object \( sfit \) in the axes with handle \( \text{HAXES} \) rather than the current axes. The range is taken from these axes rather than from the fit or the data.

For curves:

- \( \text{plot}(cfit) \) plots the \( cfit \) object over the domain of the current axes, if any. If there are no current axes, and \( \text{fun} \) is an output from the \text{fit} function, the plot is over the domain of the fitted data.

- \( \text{plot}(cfit, x, y) \) plots \( cfit \) together with the predictor data \( x \) and the response data \( y \).

- \( \text{plot}(cfit, x, y, \text{DataLineSpec}) \) plots the predictor and response data using the color, marker symbol, and line style specified by the \text{DataLineSpec} formatting string. \text{DataLineSpec} strings take the same values as \text{LineSpec} strings used by the MATLAB \text{plot} function.

- \( \text{plot}(cfit, \text{FitLineSpec}, x, y, \text{DataLineSpec}) \) plots \( \text{fun} \) using the color, marker symbol, and line style specified by the \text{FitLineSpec}
formatting string, and plots x and y using the color, marker symbol, and line style specified by the DataLineSpec formatting string. FitLineSpec and DataLineSpec strings take the same values as LineSpec strings used by the MATLAB plot function.

- `plot(cfit,x,y,outliers)` plots data indicated by outliers in a different color. outliers can be an expression describing a logical vector, e.g., `x > 10`, a vector of integers indexing the points you want to exclude, e.g., `[1 10 25]`, or a logical array where `true` represents an outlier. You can create the array with `excludedata`.

- `plot(cfit,x,y,outliers,OutlierLineSpec)` plots outliers using the color, marker symbol, and line style specified by the OutlierLineSpec. OutlierLineSpec strings take the same values as LineSpec strings used by the MATLAB plot function.

- `plot(...,ptype,...)` uses the plot type specified by `ptype`. Supported plot types are:
  - `'fit'` — Data and fit (default)
  - `'predfunc'` — Data and fit with prediction bounds for the fit
  - `'predobs'` — Data and fit with prediction bounds for new observations
  - `'residuals'` — Residuals
  - `'stresiduals'` — Standardized residuals (residuals divided by their standard deviation).
  - `'deriv1'` — First derivative of the fit
  - `'deriv2'` — Second derivative of the fit
  - `'integral'` — Integral of the fit

- `plot(...,ptype,level)` plots prediction intervals with a confidence level specified by `level`. `level` must be between 0 and 1. The default value of `level` is 0.95.

For both curves and surfaces:
Plot types can be single or multiple, with multiple plot types specified as a cell array of strings. With a single plot type, plot draws to the current axes and can be used with commands like hold and subplot. With multiple plot types, plot creates subplots for each plot type.

- \( h = \text{plot}(...) \) returns a vector of handles to the plotted objects.

**Examples**

Create a baseline sinusoidal signal:

```matlab
xdata = (0:0.1:2*pi)';
y0 = sin(xdata);
```

Add noise to the signal with non-constant variance:

```matlab
% Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

% Salt-and-pepper noise
spnoise = zeros(size(y0));
p = randperm(length(y0));
sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));
```

```matlab
ydata = y0 + gnoise + spnoise;
```

Fit the noisy data with a baseline sinusoidal model:

```matlab
f = fittype('a*sin(b*x)');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
```

Identify “outliers” as points at a distance greater than 1.5 standard deviations from the baseline model, and refit the data with the outliers excluded:

```matlab
fdata = feval(fit1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata,'indices',I);

fit2 = fit(xdata,ydata,f,'StartPoint',[1 1],...
'Exclude', outliers);

Compare the effect of excluding the outliers with the effect of giving them lower bisquare weight in a robust fit:

```matlab
fit3 = fit(xdata, ydata, f, 'StartPoint', [1 1], 'Robust', 'on');
```

Plot the data, the outliers, and the results of the fits:

```matlab
plot(fit1, 'r-', xdata, ydata, 'k.', outliers, 'm*')
hold on
plot(fit2, 'c--')
plot(fit3, 'b:')
xlim([0 2*pi])
```

Plot the residuals for the two fits considering outliers:

```matlab
figure
plot(fit2, xdata, ydata, 'co', 'residuals')
hold on
```
Load data and fit a Gaussian, excluding some data with an expression, then plot the fit, data and the excluded points.

\[
[x, y] = \text{titanium}; \\
f1 = \text{fit}(x', y', 'gauss2', 'Exclude', x<800); \\
\text{plot}(f1, x, y, x<800)
\]

For more examples excluding data and plotting fits, see \texttt{fit}.

\textbf{See Also} \hspace{1cm} \texttt{cftool} | \texttt{excludedata} | \texttt{fit} | \texttt{differentiate} | \texttt{integrate}
**Purpose**
Put together spline in ppform

**Syntax**

ppmak(breaks,coefs)
ppmak
ppmak(breaks,coefs,d)
ppmak(breaks,coefs,sizec)

**Description**
The command `ppmak(...)` puts together a spline in ppform from minimal information, with the rest inferred from that information. `fnbrk` provides any or all of the parts of the completed description. In this way, the actual data structure used for the storage of the ppform is easily modified without any effect on the various `fn...` commands that use this construct. However, the casual user is not likely to use `ppmak` explicitly, relying instead on the various spline construction commands in the toolbox to construct particular splines.

`ppmak(breaks,coefs)` returns the ppform of the spline specified by the break information in `breaks` and the coefficient information in `coefs`. How that information is interpreted depends on whether the function is univariate or multivariate, as indicated by `breaks` being a sequence or a cell array.

If `breaks` is a sequence, it must be nondecreasing, with its first entry different from its last. Then the function is assumed to be univariate, and the various parts of its ppform are determined as follows:

1. The number 1 of polynomial pieces is computed as `length(breaks)-1`, and the basic interval is, correspondingly, the interval `[breaks(1) .. breaks(1+1)]`.

2. The dimension `d` of the function’s target is taken to be the number of rows in `coefs`. In other words, each column of `coefs` is taken to be one coefficient. More explicitly, `coefs(:,i*k+j)` is assumed to contain the jth coefficient of the (i+1)st polynomial piece (with the first coefficient the highest and the kth coefficient the lowest, or constant, coefficient). Thus, with `kl` the number of columns of `coefs`, the order `k` of the piecewise-polynomial is computed as `fix(kl/1)`.
After that, the entries of `coefs` are reordered, by the command

```plaintext
coeffs = reshape(permute(reshape(coefs,[d,k,l]),[1 3 2]),[d*l,k])
```

in order to conform with the internal interpretation of the coefficient array in the ppform for a univariate spline. This only applies when you use the syntax `ppmak(breaks,coefs)` where `breaks` is a sequence (row vector), not when it is a cell-array. The permutation is not made when you use the three-argument forms of `ppmak`. For the three-argument forms only a reshape is done, not a permute.

If `breaks` is a cell array, of length `m`, then the function is assumed to be `m`-variate (tensor product), and the various parts of its ppform are determined from the input as follows:

1. The `m`-vector `l` has `length(breaks{i})-1` as its `i`th entry and, correspondingly, the `m`-cell array of its basic intervals has the interval `[breaks{i}(1) .. breaks{i}(end)]` as its `i`th entry.

2. The dimension `d` of the function’s target and the `m`-vector `k` of (coordinate-wise polynomial) orders of its pieces are obtained directly from the size of `coefs`, as follows:

   a. If `coefs` is an `m`-dimensional array, then the function is taken to be scalar-valued, i.e., `d` is 1, and the `m`-vector `k` is computed as `size(coefs)./l`. After that, `coefs` is reshaped by the command `coefs = reshape(coefs,[1,size(coefs)])`.

   b. If `coefs` is an `(r+m)`-dimensional array, with `sizec = size(c)` say, then `d` is set to `sizec(1:r)`, and the vector `k` is computed as `sizec(r+(1:m))./l`. After that, `coefs` is reshaped by the command `coefs = reshape(coefs,[prod(d),sizec(r+(1:m))]).`

Then, `coefs` is interpreted as an equivalent array of size `[d,l(1),k(1),l(2),k(2),...,l(m),k(m)]`, with its `(:,i(1),r(1),i(2),r(2),...,i(m),r(m))th` entry the coefficient of
\[ \prod_{\mu=1}^{m} (x(\mu) - \text{breaks}[\mu](i(\mu)))^{(k(\mu)-r(\mu))} \]

in the local polynomial representation of the function on the (hyper)rectangle with sides

\[ \text{breaks}[\mu](i(\mu)) \ldots \text{breaks}[\mu](i(\mu)+1), \quad \mu = 1 : m \]

This is, in fact, the internal interpretation of the coefficient array in the ppform of a multivariate spline.

`ppmak` prompts you for `breaks` and `coefs`.

`ppmak(breaks,coefs,d)` with \(d\) a positive integer, also puts together the ppform of a spline from the information supplied, but expects the function to be univariate. In that case, `coefs` is taken to be of size \([d*1,k]\), with \(l\) obtained as `length(breaks) - 1`, and this determines the order, \(k\), of the spline. With this, `coefs(i*d+j,:)` is taken to be the \(j\)th components of the coefficient vector for the \((i+1)\)st polynomial piece.

`ppmak(breaks,coefs,sizec)` with `sizec` a row vector of positive integers, also puts together the ppform of a spline from the information supplied, but interprets `coefs` to be of size `sizec` (and returns an error when `prod(size(coefs))` differs from `prod(sizec)`). This option is important only in the rare case that the input argument `coefs` is an array with one or more trailing singleton dimensions. For, MATLAB suppresses trailing singleton dimensions, hence, without this explicit specification of the intended size of `coefs`, `ppmak` would interpret `coefs` incorrectly.

**Examples**

The two splines

\[
p1 = ppmak([1 3 4],[1 2 5 6;3 4 7 8]);
p2 = ppmak([1 3 4],[1 2;3 4;5 6;7 8],2);
\]

have exactly the same ppform (2-vector-valued, of order 2). But the second command provides the coefficients in the arrangement used internally.
`ppmak([0:2],[1:6])` constructs a piecewise-polynomial function with basic interval [0..2] and consisting of two pieces of order 3, with the sole interior break 1. The resulting function is scalar, i.e., the dimension d of its target is 1. The function happens to be continuous at that break since the first piece is \( x \mapsto x^2 + 2x + 3 \), while the second piece is \( x \mapsto 4(x - 1)^2 + 5(x-1) + 6 \).

When the function is univariate and the dimension d is not explicitly specified, then it is taken to be the row number of `coefs`. The column number should be an integer multiple of the number 1 of pieces specified by `breaks`. For example, the statement `ppmak([0:2],[1:3;4:6])` leads to an error, since the break sequence [0:2] indicates two polynomial pieces, hence an even number of columns are expected in the coefficient matrix. The modified statement `ppmak([0:1],[1:3;4:6])` specifies the parabolic curve \( x \mapsto (1,4)x^2 + (2,5)x + (3,6) \). In particular, the dimension d of its target is 2. The differently modified statement `ppmak([0:2],[1:4;5:8])` also specifies a planar curve (i.e., d is 2), but this one is piecewise linear; its first polynomial piece is \( x \mapsto (1,5)x + (2,6) \).

Explicit specification of the dimension d leads, in the univariate case, to a different interpretation of the entries of `coefs`. Now the column number indicates the polynomial order of the pieces, and the row number should equal d times the number of pieces. Thus, the statement `ppmak([0:2],[1:4;5:8],2)` is in error, while the statement `ppmak([0:2],[1:4;5:8],1)` specifies a scalar piecewise cubic whose first piece is \( x \mapsto x^3 + 2x^2 + 3x + 4 \).

If you wanted to make up the constant polynomial, with basic interval [0..1] say, whose value is the matrix `eye(2)`, then you would have to use the full optional third argument, i.e., use the command

```plaintext
pp = ppmak(0:1, eye(2), [2,2,1,1]);
```

Finally, if you want to construct a 2-vector-valued bivariate polynomial on the rectangle [-1 .. 1] x [0 .. 1], linear in the first variable and constant in the second, say

```plaintext
coeefs = zeros(2,2,1); coefs(:,1) = [1 0; 0 1];
```

then the straightforward

    pp = ppmak({[-1 1],[0 1]},coefs);

will fail, producing a scalar-valued function of order 2 in each variable, as will

    pp = ppmak({[-1 1],[0 1]},coefs,size(coefs));

while the following command will succeed:

    pp = ppmak({[-1 1],[0 1]},coefs,[2 2 1]);

See the example “Intro to ppform” for other examples.

**See Also**

fnbrk
Purpose
Prediction intervals for cfit or sfit object

Syntax

\[
\begin{align*}
  ci &= \text{predint}(\text{fitresult},x) \\
  ci &= \text{predint}(\text{fitresult},x,\text{level}) \\
  ci &= \text{predint}(\text{fitresult},x,\text{level},\text{intopt},\text{simopt}) \\
  [ci,y] &= \text{predint}(\ldots)
\end{align*}
\]

Description

\[ci = \text{predint}(\text{fitresult},x)\] returns upper and lower 95% prediction bounds for response values associated with the cfit object fitresult at the new predictor values specified by the vector \(x\). fitresult must be an output from the \text{fit} function to contain the necessary information for \(ci\). \(ci\) is an \(n\)-by-2 array where \(n = \text{length}(x)\). The left column of \(ci\) contains the lower bound for each coefficient; the right column contains the upper bound.

\[ci = \text{predint}(\text{fitresult},x,\text{level})\] returns prediction bounds with a confidence level specified by level. level must be between 0 and 1. The default value of level is 0.95.

\[ci = \text{predint}(\text{fitresult},x,\text{level},\text{intopt},\text{simopt})\] specifies the type of bounds to compute.

\textit{intopt} is one of

- 'observation' — Bounds for a new observation (default)
- 'functional' — Bounds for the fitted curve

\textit{simopt} is one of

- 'off' — Non-simultaneous bounds (default)
- 'on' — Simultaneous bounds

Observation bounds are wider than functional bounds because they measure the uncertainty of predicting the fitted curve plus the random variation in the new observation. Non-simultaneous bounds are for individual elements of \(x\); simultaneous bounds are for all elements of \(x\).

\([ci,y] = \text{predint}(\ldots)\) returns the response values \(y\) predicted by fitresult at the predictors in \(x\).
**Note** predint cannot compute prediction intervals for non-parametric regression methods such as Interpolant, Lowess, and Spline.

**Examples**

Generate data with an exponential trend:

```matlab
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));
```

Fit the data using a single-term exponential:

```matlab
fitresult = fit(x,y,'exp1');
```

Compute prediction intervals:

```matlab
p11 = predint(fitresult,x,0.95,'observation','off');
p12 = predint(fitresult,x,0.95,'observation','on');
p21 = predint(fitresult,x,0.95,'functional','off');
p22 = predint(fitresult,x,0.95,'functional','on');
```

Plot the data, fit, and prediction intervals:

```matlab
subplot(2,2,1)
plot(fitresult,x,y),hold on,plot(x,p11,'m--'),xlim([0 5])
title('Nonsimultaneous observation bounds','Color','m')
subplot(2,2,2)
plot(fitresult,x,y),hold on,plot(x,p12,'m--'),xlim([0 5])
title('Simultaneous observation bounds','Color','m')
subplot(2,2,3)
plot(fitresult,x,y),hold on,plot(x,p21,'m--'),xlim([0 5])
title('Nonsimultaneous functional bounds','Color','m')
subplot(2,2,4)
plot(fitresult,x,y),hold on,plot(x,p22,'m--'),xlim([0 5])
title('Simultaneous functional bounds','Color','m')
```
See Also

confint | fit | plot
Prepare data inputs for curve fitting

**Syntax**

```
[XOut,YOut] = prepareCurveData(XIn,YIn)
[XOut,YOut,WOut] = prepareCurveData(XIn,YIn,WIn)
```

**Description**

`[XOut,YOut] = prepareCurveData(XIn,YIn)` transforms data, if necessary, for curve fitting with the `fit` function. The `prepareCurveData` function transforms data as follows:

- Return data as columns regardless of the input shapes. Error if the number of elements do not match. Warn if the number of elements match, but the sizes differ.
- Convert complex to real (remove imaginary parts) and warn of this conversion.
- Remove `NaN` or `Inf` from data and warn of this removal.
- Convert non-double to double and warn of this conversion.

Specify `XIn` as empty if you want to fit curves to `y` data against the index. If `XIn` is empty, then `XOut` is a vector of indices into `YOut`. The `fit` function can use the vector `XOut` for the `x` data when there is only `y` data.

`[XOut,YOut,WOut] = prepareCurveData(XIn,YIn,WIn)` transforms data including weights (`WIn`) for curve fitting with the `fit` function.

When you generate code from the Curve Fitting Tool, the generated code includes a call to `prepareCurveData` (or `prepareSurfaceData` for surface fits). You can call the generated file from the command line with your original data or new data as input arguments, to recreate your fits and plots. If you call the generated file with new data, the `prepareCurveData` function ensures you can use any data that you can fit in the Curve Fitting Tool, by reshaping if necessary to column doubles and removing `NaNs`, `Infs`, or the imaginary parts of complex numbers.
prepareCurveData

**Input Arguments**

- **XIn**
  X data variable for curve fitting, of any numeric type. XIn can be empty. Specify empty ([ ]) when you want to fit curves to y data against index (x=1:length(y)). See YOut.

- **YIn**
  Y data variable for curve fitting, of any numeric type.

- **WIn**
  Weights variable for curve fitting, of any numeric type.

**Output Arguments**

- **XOut**
  X data column variable prepared for curve fitting, of type double. If XIn is empty, then XOut is a vector of indices into YOut. The fit function can use the vector XOut for the x data when there is only y data.

- **YOut**
  Y data column variable prepared for curve fitting, of type double.

- **WOut**
  Weights column variable prepared for curve fitting, of type double.

**Examples**

**Reshape Rows to Columns for Curve Fitting**

The following commands load the example titanium data in which x and y are row vectors. Attempting to use rows as inputs to the fit function produces an error. The prepareCurveData function reshapes x and y to columns for use with the fit function. The subsequent lines create and plot a fit.

```matlab
[x,y] = titanium();
[x,y] = prepareCurveData(x,y);
f = fit(x,y,'smoothingspline');
plot(f,x,y)
```
See Also  

fit | prepareSurfaceData | excludedata
prepareSurfaceData

**Purpose**
Prepare data inputs for surface fitting

**Syntax**

```
[XOut, YOut, ZOut] = prepareSurfaceData(XIn, YIn, ZIn)
[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn, ZIn, WIn)
```

**Description**

```
[XOut, YOut, ZOut] = prepareSurfaceData(XIn, YIn, ZIn)
```
transforms data, if necessary, for surface fitting with the `fit` function. The function transforms data as follows:

- For table data, transform row (YIn) and column (XIn) headers into arrays YOut and XOut that are the same size as ZIn. Warn if XIn and YIn are reversed.

- Return data as columns regardless of the input shapes. Error if the number of elements do not match. Warn if the number of elements match, but the sizes are different.

- Convert complex to real (remove imaginary parts) and warn of this conversion.

- Remove NaN or Inf from data and warn of this removal.

- Convert nondouble to double and warn of this conversion.

```
[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn, ZIn, WIn)
```
transforms data including weights (WIn) for surface fitting with the `fit` function.

When you generate code from Curve Fitting Tool, the generated code includes a call to `prepareSurfaceData` (or `prepareCurveData` for curve fits). You can call the generated file from the command line with your original data or new data as input arguments, to recreate your fits and plots. If you call the generated file with new data, the `prepareCurveData` function ensures you can use any data that you can fit in Curve Fitting Tool, by reshaping if necessary and removing NaNs, Infs, or the imaginary parts of complex numbers.

**See Also**

`fit` | `prepareCurveData` | `excludedata`
Purpose
Problem-dependent parameter names of \texttt{cfit}, \texttt{sfit}, or \texttt{fittype} object

Syntax
\texttt{pnames = probnames(fun)}

Description
\texttt{pnames = probnames(fun)} returns the names of the problem-dependent (fixed) parameters of the \texttt{cfit}, \texttt{sfit}, or \texttt{fittype} object \texttt{fun} as a cell array of strings.

Examples
\begin{verbatim}
f = fittype('\( (x-a)^n + b \)', 'problem', {'a', 'b'});
coeffnames(f)
ans =
    'n'
probnames(f)
ans =
    'a'
    'b'

t = load census

c = fit(cdate,pop,f,'problem',{cdate(1),pop(1)},
    'StartPoint',2);
coeffvalues(c)
ans =
    0.9877
probvalues(c)
ans =
1.0e+003 *
    1.7900  0.0039
\end{verbatim}

See Also
\texttt{fittype} \mid \texttt{coeffnames} \mid \texttt{probvalues}
**Purpose**  
Problem-dependent parameter values of `cfit` or `sfit` object

**Syntax**  
`pvals = probvalues(fun)`

**Description**  
pvals = probvalues(fun) returns the values of the problem-dependent (fixed) parameters of the cfit object fun as a row vector.

**Examples**  
f = fittype('(x-a)^n + b','problem',{'a','b'});  
coeffnames(f)  
ans =  
     'n'  
probnames(f)  
ans =  
     'a'  
     'b'

load census  
c = fit(cdate,pop,f,'problem',{cdate(1),pop(1)},...  
     'StartPoint',2);  
coeffvalues(c)  
ans =  
     0.9877  
probvalues(c)  
ans =  
 1.0e+003 *  
     1.7900  0.0039

**See Also**  
fit | fittype | probnames
Purpose

Numerically integrate sfit object

Syntax

\[ Q = \text{quad2d}(F0, a, b, c, d) \]
\[ [Q, \text{ERRBND}] = \text{quad2d}(...) \]
\[ [Q, \text{ERRBND}] = \text{QUAD2D}(F0,a,b,c,d,\text{PARAM1},\text{VAL1},\text{PARAM2},\text{VAL2},...) \]

Description

\[ Q = \text{quad2d}(F0, a, b, c, d) \] approximates the integral of the surface fit object F0 over the planar region \( a \leq x \leq b \) and \( c(x) \leq y \leq d(x) \). The bounds c and d can each be a scalar, a function handle, or a curve fit (cfit) object.

\[ [Q, \text{ERRBND}] = \text{quad2d}(...) \] also returns an approximate upper bound on the absolute error, ERRBND.

\[ [Q, \text{ERRBND}] = \text{QUAD2D}(F0,a,b,c,d,\text{PARAM1},\text{VAL1},\text{PARAM2},\text{VAL2},...) \]
performs the integration with specified values of optional parameters.

See the MATLAB function quad2d for details of the upper bound and the optional parameters.

See Also

quad2d | fit | sfit | cfit
**Purpose**

Put together rational spline

**Syntax**

rp = rpmak(breaks, coefs)

rp = rpmak(breaks, coefs, d)

rpmak(breaks, coefs, sizec)

rs = rsmak(knots, coefs)

rs = rsmak(shape, parameters)

**Description**

Both `rpmak` and `rsmak` put together a rational spline from minimal information. `rsmak` is also equipped to provide rational splines that describe standard geometric shapes. A rational spline must be scalar-or vector-valued.

`rp = rpmak(breaks, coefs)` has the same effect as the command `ppmak(breaks, coefs)` except that the resulting ppform is tagged as a rational spline, i.e., as a rpform.

To describe what this means, let $R$ be the piecewise-polynomial put together by the command `ppmak(breaks, coefs)`, and let $r(x) = s(x)/w(x)$ be the rational spline put together by the command `rpmak(breaks, coefs)`. If $v$ is the value of $R$ at $x$, then $v(1:end-1)/v(end)$ is the value of $r$ at $x$. In other words, $R(x) = [s(x); w(x)]$. Correspondingly, the dimension of the target of $r$ is one less than the dimension of the target of $R$. In particular, the dimension (of the target) of $R$ must be at least 2, i.e., the coefficients specified by `coefs` must be $d$-vectors with $d > 1$. See `ppmak` for how the input arrays `breaks` and `coefs` are being interpreted, hence how they are to be specified in order to produce a particular piecewise-polynomial.

`rp = rpmak(breaks, coefs, d)` has the same effect as `ppmak(breaks, coefs, d+1)`, except that the resulting ppform is tagged as being a rpform. Note that the desire to have that optional third argument specify the dimension of the target requires different values for it in `rpmak` and `ppmak` for the same coefficient array `coefs`.

`rpmak(breaks, coefs, sizec)` has the same effect as `ppmak(breaks, coefs, sizec)` except that the resulting ppform is tagged as being a rpform, and the target dimension is taken to be `sizec(1)-1`. 

12-186
\( rs = \text{rsmak}(\text{knots}, \text{coefs}) \) is similarly related to \( \text{spmak}(\text{knots}, \text{coefs}) \), and \( \text{rsmak}(\text{knots}, \text{coefs}, \text{sizec}) \) to \( \text{spmak}(\text{knots}, \text{coefs}, \text{sizec}) \). In particular, \( \text{rsmak}(\text{knots}, \text{coefs}) \) puts together a rational spline in B-form, i.e., it provides a \( \text{rBform} \). See \( \text{spmak} \) for how the input arrays \( \text{knots} \) and \( \text{coefs} \) are being interpreted, hence how they are to be specified in order to produce a particular piecewise-polynomial.

\( rs = \text{rsmak}(\text{shape}, \text{parameters}) \) provides a rational spline in \( \text{rBform} \) that describes the shape being specified by the string \( \text{shape} \) and the optional additional \( \text{parameters} \). Specific choices are:

\[
\begin{align*}
\text{rsmak('arc',radius,center,[alpha,beta])} \\
\text{rsmak('circle',radius,center)} \\
\text{rsmak('cone',radius,\text{halfheight})} \\
\text{rsmak('cylinder',radius,\text{height})} \\
\text{rsmak('southcap',radius,center)} \\
\text{rsmak('torus',radius,ratio)}
\end{align*}
\]

with 1 the default value for \( \text{radius} \), \( \text{halfheight} \) and \( \text{height} \), and the origin the default for \( \text{center} \), and the arc running through all the angles from \( \text{alpha} \) to \( \text{beta} \) (default is \([-\pi/2,\pi/2]\)), and the cone, cylinder, and torus centered at the origin with their major circle in the \((x,y)\)-plane, and the minor circle of the torus having radius \( \text{radius} \times \text{ratio} \), the default for \( \text{ratio} \) being \( 1/3 \).

From these, one may generate related shapes by affine transformations, with the help of \( \text{fncmb}(rs,\text{transformation}) \).

All \( \text{fn...} \) commands except \( \text{fnint}, \text{fnder}, \text{fndir} \) can handle rational splines.

**Examples**

The commands

\[
\begin{align*}
\text{runges} & = \text{rsmak}([-5 -5 -5 5 5 5],[1 1 1; 26 -24 26]); \\
\text{run gep} & = \text{rpmak}([-5 5],[0 0 1; 1 -10 26],1);
\end{align*}
\]

both provide a description of the rational polynomial \( r(x) = 1/(x^2 + 1) \) on the interval \([-5 .. 5]\). However, outside the interval \([-5 .. 5]\), the function
given by Runge is zero, while the rational spline given by RungeP agrees with \(1/(x^2 + 1)\) for every \(x\).

The figure of a rotated cone is generated by the commands

```matlab
given by \texttt{rpmak} given by \texttt{rungep} agrees with \(1/(x^2 + 1)\) for every \(x\).

The figure of a rotated cone is generated by the commands

```matlab
fnplt(fncmb(rsmak('cone',1,2),[0 0 -1;0 1 0;1 0 0]))
axis equal, axis off, shading interp

![A Rotated Cone](image)

\textbf{A Rotated Cone Given by a Rational Quadratic Spline}

A Helix on page 12-189, showing a helix with several windings, is generated by the commands

```matlab
arc = rsmak('arc',2,[1;-1],[0 7.3*pi]);
[knots,c] = fnbrk(arc,'k','c');
helix = rsmak(knots, [c(1:2,:);aveknt(knots,3).*c(3,:); c(3,:)]);
fnplt(helix)
```
A Helix

For further illustrated examples, see “NURBS and Other Rational Splines” on page 10-30

See Also

rsmak | fnbrk | ppmak | spmak
Purpose

Piecewise biarc Hermite interpolation

Syntax

\[
c = \text{rscvn}(p, u) \\
c = \text{rscvn}(p)
\]

Description

\[
c = \text{rscvn}(p, u) \text{ returns a planar piecewise biarc curve (in quadratic } \\
rB\text{form) that passes, in order, through the given points } p(:, j) \text{ and} \\
is constructed in the following way (see Construction of a Biarc on} \\
page \text{12-192). Between any two distinct points } p(:, j) \text{ and } p(:, j+1), \\
the curve usually consists of two circular arcs (including straight-line} \\
segments) which join with tangent continuity, with the first arc starting} \\
at p(:, j) \text{ and normal there to } u(:, j), \text{ and the second arc ending at} \\
p(:, j+1) \text{ and normal there to } u(:, j+1), \text{ and with the two arcs written} \\
as one whenever that is possible. Thus the curve is tangent-continuous} \\
everywhere except, perhaps, at repeated points, where the curve may} \\
have a corner, or when the angle, formed by the two segments ending} \\
at p(:, j), \text{ is unusually small, in which case the curve may have a} \\
cusp at that point. \\
\]

\[p \text{ must be a real matrix, with two rows, and at least two columns,} \\
\text{and any column must be different from at least one of its neighboring} \\
columns. \\
\]

\[u \text{ must be a real matrix with two rows, with the same number of columns} \\
as } p \text{ (for two exceptions, see below), and can have no zero column.} \\
\]

\[c = \text{rscvn}(p) \text{ chooses the normals in the following way. For } j=2: \text{end}-1, \\
u(:, j) \text{ is the average of the (normalized, right-turning) normals to the} \\
vectors } p(:, j) - p(:, j-1) \text{ and } p(:, j+1) - p(:, j). \text{ If } p(:, 1) == p(:, \text{end}), \\
then both end normals are chosen as the average of the normals to} \\
p(:, 2) - p(:, 1) \text{ and } p(:, \text{end}) - p(:, \text{end}-1), \text{ thus preventing a corner in} \\
the resulting closed curve. Otherwise, the end normals are so chosen} \\
that there is only one arc over the first and last segment (not-a-knot} \\
encondition). \\
\]

\[\text{rscvn}(p, u), \text{ with } u \text{ having exactly two columns, also chooses the} \\
interior normals as for the case when } u \text{ is absent but uses the two} \\
columns of } u \text{ as the end-point normals.} \]
Examples

Example 1. The following code generates a description of a circle, using just four pieces. Except for a different scaling of the knot sequence, it is the same description as is supplied by \texttt{rsmak('circle',1,[1;1])}.

\begin{verbatim}
p = [1 0 -1 0 1; 0 1 0 -1 0]; c = rscvn([p(1,:)+1;p(2,:)+1],p);
\end{verbatim}

The same circle, but using just two pieces, is provided by

\begin{verbatim}
c2 = rscvn([0,2,0; 1,1,1]);
\end{verbatim}

Example 2. The following code plots two letters. Note that the second letter is the result of interpolation to just four points. Note also the use of translation in the plotting of the second letter.

\begin{verbatim}
p = [-1 .8 -1 1 -1 -1 -1; 3 1.75 .5 -1.25 -3 -3 3];
i = eye(2); u = i(:,[2 1 2 1 2 1 1]); B = rscvn(p,u);
S = rscvn([1 -1 1 -1; 2.5 2.5 -2.5 -2.5]);
fnplt(B), hold on, fnplt(fncmb(S,[3;0])), hold off
axis equal, axis off
\end{verbatim}

Two Letters Composed of Circular Arcs

Example 3. The following code generates the Construction of a Biarc on page 12-192, of use in the discussion below of the biarc construction.
used here. Note the use of \texttt{fntlr} to find the tangent to the biarc at the
beginning, at the point where the two arcs join, and at the end.

\begin{verbatim}
p = [0 1;0 0]; u = [.5 -.1;-.25 .5]; plot(p(1,:),p(2,:),'k'), hold on
biarc = rscvn(p,u); breaks = fnbrk(biarc,'b');
fnplt(biarc,breaks(1:2),'b',3), fnplt(biarc,breaks(2:3),'r',3)
v = fntlr(biarc,2,breaks);
quiver(vd(1,:),vd(2,:),vd(4,:),-vd(3,:)), hold off
\end{verbatim}

\begin{center}
\includegraphics[width=\textwidth]{biarc.png}
\end{center}

\section*{Construction of a Biarc}

\subsection*{Algorithms}

Given two distinct points, \(p_1\) and \(p_2\), in the plane and, correspondingly,
two nonzero vectors, \(u_1\) and \(u_2\), there is a one-parameter family of
biarcs (i.e., a curve consisting of two arcs with common tangent at their
join) starting at \(p_1\) and normal there to \(u_1\) and ending at \(p_2\) and normal
there to \(u_2\). One way to parametrize this family of biarcs is by the
normal direction, \(v\), at the point \(q\) at which the two arcs join. With a
nonzero \(v\) chosen, there is then exactly one choice of \(q\), hence the entire
biarc is then determined. In the construction used in rscvn, \( v \) is chosen as the reflection, across the perpendicular to the segment from \( p_1 \) to \( p_2 \), of the average of the vectors \( u_1 \) and \( u_2 \), -- after both vectors have been so normalized that their length is 1 and that they both point to the right of the segment from \( p_1 \) to \( p_2 \). This choice for \( v \) seems natural in the two standard cases: (i) \( u_2 \) is the reflection of \( u_1 \) across the perpendicular to the segment from \( p_1 \) to \( p_2 \); (ii) \( u_1 \) and \( u_2 \) are parallel. This choice of \( v \) is validated by Biarcs as a Function of the Left Normal on page 12-193 which shows the resulting biarcs when \( p_1 \), \( p_2 \), and \( u_2 = [ .809; .588 ] \) are kept fixed and only the normal at \( p_1 \) is allowed to vary.

**Biarcs as a Function of the Left Normal**

But it is impossible to have the interpolating biarc depend continuously at all four data, \( p_1 \), \( p_2 \), \( u_1 \), \( u_2 \). There has to be a discontinuity as the normal directions, \( u_1 \) and \( u_2 \), pass through the direction from \( p_1 \) to \( p_2 \). This is illustrated in Biarcs as a Function of One Endpoint on page 12-194 which shows the biarcs when one point, \( p_1 = [0;0] \), and the
two normals, $u_1 = [1; 1]$ and $u_2 = [1; -1]$, are held fixed and only the other point, $p_2$, moves, on a circle around $p_1$.

**Biarcs as a Function of One Endpoint**

**See Also**

rsmak | cscvn
Purpose
Put together rational spline for standard geometric shapes

Syntax
rs = rsmak(shape,parameters)

Description
rs = rsmak(shape,parameters) provides a rational spline in rBform that
describes the shape being specified by the string shape and the optional
additional parameters. Specific choices for shape are:

rsmak('arc',radius,center,[alpha,beta])
rsmak('circle',radius,center)
rsmak('cone',radius,halfheight)
rsmak('cylinder',radius,height)
rsmak('southcap',radius,center)
rsmak('torus',radius,ratio)

with 1 the default value for radius, halfheight and height, and
the origin the default for center, and the arc running through all
the angles from alpha to beta (default is [-pi/2,pi/2]), and the
cone, cylinder, and torus centered at the origin with their major circle
in the (x,y)-plane, and the minor circle of the torus having radius
radius*ratio, the default for ratio being 1/3.

From these, one may generate related shapes by affine transformations,
with the help of fncmb(rs,transformation).

See Also
rpmak

See Also
rpmak
Purpose
Assign values in fit options structure

Syntax
set(options)
s = set(options)
set(options,fld1,val1,fld2,val2,...)
set(options,flds,vals)

Description
set(options) displays all property names of the fit options structure
options. If a property has a finite list of possible string values, these
values are also displayed.

s = set(options) returns a structure s with the same property names
as options. If a property has a finite list of possible string values, the
value of the property in s is a cell array containing the possible string
values. If a property does not have a finite list of possible string values,
the value of the property in s is an empty cell array.

set(options,fld1,val1,fld2,val2,...) sets the properties specified
by the strings fld1, fld2, ... to the values val1, val2, ..., respectively.

set(options,flds,vals) sets the properties specified by the cell array
of strings flds to the corresponding values in the cell array vals.

Examples
Create a custom nonlinear model, and create a default fit options
structure for the model:

f = fittype('a*x^2+b*exp(n*c*x)', 'problem', 'n');
options = fitoptions(f);

Set the Robust and Normalize properties of the fit options structure
using property name/value pairs:

set(options,'Robust','LAR','Normalize','On')

Set the Display, Lower, and Algorithm properties of the fit options
structure using cell arrays of property names/values:

set(opts,{'Disp','Low','Alg'},...
     {'Final',[0 0 0],'Levenberg'})
See Also

fitoptions | get
Purpose
Set model fit options

Syntax
FT = setoptions(FT, options)

Description
FT = setoptions(FT, options) sets the fit options of FT to options, where FT is a fitttype, cfit, or sfit object. The FT output argument must match the FT input argument.

See Also
fitoptions | fit | fittype
Purpose  Constructor for sfit object

Syntax  surfacefit = sfit(fittype,coeff1,coeff2,...)

Description  An sfit object encapsulates the result of fitting a surface to data. They are normally constructed by calling the fit function, or interactively by exporting a fit from the Curve Fitting Tool to the workspace. You can get and set coefficient properties of the sfit object.

You can treat an sfit object as a function to make predictions or evaluate the surface at values of X and Y.

Like the cfit class, sfit inherits all fittype methods.

surfacefit = sfit(fittype,coeff1,coeff2,...) constructs the sfit object surfacefit using the model type specified by the fittype object and the coefficient values coeff1, coeff2, etc.

Note  sfit is called by the fit function when fitting fittype objects to data. To create a sfit object that is the result of a regression, use fit.

You should only call sfit directly if you want to assign values to coefficients and problem parameters of a fittype object without performing a fit.

Methods of sfit objects:

- argnames  Input argument names of cfit, sfit, or fittype object
- category  Category of fit of cfit, sfit, or fittype object
- coeffnames  Coefficient names of cfit, sfit, or fittype object
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>coeffvalues</td>
<td>Coefficient values of cfit or sfit object</td>
</tr>
<tr>
<td>confint</td>
<td>Confidence intervals for fit coefficients of cfit or sfit object</td>
</tr>
<tr>
<td>dependnames</td>
<td>Dependent variable of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>differentiate</td>
<td>Differentiate cfit or sfit object</td>
</tr>
<tr>
<td>feval</td>
<td>Evaluate cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>formula</td>
<td>Formula of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>indepnames</td>
<td>Independent variable of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>islinear</td>
<td>Determine if cfit, sfit, or fittype object is linear</td>
</tr>
<tr>
<td>numargs</td>
<td>Number of input arguments of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>numcoeffs</td>
<td>Number of coefficients of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>plot</td>
<td>Plot cfit or sfit object</td>
</tr>
<tr>
<td>predint</td>
<td>Prediction intervals for cfit or sfit object</td>
</tr>
<tr>
<td>probnames</td>
<td>Problem-dependent parameter names of cfit, sfit, or fittype object</td>
</tr>
<tr>
<td>probvalues</td>
<td>Problem-dependent parameter values of cfit or sfit object</td>
</tr>
<tr>
<td>quad2d</td>
<td>Numerically integrate sfit object</td>
</tr>
<tr>
<td>setoptions</td>
<td>Set model fit options</td>
</tr>
</tbody>
</table>
**sfit**

Constructor for sfit object

**type**

Name of cfit, sfit, or fittype object

**Examples**

You can treat an sfit object as a function to make predictions or evaluate the surface at values of X and Y, e.g.,

```matlab
x = 3 - 6 * rand( 49, 1 );
y = 3 - 6 * rand( 49, 1 );
z = peaks( x, y );
sf = fit( [x, y], z, 'poly32' );
zhat = sf( mean( x ), mean( y ) )
```

**See Also**

fit | fittype | feval | cfit
**Purpose**

Open Curve Fitting Tool

**Syntax**

```sftool```
```
sftool(x,y,z)
sftool(x,y,z,w)
sftool(filename)
```

**Description**

**Note**  `sftool` will be removed in a future release. Use `cftool` instead.

`sftool` opens Curve Fitting Tool or brings focus to the tool if it is already open.

`sftool(x,y,z)` creates a fit to `x` and `y` inputs (or predictor data) and `z` output (or response data). `sftool` opens Curve Fitting Tool if necessary.

`x`, `y`, and `z` must be numeric, have two or more elements, and have compatible sizes. Sizes are compatible if either:

- `x`, `y`, and `z` all have the same number of elements, or
- `x` and `y` are vectors, `z` is a 2D matrix, where `length(x) = n`, `length(y) = m`, and `[m,n] = size(z).

`sftool(x,y,z,w)` creates a fit with weights `w`. `w` must be numeric and have the same number of elements as `z`.

`sftool(filename)` loads the surface fitting session in `filename` into Curve Fitting Tool. The `filename` should have the extension `.sfit`.

`Inf`s, `NaN`s, and imaginary parts of complex numbers are ignored in the data.

Curve Fitting Tool provides a flexible and intuitive graphical user interface where you can interactively fit curves and surfaces to data and view plots. You can:

- Create, plot, and compare multiple fits
- Use linear or nonlinear regression, interpolation, local smoothing regression, or custom equations
• View goodness-of-fit statistics, display confidence intervals and residuals, remove outliers and assess fits with validation data

• Automatically generate code for fitting and plotting surfaces, or export fits to workspace for further analysis

See Also
cftool

How To
• “Interactive Curve and Surface Fitting” on page 2-2
**Purpose**

Smooth response data

**Syntax**

- `yy = smooth(y)`
- `yy = smooth(y,span)`
- `yy = smooth(y,method)`
- `yy = smooth(y,span,method)`
- `yy = smooth(y,'sgolay',degree)`
- `yy = smooth(y,span,'sgolay',degree)`
- `yy = smooth(x,y,...)`

**Description**

`yy = smooth(y)` smooths the data in the column vector `y` using a moving average filter. Results are returned in the column vector `yy`. The default span for the moving average is 5.

The first few elements of `yy` are given by

\[
\begin{align*}
yy(1) &= y(1) \\
yy(2) &= \frac{(y(1) + y(2) + y(3))}{3} \\
yy(3) &= \frac{(y(1) + y(2) + y(3) + y(4) + y(5))}{5} \\
yy(4) &= \frac{(y(2) + y(3) + y(4) + y(5) + y(6))}{5} \\
&\quad \ldots
\end{align*}
\]

Because of the way endpoints are handled, the result differs from the result returned by the `filter` function.

`yy = smooth(y,span)` sets the span of the moving average to `span`. `span` must be odd.

`yy = smooth(y,method)` smooths the data in `y` using the method `method` and the default span. Supported values for `method` are listed in the table below.
<table>
<thead>
<tr>
<th>method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'moving'</td>
<td>Moving average (default). A lowpass filter with filter coefficients equal to the reciprocal of the span.</td>
</tr>
<tr>
<td>'lowess'</td>
<td>Local regression using weighted linear least squares and a 1st degree polynomial model</td>
</tr>
<tr>
<td>'loess'</td>
<td>Local regression using weighted linear least squares and a 2nd degree polynomial model</td>
</tr>
<tr>
<td>'sgolay'</td>
<td>Savitzky-Golay filter. A generalized moving average with filter coefficients determined by an unweighted linear least-squares regression and a polynomial model of specified degree (default is 2). The method can accept nonuniform predictor data.</td>
</tr>
<tr>
<td>'rlowess'</td>
<td>A robust version of 'lowess' that assigns lower weight to outliers in the regression. The method assigns zero weight to data outside six mean absolute deviations.</td>
</tr>
<tr>
<td>'rloess'</td>
<td>A robust version of 'loess' that assigns lower weight to outliers in the regression. The method assigns zero weight to data outside six mean absolute deviations.</td>
</tr>
</tbody>
</table>

\[
yy = \text{smooth}(y, \text{span}, \text{method})\] sets the span of \textit{method} to \textit{span}. For the \textit{loess} and \textit{lowess} methods, \textit{span} is a percentage of the total number of data points, less than or equal to 1. For the moving average and Savitzky-Golay methods, \textit{span} must be odd (an even \textit{span} is automatically reduced by 1).

\[
yy = \text{smooth}(y, 'sgolay', \text{degree})\] uses the Savitzky-Golay method with polynomial degree specified by \textit{degree}.

\[
yy = \text{smooth}(y, \text{span}, 'sgolay', \text{degree})\] uses the number of data points specified by \textit{span} in the Savitzky-Golay calculation. \textit{span} must be odd and \textit{degree} must be less than \textit{span}. 

12-205
yy = smooth(x,y,...) additionally specifies x data. If x is not provided, methods that require x data assume x = 1:length(y). You should specify x data when it is not uniformly spaced or sorted. If x is not uniform and you do not specify method, lowess is used. If the smoothing method requires x to be sorted, the sorting occurs automatically.

**Tips**

Another way to generate smoothed data is to fit it with a smoothing spline. Refer to the fit function for more information.

**Examples**

Load the data in count.dat:

```matlab
load count.dat
```

The 24-by-3 array count contains traffic counts at three intersections for each hour of the day.

First, use a moving average filter with a 5-hour span to smooth all of the data at once (by linear index):

```matlab
c = smooth(count(:));
C1 = reshape(c,24,3);
```

Plot the original data and the smoothed data:

```matlab
subplot(3,1,1)
plot(count,:);
hold on
plot(C1,-);
title('Smooth C1 (All Data)')
```

Second, use the same filter to smooth each column of the data separately:

```matlab
C2 = zeros(24,3);
for I = 1:3,
    C2(:,I) = smooth(count(:,I));
end
```
Again, plot the original data and the smoothed data:

```matlab
subplot(3,1,2)
plot(count,':');
hold on
plot(C2,'-');
title('Smooth C2 (Each Column)')
```

Plot the difference between the two smoothed data sets:

```matlab
subplot(3,1,3)
plot(C2 - C1,'o-')
title('Difference C2 - C1')
```

Note the additional end effects from the 3-column smooth.

**Examples**

Create noisy data with outliers:

```matlab
x = 15*rand(150,1);
y = sin(x) + 0.5*(rand(size(x))-0.5);
```
$$y(\text{ceil}(\text{length}(x) \cdot \text{rand}(2,1))) = 3;$$

Smooth the data using the loess and rloess methods with a span of 10%:

$$yy1 = \text{smooth}(x,y,0.1,\text{'loess'});$$
$$yy2 = \text{smooth}(x,y,0.1,\text{'rloess'});$$

Plot original data and the smoothed data.

$$[xx,\text{ind}] = \text{sort}(x);$$
$$\text{subplot(2,1,1)}$$
$$\text{plot(xx,y(\text{ind}),'b.',xx,yy1(\text{ind}),'r-')}$$
$$\text{set(gca,'YLim',[-1.5 3.5])}$$
$$\text{legend('Original Data','Smoothed Data Using '}'loess'''...}$$
$$\text{'Location','NW')}$$
$$\text{subplot(2,1,2)}$$
$$\text{plot(xx,y(\text{ind}),'b.',xx,yy2(\text{ind}),'r-')}$$
$$\text{set(gca,'YLim',[-1.5 3.5])}$$
$$\text{legend('Original Data','Smoothed Data Using '}'rloess'''...}$$
$$\text{'Location','NW')}$$
Note that the outliers have less influence on the robust method.

**See Also**  
fit | sort
Purpose
Solve almost block-diagonal linear system

Syntax
x = slvblk(blokmat,b)
x = slvblk(blockmat,b,w)

Description
x = slvblk(blokmat,b) returns the solution (if any) of the linear system Ax = b, with the matrix A stored in blokmat in the spline almost block-diagonal form. At present, only the command spcol provides such a description, of the matrix whose typical entry is the value of some derivative (including the 0th derivative, i.e., the value) of a B-spline at some site. If the linear system is overdetermined (i.e., has more equations than unknowns but is of full rank), then the least-squares solution is returned.

The right side b may contain several columns, and is expected to contain as many rows as there are rows in the matrix described by blokmat.

x = slvblk(blockmat,b,w) returns the vector x that minimizes the weighted sum $\sum_j w(j)(Ax - b(j))^2$.

Examples
sp=spmak(knots,slvblk(spcol(knots,k,x,1),y.')) provides in sp the B-form of the spline s of order k with knot sequence knots that matches the given data (x,y), i.e., for which s(x) equals y.

Algorithms
The command bkbrk is used to obtain the essential parts of the coefficient matrix described by blokmat (in one of two available forms). A QR factorization is made of each diagonal block, after it was augmented by the equations not dealt with when factoring the preceding block. The resulting factorization is then used to solve the linear system by backsubstitution.

See Also
bkbrk | spap2 | spapi | spcol
**Purpose**
Locate sites with respect to mesh sites

**Syntax**
pointer = sorted(meshsites, sites)

**Description**
Various commands in this toolbox need to determine the index \( j \) for which a given \( x \) lies in the interval \([t_j, t_{j+1}]\), with \((t_i)\) a given nondecreasing sequence, e.g., a knot sequence. This job is done by `sorted` in the following fashion.

`pointer = sorted(meshsites, sites)` is the integer row vector whose \( j \)-th entry equals the number of entries in `meshsites` that are \( \leq \) `sites(j)`, with `ssites` the vector `sort(sites)`. Thus, if both `meshsites` and `sites` are nondecreasing, then

\[ meshsites(pointer(j)) \quad sites(j) < meshsites(pointer(j)+1) \]

with the obvious interpretations when

\[ pointer(j) < 1 \quad \text{or} \quad \text{length(meshsites)} < pointer(j) + 1 \]

Specifically, having `pointer(j) < 1` then corresponds to having `sites(j)` strictly to the left of `meshsites(1)`, while having `length(meshsites) < pointer(j)+1` then corresponds to having `sites(j)` at, or to the right of, `meshsites(end)`.

**Examples**
The statement

`sorted([1 1 1 2 2 3 3 3],[0:4])`

will generate the output `0 3 5 8 8`, as will the statement

`sorted([3 2 1 1 3 2 3 1],[2 3 0 4 1])`

**Algorithms**
The indexing output from `sort([meshsites(:),' ,sites(:)'])` is used.
**Purpose**  
Least-squares spline approximation

**Syntax**  

- \( \text{spap2}(\text{knots}, k, x, y) \)
- \( \text{spap2}(1, k, x, y) \)
- \( \text{sp} = \text{spap2}(\ldots, x, y, w) \)
- \( \text{spap2}([\text{knor1, \ldots, knor1m}], k, \{x1, \ldots, xm\}, y) \)
- \( \text{spap2}([\text{knor1, \ldots, knor1m}], k, \{x1, \ldots, xm\}, y, w) \)

**Description**  
\( \text{spap2}(\text{knots}, k, x, y) \) returns the B-form of the spline \( f \) of order \( k \) with the given knot sequence \( \text{knots} \) for which

\[
y(:, j) = f(x(j)), \text{ all } j
\]

in the weighted mean-square sense, meaning that the sum

\[
\sum_j w(j) |y(:, j) - f(x(j))|^2
\]

is minimized, with default weights equal to 1. The data values \( y(:, j) \) may be scalars, vectors, matrices, even ND-arrays, and \( |z|^2 \) stands for the sum of the squares of all the entries of \( z \). Data points with the same site are replaced by their average.

If the sites \( x \) satisfy the (Schoenberg-Whitney) conditions

\[
\text{knots}(j) < x(j) < \text{knots}(j + k)
\]

\[
(*) \quad j = 1, \ldots, \text{length}(x) = \text{length(}\text{knots}) - k
\]

then there is a unique spline (of the given order and knot sequence) satisfying (*) exactly. No spline is returned unless (**) is satisfied for some subsequence of \( x \).

\( \text{spap2}(1, k, x, y) \), with 1 a positive integer, returns the B-form of a least-squares spline approximant, but with the knot sequence chosen for you. The knot sequence is obtained by applying \( \text{aprknt} \) to an appropriate subsequence of \( x \). The resulting piecewise-polynomial consists of 1 polynomial pieces and has \( k-2 \) continuous derivatives.
If you feel that a different distribution of the interior knots might do a better job, follow this up with

```matlab
sp1 = spap2(newknt(sp),k,x,y));
```

```matlab
sp = spap2(...,x,y,w)
```

lets you specify the weights `<code>w</code>` in the error measure (given above). `<code>w</code>` must be a vector of the same size as `<code>x</code>`, with nonnegative entries. All the weights corresponding to data points with the same site are summed when those data points are replaced by their average.

```matlab
spap2({knorl1,...,knorlm},k,{x1,...,xm},y)
```

provides a least-squares spline approximation to gridded data. Here, each `<code>knorli</code>` is either a knot sequence or a positive integer. Further, `<code>k</code>` must be an `<code>m</code>`-vector, and `<code>y</code>` must be an `<code>(r+m)</code>`-dimensional array, with `<code>y(:,i1,...,im)</code>` the datum to be fitted at the site `[x{1}(i1),...,x{m}(im)]`, all `<code>i1</code>`, ... `<code>im</code>`. However, if the spline is to be scalar-valued, then, in contrast to the univariate case, `<code>y</code>` is permitted to be an `<code>m</code>`-dimensional array, in which case `<code>y(i1,...,im)</code>` is the datum to be fitted at the site `[x{1}(i1),...,x{m}(im)]`, all `<code>i1</code>`, ... `<code>im</code>`.

```matlab
spap2({knorl1,...,knorlm},k,{x1,...,xm},y,w)
```

also lets you specify the weights. In this `<code>m</code>`-variate case, `<code>w</code>` must be a cell array with `<code>m</code>` entries, with `<code>w{i}</code>` a nonnegative vector of the same size as `<code>xi</code>`, or else `<code>w{i}</code>` must be empty, in which case the default weights are used in the `<code>i</code>`th variable.

### Examples

```matlab
sp = spap2(augknt([a,xi,b],4),4,x,y)
```

is the least-squares approximant to the data `<code>x</code>`, `<code>y</code>`, by cubic splines with two continuous derivatives, basic interval `[a..b]`, and interior breaks `<code>xi</code>`, provided `<code>xi</code>` has all its entries in `(a..b)` and the conditions (**)) are satisfied in some fashion. In that case, the approximant consists of `length(xi)+1` polynomial pieces. If you do not want to worry about the conditions (**)) but merely want to get a cubic spline approximant consisting of `<code>l</code>` polynomial pieces, use instead

```matlab
sp = spap2(l,4,x,y);
```
If the resulting approximation is not satisfactory, try using a larger
1. Else use

\[
sp = \text{spap2}(\text{newknt}(sp), 4, x, y);
\]

for a possibly better distribution of the knot sequence. In fact, if that
helps, repeating it may help even more.

As another example, \text{spap2}(1, 2, x, y); provides the least-squares
straight-line fit to data \(x, y\), while

\[
w = \text{ones(size}(x)); w([1 \text{ end}]) = 100; \text{spap2}(1, 2, x, y, w);
\]

forces that fit to come very close to the first data point and to the last.

**Algorithms**

\text{spcol} is called on to provide the almost block-diagonal collocation
matrix \((B_j^i k(x_j))\), and \text{s1vblk} solves the linear system (*) in the
(weighted) least-squares sense, using a block QR factorization.

Gridd data are fitted, in tensor-product fashion, one variable at
a time, taking advantage of the fact that a univariate weighted
least-squares fit depends linearly on the values being fitted.

**See Also**

\text{slvblk} | \text{spapi} | \text{spcol}
**Purpose**  
Spline interpolation

**Syntax**

```plaintext
spline = spapi(knots,x,y)
sapi(k,x,y)
sapi({knork1,...,knorkm},{x1,...,xm},y)
sapi(...,'noderiv')
```

**Description**

`spline = spapi(knots,x,y)` returns the spline \( f \) (if any) of order

\[ k = \text{length}(\text{knots}) - \text{length}(x) \]

with knot sequence `knots` for which

\[ (*) \quad f(x(j)) = y(:,j), \text{ all j}. \]

If some of the entries of `x` are the same, then this is taken in the osculatory sense, i.e., in the sense that \( D^m f(x(j)) = y(:,j) \), with \( m(j) : = \#\{ i < j : x(i) = x(j) \} \), and \( D^m f \) the \( m \)th derivative of \( f \). Thus \( r \)-fold repetition of a site \( z \) in \( x \) corresponds to the prescribing of value and the first \( r - 1 \) derivatives of \( f \) at \( z \). If you don’t want this, call `spapi` with an additional (fourth) argument, in which case, at each data site, the average of all data values with the same data site is matched.

The data values, \( y(:,j) \), may be scalars, vectors, matrices, or even ND-arrays.

`spapi(k,x,y)` , with `k` a positive integer, merely specifies the desired spline order, `k`, in which case `aptknt` is used to determine a workable (though not necessarily optimal) knot sequence for the given sites `x`. In other words, the command `spapi(k,x,y)` has the same effect as the more explicit command `spapi(aptknt(x,k),x,y)`.

`spapi({knork1,...,knorkm},{x1,...,xm},y)` returns the B-form of a tensor-product spline interpolant to gridded data. Here, each `knorki` is either a knot sequence, or else is a positive integer specifying the polynomial order to be used in the `i`th variable, thus leaving it to `spapi` to provide a corresponding knot sequence for the `i`th variable. Further, \( y \) must be an \((r+m)\)-dimensional array, with \( y(:,i1,...,im) \) the datum to be fitted at the site \( [x{1}(i1),...,x{m}(im)] \), all \( i1, ..., im \),
unless the spline is to be scalar-valued, in which case, in contrast to the univariate case, \( y \) is permitted to be an \( m \)-dimensional array.

\texttt{spapi(...,'noderiv')} with the string 'noderiv' as a fourth argument, has the same effect as \texttt{spapi(...)} except that data values sharing the same site are interpreted differently. With the fourth argument present, the average of the data values with the same data site is interpolated at such a site. Without it, data values with the same data site are interpreted as values of successive derivatives to be matched at such a site, as described above, in the first paragraph of this Description.

\textbf{Examples}

\texttt{spapi([0 0 0 0 1 2 2 2],[0 1 1 1 2],[2 0 1 2 -1])} produces the unique cubic spline \( f \) on the interval [0..2] with exactly one interior knot, at 1, that satisfies the five conditions

\[ f(0+) = 2, \quad f(1) = 0, \quad Df(1) = 1, \quad D^2f(1) = 2, \quad f(2–) = -1 \]

These include 3-fold matching at 1, i.e., matching there to prescribed values of the function and its first two derivatives.

Here is an example of osculatory interpolation, to values \( y \) and slopes \( s \) at the sites \( x \) by a quintic spline:

\texttt{sp = spapi(augknt(x,6,2),[x,x,min(x),max(x)],[y,s,ddy0,ddy1]);}

with \( ddy0 \) and \( ddy1 \) values for the second derivative at the endpoints.

As a related example, if the function \( \sin(x) \) is to be interpolated at the distinct data sites \( x \) by a cubic spline, and its slope is also to be matched at a subsequence \( x(s) \), then this can be accomplished by the command

\texttt{sp = spapi(4,[x x(s)],[\sin(x) \cos(x(s))]);}

in which a suitable knot sequence is supplied with the aid of \texttt{aptknt}.

In fact, if you wanted to interpolate the same data by quintic splines, simply change the 4 to 6.

As a bivariate example, here is a bivariate interpolant.
x = -2:.5:2; y = -1:.25:1; [xx, yy] = ndgrid(x, y);
z = exp(-(xx.^2+yy.^2));
sp = spapi([3,4],[x,y],z); fnplt(sp)

As an illustration of osculatory interpolation to gridded data, here is complete bicubic interpolation, with the data explicitly derived from the bicubic polynomial \( g(u,v) = u^3v^3 \), to make it easy for you to see exactly where the slopes and slopes of slopes (i.e., cross derivatives) must be placed in the data values supplied. Since our \( g \) is a bicubic polynomial, its interpolant, \( f \), must be \( g \) itself. We test this.

sites = {[0,1],[0,2]}; coefs = zeros(4,4); coefs(1,1) = 1;
g = ppmak(sites,coefs);
Dxg = fnval(fnder(g,[1,0]),sites);
Dyg = fnval(fnder(g,[0,1]),sites);
Dxyg = fnval(fnder(g,[1,1]),sites);
f = spapi([4,4], {sites{1}([1,2,1,2]),sites{2}([1,2,1,2])}, ...
   [fnval(g,sites), Dyg; ...
   Dxg.' , Dxyg]);
if any( squeeze( fnbrk(fn2fm(f,'pp'), 'c') ) - coefs )
   'something went wrong', end

### Algorithms
spcol is called on to provide the almost-block-diagonal collocation matrix \( (B_{jk}(x)) \) (with repeats in \( x \) denoting derivatives, as described above), and slvblk solves the linear system (*), using a block QR factorization.

Gridded data are fitted, in tensor-product fashion, one variable at a time, taking advantage of the fact that a univariate spline fit depends linearly on the values being fitted.

### Limitations
The given (univariate) knots and sites must satisfy the Schoenberg-Whitney conditions for the interpolant to be defined. Assuming the site sequence \( x \) to be nondecreasing, this means that we must have

\[
\text{knots}(j) < x(j) < \text{knots}(j+k), \text{ all } j
\]
(with equality possible at knots(1) and knots(end)). In the multivariate case, these conditions must hold in each variable separately.

**See Also**

csapi | spap2 | spaps | spline
**Purpose**

Smoothing spline

**Syntax**

```
sp = spaps(x,y,tol)
[sp,values] = spaps(x,y,tol)
[sp,values,rho] = spaps(x,y,tol)
[...] = spaps(x,y,tol,arg1,arg2,...)
[...] = spaps({x1,...,xr},y,tol,...)
```

**Description**

```
sp = spaps(x,y,tol) returns the B-form of the smoothest function f
that lies within the given tolerance tol of the given data points (x(j),
y(:,j)), j=1:length(x). The data values y(:,j) may be scalars,
vectors, matrices, even ND-arrays. Data points with the same data site
are replaced by their weighted average, with its weight the sum of the
 corresponding weights, and the tolerance tol is reduced accordingly.

[sp,values] = spaps(x,y,tol) also returns the smoothed values,
i.e., values is the same as fnval(sp,x).
```

Here, the distance of the function f from the given data is measured by

```
E(f) = \sum_{j=1}^{n} w(j) |(y(:,j) - f(x(j)))|^2
```

with the default choice for the weights w making \( E(f) \) the composite

trapezoidal rule approximation to \( \int_{\min(x)}^{\max(x)} |y - f|^2 \), and \( |z|^2 \) denoting

the sum of squares of the entries of z.

Further, smoothest means that the following roughness measure is

minimized:

```
F(D^m f) = \int_{\min(x)}^{\max(x)} \lambda(t)|D^m f(t)|^2 dt
```
where $D^mf$ denotes the $m$th derivative of $f$. The default value for $m$ is 2, the default value for the roughness measure weight $\lambda$ is the constant 1, and this makes $f$ a cubic smoothing spline.

When `tol` is nonnegative, then the spline $f$ is determined as the unique minimizer of the expression $\rho E(f) + F(D^mf)$, with the smoothing parameter $\rho$ (optionally returned) so chosen that $E(f)$ equals `tol`. Hence, when $m$ is 2, then, after conversion to ppform, the result should be the same (up to roundoff) as obtained by `csaps(x,y,\rho/(\rho + 1))`. Further, when `tol` is zero, then the “natural” or variational spline interpolant of order $2m$ is returned. For large enough `tol`, the least-squares approximation to the data by polynomials of degree $<m$ is returned.

When `tol` is negative, then $\rho$ is taken to be $-\text{tol}$.

The default value for the weight function $\lambda$ in the roughness measure is the constant function 1. But you may choose it to be, more generally, a piecewise constant function, with breaks only at the data sites. Assuming the vector `x` to be strictly increasing, you specify such a piecewise constant $\lambda$ by inputting `tol` as a vector of the same size as `x`. In that case, `tol(i)` is taken as the constant value of $\lambda$ on the interval $(x(i-1) .. x(i))$, i=2:length(`x`), while `tol(1)` continues to be used as the specified tolerance.

`[sp,values,rho] = spaps(x,y,tol)` also returns the actual value of $\rho$ used as the third output argument.

`[...] = spaps(x,y,tol,arg1,arg2,...)` lets you specify the weight vector `w` and/or the integer $m$, by supplying them as an `argi`. For this, `w` must be a nonnegative vector of the same size as `x`; $m$ must be 1 (for a piecewise linear smoothing spline), or 2 (for the default cubic smoothing spline), or 3 (for a quintic smoothing spline).

If the resulting smoothing spline, `sp`, is to be evaluated outside its basic interval, it should be replaced by `fnxtr(sp,m)` to ensure that its $m$-th derivative is zero outside that interval.

`[...] = spaps({x1,...,xr},y,tol,...)` returns the B-form of an $r$-variate tensor-product smoothing spline that is roughly within the specified tolerance to the given `gridded`
data. (For scattered data, use tpaps.) Now y is expected to
supply the corresponding gridded values, with size(y) equal to
[length(x1),...,length(xr)] in case the function is scalar-valued,
and equal to [d,length(x1),...,length(xr)] in case the function
is d-valued. Further, tol must be a cell array with r entries, with
tol{i} the tolerance used during the i-th step when a univariate
(but vector-valued) smoothing spline in the i-th variable is being
constructed. The optional input for m must be an r-vector (with entries
from the set {1,2,3}), and the optional input for w must be a cell array
of length r, with w{i} either empty (to indicate that the default choice
is wanted) or else a positive vector of the same length as xi.

Examples

The statements

\[
\begin{align*}
  w &= \text{ones(size(x))}; \quad w([1 \text{ end}]) = 100; \\
  sp &= \text{spaps}(x,y, 1.e-2, w, 3);
\end{align*}
\]

give a quintic smoothing spline approximation to the given data that
close to interpolates the first and last datum, while being within about
1.e-2 of the rest.

\[
\begin{align*}
  x &= -2:.2:2; \quad y = -1:.25:1; \quad [xx,yy] = \text{ndgrid}(x,y); \quad \text{rand('seed',39)}; \\
  z &= \exp(-(xx.^2+yy.^2)) + (\text{rand(size(xx))}-.5)/30; \\
  sp &= \text{spaps}([x,y],z,8/(60^2)); \quad \text{fnplt}(sp), \quad \text{axis off}
\end{align*}
\]

produces the figure below, showing a smooth approximant to noisy data
from a smooth bivariate function. Note the use of ndgrid here; use of
meshgrid would have led to an error.
Reinsch’s approach is used (including his clever way of choosing the equation for the optimal smoothing parameter in such a way that a good initial guess is available and Newton’s method is guaranteed to converge and to converge fast).

References

See Also
csaps | spap2 | spapi | tpaps
Purpose

B-spline collocation matrix

Syntax

colmat = spcol(knots,k,tau)
colmat = spcol(knots,k,tau,arg1,arg2,...)

Description

colmat = spcol(knots,k,tau) returns the matrix, with length(tau) rows and length(knots) - k columns, whose (i,j)th entry is

\[ D^m(i)B_j(tau(i)) \]

This is the value at tau(i) of the m(i)th derivative of the jth B-spline of order k for the knot sequence knots. Here, tau is a sequence of sites, assumed to be nondecreasing, and m = knt2mlt(tau), i.e., m(i) is #\{j < i:tau(j) = tau(i)\}, all i.

colmat = spcol(knots,k,tau,arg1,arg2,...) also returns that matrix, but gives you the opportunity to specify some aspects.

If one of the argi is a string with the same first two letters as in 'slvblk', the matrix is returned in the almost block-diagonal format (specialized for splines) required by slvblk (and understood by bkbrk).

If one of the argi is a string with the same first two letters as in 'sparse', then the matrix is returned in the sparse format of MATLAB.

If one of the argi is a string with the same first two letters as in 'noderiv', multiplicities are ignored, i.e., m(i) is taken to be 1 for all i.

Examples

To solve approximately the non-standard second-order ODE

\[ D^2y(t) = 5 \cdot (y(t) - \sin(2t)) \]

on the interval [0..π], using cubic splines with 10 polynomial pieces, you can use spcol in the following way:

tau = linspace(0,pi,101); k = 4;
knots = augknt(linspace(0,pi,11),k);
colmat = spcol(knots,k,brk2knt(tau,3));
spcol

```
coefs = (colmat(3:3:end,:)/5-colmat(1:3:end,:))\(-sin(2*tau).');
sp = spmak(knots,coefs..');

You can check how well this spline satisfies the ODE by computing and
plotting the residual, \(D^2y(t) - 5 \cdot (y(t) - \sin(2t))\), on a fine mesh:

t = linspace(0,pi,501);
yt = fnval(sp,t);
D2yt = fnval(fnder(sp,2),t);
plot(t,D2yt - 5*(yt-sin(2*t)));
title(['residual error; to be compared to max(abs(D^2y)) = ',
       num2str(max(abs(D2yt)))])
```

The statement `spcol([1:6],3,.1+[2:4])` provides the matrix

```
ans =
             0.5900   0.0050      0
0.4050   0.5900   0.0050
          0   0.4050   0.5900
```

in which the typical row records the values at 2.1, or 3.1, or 4.1, of all
B-splines of order 3 for the knot sequence 1:6. There are three such
B-splines. The first one has knots 1,2,3,4, and its values are recorded
in the first column. In particular, the last entry in the first column is
zero since it gives the value of that B-spline at 4.1, a site to the right
of its last knot.

If you add the string 's1' as an additional input to `spcol`, then you can
ask `bkbrk` to extract detailed information about the block structure
of the matrix encoded in the resulting output from `spcol`. Thus, the
statement `bkbrk(spcol(1:6,3,.1+2:4,'s1'))` gives:

```
block 1 has 2 row(s)
   0.5900   0.0050      0
   0.4050   0.5900   0.0050
next block is shifted over 1 column(s)
block 2 has 1 row(s)
```
This is the most complex command in this toolbox since it has to deal with various ordering and blocking issues. The recurrence relations are used to generate, simultaneously, the values of all B-splines of order $k$ having anyone of the $\tau(i)$ in their support.

A separate calculation is carried out for the (presumably few) sites at which derivative values are required. These are the sites $\tau(i)$ with $m(i) > 0$. For these, and for every order $k - j$, $j = j_0, j_0 - 1, \ldots, 0$, with $j_0$ equal to $\max(m)$, values of all B-splines of that order are generated by recurrence and used to compute the $j$th derivative at those sites of all B-splines of order $k$.

The resulting rows of B-spline values (each row corresponding to a particular $\tau(i)$) are then assembled into the overall (usually rather sparse) matrix.

When the optional argument 's1' is present, these rows are instead assembled into a convenient almost block-diagonal form that takes advantage of the fact that, at any site $\tau(i)$, at most $k$ B-splines of order $k$ are nonzero. This fact (together with the natural ordering of the B-splines) implies that the collocation matrix is almost block-diagonal, i.e., has a staircase shape, with the individual blocks or steps of varying height but of uniform width $k$.

The command slvblk is designed to take advantage of this storage-saving form available when used, in spap2, spapi, or spaps, to help determine the B-form of a piecewise-polynomial function from interpolation or other approximation conditions.

The sequence $\tau$ is assumed to be nondecreasing.

See Also

slvblk | spap2 | spapi
Purpose: Spline curve by uniform subdivision

Syntax:

```
spcrv(c, k)
spcrv(c)
spcrv(c, k, maxpnt)
```

Description:

The function `spcrv` is used to generate a dense sequence of points on a uniform B-spline curve of order `k` with B-spline coefficients `c`. The curve is defined as:

\[ f(t) = \sum_{j=1}^{n} B(t - k/2 | j, ..., j + k) \cdot c(j), \quad \frac{k}{2} \leq t \leq n + \frac{k}{2} \]

with \( B(\cdot | a, ..., z) \) the B-spline with knots \( a, ..., z \), and \( n \) the number of coefficients in `c`, i.e., \([d, n]\) equals `size(c)`.

- `spcrv(c)` chooses the order `k` to be 4.
- `spcrv(c, k, maxpnt)` makes sure that at least `maxpnt` points are generated. The default value for the maximum number of sites \( tt \) to be generated is 100.

The parameter interval that the site sequence \( tt \) fills out uniformly is the interval \([k/2 .. (n-k/2)]\).

The output consists of the array \( f(tt) \).

Examples:

The following would show a questionable broken line and its smoothed version:

```matlab
points = [0 0 1 1 0 -1 -1 0 0 ;
          0 0 0 1 2 1 0 -1 -2];
plot(points(1,:),points(2,:),':')
values = spcrv(points,3);
hold on, plot(values(1,:),values(2,:)), hold off
```

Algorithms:

Repeated midpoint knot insertion is used until there are at least `maxpnt` sites. There are situations where use of `fnplt` would be more efficient.
See Also

fnplt
Purpose
Experiment with some spline approximation methods

Syntax
splinetoold
splinetoold(x,y)

Description
splinetoold is a graphical user interface (GUI), whose initial menu provides you with various choices for data including the option of importing some data from the workspace.

splinetoold(x,y) brings up the GUI with the specified data x and y, which are vectors of the same length.

Tips
The Spline Tool is shown in the following figure comparing cubic spline interpolation with a smoothing spline on sample data created by adding noise to the cosine function.
Approximation Methods

The approximation methods and options supported by the GUI are shown below.

<table>
<thead>
<tr>
<th>Approximation Method</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cubic Interpolating Spline</td>
<td>Adjust the type and values of the end conditions.</td>
</tr>
<tr>
<td>Smoothing Spline</td>
<td>Choose between cubic (order 4) and quintic (order 6) splines. Adjust the value of the tolerance and/or smoothing parameter. Adjust the weights in the error and roughness measures.</td>
</tr>
<tr>
<td>Least-Squares Approximation</td>
<td>Vary the order from 1 to 14. The default order is 4, which gives cubic approximating splines. Modify the number of polynomial pieces. Add and move knots to improve the fit. Adjust the weights in the error measure.</td>
</tr>
<tr>
<td>Spline Interpolation</td>
<td>Vary the order from 2 to 14. The default order is 4, which gives cubic spline interpolants. If the default knots supplied are not satisfactory, you can move them around to vary the fit.</td>
</tr>
</tbody>
</table>

Graphs

You can generate and compare several approximations to the same data. One of the approximations is always marked as “current” using a thicker line width. The following displays are available:

- Data graph. It shows:
  - The data
  - The approximations chosen for display in List of approximations
  - The current knot sequence or the current break sequence
• Auxiliary graph (if viewed) for the current approximation. You can invoke this graph by selecting any one of the items in the View menu. It shows one of the following:
  - The first derivative
  - The second derivative
  - The error

By default, the error is the difference between the given data values and the value of the approximation at the data sites. In particular, the error is zero (up to round-off) when the approximation is an interpolant. However, if you provide the data values by specifying a function, then the error displayed is the difference between that function and the current approximation. This also happens if you change the y-label of the data graph to the name of a function.

**Menu Options**

You can annotate and print the graphs with the File > Print to Figure menu.

You can export the data and approximations to the workspace for further use or analysis with the File > Export Data and File > Export Spline menus, respectively.

You can create, with the File > Generate Code menu, a function file that you can use to generate, from the original data, any or all graphs currently shown. This file also provides you with a written record of the commands used to generate the current graph(s).

You can save, with the Replicate button, the current approximation before you experiment further. If, at a later time, you click on the approximation so saved, splinetool restores everything to the way it was, including the data used in the construction of the saved approximation. This is true even if, since saving this approximation, you have edited the data while working on other approximations.

You can add, delete, or move data, knots, and breaks by right-clicking in the graph, or selecting the appropriate item in the Edit menu.
You can toggle the grid or the legend in the graph(s) with the **Tools** menu.

### Examples

- “Exploring End Conditions For Cubic Spline Interpolation” on page 12-232
- “Estimating the Second Derivative at an Endpoint” on page 12-235
- “Least-Squares Approximation” on page 12-237
- “Smoothing Spline” on page 12-240

### Exploring End Conditions For Cubic Spline Interpolation

The purpose of this example is to explore the various end conditions available with cubic spline interpolation:

1. Type `splinetooll` at the command line.

2. Select **Import your own data** from the initial screen, and accept the default function. You should see the following display.
The default approximation shown is the cubic spline interpolant with the not-a-knot end condition.

The vector $x$ of data sites is \texttt{linspace(0,2*pi,31)} and the values are $\cos(x)$. This differs from simply providing the vector $y$ of values in that the cosine function is explicitly recorded as the underlying function. Therefore, the error shown in the graph is the error in the spline as an approximation to the cosine rather than as an approximation to the given values. Notice the resulting relatively large error, about $5e-5$, near the endpoints.

3 For comparison, follow these steps:

- Click on \textbf{New} in the \textbf{List of approximations}.
- In \textbf{Approximation method}, select \textbf{complete} from the list of \textbf{End conditions}. 
Since the first derivative of the cosine function is sine, adjust the first-derivative values to their known values of zero at both the left end and the right end.

This procedure results in the display shown below (after the mouse is used to move the Legend further down). Note that the right end slope is zero only up to round-off. **Bottomline** tells you that the toolbox function `csape` was used to create the spline.

Be impressed by the improvement in the error, which is only about $5\times 10^{-6}$. 
For further comparison, follow these steps:

- Click on New in the List of approximations.
- In Approximation method, select natural from the list of End conditions.

Note the deterioration of the approximation near the ends, an error of about $2e-3$, which is much worse than with the not-a-knot end conditions.

For a final comparison, follow these steps:

- Click on New in the List of approximations.
- Since we know that the cosine function is periodic, in Approximation method, select periodic from the list of End conditions.

Note the dramatic improvement in the approximation, back to an error of about $5e-6$, particularly compared to the natural end conditions.

Estimating the Second Derivative at an Endpoint

This example uses cubic spline interpolation and least-squares approximation to determine an estimate of the initial acceleration for a drag car:

1. Type `splinetoool` at the command line or if the GUI is already running, click on File > Restart.

2. Choose Richard Tapia’s drag racing data. These data show the distance traveled by a drag car as a function of time. The message window asks you to estimate the initial acceleration by setting the initial speed to zero. Click on OK, or use Space or Enter, to remove the message window.

3. In Approximation method, select complete from the list of End conditions.
4 Adjust the initial speed by changing the first derivative at the left endpoint to zero.

5 Look for the value of the initial acceleration, which is given by the value of the second derivative at the left endpoint. You can toggle between the first derivative and the second derivative at this endpoint by clicking on the left end button. The value of the second derivative should be around 187 in the units chosen. Choose View > Show 2nd Derivative to see this graphically.

6 For comparison, click on New, then choose Least-Squares Approximation as the Approximation method. With this method, you can no longer specify end conditions. Instead, you may vary the order of the method. Verify that the initial acceleration is close to the cubic interpolation value.

The results of this procedure are shown below.
Least-Squares Approximation

This example encourages you to place five interior knots in such a way that the least-squares approximation to these data by cubic splines has an absolute error no bigger than .04 everywhere:

1. Type `splinetool` at the command line or if the GUI is already running, click on **File > Restart**.

2. Choose **Titanium heat data**.
3 Select **Least-Squares Approximation** as the **Approximation method**.

4 Notice how poorly this approximates the data since there are no interior knots. To view the current knots and add new knots, choose **knots** from **Data, breaks/knots, weights**. The knots are now listed in **knots**, and also displayed in the data graph as vertical lines. Notice that there are just the two end knots, each with multiplicity 4.

5 Right-click in the data graph and choose **Add Knot**. This brings up crosshairs for you to move with the mouse. Its precise horizontal location is shown in the edit field below the list of knots. A mouse click places a new knot at the current location of the crosshairs. One possible strategy is to place the additional knot at the place of maximum absolute error, as shown in the auxiliary graph below the data graph.
If you right-click and choose Replicate Knot, you will increase the multiplicity of the current knot, which is shown by its repeated occurrence in Knots. If you don’t like a particular knot, you can delete it. To delete a specific knot, you must first select it in either the list of knots or the data graph, and then right-click in the graph and choose Delete Knot.

6 You could also ask for an approximation using six polynomial pieces, which corresponds to five interior knots. To do this, enter 6 as # pieces in Data, breaks/knots, weights.

7 After you have the five interior knots, try to make the error even smaller by moving the knots. To do this, select the knot you want to move by clicking on its vertical line in the graph, then use the
interface control below Knots in Data, breaks/knots, weights and observe how the error changes with the movement of the knot. You can also use the edit field to overwrite the current knot location. You could also try adjust, which redistributes the current knot sequence.

8 Use Replicate in List of approximations to save any good knot distribution for later use. Rename the replicated approximation to lstsqr using Rename. To return to the original approximation, click on its name in List of approximations.

**Smoothing Spline**

This example experiments with smoothing splines:

1 Type splinetoool at the command line or, if the GUI is already running, click on File > Restart.

2 Choose Titanium heat data.

3 In Approximation method, choose Smoothing Spline.

4 Vary Parameter between 0 and 1, which changes the approximation from the least-squares straight-line approximation to the “natural” cubic spline interpolant.

5 Vary Tolerance between 0 and some large value, even inf. The approximation changes from the best possible one, the “natural” cubic spline interpolant, to the least-squares straight-line approximation.

6 As you increase the Parameter value or decrease the Tolerance value, the error decreases. However, a smaller error corresponds to more roughness, as measured by the size of the second derivative. To see this, choose View > Show 2nd Derivative and vary the Parameter and Tolerance values once again.

7 This step modifies the weights in the error measure to force the approximation to pass through a particular data point.
• Set **Tolerance** to 0.2. Notice that the approximation does not pass through the highest data point. To see the large error at this site, choose **View > Error**.

• To force the smoothing spline to go through this point, choose **Error Weights** from **Data, breaks/knots, weights**.

• Click on the highest data point in the graph and notice its site, which is indicated in **Sites and Values**.

• Use the edit field beneath the list of weights to change the current weight to 1000. Notice how much closer the smoothing spline now comes to that highest data point, and the decrease in the error at that site. Turn on the grid, by **Tools > Grid**, to locate the error at that site more readily.

8 This step modifies the weights in the roughness measure to permit a more accurate but less smooth approximation in the peak area while insisting on a smoother, hence less accurate, approximation away from the peak area.

• Choose **Jumps in Roughness Weight** from **Data, breaks/knots, weights**.

• Choose **View > Show 2nd Derivative**

• Select any data point to the left of the peak in the data.

• Set the jump at the selected site to -1 by changing its value in the edit field below it. Since the roughness weight for the very first site interval is 1, you have just set the roughness weight to the right of the highlighted site to 0. Correspondingly, the second derivative has become relatively small to the left of that site.

• Select any data point to the right of the peak in the data.

• Set the jump across the selected site to 1. Since the roughness weight just to the left of the highlighted site is 0, you have just set the roughness weight to the right of the highlighted site to 1. Correspondingly, the second derivative has become relatively small to the right of that site. The total effect is a very smooth but not very accurate fit away from the peak, while in the peak area,
the spline fit is much better but the second derivative is much larger, as is shown in the auxiliary graph below.

At the sites where there is a jump in the roughness weight, there is a corresponding jump in the second derivative. If you increase the Parameter value, the error across the peak area decreases but the second derivative remains quite large, while the opposite holds true away from the peak area.

See Also  csape | csapi | csaps | spap2 | spapi | spaps
**Purpose**
Taylor coefficients from local B-coefficients

**Syntax**

\[
[v, b] = \text{splpp}(tx, a) \\
[v, b] = \text{sprpp}(tx, a)
\]

**Description**
These are utility commands of use in the conversion from B-form to ppform (and in certain evaluations), but of no interest to the casual user.

\[
[v, b] = \text{splpp}(tx, a)
\]
provides the matrices \(v\) and \(b\), both of the same size \([r, k]\) as \(a\), and related to the input in the following way.

For \(i=1:r\), \(b(i,:)\) are the B-coefficients, with respect to the knot sequence \([tx(i,1:k-1), 0, \ldots, 0]\), of the polynomial of order \(k\) on the interval \([tx(i,k-1), tx(i,k)]\) whose \(k\) B-spline coefficients, with respect to the knot sequence \(tx(i,:),\) are in \(a(i,:).\) This is done by repeated knot insertion (of the knot 0). It is assumed that \(tx(i,k-1)<0<=tx(i,k)\).

For \(i=1:r\), \(v(i,:)\) are the polynomial coefficients for that polynomial, i.e., \(v(i,j)\) is the number \(D^{k-j}s(0–)/k–j\), \(j=1:k\), with \(s\) having the knots \(tx(i,:))\) and the B-coefficients \(a(i,:).\)

\[
[v, b] = \text{sprpp}(tx, a)
\]
carries out exactly the same job, except that now \(b(i,:)\) are the B-coefficients for that polynomial with respect to the knot sequence \([0, \ldots, 0, tx(i,k–2*(k-1)]\), and, correspondingly, \(v(i,j)\) is \(D^{k-j}s(0 + )/k–j\), \(j=1:k\). Also, now it is assumed that \(tx(i,k-1)<0<=tx(i,k)\).

**Examples**
The statement \([v, b]=\text{splpp}([-2 -1 0 1],[0 1 0])\) provides the sequence

\[
v = -1.0000 -1.0000 0.5000 = D^2s(0–)/2, Ds(0–), s(0–)
\]

with \(s\) the B-spline with knots -2, -1, 0, 1. This is so because the 1 in \text{splpp} indicates the limit from the left, and the second argument, \([0 1 0]\), indicates the spline \(s\) in question to be

\[
s = 0 \times B(\cdot | [?, -2, -1, 0]) + 1 \times B(\cdot | [-2, -1, 0, 1]) + 0 \times B(\cdot | [-1, 0, 1, ?])
\]
i.e., this particular linear combination of the third-order B-splines for
the knot sequence ..., -2, -1, 0, 1,... (Note that the values calculated do
not depend on the knots marked ?.) The above statement also provides
the sequence \( b = 0 \ 1.0000 \ 0.5000 \) of B-spline coefficients for the
polynomial piece of \( s \) on the interval \([-1.0]\), and with respect to the
knot sequence ?, -2, -1, 0, 0, ?.

In other words, on the interval \([-1.0]\), the B-spline with knots 2, -1,
0, 1 can be written

\[
0 \times B(\cdot | (?, ?) \ -1, 0, 1) + 1 \times B(\cdot | [-2, -1, 0, 0]) + 5 \times B(\cdot | [-1, 0, 0, ?])
\]

The statement \([v, b] = \text{sprpp}([[-1, 0, 1, 2],[1, 0, 0]])\) provides the
sequence

\[
v = [0.5000 \ -1.0000 \ 0.5000] = D^2 s(0+) / 2, Ds(0+), s(0+)
\]

with \( s \) the B-spline with knots ?, -1, 0, 1. Its polynomial piece on
the interval \([0.1]\) is independent of the choice of ?, so we might as well think
of ? as -2, i.e., we are dealing with the same B-spline as before. Note
that the last two numbers agree with the limits from the left computed
above, while the first number does not. This reflects the fact that a
quadratic B-spline with simple knots is continuous with continuous
first, but discontinuous second, derivative. (It also reflects the fact that
the leftmost knot of a B-spline is irrelevant for its right-most polynomial
piece.) The sequence \( b = 0.5000 \ 0 \ 0 \) also provided states that, on the
interval \([0.1]\), the B-spline \( B(\cdot | [-1, -1, 0, 1]) \) can be written

\[
0.5 \times B(\cdot | [0, 0, 0, 1]) + 0 \times B(\cdot | [0, 0, 1, 2]) + 0 \times B(\cdot | [0, 1, 2, ?])
\]
**Purpose**
Put together spline in B-form

**Syntax**

```
spmak(knots,coeffs)
spmak(knots,coeffs,sizec)
spmak
sp = spmak(knots,coeffs)
```

**Description**
The command `spmak(…)` puts together a spline function in B-form, from minimal information, with the rest inferred from the input. `fnbrk` returns all the parts of the completed description. In this way, the actual data structure used for the storage of this form is easily modified without any effect on the various fn... commands that use this construct.

`spmak(knots,coeffs)` returns the B-form of the spline specified by the knot information in `knots` and the coefficient information in `coeffs`.

The action taken by `spmak` depends on whether the function is univariate or multivariate, as indicated by `knots` being a sequence or a cell array. For the description, let `sizec` be `size(coeff)`.

If `knots` is a sequence (required to be non-decreasing), then the spline is taken to be univariate, and its order `k` is taken to be `length(knots)-sizec(end)`. This means that each ‘column’ `coeffs(:,j)` of `coeffs` is taken to be a B-spline coefficient of the spline, hence the spline is taken to be `sizec(1:end-1)`-valued. The basic interval of the B-form is `[knots(1) .. knots(end)]`. Knot multiplicity is held to be $\leq k$. This means that the coefficient `coeffs(:,j)` is simply ignored in case the corresponding B-spline has only one distinct knot, i.e., in case `knots(j)` equals `knots(j+k)`.

If `knots` is a cell array, of length `m`, then the spline is taken to be `m`-variate, and `coeffs` must be an $(r+m)$-dimensional array, – except when the spline is to be scalar-valued, in which case, in contrast to the univariate case, `coeffs` is permitted to be an `m`-dimensional array, but `sizec` is reset by

```
sizec = [1, sizec]; r = 1;
```
The spline is \texttt{sizec(1:r)}-valued. This means the output of the spline is an array with \( r \) dimensions, e.g., if \texttt{sizec(1:2) = [2, 3]} then the output of the spline is a 2-by-3 matrix.

The spline is \texttt{sizec(1:r)}-valued, the \( i \)th entry of the \( m \)-vector \( k \) is computed as \texttt{length(knots{\( i \)}) - sizec(r+i)}, \( i=1:m \), and the \( i \)th entry of the cell array of basic intervals is set to \texttt{[knots{\( i \)}(1), knots{\( i \)}(end)]}.

\texttt{spmak(knots,coefs,sizec)} lets you supply the intended size of the array \texttt{coefs}. Assuming that \texttt{coefs} is correctly sized, this is of concern only in the rare case that \texttt{coefs} has one or more trailing singleton dimensions. For, MATLAB suppresses trailing singleton dimensions, hence, without this explicit specification of the intended size of \texttt{coefs}, \texttt{spmak} would interpret \texttt{coefs} incorrectly.

\texttt{spmak} prompts you for \texttt{knots} and \texttt{coefs}.

\texttt{sp = spmak(knots,coeffs)} returns the spline \texttt{sp}.

**Examples**

\texttt{spmak(1:6,0:2)} constructs a spline function with basic interval \([1..6]\), with 6 knots and 3 coefficients, hence of order \( 6 - 3 = 3 \).

\texttt{spmak(t,1)} provides the B-spline \( B(\cdot|t) \) in B-form.

The coefficients may be \( d \)-vectors (e.g., 2-vectors or 3-vectors), in which case the resulting spline is a curve or surface (in \( \mathbb{R}^2 \) or \( \mathbb{R}^3 \)).

If the intent is to construct a 2-vector-valued bivariate polynomial on the rectangle \([-1..1] \times [0..1]\), linear in the first variable and constant in the second, say

\[
\text{coefs} = \text{zeros}([2,2,1]); \text{coefs}(::,1) = [1,0;0,1];
\]

then the straightforward

\texttt{sp = spmak({[-1 -1 1 1],[0 1]},coefs)};

will result in the error message 'There should be no more knots than coefficients', because the trailing singleton dimension of...
coefs will not be perceived by spmak, while proper use of that third argument, as in

\[
sp = \text{spmak}({[-1 -1 1 1],[0 1]},\text{coefs},[2 2 1]);
\]

will succeed. Replacing here [2 2 1] by size(coefs) would not work. See the example “Intro to B-form” for other examples.

**Diagnostics**

There will be an error return if the proposed knot sequence fails to be nondecreasing, or if the coefficient array is empty, or if there are not more knots than there are coefficients. If the spline is to be multivariate, then this last diagnostic may be due to trailing singleton dimensions in coefs.

**See Also**

fnbrk
**Purpose**

Explain spline terms

**Syntax**

```matlab
spterms(term)
expl = spterms(term)
[... , term] = spterms(...)
```

**Description**

`spterms(term)` provides, in a message box, an explanation of the technical term indicated by the string `term` as used in the Curve Fitting Toolbox spline functions and, specifically, in the GUI `splinetool`. Only the first few (but at least two) letters of the desired term need to be specified, and the full term is shown in the title of the message box.

```matlab
expl = spterms(term) returns, in `expl`, the string, or cell array of strings, comprising the explanation of the desired term.
```

```matlab
[... , term] = spterms(...) also returns, in `term`, the fully spelled-out term actually used.
```

**Examples**

`spterms('sp')` gives an explanation of the term ‘spline’, while `spterms('spline i')` explains the terms ‘spline interpolation’.

`help spterms` provides the list of all available terms.

**See Also**

`splinetool`

**How To**

- “List of Terms for Spline Fitting” on page A-2
Purpose
Scattered translates collocation matrix

Syntax
colmat = stcol(centers, x, type)
colmat = stcol(..., 'tr')

Description
colmat = stcol(centers, x, type) is the matrix whose (i,j)th entry is
\[ \psi_j(x(:,i)), \quad i = 1: \text{size}(x,2), j = 1: n \]
with the bivariate functions \( \psi_j \) and the number \( n \) depending on the centers and the string type, as detailed in the description of stmak.

centers and x must be matrices with the same number of rows.
The default for type is the string 'tp', and for this default, \( n \) equals size(centers, 2), and the functions \( \psi_j \) are given by
\[ \psi_j(x) = \psi(x - \text{centers}(:,j)), \quad j = 1: n \]
with \( \psi \) the thin-plate spline basis function
\[ \psi(x) = |x|^2 \log|x|^2 \]
and with \( |x| \) denoting the Euclidean norm of the vector \( x \).

Note See stmak for a description of other possible values for type.

The matrix colmat is the coefficient matrix in the linear system
\[ \sum_j a_j \psi_j(x(:,i)) = y_i, \quad i = 1: \text{size}(x,2) \]
that the coefficients \( a_j \) of the function \( f = \sum a_j \psi_j \) must satisfy in order that \( f \) interpolate the value \( y_i \) at the site \( x(:,i) \), all \( i \).
colmat = stcol(...,'tr') returns the transpose of the matrix returned by stcol(...).

**Examples**

**Example 1.** The following evaluates and plots the function

\[ f(x) = \psi(x - c_1) + \psi(x - c_2) + \psi(x - c_3) - 3.5\psi(x) \]

on a regular mesh, with \( \psi \) the above thin-plate basis function, and with \( c_1, c_2, c_3 \) three points on the unit circle; see the figure below.

```matlab
a = [0,2/3*pi,4/3*pi]; centers = [cos(a), 0; sin(a), 0];
[xx,yy] = ndgrid(linspace(-2,2,45));
xy = [xx(:) yy(:)].';
coefs = [1 1 1 -3.5];
zz = reshape( coefs*stcol(centers,xy,'tr') , size(xx));
surf(xx,yy,zz), view([240,15]), axis off
```

**Example 2.** The following also evaluates, on the same mesh, and plots the length of the gradient of the function in Example 1.
zz = reshape( sqrt( ... 
    ([coefs,0]*stcol(centers,xy,'tp10','tr')).^2 + ... 
    ([coefs,0]*stcol(centers,xy,'tr','tp01')).^2), 
    size(xx));
figure, surf(xx,yy,zz), view([220,-15]), axis off

See Also

spcol | stmak
**Purpose**
Put together function in stform

**Syntax**
```
stmak(centers, coefs)
```
```
st = stmak(centers, x, type)
```
```
st = stmak(centers, coefs, type, interv)
```

**Description**
**stmak(centers, coefs)** returns the stform of the function $f$ given by

$$
f(x) = \sum_{j=1}^{n} \text{coefs}(; , j) \cdot \psi(x - \text{centers}(; , j))
$$

with

$$
\psi(x) = |x|^2 \log |x|^2
$$

the thin-plate spline basis function, and with $|x|$ denoting the Euclidean norm of the vector $x$.

centers and coefs must be matrices with the same number of columns.

**st = stmak(centers, x, type)** stores in st the stform of the function $f$ given by

$$
f(x) = \sum_{j=1}^{n} \text{coefs}(; , j) \cdot \psi_j(x)
$$

with the $\psi_j$ as indicated by the string type, which can be one of the following:

- 'tp00', for the thin-plate spline;
- 'tp10', for the first derivative of a thin-plate spline wrto its first argument;
- 'tp01', for the first derivative of a thin-plate spline wrto its second argument;
- 'tp', the default.
Here are the details.

| 'tp00' | \( \psi_j(x) = \varphi(|x - c_j|^2), c_j = \text{centers}(:,j), j=1:n-3 \)  
|        | with \( \varphi(t) = t \log(t) \)  
|        | \( \psi_{n-2}(x) = x(1) \)  
|        | \( \psi_{n-1}(x) = x(2) \)  
|        | \( \psi_n(x) = 1 \)  

| 'tp10' | \( \psi_j(x) = \varphi(|x - c_j|^2), c_j = \text{centers}(:,j), j=1:n-1 \)  
|        | with \( \varphi(t) = (D_1 t)(\log t + 1) \), and \( D_1 t \) the partial derivative of \( t = t(x) = |x - c_j|^2 \) wrto \( x(1) \)  
|        | \( \psi_n(x) = 1 \)  

| 'tp01' | \( \psi_j(x) = \varphi(|x - c_j|^2), c_j = \text{centers}(:,j), j=1:n-1 \)  
|        | with \( \varphi(t) = (D_2 t)(\log t + 1) \), and \( D_2 t \) the partial derivative of \( t = t(x) = |x - c_j|^2 \) wrto \( x(2) \)  
|        | \( \psi_n(x) = 1 \)  

| 'tp' (default) | \( \psi_j(x) = \varphi(|x - c_j|^2), c_j = \text{centers}(:,j), j=1:n \)  
|                | with \( \varphi(t) = t \log(t) \)  

\text{st} = \text{stmak(centers,coefs,type,interv)} also specifies the basic interval for the stform, with \text{interv}\{j\} specifying, in the form \([a,b]\), the range of the \( j \)th variable. The default for \text{interv} is the smallest such box that contains all the given centers.

**Examples**

**Example 1.** The following generates the figure below, of the thin-plate spline basis function, \( \psi(x) = |x|^2 \log|x|^2 \), but suitably restricted to show that this function is negative near the origin. For this, the extra lines are there to indicate the zero level.

```matlab
inx = [-1.5 1.5]; iny = [0 1.2]; fnplt(stmak([0;0],1),{inx,iny}) hold on, plot(inx,repmat(linspace(iny(1),iny(2),11),2,1),'r')
```
Example 2. We now also generate and plot, on the very same domain, the first partial derivative $D_2\psi$ of the thin-plate spline basis function, with respect to its second argument.

```matlab
inx = [-1.5 1.5]; iny = [0 1.2];
fnplt(stmak([0;0],[1 0],'tp01',{inx,iny}))
view([13,10]),shading flat,axis off
```

Note that, this time, we have explicitly set the basic interval for the stform.

The resulting figure, below, shows a very strong variation near the origin. This reflects the fact that the second derivatives of $\psi$ have a logarithmic singularity there.
See Also

stcol
Purpose
Positive part

Syntax
\[ xp = \text{subplus}(x) \]

Description
\[ xp = \text{subplus}(x) \] returns \((x)_+\), i.e., the positive part of \(x\), which is \(x\) if \(x\) is nonnegative and 0 if \(x\) is negative. In other words, \(xp\) equals \(\max(x,0)\). If \(x\) is an array, this operation is applied entry by entry.

Examples
Example 1. Here is a plot of the essential part of the subplus function, as generated by

\[ x = -2:2; \text{plot}(x,\text{subplus}(x),'linew',4), \text{axis([-2,2,-.5,2.5])} \]

Example 2. The following anonymous function describes the so-called hat function:

\[ \text{hat} = @(x) \text{subplus}(x) - 2*\text{subplus}(x-1) + \text{subplus}(x-2); \]

i.e., the spline also given by \(\text{spmak}(0:2,1)\), as the following plot shows.

\[ x = -.5:.5:2.5; \text{plot}(x,\text{hat}(x),'linew',4), \text{set(gca,'Fontsize',16)} \]
Purpose
Titanium test data

Syntax
[x,y] = titanium

Description
[x,y] = titanium returns measurements of a certain property of
titanium as a function of temperature. Since their use in,
these data have become a standard test for data fitting since they are hard to fit by
classical techniques and have a significant amount of noise.

Examples
The plot of the data shown below is generated by the following commands:

[x,y] = titanium; plot(x,y,'ok'), set(gca,'Fontsize',16)

References
C. de Boor and J. R. Rice, Least squares cubic spline approximation II -
Variable knots, CSD TR 21, Comp.Sci., Purdue Univ., April 1968.
Purpose

Thin-plate smoothing spline

Syntax

\[ \text{tpaps}(x,y) \]
\[ \text{tpaps}(x,y,p) \]
\[ [...,p] = \text{tpaps}(...) \]

Description

\( \text{tpaps}(x,y) \) is the stform of a thin-plate smoothing spline \( f \) for the given data sites \( x(:,j) \) and the given data values \( y(:,j) \). The \( x(:,j) \) must be distinct points in the plane, the values can be scalars, vectors, matrices, even ND-arrays, and there must be exactly as many values as there are sites.

The thin-plate smoothing spline \( f \) is the unique minimizer of the weighted sum

\[ pE(f) + (1-p)R(f) \]

with \( E(f) \) the error measure

\[ E(f) = \sum_{j} |y(:,j) - f(x(:,j))|^2 \]

and \( R(f) \) the roughness measure

\[ R(f) = \int (|D_1 D_1 f|^2 + 2|D_1 D_2 f|^2 + |D_2 D_2 f|^2) \]

Here, the integral is taken over all of \( R^2 \), \( |z|^2 \) denotes the sum of squares of all the entries of \( z \), and \( Df \) denotes the partial derivative of \( f \) with respect to its \( i \)th argument, hence the integrand involves second partial derivatives of \( f \). The smoothing parameter \( p \) is chosen so that \( (1-p)/p \) equals the average of the diagonal entries of the matrix \( A \), with \( A + (1-p)/p \text{ eye}(n) \) the coefficient matrix of the linear system for the \( n \) coefficients of the smoothing spline to be determined. This choice of \( p \) is meant to ensure that we are in between the two extremes, of interpolation (when \( p \) is close to 1 and the coefficient matrix is essentially \( A \)) and complete smoothing (when \( p \) is close to 0 and the
The coefficient matrix is essentially a multiple of the identity matrix. This should serve as a good first guess for $p$.

$\text{tpaps}(x,y,p)$ also inputs the smoothing parameter, $p$, a number between 0 and 1. As the smoothing parameter varies from 0 to 1, the smoothing spline varies, from the least-squares approximation to the data by a linear polynomial when $p$ is 0, to the thin-plate spline interpolant to the data when $p$ is 1.

$[...;p] = \text{tpaps}(...) \text{ also returns the smoothing parameter actually used.}$

**Examples**

**Example 1.** The following code obtains values of a smooth function at 31 randomly chosen sites, adds some random noise to these values, and then uses $\text{tpaps}$ to recover the underlying exact smooth values. To illustrate how well $\text{tpaps}$ does in this case, the code plots, in addition to the smoothing spline, the exact values (as black balls) as well as each arrow leading from a smoothed value to the corresponding noisy value.

```matlab
rand('seed',23); nxy = 31;
xy = 2*(rand(2,nxy)-.5); vals = sum(xy.^2);
noisyvals = vals + (rand(size(vals))-.5)/5;
st = tpaps(xy,noisyvals); fnplt(st), hold on
avals = fnval(st,xy);
plot3(xy(1,:),xy(2,:),vals,'wo','markerfacecolor','k')
quiver3(xy(1,:),xy(2,:),avals,zeros(1,nxy),zeros(1,nxy), ...
        noisyvals-avals,'r'), hold off
```
Example 2. The following code uses an interpolating thin-plate spline to vector-valued data values to construct a map, from the plane to the plane, that carries the unit square \( \{x: |x(j)| \leq 1, j = 1:2\} \) approximately onto the unit disk \( \{x: x(1)^2 + x(2)^2 \leq 1\} \), as shown by the picture generated.

\[
\begin{align*}
n &= 64; \\
t &= \text{linspace}(0, 2\pi, n+1); \\
t(\text{end}) &= []; \\
values &= [\cos(t); \sin(t)]; \\
centers &= values./\text{repmat}(\text{max}(\text{abs}(values)), 2, 1); \\
st &= \text{tpaps}(\text{centers, values, 1}); \\
\text{fnplt}(st), \text{axis equal}
\end{align*}
\]

Note the choice of 1 for the smoothing parameter here, to obtain interpolation.
Limitations

The determination of the smoothing spline involves the solution of a linear system with as many unknowns as there are data points. Since the matrix of this linear system is full, the solving can take a long time even if, as is the case here, an iterative scheme is used when there are more than 728 data points. The convergence speed of that iteration is strongly influenced by $p$, and is slower the larger $p$ is. So, for large problems, use interpolation, i.e., $p$ equal to 1, only if you can afford the time.

See Also

csaps | spaps
Purpose

Name of cfit, sfit, or fittype object

Syntax

name = type(fun)

Description

name = type(fun) returns the custom or library name name of the cfit, sfit, or fittype object fun as a character array.

Examples

f = fittype('a*x^2+b*exp(n*x)');
category(f)
an =
custom
type(f)
an =
customnonlinear

g = fittype('fourier4');
category(g)
an =
library
type(g)
an =
fourier4

See Also

fittype | category

How To

• “List of Library Models for Curve and Surface Fitting” on page 4-13
Bibliography


Symbols and Numerics

1-column matrix 8-8
1-row matrix 8-8
2D A-9
3D A-9

A
adjusted R-square 7-19
adjusted residuals 4-54
algorithms 4-57
almost block-diagonal 12-7
  collocation matrix 12-217
  in spcol 12-225
linear system 12-210
  use 12-223
appropriate knot sequence 10-20
aptknt 12-2
area enclosed by spline curve 9-11
argnames 12-4
augknt 12-5
  use 9-12 10-21 11-12 11-15 11-21 12-28
augmented knot sequence 12-5
aveknt 12-6
  use 11-17 12-164
axes limit control
  nonparametric fit example 6-15

B
B in B-spline 10-20
B-form 10-16
  discussion of 10-3
  in spmak 12-245
smoothness conditions 10-20
  vs ppform 10-15
B-representation 8-6
B-spline
  coefficients 11-10
  example 12-243 12-246
(basis A-5
(basis function
  in stform 10-36
  of thin-plate spline A-7
    in stcol 12-249
    in stmak 12-252
(Overview) 10-9
basis map 11-3
BBform 12-106
bell-shaped 12-10
best interpolant 10-6
biarc 12-190 12-192
(Glossary) A-4
in CAGD 10-18
in spcol 12-223
in spcrv 12-226
normalized 10-3
of order k 10-3
some sample figures 10-18
support of 10-5
  via bspline 12-11
B\x8e zier 12-106
backslash operator 4-51
banded 10-5 11-24
banded linear system 10-5
basic interval 12-138
  as set in ppmak 12-171
  cautionary note 12-108 12-128
  extension outside 10-17
  for the B-form 12-245
  for the pp-form 10-10
  of B-form 10-17
  outside of 11-22
  use 11-22
  use in
    fnnder 12-117
    fnint 12-121
    fnjmp 12-123
    fnmin 12-125
    newknt 12-159
bias 11-25
bicubic spline example 9-13 12-26
bisquare weights
  robust fitting 4-54
bivariate 8-6
bkbrk 12-7
  in spcol 12-223
bounds
  confidence
    definition 7-28
  prediction
    definition 7-28
break
  example 10-12
  in ppform 10-10
  interior 10-20
  use 11-12
  vs knot 10-20
break sequence
  example 10-12 12-174
  in ppform 10-10
breaks (Glossary) A-4
breaks vs knots 10-16
conversion 10-20
brk2knt 12-8
bspligui 12-9
bspline
  use 10-17

cftool 12-14
chbpnt 12-16
Chebyshev polynomial 11-14
Chebyshev spline 11-14
circle, spline approximation to 10-25
circular arc 12-190
clamped end condition 12-22
coefficient
  confidence bounds 7-29
  constraints
    Fit Options GUI 4-7
    Fourier series example 5-12
    Gaussian example 5-23
  starting values
    Fit Options GUI 4-7
    Gaussian example 5-23
structure
  piecewise polynomials 6-15
coefficient of multiple determination 7-18
coeffnames 12-18
coeffvalues 12-19
collocation 11-9
  in spcol 12-223
  matrix 10-24
    constructed in spcol 12-223
    use in spapi 12-217
    use 11-8
collocation matrix
  in stcol 12-249
column-vector 8-8
composing function with a matrix 12-113
coefficient bounds
  definition 7-28
  Legendre polynomial example 5-43
confint 12-20
constraints
  Fit Options GUI 4-7
  Fourier series example 5-12
  Gaussian example 5-23
constructive approach to splines 10-6
control point
  example 10-24
  of a spline curve 10-16
  of a spline function 12-6
control polygon
  example 10-35
  of a spline function 12-6
  use 11-16
conversion
  B-form to ppform 10-5
  via splpp, sprpp 12-243
coordinates with respect to a basis A-6
covariance matrix of coefficient estimates 7-30
csape 12-22
csapi 12-28
  example 12-138
  use 12-134
csaps 12-30
cscvn 12-36
  in getcurve 12-151
cubic
  B-spline
    example 10-18
  Hermite 12-5
  smoothing spline 10-6
  spline
    example 11-14
  cubic means order 4 10-16
  cubic smoothing spline
    via csaps 12-30
cubic spline
  via spap2 12-213
  via spapi 12-216
cubic spline curve
  via cscvn 12-36
cubic spline interpolation 6-3 12-22
  via csapi 12-28
Curry-Schoenberg Theorem A-6
curvature 10-25
curve A-3
finding point on 9-12
  plotted via fnplt 12-126
  via spmak 12-246
  vs function A-3
curve fitting methods 3-8
  overview 3-6
curve fitting objects 3-6
  overview 3-6
Curve Fitting Tool
  Fourier series example 5-15
  Legendre polynomial example 5-42
  nonparametric fit example 6-15
  prediction bounds 7-25
  rational example 4-38
  residuals 7-24
custom equations
  general
    Fourier series example 5-9
    Gaussian example 5-20
  linear
    Legendre polynomial example 5-37
D
d-valued A-2
d-vector 8-8
data point A-7
  multiplicity
    in sorted 12-211
    in spapi 12-215
data sets
  enso 5-9
  gauss3 5-20
  hahn1 4-37
data site A-7
data value A-7
datastats 12-38
default
coefficient parameters
  fit options 4-10
confidence level for bounds 7-29
degree raising 12-115
degrees of freedom 7-19 11-9
dependnames 12-40
derivative
  of a rational spline A-6
design matrix 4-50
dialog box
  Create Custom Equation 5-46
Fitting
  Legendre polynomial example 5-42
differential equation
  non-standard 12-223
differentiate 12-41
differentiating a fit
  example 7-36
differentiation
  discrete 12-159
  in the pp sense 12-118
  of B-form 12-118
  via fnnder 12-117
dimension A-6
discrete
  differentiation 12-159
  least-squares approximation 11-21
domain of a function A-2
draftsman’s spline 10-2
dual functional 10-5
  use in fn2fm 12-107

e
end
  break 10-11
  knot 10-17
end conditions 12-22
  clamped 12-23
  complete 12-23
  curved 12-23
  Lagrange 12-23

natural 12-23
not-a-knot 12-22
other 12-24
variational 12-23
enso data set 5-9
equal quality data 4-48
equations
  custom 5-2
  library 4-3
equidistribute 12-159
error distributions 4-48
error measure 10-6
  (Glossary) A-8
  in csaps 12-30
  in spaps 12-219
  in splinetool 12-240
  in tpaps 12-259
error sum of squares 7-17
error weight A-8
evaluation
  of tensor product spline 11-20
  simultaneous 12-138
  via fnval 12-137
examples
  Fourier series fit 5-9
  Gaussian fit 5-20
  Legendre polynomial fit 5-37
  nonparametric fit 6-11
  rational fit 4-37
excludedata 12-47
exponentials
  fit type definition 4-25
extension beyond basic interval
  B-form 10-17
  cautionary note 12-108
  ppform 10-11
  via fnxtr 12-139
extrapolation 12-139
F
feval 12-52
filtering data
  moving average 6-30
  Savitzky-Golay 6-32
finite differencing parameters 4-9
fit 12-55
fit convergence criteria 4-9
Fit Editor
  Legendre polynomial example 5-42
  nonparametric fit example 6-11
fit options
  example 4-11
Fit Options GUI
  description 4-7
  Fourier series example 5-12
  Gaussian example 5-23
fitoptions 12-75
fitting
  algorithms 4-57
  fit options 4-7
  least-squares method
    linear 4-49
    nonlinear 4-56
  nonparametric 6-2
  parametric 4-2
Fitting GUI
  nonparametric fit example 6-11
fittype 12-91
fn2fm 12-106
fnbrk 12-109
  use 11-16 11-22 11-28
fnchg 12-112
fncmb 12-113
  use 9-13 12-24
fnder 12-117
  use 11-16 12-24
fndir 12-119
fnint 12-121
  vs fnder 12-117
fnjmp 12-123
fnmin 12-124
fnplt 12-126
  use 9-18 11-15 12-36
  vs spcrv 12-226
fnrfn 12-129
fntlr 12-131
fnval 12-137
  use 11-17 11-24 to 11-25 12-24
fnxtr 12-139
  use 11-5
fnzeros 12-142
formula 12-147
Fourier series
  example 5-9
  fit type definition 4-29
franke 11-20 12-148
Franke function 11-20
  picture 11-24
function A-2
  vs curve A-3
function reference
  argnames 12-4
  category 12-12
  cfit 12-13
  cftool 12-14
  coeffnames 12-18
  coeffvalues 12-19
  confint 12-20
  datastats 12-38
  dependnames 12-40
  differentiate 12-41
  excludedata 12-47
  feval 12-52
  fit 12-55
  fitoptions 12-75
  fittype 12-91
  formula 12-147
  get 12-149
  indepnames 12-152
integrate 12-153
islinear 12-155
numargs 12-161
numcoeffs 12-162
plot 12-165
predint 12-176
probnames 12-183
probvalues 12-184
quad2d 12-185
set 12-196
setoptions 12-198
sfit 12-199
sftool 12-202
smooth 12-204
type 12-263
functional
dual 10-5

g
Gauss points 11-9
gauss3 data set 5-20
Gaussian
example 5-20
fit type definition 4-31
general equations
custom 5-48
General Equations pane 5-48
Fourier series example 5-10
get 12-149
getcode 12-151
good interpolation sites
from chbpnt 12-16
from Chebyshev spline 11-14
via aveknt 12-6
goodness of fit
statistics 7-17
Greville site 10-23
gridded data
example 9-13 11-20

GUI
Fit Options
description 4-7
Fourier series example 5-12
Gaussian example 5-23
Fitting
nonparametric fit example 6-11
Table Options
goodness of fit evaluation 7-25

H
hahn1 data set 4-37
hat function 12-256
hat matrix 4-51
helix 12-188
Hermite
cubics 12-5
Hermite interpolation 12-190 12-215

I
implicit 8-5
indepnames 12-152
integral
definite 9-18
indefinite 12-121
integral equation 8-5
integrate 12-153
integrating a fit
example 7-36
integration 12-117
interior
break 10-11
knot 10-17
interpolant
variational
via csaps 12-31
via spaps 12-220
interpolants 6-3
interpolation A-7
   by thin-plate spline 12-261
   Hermite 9-12 12-215
   optimal 12-163
   via cscvn 12-36
   via spapi 12-215
   via spaps 12-220
interpolation points, good 12-6
interval notation (Glossary) A-2
islinear 12-155
iteratively reweighted least squares 4-54

J
   Jacobian 4-57
jump
   allow for 10-21
   ignored in fnnder 12-118
   in derivative 10-4

K
   knot 9-4
      average
         use 11-15
         via aveknt 12-6
      insertion
         used in fn2fm 12-107
         used in spcrv 12-226
         used in sp1pp 12-243
   interior 11-21
   multiplicity 12-128
      at endpoints 10-20
      at endpoints: cautionary note 12-128
   multiplicity vs smoothness 10-3
   sequence
      appropriate 10-20
      improved 12-159
      in B-form 10-16
   in spcol 12-223
   of a spline (Glossary) A-6
      optimal 12-163
      simple (Glossary) A-6
   knots vs breaks 10-16
      conversion 10-20
   knt2brk 12-157
   knt2mlt 12-157

L
   Lagrange end condition 12-24
   LAR 4-54
   least absolute residuals 4-54
   least-squares
      approximation
         by “natural” cubic splines 11-2
         discrete: example 11-21
         discrete: via slvblk 12-210
      (Glossary) A-8
         via spap2 12-212
         via spline 11-7
   in csaps 12-31
   in spaps 12-220
   least-squares fitting
      linear 4-49
      nonlinear 4-56
      robust 4-54
      weighted linear 4-52
   Legendre polynomials
      example 5-37
      generating 5-38
   Levenberg-Marquardt algorithm 4-57
   leverages 4-54
   library models 4-3
   limit from the left
      in sp1pp 12-243
      via fnval 12-138
   limit from the right 12-138
   linear
combination of functions 12-113
dependence 11-29
operations 12-113
space A-5
linear equations
  custom 5-46
  fit options 4-7
Linear Equations pane 5-46
linear interpolation 6-3
linear least squares 4-49
local
  polynomial coefficients 10-3
  power form
    (Glossary) A-4
    in ppform 10-10
local regression 6-34
  robust 6-38
loess 6-34
lowess 6-34

M
  m-variate A-4
  MAD
    robust fitting 4-55
  matrix
    banded 10-5
  matrix-valued A-2
  maximum
    via fnmin 12-124
  median absolute deviation
    robust fitting 4-55
  mesh 12-29
  meshgrid 12-29
  minimize 10-6
  minimum
    via fnmin 12-124
  models
    custom 5-2
    library 4-3
  Moebius 10-29
  moving average filtering 6-30
  multiple correlation coefficient 7-18
  multiplicity
    in a sequence 12-157
    of a data point 12-215
    of a knot 10-3
    vs smoothness
    in bspligui 12-9
  multivariable (see multivariate) 10-27
  multivariate 10-27
    example 12-26
    in fnval 12-138
    overview 10-8
    tensor product 10-27
    vs univariate A-3

N
  naming conventions 8-8
  natural
    (Glossary) A-9
    in csaps 12-31
    in cscvn 12-36
  ND-valued A-2 A-10
  nearest neighbor interpolation 6-3
  nested multiplication 12-138
  newknt 12-159
    use 11-12
  Newton’s method
    example 11-10
    in optknt 12-164
  noise 10-6
  noisy 9-7
  nonlinear equations
    fit options 4-7
    fitting 4-56
  nonlinear least squares 4-56
  nonlinear system
    in optknt 12-164
nonparametric fitting  example 6-11
methods 6-2
normal equations 4-50
normalized B-spline 10-3
not-a-knot end condition 12-22 12-190
in csape 12-29
numargs 12-161
numcoeffs 12-162
NURBS 10-35

optimal
interpolation 12-163
knot sequence 12-163
optknt 12-163
order 10-19
of a polynomial A-3
of a pp 10-12
of a spline 10-5
of ppform 10-10
osculatory 12-215
outliers
robust fit 4-54
overfitting
goodness of fit evaluation 7-26

parabolic 10-19
curve
example 12-174
spline 11-21
parametric
bicubic spline 12-26
cubic spline curve 12-36
parametric fitting 4-2
parametrization A-3
chord-length 9-10
parametrized 12-226
pchip 6-5
perfect spline 12-123
periodic 12-36
PGS 8-5
piecewise cubic
example 12-174
piecewise polynomials 6-5
piecewise-polynomial
(Glossary) A-4
in ppform 10-10
placeholder notation A-3
plot 12-165
plotting 12-126
point on a curve
finding 9-12
polygon 11-16
polynomial part of stform 10-36
polynomials
fit type definition 4-19
Legendre 5-38
piecewise 6-5
rational models 4-35
polyval 10-10
power form A-4
power series
fit type definition 4-33
pp 10-12
pp-representation 8-6
ppform
from fncmb 12-115
from spline 8-7
of a B-spline 12-11
(Overview) 10-2
via ppmak 12-171
vs B-form 10-15
ppmak 12-171
prediction bounds
definition 7-28
prediction intervals
example 7-33
predint 12-176
probnames 12-183
probvalues 12-184
projection matrix 4-51

Q
QR decomposition 4-51
QR factorization 12-217
  in spap2 12-214
  in spapi 12-217
  use in slvblk 12-210
quad2d 12-185
quality of data
  weighted linear least squares 4-52
quartic 10-24

R
R-square 7-18
  adjusted 7-19
  negative values 7-19
radial basis function 10-9 10-36
range of a function A-2
rational spline 10-30
  from rpmak, rsmak 12-186
  (Glossary) A-6
rational splines
  example 4-37
  fit type definition 4-35
RBF 10-9
rBform 10-30
recovery scheme 12-163
recurrence relation
  for B-splines 10-5
  use in fnval 12-138
  use in spcol 12-225
regression
  sum of squares 7-18
  weights 6-35
    least squares 4-52
Remez algorithm 11-16
residual degrees of freedom 7-19
residuals
  adjusted 4-54
  definition 7-21
  displaying
    goodness of fit evaluation 7-21
restriction to an interval 10-13
RMSE 7-20
robust
  fitting
    regression schemes 4-54
robust fitting
  example 4-58
robust least squares 4-54
robust smoothing 6-38
robust weights
  fitting 4-55
Rodrigues' formula 5-38
root mean squared error 7-20
roughness measure 10-6
  (Glossary) A-6
  in csaps 12-30
  in spaps 12-219
  in splinetool 12-241
  in tpaps 12-259
roughness weight A-9
row-vector 8-8
rpform 10-30
rpmak 12-186
rscvn 12-190
rsform 10-30
rsmak 12-186

S
Savitzky-Golay filtering 6-32
scalar-valued vs vector-valued A-2
scaling of a function 12-113
scatter plot smooth 6-34
scattered
data
in tpaps 12-259
translates 10-36
Schoenberg 10-2 A-4
Schoenberg-Whitney
conditions
(Glossary) A-8
in optknot 12-164
in spap2 12-212
in spapi 12-217
theorem
(Glossary) A-8
(Overview) 10-5
secant method 11-17
set 12-196
setoptions 12-198
sfit 12-199
sftool 12-202
shape-preserving interpolation 6-3
shifted power form A-4
side conditions 11-9
simple knot A-6
sine functions 4-42
site A-7
slvblk 12-210
   in spap2 12-214
   in spapi 12-217
smooth 12-204
smoothing A-8
parameter
(Glossary) A-9
in csaps 12-30
in spaps 12-220
in tpaps 12-260
(Overview) 10-6
spline 10-8
smoothing data

example 1 6-40
example 2 6-42
local regression 6-34
moving average filtering 6-30
Savitzky-Golay filtering 6-32
smoothing parameter 6-8
smoothing spline 6-8
smoothness 12-9
   across breaks 10-3
   across knot 10-16
   condition 10-20
      guaranteed 12-5
      in B-form 10-19
      multiplicity of 10-3
sort 12-211
sorted 12-211
spap2 12-212
   use 11-21 11-25 to 11-26 11-28
spapi 12-215
   use 9-4 11-15 11-18
spaps 12-219
sparse 12-223
   matrix 12-225
spcol 12-223
   in spap2 12-214
   in spapi 12-217
   use 10-20 10-24 11-10 11-12 11-24
spcrv 12-226
   vs fnplt 12-226
sphere
   via csape 12-26
   via rsmak 10-33
spline 6-5
   approximation to a circle 10-25
cubic interpolant 6-3
curve
   area enclosed by 9-11
   example 10-24
   via cscvn 12-36
   via spapi 9-10
via spcrv 12-226
draftsman’s 10-2
naming of 10-2
smoothing 6-8
specified 10-16
splinetool 12-228
splpp 12-243
spmak 12-245
  use 10-22 11-12 11-24 12-11 12-125
sprpp 12-243
spterms 12-248
SSE, SSR, SST 7-18
staircase shape 12-225
standard error 7-20
starting values
  Fit Options GUI 4-7
  Gaussian example 5-23
stcol 12-249
stform
  from stmak 12-252
stmak 12-252
structure of coefficients 6-15
subdivision 12-226
subplus 12-256
sum of sine functions
  fit type definition 4-42
sum of squares
  error 7-17
  regression 7-18
  total 7-18
support of a B-spline 10-5
surface A-3
surface fitting methods 3-11 7-13
surface fitting objects 3-11 7-13

T
Table Options GUI
  goodness of fit evaluation 7-25
target of a function A-2

Taylor
  polynomial
    example 12-135
    via fntlr 12-131
  series 10-2
tensor product 10-27 12-138
  example 11-20
  (Glossary) A-3
  polynomial A-4
thin-plate spline 10-8
  (Glossary) A-7
titanium 12-258
torus
  via rsmak 12-186 to 12-187
total sum of squares 7-18
tpaps 12-259
trivariate 10-8
truncated 10-2
trust-region algorithm 4-57
type 12-263

U
uniform
  knot sequence 11-21
  mesh 12-31
unimodal 12-10
unique spline 12-212
uniqueness of B-form 10-20
unit circle 10-32
univariate vs multivariate A-3

V
value outside basic interval 10-15
variational 12-31
  approach to splines 10-6
  interpolant
    via csaps 12-31
    via spaps 12-220
vector
  curve 12-127
  in this toolbox 8-8
  is always a column matrix 10-10
  -valued
    example 11-21
    in spmak 12-246
    splines 9-10
    vs scalar-valued A-2

W
Weibull distribution

fit type definition 4-44
weighted linear least squares 4-52
weights
  regression
    least squares 4-52
robust
  least squares 4-54
workflow
  object-oriented fitting 3-3